Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury **will** result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury **may** result if proper precautions are not taken.

**CAUTION**
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**NOTICE**
indicates that an unintended result or situation can occur if the corresponding information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation for the specific task, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

Purpose of the operating instructions

These operating instructions provide information for manuals derived from the requirements for mechanical engineering documentation according to DIN EN 62079. This information relates to the place of use, transport, storage, mounting, use and maintenance.

These operating instructions are intended for:

- Users
- Commissioning engineers
- Maintenance personnel

Pay particular attention to the section "Safety instructions and standards (Page 33)".

You can find more information such as operating instructions, examples and reference information in the online help of WinCC flexible.

Required knowledge

General knowledge of automation technology and process communication is needed to understand the operating instructions.

It is also assumed that those using the manual have experience in using personal computers and an understanding of Microsoft operating systems.

Scope of this manual

The manual applies to the "Mobile Panel 277 IWLAN V2" HMI devices in combination with the following software:

- STEP 7 V5.4, SP2 or higher
- Optional package "SIMATIC S7 Distributed Safety V5.4", SP3 or higher
- WinCC flexible 2008, SP2 with HSP "Mobile Panel 277 Wireless V2.0"

NOTICE

Manual belongs to HMI device

The supplied manual belongs to the HMI device and is also required to repeat commissioning. Keep all supplied and supplementary documentation for the entire service life of the HMI device.

Provide all stored documents to subsequent owners of the HMI device.
Trademarks
The following names marked with the ® symbol are registered trademarks of Siemens AG:

- HMI®
- SIMATIC®
- WinCC®

Style conventions

<table>
<thead>
<tr>
<th>Style Convention</th>
<th>Scope</th>
</tr>
</thead>
</table>
| "Add screen"     | • Terminology that appears in the user interface, for example dialog names, tabs, buttons, menu commands  
|                  | • Required input, for example, limits, tag values.  
|                  | • Path information  
| "File > Edit"    | Operational sequences, for example, menu commands, shortcut menu commands.  
| <F1>, <Alt+P>    | Keyboard operation  

Please observe notes labeled as follows:

Note
A note contains important information about the product described in the manual and its use, or a specific section of the manual to which you should pay particular attention.

Naming conventions

<table>
<thead>
<tr>
<th>Term</th>
<th>Applies to</th>
</tr>
</thead>
</table>
| Plant                 | System   
|                       | Machining center   
|                       | One or more machines   
| Actuate               | By means of the touch screen on the HMI device   
|                       | By operating a mouse on the HMI device   
| Mobile Panel 277 IWLAN V1 | Previous version of the Mobile Panel 277 IWLAN   
| Mobile Panel 277 IWLAN | Mobile Panel 277 IWLAN V1   
|                       | Mobile Panel 277 IWLAN V2   

<table>
<thead>
<tr>
<th>Term</th>
<th>Applies to</th>
</tr>
</thead>
</table>
| Plant                 | System   
|                       | Machining center   
|                       | One or more machines   
| Actuate               | By means of the touch screen on the HMI device   
|                       | By operating a mouse on the HMI device   

Figures

This manual contains illustrations of the described devices. The illustrations can deviate from the particularities of the delivered device.

Technical Support

Technical support for the products covered in the manual is available in the Internet at:

- Service (http://support.automation.siemens.com/WW/view/en/16604318)
- Contacts and office locations (http://www.automation.siemens.com/mcms/aspa-db/en/Pages/default.aspx)

Additional information on SIMATIC products is available in the Internet at:

- Overall SIMATIC documentation (http://www.automation.siemens.com/simatic/portal/html_76/techdoku.htm)

Recycling and disposal

The products described in this manual are recyclable because of the low level of contaminants in their components. Contact a certified disposal service company for environmentally sound recycling and disposal of your old devices.

Used batteries and rechargeable batteries

Used batteries and lithium ion batteries are hazardous waste. Always dispose of used batteries and lithium ion batteries properly in accordance with the regulations in effect. Identify the container provided for this purpose with the label, "Used batteries and rechargeables".

Note

Batteries and rechargeables do not belong in the garbage. The user is legally obliged to return used batteries and rechargeable batteries. You can deposit used batteries and rechargeables at any public collection site and anywhere batteries or rechargeables of similar type are sold.

You can also send batteries and rechargeables to the following address:

Siemens AG
Industry Sector
Returns Center
Siemensstr. 2
90766 Fürth
Germany
Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>Overview</td>
<td>13</td>
</tr>
<tr>
<td>1.1</td>
<td>Product overview</td>
<td>13</td>
</tr>
<tr>
<td>1.2</td>
<td>Scope of delivery</td>
<td>13</td>
</tr>
<tr>
<td>1.3</td>
<td>Mobile Panel 277 IWLAN</td>
<td>14</td>
</tr>
<tr>
<td>1.4</td>
<td>Accessory kit</td>
<td>16</td>
</tr>
<tr>
<td>1.5</td>
<td>Accessories</td>
<td>16</td>
</tr>
<tr>
<td>1.6</td>
<td>Equipment for HMI device and plant</td>
<td>17</td>
</tr>
<tr>
<td>1.6.1</td>
<td>Overview</td>
<td>17</td>
</tr>
<tr>
<td>1.6.2</td>
<td>Charging station</td>
<td>18</td>
</tr>
<tr>
<td>1.6.3</td>
<td>Power supply unit</td>
<td>19</td>
</tr>
<tr>
<td>1.6.4</td>
<td>Transponder</td>
<td>20</td>
</tr>
<tr>
<td>1.6.5</td>
<td>Access point</td>
<td>20</td>
</tr>
<tr>
<td>1.7</td>
<td>Compatibility of equipment</td>
<td>21</td>
</tr>
<tr>
<td>1.8</td>
<td>Communication and approved controllers</td>
<td>22</td>
</tr>
<tr>
<td>1.9</td>
<td>Software requirements</td>
<td>22</td>
</tr>
<tr>
<td>1.10</td>
<td>Supported WinCC flexible objects</td>
<td>23</td>
</tr>
<tr>
<td>1.11</td>
<td>Configuration and process control phases</td>
<td>27</td>
</tr>
<tr>
<td>1.12</td>
<td>Ranges in a transponder system</td>
<td>28</td>
</tr>
<tr>
<td>1.13</td>
<td>Rapid Roaming with iPCF and iPCF-MC</td>
<td>30</td>
</tr>
<tr>
<td>2</td>
<td>Safety instructions and standards</td>
<td>33</td>
</tr>
<tr>
<td>2.1</td>
<td>Safety instructions</td>
<td>33</td>
</tr>
<tr>
<td>2.2</td>
<td>Approvals</td>
<td>34</td>
</tr>
<tr>
<td>2.3</td>
<td>Standards on operating safety</td>
<td>36</td>
</tr>
<tr>
<td>2.4</td>
<td>Operating conditions</td>
<td>37</td>
</tr>
<tr>
<td>2.5</td>
<td>Electromagnetic compatibility</td>
<td>38</td>
</tr>
<tr>
<td>3</td>
<td>Planning application</td>
<td>41</td>
</tr>
<tr>
<td>3.1</td>
<td>Ambient conditions for transportation and storage</td>
<td>41</td>
</tr>
<tr>
<td>3.2</td>
<td>Ambient conditions for operation</td>
<td>42</td>
</tr>
<tr>
<td>3.3</td>
<td>Insulation resistance, protection class and degree of protection</td>
<td>45</td>
</tr>
<tr>
<td>3.4</td>
<td>WLAN properties</td>
<td>46</td>
</tr>
<tr>
<td>3.5</td>
<td>Equipping a plant with transponders</td>
<td>47</td>
</tr>
<tr>
<td>3.5.1</td>
<td>Dividing plant into zones</td>
<td>47</td>
</tr>
<tr>
<td>3.5.2</td>
<td>Zone quality</td>
<td>48</td>
</tr>
<tr>
<td>3.6</td>
<td>Mounting location and clearance of charging station</td>
<td>49</td>
</tr>
</tbody>
</table>
# Operating Instructions, 10/2010, A5E02480233-01

## Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>4 Installing and wiring devices</strong></td>
<td>55</td>
</tr>
<tr>
<td>4.1 Check the scope of delivery</td>
<td>55</td>
</tr>
<tr>
<td>4.2 Mounting the charging station</td>
<td>55</td>
</tr>
<tr>
<td>4.3 Connecting the charging station</td>
<td>56</td>
</tr>
<tr>
<td>4.4 Mounting the transponder</td>
<td>57</td>
</tr>
<tr>
<td>4.5 Setting the transponder ID and inserting the batteries</td>
<td>57</td>
</tr>
<tr>
<td>4.6 Connecting the HMI device</td>
<td>60</td>
</tr>
<tr>
<td>4.6.1 Safety instructions</td>
<td>60</td>
</tr>
<tr>
<td>4.6.2 Opening and closing the battery and terminal compartment</td>
<td>61</td>
</tr>
<tr>
<td>4.6.3 Ports and reset button</td>
<td>63</td>
</tr>
<tr>
<td>4.6.4 Inserting a memory card</td>
<td>64</td>
</tr>
<tr>
<td>4.6.5 Inserting, charging and changing the main battery</td>
<td>66</td>
</tr>
<tr>
<td>4.6.5.1 Safety instructions</td>
<td>66</td>
</tr>
<tr>
<td>4.6.5.2 Replacing the main rechargeable battery</td>
<td>67</td>
</tr>
<tr>
<td>4.6.5.3 Charging the main rechargeable battery</td>
<td>67</td>
</tr>
<tr>
<td>4.6.5.4 Displaying the battery charge status</td>
<td>69</td>
</tr>
<tr>
<td>4.6.6 Connecting the PLC</td>
<td>70</td>
</tr>
<tr>
<td>4.6.7 Connecting the configuration PC</td>
<td>70</td>
</tr>
<tr>
<td>4.6.8 Connecting a printer</td>
<td>72</td>
</tr>
<tr>
<td>4.6.9 Connecting a USB device</td>
<td>73</td>
</tr>
<tr>
<td>4.6.10 Connecting the power supply unit</td>
<td>74</td>
</tr>
<tr>
<td>4.7 Switching on and testing the HMI device</td>
<td>75</td>
</tr>
<tr>
<td>4.8 Switching off the HMI device</td>
<td>76</td>
</tr>
<tr>
<td><strong>5 Operator controls and displays</strong></td>
<td>77</td>
</tr>
<tr>
<td>5.1 Overview</td>
<td>77</td>
</tr>
<tr>
<td>5.2 LED display</td>
<td>79</td>
</tr>
<tr>
<td>5.3 Power management</td>
<td>81</td>
</tr>
<tr>
<td>5.4 Operator controls</td>
<td>82</td>
</tr>
<tr>
<td>5.4.1 Operating the handwheel</td>
<td>82</td>
</tr>
<tr>
<td>5.4.2 Operating the key-operated switch</td>
<td>83</td>
</tr>
<tr>
<td>5.4.3 Operating the illuminated push-button</td>
<td>84</td>
</tr>
<tr>
<td>5.4.4 Evaluation of the operator controls</td>
<td>84</td>
</tr>
<tr>
<td>5.4.4.1 Overview</td>
<td>84</td>
</tr>
<tr>
<td>5.4.4.2 Evaluating operator controls as direct keys</td>
<td>84</td>
</tr>
<tr>
<td>5.4.4.3 Controlling the LEDs of the function keys via system functions</td>
<td>88</td>
</tr>
<tr>
<td>5.4.4.4 Controlling the handwheel via system functions</td>
<td>88</td>
</tr>
<tr>
<td>5.4.4.5 Controlling key-operated switches via system functions</td>
<td>89</td>
</tr>
<tr>
<td>5.4.4.6 Controlling and evaluating illuminated mushroom pushbuttons via system functions</td>
<td>89</td>
</tr>
<tr>
<td>5.5 Labeling the function keys</td>
<td>90</td>
</tr>
<tr>
<td>5.6 Holding, operating and setting down the HMI device</td>
<td>93</td>
</tr>
<tr>
<td>5.7 Charging station</td>
<td>94</td>
</tr>
<tr>
<td>5.7.1 Charging the main battery in the charging compartment</td>
<td>94</td>
</tr>
<tr>
<td>5.7.2 LED-displays on the charging station</td>
<td>95</td>
</tr>
<tr>
<td>5.7.3 Locking the charging station</td>
<td>96</td>
</tr>
</tbody>
</table>
# Configuring the HMI device

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Desktop and Loader</td>
<td>97</td>
</tr>
<tr>
<td>6.2 Operating desktop and loader</td>
<td>100</td>
</tr>
<tr>
<td>6.3 Enabling and disabling SecureMode</td>
<td>101</td>
</tr>
<tr>
<td>6.4 Control Panel</td>
<td>101</td>
</tr>
<tr>
<td>6.4.1 Overview</td>
<td>101</td>
</tr>
<tr>
<td>6.4.2 Functions in the Control Panel</td>
<td>102</td>
</tr>
<tr>
<td>6.4.3 Operating the Control Panel</td>
<td>103</td>
</tr>
<tr>
<td>6.4.4 Using the screen keyboard in the Control Panel</td>
<td>104</td>
</tr>
<tr>
<td>6.4.5 Configuring operation</td>
<td>107</td>
</tr>
<tr>
<td>6.4.5.1 Configuring the screen keyboard</td>
<td>107</td>
</tr>
<tr>
<td>6.4.5.2 Changing display brightness</td>
<td>108</td>
</tr>
<tr>
<td>6.4.5.3 Setting the character repeat rate of the screen keyboard</td>
<td>109</td>
</tr>
<tr>
<td>6.4.5.4 Setting the double-click</td>
<td>110</td>
</tr>
<tr>
<td>6.4.5.5 Calibrating the touch screen</td>
<td>111</td>
</tr>
<tr>
<td>6.4.5.6 Starting the HMI device again</td>
<td>112</td>
</tr>
<tr>
<td>6.5 Entering and deleting a password</td>
<td>114</td>
</tr>
<tr>
<td>6.6 WLAN communication</td>
<td>115</td>
</tr>
<tr>
<td>6.6.1 Overview</td>
<td>115</td>
</tr>
<tr>
<td>6.6.2 Assigning WLAN communication parameters</td>
<td>119</td>
</tr>
<tr>
<td>6.6.3 Assigning IPCF-MC parameters</td>
<td>124</td>
</tr>
<tr>
<td>6.7 General settings</td>
<td>127</td>
</tr>
<tr>
<td>6.7.1 Setting the date and time</td>
<td>127</td>
</tr>
<tr>
<td>6.7.2 Backing up registry information and temporary data</td>
<td>128</td>
</tr>
<tr>
<td>6.7.3 Displaying information about the HMI device</td>
<td>130</td>
</tr>
<tr>
<td>6.7.4 Display firmware</td>
<td>131</td>
</tr>
<tr>
<td>6.7.5 Display the charging status and temperature of the rechargeable battery</td>
<td>131</td>
</tr>
<tr>
<td>6.7.6 Selecting transponders</td>
<td>132</td>
</tr>
<tr>
<td>6.7.7 Activate memory management</td>
<td>133</td>
</tr>
<tr>
<td>6.7.8 Activating vibration alarm</td>
<td>134</td>
</tr>
<tr>
<td>6.7.9 Changing the printer properties</td>
<td>135</td>
</tr>
<tr>
<td>6.7.10 Regional and language settings</td>
<td>136</td>
</tr>
<tr>
<td>6.7.11 Setting the screen saver</td>
<td>137</td>
</tr>
<tr>
<td>6.7.12 Displaying general system properties</td>
<td>139</td>
</tr>
<tr>
<td>6.7.13 Displaying memory distribution</td>
<td>140</td>
</tr>
<tr>
<td>6.7.14 Setting the location of the project</td>
<td>141</td>
</tr>
<tr>
<td>6.7.15 Setting the delay time for the project</td>
<td>142</td>
</tr>
<tr>
<td>6.8 Enabling PROFINET IO</td>
<td>143</td>
</tr>
<tr>
<td>6.9 Programming the data channel</td>
<td>144</td>
</tr>
<tr>
<td>6.10 Configuring network operation</td>
<td>145</td>
</tr>
<tr>
<td>6.10.1 Overview</td>
<td>145</td>
</tr>
<tr>
<td>6.10.2 Specifying the computer name of the HMI device</td>
<td>147</td>
</tr>
<tr>
<td>6.10.3 Specifying the IP address and name server</td>
<td>148</td>
</tr>
<tr>
<td>6.10.4 Specifying the logon data</td>
<td>149</td>
</tr>
<tr>
<td>6.10.5 Configuring e-mail</td>
<td>150</td>
</tr>
<tr>
<td>6.11 Changing internet settings</td>
<td>152</td>
</tr>
<tr>
<td>6.11.1 Changing general settings</td>
<td>152</td>
</tr>
<tr>
<td>6.11.2 Setting the proxy server</td>
<td>153</td>
</tr>
<tr>
<td>6.11.3 Changing privacy settings</td>
<td>154</td>
</tr>
<tr>
<td>6.11.4 Importing, displaying and deleting certificates</td>
<td>155</td>
</tr>
</tbody>
</table>
# Table of contents

## 6.12 Saving to external storage medium – backup .......................................................... 157
## 6.13 Restoring from external storage medium – Restore ............................................... 159

### 7 Commissioning a project .................................................................................... 163

#### 7.1 Using an existing project .................................................................................. 163
#### 7.2 Operating modes ............................................................................................... 163
#### 7.3 Available data channels .................................................................................... 164
#### 7.4 Preparing and backing up a project .................................................................... 164

##### 7.4.1 Overview ..................................................................................................... 164
##### 7.4.2 Transfer ..................................................................................................... 165

###### 7.4.2.1 Overview ................................................................................................. 165
###### 7.4.2.2 Starting manual transfer ........................................................................... 166
###### 7.4.2.3 Starting automatic transfer ........................................................................ 167
###### 7.4.2.4 Starting backtransfer ................................................................................ 168
##### 7.4.3 Testing a project .......................................................................................... 169
##### 7.4.4 Backup and restore ..................................................................................... 170

###### 7.4.4.1 Overview ................................................................................................. 170
###### 7.4.4.2 Backing up with WinCC flexible ................................................................. 171
###### 7.4.4.3 Backing up with ProSave ............................................................................ 172
###### 7.4.4.4 Restoring with WinCC flexible ................................................................... 173
###### 7.4.4.5 Restoring with ProSave .............................................................................. 174
##### 7.4.5 Updating the operating system ...................................................................... 175

###### 7.4.5.1 Overview ................................................................................................. 175
###### 7.4.5.2 Updating the operating system using WinCC flexible ................................ 175
###### 7.4.5.3 Updating the operating system using ProSave ........................................... 176
##### 7.4.6 Restoring factory settings ............................................................................. 177

###### 7.4.6.1 Overview ................................................................................................. 177
###### 7.4.6.2 Restoring the factory settings using WinCC flexible .................................... 178
###### 7.4.6.3 Restoring the factory settings with ProSave ............................................... 180
##### 7.4.7 Installing and removing software options ...................................................... 183

###### 7.4.7.1 Overview ................................................................................................. 183
###### 7.4.7.2 Installing with WinCC flexible ................................................................. 183
###### 7.4.7.3 Removing with WinCC flexible ................................................................. 184
###### 7.4.7.4 Installing with ProSave ............................................................................... 185
###### 7.4.7.5 Removing with ProSave ............................................................................. 185
##### 7.4.8 Transferring license keys back and forth ...................................................... 186

###### 7.4.8.1 Overview ................................................................................................. 186
###### 7.4.8.2 Transfer license keys ................................................................................ 187
###### 7.4.8.3 Transfer license keys back .......................................................................... 188

## 8 Commissioning the plant ....................................................................................... 189

#### 8.1 Overview ........................................................................................................... 189
#### 8.2 Acceptance of the plant .................................................................................... 189
#### 8.3 Transponder system .......................................................................................... 190
#### 8.3.1 Testing zones ................................................................................................. 190

## 9 Operating a project ................................................................................................ 191

#### 9.1 Starting the project ............................................................................................ 191
#### 9.2 Operator input options ...................................................................................... 192
#### 9.3 Direct keys ......................................................................................................... 194
## Table of contents

9.4 Setting the project language ........................................................................................................... 195
9.5 Operating the screen keyboard in the project ................................................................................... 195
9.6 Device-specific displays .................................................................................................................... 199
9.6.1 Showing the battery charge ........................................................................................................ 199
9.6.2 Displaying WLAN quality ........................................................................................................... 200
9.6.3 Display "zone name" object ......................................................................................................... 201
9.6.4 Display "zone quality" object ....................................................................................................... 201
9.7 Project security .................................................................................................................................. 201
9.7.1 Overview ..................................................................................................................................... 201
9.7.2 User View ................................................................................................................................... 201
9.7.3 User logon.................................................................................................................................. 204
9.7.4 User logoff .................................................................................................................................. 205
9.7.5 Creating users ............................................................................................................................. 206
9.7.6 Changing user data ...................................................................................................................... 208
9.7.7 Deleting users ............................................................................................................................. 209
9.8 Function keys .................................................................................................................................. 209
9.9 Bar .................................................................................................................................................. 210
9.10 Gauge .......................................................................................................................................... 211
9.11 Operating the slider control ............................................................................................................. 211
9.12 Operating the switch ......................................................................................................................... 212
9.13 Operating the Trend View .............................................................................................................. 213
9.14 Operating the status force ................................................................................................................. 215
9.15 Operating the Sm@rtClient view .................................................................................................... 217
9.16 Operate alarm view and alarm window ......................................................................................... 219
9.16.1 Overview .................................................................................................................................. 219
9.16.2 Recognizing pending alarms ...................................................................................................... 221
9.16.3 Alarm view ................................................................................................................................. 222
9.16.3.1 Overview ................................................................................................................................ 222
9.16.3.2 Displaying alarms ................................................................................................................... 222
9.16.3.3 Display alarm window ............................................................................................................. 224
9.16.4 Display infotexts for an alarm .................................................................................................... 224
9.16.5 Acknowledge alarm .................................................................................................................... 224
9.16.6 Edit alarm .................................................................................................................................. 225
9.17 Operating recipes ............................................................................................................................. 226
9.17.1 Overview .................................................................................................................................. 226
9.17.2 Structure of a recipe ..................................................................................................................... 226
9.17.3 Recipes in the Project .................................................................................................................. 228
9.17.4 Recipe displays ............................................................................................................................ 229
9.17.5 Recipe Values in the HMI Device and the PLC ........................................................................... 232
9.17.6 Operating the recipe view ........................................................................................................... 234
9.17.6.1 Overview ................................................................................................................................ 234
9.17.6.2 Creating a recipe data record .................................................................................................. 235
9.17.6.3 Editing a recipe data record .................................................................................................... 236
9.17.6.4 Deleting a recipe data record .................................................................................................. 237
9.17.6.5 Synchronizing tags .................................................................................................................. 237
9.17.6.6 Reading a recipe data record from the PLC .......................................................................... 238
9.17.6.7 Transferring a recipe data record to the PLC ........................................................................ 239
9.17.7 Operating the simple recipe view ............................................................................................... 240
# Table of contents

9.17.7.1 Overview .................................................................................................................. 240
9.17.7.2 Creating a recipe data record .................................................................................. 242
9.17.7.3 Editing a recipe data record .................................................................................... 242
9.17.7.4 Deleting a recipe data record .................................................................................. 243
9.17.7.5 Reading a recipe data record from the PLC .......................................................... 244
9.17.7.6 Transferring a recipe data record to the PLC ......................................................... 244
9.17.8 Exporting a recipe data record .................................................................................... 245
9.17.9 Importing a recipe data record .................................................................................... 246
9.17.10 Examples ................................................................................................................... 247
9.17.10.1 Entering a recipe data record .................................................................................. 247
9.17.10.2 Manual production sequence ............................................................................... 248
9.18 Closing the project ......................................................................................................... 248

10 Maintenance and care ....................................................................................................... 249
  10.1 Maintenance and care .................................................................................................... 249
  10.2 Spare parts and repairs ................................................................................................. 250

11 Technical specifications .................................................................................................... 251
  11.1 Dimension drawings ...................................................................................................... 251
    11.1.1 Mobile Panel 277 IWLAN ........................................................................................ 251
    11.1.2 Charging station ...................................................................................................... 253
    11.1.3 Transponder ............................................................................................................ 254
  11.2 Specifications ................................................................................................................ 255
    11.2.1 Mobile Panel 277 IWLAN ........................................................................................ 255
    11.2.2 Interface description ............................................................................................... 257
    11.2.3 Main rechargeable battery ...................................................................................... 259
    11.2.4 Charging station ...................................................................................................... 259
    11.2.5 Transponder ............................................................................................................ 260
  11.3 WLAN radiation characteristics of the HMI device ...................................................... 261
    11.3.1 Radiation characteristic in the 2.4 GHz band ......................................................... 261
    11.3.2 Radiation characteristic in the 5 GHz band ............................................................ 262
  11.4 Radiation characteristics of the transponder system ..................................................... 264
    11.4.1 Radiation characteristic of HMI device ................................................................... 264
    11.4.2 Radiation characteristic of the transponder ............................................................. 267

A Appendix .......................................................................................................................... 271
  A.1 ESD guideline ................................................................................................................ 271
  A.2 System alarms ................................................................................................................. 273

B Abbreviations ...................................................................................................................... 307
  B.1 Abbreviations ................................................................................................................ 307

Glossary .................................................................................................................................. 309

Index ..................................................................................................................................... 315
Overview

1.1 Product overview

Expanded possible fields of application with the SIMATIC Mobile Panel 277 IWLAN

The Mobile Panel 277 IWLAN is suitable for mobile operation in the plant. With the Mobile Panel 277 IWLAN, the operator can operate and monitor the production process wirelessly from almost any location in the plant.

The HMI device communicates with the PLC via WLAN. The Mobile Panel 277 IWLAN is battery-powered.

The HMI device is equipped with a zone recognition function. The use of zone-specific process plant images provides optimum assistance to the operator when operating and monitoring the plant.

The ergonomic design of the HMI device enables safe and consistent working with the Mobile Panel 277 IWLAN.

The Mobile Panel 277 IWLAN offers short commissioning times, a large user memory and high performance. The HMI device is optimized for projects based on WinCC flexible.

The Mobile Panel 277 IWLAN has the following features:

- Wireless operation with
  - IWLAN interface via PROFINET
  - Battery operation
- Zone recognition
- 7.5" TFT screen with 64k colors
- 18 function keys with LED
- Extended HMI functions

1.2 Scope of delivery

The scope of delivery includes:

- 1 Mobile Panel 277 IWLAN
- 1 main rechargeable battery
- 1 accessory kit
- 1 data carrier with documents

Additional documents may be included in the scope of delivery.
1.3 Mobile Panel 277 IWLAN

The Mobile Panel 277 IWLAN works wirelessly in battery mode or plugged into a charging station.

Front view

The following figure shows a fully equipped Mobile Panel 277 IWLAN.

① Handwheel, optional
② LED display
③ Membrane keyboard
④ Display with touch screen
⑤ "ON/OFF" button
⑥ Covers for the labeling strips for the slot openings
⑦ Illuminated pushbutton, optional
⑧ Key-operated switch, optional
Overview

1.3 Mobile Panel 277 IWLAN

Side view

① Fall protection
② Buttons, arranged on both sides, without a function
③ Handle

Rear view

① Nameplate
② Handle
③ Battery compartment cover
④ Connection compartment cover
⑤ Contacts for charging station
⑥ USB connector
⑦ Connection for power supply
1.4 Accessory kit

The accessory kit contains:

- 1 cover cap with rubber seal
- 1 screw for fixing the cover cap
- 1 label for cover caps

Additional documents may be enclosed with the accessory kit.

1.5 Accessories

The accessory can be ordered from the Internet at Industry Mall (http://mall.automation.siemens.com).

- Labeling strips
  Labeling strips serve for the project-oriented labeling of function keys on the HMI device. Stickers for the cover caps can also be supplied, in addition to the labeling strips. The cover caps cover the slot openings for the labeling strips.
  Order number: 6AV6671-5BF00-0AX0

- Replacement key set
  The replacement key set contains two keys for the key switch.
  Order number: 6AV6574-1AG04-4AA0

- Main battery
  The main rechargeable battery supplies power to the HMI device.
  Order number: 6AV6671-5CL00-0AX0

- Protective foil
  The protective foil prevents the touch screen from becoming scratched or soiled.
  Order number: 6AV6671-5BC00-0AX0

- Service package for the HMI device
  Order number: 6AV6671-5CA00-0AX2
  The service pack includes:
  - Cover caps
  - Battery compartment cover
• Memory card
  Only use SD memory cards tested and approved by Siemens AG or MicroMemory cards.

  **Note**
  The MicroMemory card of the SIMATIC S7 controller is not suited for use with this HMI device.

• USB Flash drive for SIMATIC PC
  The USB Flash drive for SIMATIC PC is a mobile data storage device with a high data throughput, designed for industrial use.

1.6 Equipment for HMI device and plant

1.6.1 Overview

The following devices are needed for the HMI device and for fail-safe operation of a plant:

- **HMI device**
  - Charging station
  - Power supply unit, optional

- **Plant**
  - Transponder
  - Access point
  - Signal lamp, optional
  - Security systems, optional

The devices listed are not included in the scope of delivery of the HMI device. Order these devices separately.

You can find order information on the Internet at Industry Mall (http://mall.automation.siemens.com).
1.6.2 Charging station

The charging station is used to charge the main battery in the HMI device and to safely store the HMI device. The charging station is designed to be used in the system.

Order number: 6AV6671-5CE00-0AX1

- Lock
- Hook for hooking in the HMI device
- Charging compartment for one main battery
- Charging contact for the HMI device
- LED display

On the underside of the charging station you will find the slot for power supply.

Charging station accessory kit

The accessory kit contains:
- 1 lock
- 1 key set for lock
- 1 cable connector
- 4 spacer sleeves for mounting on conductive surfaces

The accessory kit can include documents.
1.6.3 Power supply unit

The power supply unit supplies the power to the HMI device. The power supply unit can be used in 120 and 230 V AC power networks. The setting of the voltage range takes place automatically. Output voltage is 12V DC.

① “Power” LED
② Connecting cable
③ Power supply unit
④ Power supply cable

Order number: 6AV6671-5CN00-0AX1

The power supply unit is provided with four power supply cables with plugs for the following regions:

- Europe
- Asia
- North America
- United Kingdom of Great Britain and Northern Ireland

Read the relevant documentation.
Overview

1.6 Equipment for HMI device and plant

1.6.4 Transponder

A transponder is required for setting up configured zones. The Mobile Panel 277 IWLAN V2 supports the zone system.

Order number: 6AV6671-5CM00-0AX1

Accessory kit

The accessory kit contains:
- 3 AA mignon batteries, 1.5 V

The accessory kit can include documents.

1.6.5 Access point

The access point is needed for the WLAN. The access point serves as a gateway between the wireless and wired network.
To use the function iPCF-MC for Rapid Roaming, you need an access point with two wireless interfaces of the type SCALANCE W78x-2RR and firmware V4.3.

The HMI device supports operation with the following access points:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Number of WLAN interfaces</th>
<th>Antenna</th>
<th>iPCF-MC Rapid roaming</th>
<th>Order number</th>
</tr>
</thead>
</table>
| SCALANCE W784-1 | 1                          | External | No                    | 6GK5 784-1AA30-2AA0  
6GK5 784-1AA30-2AB0  
1 |
| SCALANCE W786-1PRO | 1                          | Internal | No                    | 6GK5 786-1BA60-2AA0  
6GK5 786-1BA60-2AB0  
1 |
| SCALANCE W786-2RR  | 2                          | Internal | Yes                   | 6GK5 786-2BA60-6AA0  
6GK5 786-2BA60-6AB0  
1 |
| SCALANCE W788-1PRO | 1                          | External | No                    | 6GK5 788-1AA60-2AA0  
6GK5 788-1AA60-2AB0  
1 |
| SCALANCE W788-2RR  | 2                          | External | Yes                   | 6GK5 788-2AA60-6AA0  
6GK5 788-2AA60-6AB0  
1 |
| SCALANCE W786-1PRO | 1                          | Internal | No                    | 6GK5 786-1BA60-2AA0  
6GK5 786-1BA60-2AB0  
1 |
| SCALANCE W786-2RR  | 2                          | Internal | Yes                   | 6GK5 786-2BA60-6AA0  
6GK5 786-2BA60-6AB0  
1 |
| SCALANCE W786-2RR  | 2                          | External | Yes                   | 6GK5 786-2AA60-6AA0  
6GK5 786-2AA60-6AB0  
1 |

1 US version

Read the relevant documentation.

Additional access points and WLAN products are available in the Internet at Industry Mall ([http://mall.automation.siemens.com](http://mall.automation.siemens.com)).

### 1.7 Compatibility of equipment

The following devices are compatible with all versions of the Mobile Panel 227 IWLAN:

- Charging station
- Main battery
- Power supply unit

The following applies for the transponder:

- Transponder for the Mobile Panel 277 IWLAN V2
  These cannot be used for a Mobile Panel 277 IWLAN V1.
- Transponder for the Mobile Panel 277 IWLAN V1
  These can be used without restrictions, but do not support compatibility in the 2.4 GHz WLAN bandwidth.
1.8 Communication and approved controllers

Number of communication connections

<table>
<thead>
<tr>
<th>Communication link</th>
<th>Mobile Panel 277 IWLAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity, max.</td>
<td>6</td>
</tr>
<tr>
<td>Number, based on the</td>
<td>8</td>
</tr>
<tr>
<td>SIMATIC HMI HTTP Protocol</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

If PLCs from other manufacturers are used, you may not enable PROFINET IO in the Control Panel.

Approved PLCs

The HMI device has been enabled for use with PLCs and protocols from the following manufacturers:

<table>
<thead>
<tr>
<th>PLC</th>
<th>Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC S7</td>
<td>PROFINET</td>
</tr>
<tr>
<td>SIMATIC HMI HTTP Protocol</td>
<td>HTTP/HTTPS (Ethernet)</td>
</tr>
<tr>
<td>Allen-Bradley E/IP C.Logix</td>
<td>Ethernet IP, OPC</td>
</tr>
<tr>
<td>Modicon MODBUS TCP/IP</td>
<td>Modbus TCP/IP</td>
</tr>
</tbody>
</table>

1.9 Software requirements

You need the following software to configure the HMI device:

- WinCC flexible 2008, SP2 with HSP "Mobile Panel 277 Wireless V2"
- SIMATIC STEP 7 V5.4, as of SP2

Software options for the HMI device:

- WinCC flexible/Sm@rtService
  The Sm@rtService software option enables remote access via Ethernet to an HMI device from the HMI device or PC. Read-only access on the removed HMI device is possible.
- WinCC flexible/Sm@rtAccess
  The Sm@rtAccess software option allows you to set up communication between different HMI systems.
• WinCC flexible /Audit
  The /Audit software option enhances the functionality of the HMI device with operator input logging in an audit trail and electronic signature.

• ProAgent
  The WinCC flexible /ProAgent option extends the functionality of the HMI device with specific and high-speed diagnostics of process errors.

1.10 Supported WinCC flexible objects

The following tables contain the maximum number of objects you can use with the HMI device in a project.

Note
The maximum number of multiple objects used simultaneously can affect the performance of the active WinCC flexible project.

Alarms

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Number of discrete alarms</td>
<td>4,000</td>
</tr>
<tr>
<td></td>
<td>Number of analog alarms</td>
<td>200</td>
</tr>
<tr>
<td></td>
<td>Length of the alarm text</td>
<td>80 characters</td>
</tr>
<tr>
<td></td>
<td>Maximum number of tags in an alarm</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>LEDs</td>
<td>Alarm line, Alarm window, Alarm view</td>
</tr>
<tr>
<td></td>
<td>Acknowledge error alarms individually</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Acknowledge several error alarms simultaneously</td>
<td>16 alarm groups</td>
</tr>
<tr>
<td></td>
<td>(group acknowledgment of alarm groups)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Edit alarm</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Alarm indicator</td>
<td>Yes</td>
</tr>
<tr>
<td>ALARM_S</td>
<td>Display S7 alarms</td>
<td></td>
</tr>
<tr>
<td>Alarm buffer, retentive</td>
<td>Alarm buffer capacity</td>
<td>512 alarms</td>
</tr>
<tr>
<td></td>
<td>Maximum number of active alarm events</td>
<td>250</td>
</tr>
<tr>
<td></td>
<td>View alarm</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Delete alarm buffer</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Line-by-line printing of alarms</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Overview
1.10 Supported WinCC flexible objects

Tags, values and lists

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>Number</td>
<td>2048</td>
</tr>
<tr>
<td>Limit value monitoring</td>
<td>Input/Output</td>
<td>Yes</td>
</tr>
<tr>
<td>Linear scaling</td>
<td>Input/Output</td>
<td>Yes</td>
</tr>
<tr>
<td>Text list</td>
<td>Number</td>
<td>500 ¹</td>
</tr>
<tr>
<td>Graphics list</td>
<td>Number</td>
<td>400 ¹</td>
</tr>
</tbody>
</table>

¹ The maximum total of text and graphics lists is 500.

Screens

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen</td>
<td>Number</td>
<td>500</td>
</tr>
<tr>
<td>Fields per screen</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>Tags per screen</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>Complex objects per screen (for example bars)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Template</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

Recipes

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipe</td>
<td>Number</td>
<td>300</td>
</tr>
<tr>
<td>Data records per recipe</td>
<td>500</td>
<td></td>
</tr>
<tr>
<td>Entries per recipe</td>
<td>1000</td>
<td></td>
</tr>
<tr>
<td>Recipe memory</td>
<td>64 KB</td>
<td></td>
</tr>
<tr>
<td>Storage location¹)</td>
<td>Memory card, USB stick, Network drive</td>
<td></td>
</tr>
</tbody>
</table>

¹) The number of recipe data records might be restricted by the capacity of the storage medium.
Logs

**NOTICE**

**Logging**

The HMI device is suitable for logging small volumes of data. The use of a large circular log has a negative effect on performance. In order to log larger amounts of data, use segmented circular logs with multiple sequential logs.

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logs</td>
<td>Number of logs</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Number of partial logs in a segmented circular log</td>
<td>400</td>
</tr>
<tr>
<td></td>
<td>Entries in each log including all partial logs</td>
<td>10000</td>
</tr>
<tr>
<td></td>
<td>Filing format</td>
<td>RDB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CSV with ANSI character set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TXT (Unicode)</td>
</tr>
<tr>
<td></td>
<td>Storage location(^1)</td>
<td>Memory card</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USB stick</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Network drive</td>
</tr>
</tbody>
</table>

1. The number of entries in the log may be restricted by the capacity of the storage medium.

**Safety**

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>User administration</td>
<td>Number of user groups</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Number of users</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Number of authorizations</td>
<td>32</td>
</tr>
</tbody>
</table>

**Infotexts**

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infotext</td>
<td>Length (no. of characters)</td>
<td>320</td>
</tr>
<tr>
<td></td>
<td>(depending on font)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For alarms</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>For screens</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>For screen objects (for example for I/O field, switch, button, invisible button)</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Overview
1.10 Supported WinCC flexible objects

### Additional functions

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor setting</td>
<td>Touch screen calibration</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Brightness setting</td>
<td>Yes</td>
</tr>
<tr>
<td>Language change</td>
<td>Number of languages</td>
<td>16</td>
</tr>
<tr>
<td>VBScript</td>
<td>User-specific extension of the functionality</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Number of scripts</td>
<td>50</td>
</tr>
<tr>
<td>Graphic object</td>
<td>Vector and pixel graphics</td>
<td>Yes</td>
</tr>
<tr>
<td>Trend</td>
<td>Number</td>
<td>300</td>
</tr>
<tr>
<td>Task planner</td>
<td>Number of tasks</td>
<td>48</td>
</tr>
<tr>
<td>Text object</td>
<td>Number</td>
<td>10000</td>
</tr>
<tr>
<td>Direct key</td>
<td>PROFINET IO direct keys</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Device-specific functions

<table>
<thead>
<tr>
<th>Object</th>
<th>Specification</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main battery</td>
<td>Displaying the battery charge status</td>
<td>Yes</td>
</tr>
<tr>
<td>WLAN quality</td>
<td>Displaying WLAN quality</td>
<td>Yes</td>
</tr>
<tr>
<td>Zone name</td>
<td>Displaying zone names</td>
<td>Yes</td>
</tr>
<tr>
<td>Zone quality</td>
<td>Displaying zone quality</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Functions for transponder system

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of transponders available for all zones in the project</td>
<td>127</td>
</tr>
<tr>
<td>Number of zones in the project, maximum</td>
<td>127</td>
</tr>
<tr>
<td>Number of transponders per zone, maximum</td>
<td>127</td>
</tr>
</tbody>
</table>
1.11 Configuration and process control phases

You must follow the phases below in order to use an HMI device in the system:

- Configuration phase
- Process control phase

Configuration phase

The configuration phase consists of the following operations:

- Create project
- Transferring a project
- Accept project – determine checksum
- Test project
- Simulate project
- Save project

Process control phase

The process control phase includes operation and monitoring of active production processes with the HMI device. The HMI screens on the HMI device visualize the production process.
1.12 Ranges in a transponder system

In a plant with transponder logons, there are the following ranges:

- WLAN/IWLAN for communication between an F-CPU and an HMI device
- Transponder with zone for logon to a plant
- Transmission and reception range of an HMI device for logging onto a plant

**WLAN/IWLAN**

Controller and HMI device communicate over the radio cell of the access point. The access point serves as a gateway between the wireless and wired network.

At least one access point is provided for WLAN or IWLAN in the plant.
The figure below shows an example of the various areas.

1. SCALANCE W access point
2. WLAN/IWLAN, radio cell of the access point
3. PLC
4. Signal lamp
5. Zone
6. Plant
7. Wireless range of the HMI device (green range)
8. Charging station
9. WLAN of the HMI device (blue lines)
10. HMI device

**Transponder**

Transponders are used to set up zones in the plant.

The wireless range of the transponder corresponds with the zone in its expansion. See section "Radiation characteristics of the transponder system" (Page 264).
Zone

A zone is used to operate and observe depending on the location of the operator. For example, a screen change can be configured for entering or exiting a zone.

The zone is a configurable object within a transponder system.

1.13 Rapid Roaming with iPCF and iPCF-MC

The wireless range of an IWLAN system can be extended using several access points. The wireless connection of an HMI device that is moved between SCALANCE W78x access point ranges is briefly interrupted and then recovered (roaming).

Capabilities provided by iPCF

In the industrial environment, there are applications that require deterministic behavior for a large number of participants and high data throughput in a cell. Moreover, a deterministic behavior is required for cell cross-overs with handover times of less than 100 ms.

The iPCF extension (Industrial Point Coordination Function) was developed to meet these requirements.

iPCF ensures that all data traffic runs in coordinated fashion in a wireless cell, controlled by the access point. It also optimizes the throughput with a high number of participants by avoiding collisions. iPCF also facilitates very fast cell changes.

Special features provided by iPCF-MC

iPCF-MC was designed to enable free-moving participants to exploit the special advantages provided by iPCF, which allows communication independent of an RCoax line or directional antennas. With iPCF-MC, the client looks for potentially suitable access points even when it is receiving iPCF queries from the access point and the existing connection to an access point is functioning correctly. This makes it possible to switch to another access point very quickly if it becomes necessary. Unlike iPCF, with iPCF-MC the handover times do not depend on the number of radio channels in use.
The following figure shows an example of a plant with four WLAN areas.

① Radio cell of access point 1
② Radio cell of access point 2
③ Radio cell of access point 3
④ Radio cell of access point 4
⑤ Plant

For rapid roaming with iPCF-MC, you will require a suitable access point – see section "Access point" (Page 20).

For stable PNIO communication, a WLAN client should be located at all times in a radio cell with a signal strength > 60% or > -65 dBm. This can be checked by switching the various segments on and off.
This does not mean that the client needs to change over at a signal strength < 60% or < -65 dBm. Make sure that you provide access points with sufficient signal strength.

Limitations due to iPFC-MC

iPFC-MC is an in-house development of the Siemens AG that will only work with participants in which iPFC-MC has been installed.

Operating principle of iPFC-MC

iPFC-MC uses both radio interfaces of the access point differently: One interface works as management interface and sends a beacon every five milliseconds. The other interface transmits the user data.

The following requirements have to be met to use iPFC-MC:

- All "RR" versions of the SCALANCE W-700 access points with at least two WLAN interfaces can be used as access point. The HMI device and all SCALANCE W-700 "RR" versions are suited as clients.
- You have to operate the management interface and the data interface in the same frequency band; they also have to match in their radio coverage. iPFC-MC will not work if both radio interfaces are equipped with directional antenna the cover different areas.
- The management interfaces of all access points that a client is to access must use the same channel. A client will only scan this one channel to find all available access points.
- You cannot use the transmission method to IEEE 802.11h for the management interface. 802.11h can be used for the data interface.
2 Safety instructions and standards

2.1 Safety instructions

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Injury or material damage</td>
</tr>
</tbody>
</table>

If you do not exactly adhere to the safety regulations and procedural instructions contained in this manual, hazards may arise and safety features be rendered ineffective. This can result in personal injuries or material damage.

Closely follow closely the safety regulations and procedural instructions in each situation.

Observe the regulations for safety and accident prevention applicable to your application in addition to the safety instructions given in this manual.

Project security

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Injury or material damage</td>
</tr>
</tbody>
</table>

The configuration engineer for plant control must take precautions to ensure that an interrupted program will be correctly integrated again after communication failures, voltage dips or power outages.

A dangerous operating state must not be allowed to occur - not even temporarily - during the entire execution of the control program, even during a troubleshooting.

Safety during commissioning and operation

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation according to the instructions</td>
</tr>
</tbody>
</table>

Commissioning of the HMI device is prohibited until it has been absolutely ensured that the machine to be operated with the HMI device complies with Directive 2006/42/EC.

Verify before commissioning that the provisions of Directive 2006/42/EC are fulfilled.
Safety during operation

⚠️ WARNING

HMI device failure
A strong shock or impact can impede the functionality of the HMI device.
After a strong mechanical action, ensure the HMI device and the safety-related parts are in working order.

Exclusive operating right
The simultaneous operation of the plant with multiple HMI devices is not allowed.
Prevent simultaneous operation through the appropriate configuration.

Note
High-frequency radiation, for example from cellular phones, can lead to undesirable operating states in a plant.

2.2 Approvals

Note
The following overview shows possible approvals.
The only valid approvals for the HMI device, charging station, power supply unit and transponder are those shown on the label on the rear panel.

CE approval
The HMI device, charging station, power supply unit, and transponder comply with the European standards published in the Official Journals of the European Union for programmable controllers:

- 2004/108/EC "Electromagnetic Compatibility" (EMC Directive)
- Specific absorption rate in accordance with EN 50932:2004
EC Declaration of Conformity
The EC Declarations of Conformity are available to the relevant authorities at the following address:
Siemens AG
Industry Sector
I IA AS RD ST
PO Box 1963
92209 Amberg
Germany

UL approval
Underwriters Laboratories Inc. in accordance with:
- UL 60950-1 – Information Technology Equipment – Safety
The approval is only valid in the case of battery operation or when stationary in the charging station.

Marking for Australia
The HMI device, charging station, power supply, and transponder meet all requirements set forth in AS/NZS CISPR 16.

Wireless approval
The Certificates of Broadcasting and Communication Equipment are listed on the label attached to the rear panel of the HMI device and in the product information for "Mobile Panel 277 IWLAN V2, Mobile Panel 277F IWLAN V2, Mobile Panel 277F IWLAN (RFID Tag)" on the Internet at:
Note that only the CBCE certificates specified on the label of the HMI device are legally binding.

Requesting certificates
A copy of the certificates and associated reports is available upon request from the following address:
Siemens AG
Industry Sector
I IA AS RD ST
PO Box 1963
92209 Amberg
Germany
2.3 Standards on operating safety

The HMI device meets the following standards for use in a plant:

<table>
<thead>
<tr>
<th>Standard</th>
<th>Title</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN 954-1</td>
<td>Safety of machinery – Safety-related parts of control systems – General principles for design</td>
<td>15.06.1997</td>
</tr>
<tr>
<td>EN 12417</td>
<td>Machine Tools - Safety - Machining Centres</td>
<td>01.07.2009</td>
</tr>
<tr>
<td>EN 60950</td>
<td>Information Technology Equipment (General Requirements)</td>
<td>01.11.2006</td>
</tr>
<tr>
<td>UL 60950 -1</td>
<td>Safety of Information Technology Equipment</td>
<td>27.03.2007</td>
</tr>
</tbody>
</table>

EMC testing

The values of the EMC test for the HMI device conform to the following standards:

<table>
<thead>
<tr>
<th>Standard</th>
<th>Title</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN 61000-6-2</td>
<td>EMC – Part 6-2: Generic standards - Immunity for industrial environments</td>
<td>01.05.2006</td>
</tr>
<tr>
<td>EN 61000-6-4</td>
<td>EMC – Part 6-4: Generic standards - Emission standard for industrial environments</td>
<td>01.11.2007</td>
</tr>
<tr>
<td>DIN EN 50360</td>
<td>Product standard to demonstrate the compliance of mobile phones with the basic restrictions related to human safety in electromagnetic fields (300 MHz to 3 GHz)</td>
<td>01.05.2002</td>
</tr>
<tr>
<td>DIN EN 50371</td>
<td>Generic standard to demonstrate compliance of low power electronic and electrical apparatus with the basic restrictions related to human exposure to electromagnetic fields (10 MHz to 300 GHz)</td>
<td>01.11.2002</td>
</tr>
<tr>
<td>DIN EN 61131-2</td>
<td>Programmable Logic Controllers – Part 2: Equipment requirements and testing</td>
<td>01.01.2009</td>
</tr>
<tr>
<td>DIN EN 300440-1</td>
<td>Electromagnetic compatibility and radio spectrum matters</td>
<td>01.08.2009</td>
</tr>
<tr>
<td>DIN EN 301893</td>
<td>Broadband Radio Access Networks (BRAN)</td>
<td>01.05.2009</td>
</tr>
<tr>
<td>EN 50385</td>
<td>Product standard to demonstrate the compliance of radio base stations and fixed terminal stations for wireless telecommunication systems</td>
<td>01.05.2003</td>
</tr>
<tr>
<td>EN 300328</td>
<td>Electromagnetic compatibility and radio spectrum matters</td>
<td>01.03.2009</td>
</tr>
<tr>
<td>EN 300330</td>
<td>Electromagnetic compatibility and radio spectrum matters (ERM)</td>
<td>01.08.2006</td>
</tr>
<tr>
<td>EN 301489-1</td>
<td>Electromagnetic compatibility and radio spectrum matters (ERM)</td>
<td>01.01.2010</td>
</tr>
<tr>
<td>EN 301489-3</td>
<td>Electromagnetic compatibility and radio spectrum matters (ERM)</td>
<td>01.01.2003</td>
</tr>
</tbody>
</table>
Additional measurements

Additional measurements were made for:

- Japan
  - Table/Annex No 43,44,45 – Test Method for Radio Equipment mentioned in Certification Regulations Article, Item 19, 19-2, 19-3 and 19-3-2
  - Table/Annex No 47 – Test Method for Radio Equipment mentioned in Certification Regulations Article, Item 19-5 and 19-11
  - RFID – ARIB STD T-82
- Taiwan
  - LP0002

### 2.4 Operating conditions

**NOTICE**

**Wireless control device**

A wireless control device may cause interference.

If a wireless control device is used, the following must be ensured:

- That other systems at the site are **not** disturbed by the wireless control device
- That other systems at the site do **not** disturb the wireless control device

**Use in industry**

The HMI device is designed for industrial use. For this reason, the following standards are met:

- Interference emission requirements, paragraph 7.3, DIN EN 60947-1, Environment A
- Interference immunity requirements DIN EN 61326
2.5 Electromagnetic compatibility

Residential use

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interference to radio and TV reception</strong>&lt;br&gt;The HMI device is not suitable for use in residential areas: Operation of HMI devices in residential areas can cause interference to radio and television reception.&lt;br&gt;If the HMI device is used in a residential area, you must take measures to achieve Limit Class B conforming to EN 55016 for RF interference.</td>
</tr>
</tbody>
</table>

To achieve radio interference suppression class B, for example, install filters in power supply lines.<br>Individual acceptance is required.

2.5 Electromagnetic compatibility

The HMI device, charging station, transponder, and power adapter are also compliant with requirements of the EMC legislation within the European market. The enhanced testing and limit value levels defined by CDV 61326-3-1/Ed. 1 have been taken into account during the type test.

EMC-compliant installation

The EMC compliant installation of the charging station and transponders, including the use of interference-proof cables, is the prerequisite for error-free operation. The following documents also apply to the installation of the charging station:

- Description "Directives for interference-free installation of PLCs"<br>(http://support.automation.siemens.com/WW/view/de/1064706), German
Pulse-shaped disturbance

The following table shows the electromagnetic compatibility of modules with regard to pulse-shaped interference. The table applies to the charging station, with and without an attached HMI device.

<table>
<thead>
<tr>
<th>Pulse-shaped disturbance</th>
<th>Tested with</th>
<th>Degree of severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge in accordance with IEC 61000-4-2</td>
<td>Air discharge: 8 kV Contact discharge: 6 kV</td>
<td>3</td>
</tr>
<tr>
<td>Burst pulses (high-speed transient interference) in accordance with IEC 61000-4-4</td>
<td>2 kV supply line</td>
<td>3</td>
</tr>
</tbody>
</table>

An external safety circuit is required for the "Surge immunity test according to IEC 61000-4-5". The safety circuit is described in the Installation manual "Automation System S7-300 – Installation" (http://support.automation.siemens.com/WW/view/en/15390415), section "Lightning and overvoltage protection".

<table>
<thead>
<tr>
<th>Pulse-shaped disturbance</th>
<th>Tested with</th>
<th>Degree of severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asymmetrical coupling</td>
<td>2 kV power cable DC voltage with protective elements</td>
<td>3</td>
</tr>
<tr>
<td>Symmetrical coupling</td>
<td>1 kV power cable DC voltage with protective elements</td>
<td>3</td>
</tr>
</tbody>
</table>

Sinusoidal interference

The following table shows the EMC behavior of the modules with respect to sinusoidal interference.

The table applies to the HMI device, charging station and power supply unit.

<table>
<thead>
<tr>
<th>Sinusoidal interference</th>
<th>Test values</th>
<th>Degree of severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>HF radiation (in electromagnetic fields) in accordance with IEC 61000-4-3</td>
<td>80% amplitude modulation at 1 kHz</td>
<td>3</td>
</tr>
<tr>
<td>• Up to 10 V/m in the 80 MHz to 1 GHz range</td>
<td>• Up to 10 V/m in the 1,4 GHz to 2 GHz range</td>
<td></td>
</tr>
<tr>
<td>• Up to 1 V/m in the 2 GHz to 2,7 GHz range</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RF interference current on cables and cable shielding conforming to IEC 61000-4-6</td>
<td>Test voltage 10 V, with 80% amplitude modulation of 1 kHz in the 9 kHz to 80 MHz range</td>
<td>3</td>
</tr>
</tbody>
</table>
Safety instructions and standards

2.5 Electromagnetic compatibility

Emission of radio interference

The following table shows the unwanted emissions from electromagnetic fields in accordance with EN 55016, Limit Value Class A, Group 1, measured at a distance of 10 m.

<table>
<thead>
<tr>
<th>Frequency Range</th>
<th>Emission Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 to 230 MHz</td>
<td>&lt; 40 dB (V/m) quasi-peak</td>
</tr>
<tr>
<td>230 to 1,000 MHz</td>
<td>&lt; 47 dB (V/m) quasi-peak</td>
</tr>
</tbody>
</table>

Note

Before you connect the HMI device to the public electrical network, ensure that it is compliant with Limit Value Class B in accordance with EN 55022.

Specific absorption rate SAR

The following applies to specific absorption rate:

- Recommendation 1999/519/EC; Exposure of the public to EMF
- Limit values for Europe according to EN 50932
- Limit values for USA in accordance with FCC OET Bulletin 65 Supplement C
  - 2.0 W/kg within 10 g of tissue (in accordance with ICNIRP guideline)
  - 1.6 W/kg within 1 g of tissue (in accordance with IEEE/FCC)
Planning application

3.1 Ambient conditions for transportation and storage

The permissible ambient conditions of this HMI device exceed requirements in accordance with IEC 61131-2. The following specifications apply to devices that are shipped and stored in the original packaging.

- The climatic conditions are compliant with IEC 60721-3-2, Class 2K4
- The mechanical conditions are compliant with IEC 60721-3-2, Class 2M2

The following table shows the permitted ambient conditions for the HMI device, charging station, and power supply.

<table>
<thead>
<tr>
<th>Type of condition</th>
<th>Permitted range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop test (in transport package)</td>
<td>≤ 1 m</td>
</tr>
<tr>
<td>Temperature</td>
<td>-20 to +60 °C</td>
</tr>
<tr>
<td>Atmospheric pressure</td>
<td>1140 hPa to 660 hPa, corresponds to an elevation of -1000 to 3500 m</td>
</tr>
<tr>
<td>Humidity, relative</td>
<td>Applies to HMI device:</td>
</tr>
<tr>
<td></td>
<td>10 to 90%, without condensation</td>
</tr>
<tr>
<td></td>
<td>Applies to charging station and transponder</td>
</tr>
<tr>
<td></td>
<td>35% to 85%, without condensation</td>
</tr>
<tr>
<td>Sinusoidal vibration in accordance with IEC 60068-2-6</td>
<td>5 Hz to 9 Hz: 3.5 mm</td>
</tr>
<tr>
<td></td>
<td>9 Hz to 500 Hz: 9.8 m/s²</td>
</tr>
<tr>
<td>Shock in accordance with IEC 60068-2-29</td>
<td>250 m/s², 6 ms, 1000 shocks</td>
</tr>
</tbody>
</table>

NOTICE

Equipment failure

Moisture in the form of condensation on or in the device is formed:
- When transporting a device at low temperatures
- Under extreme temperature variations

Moisture and condensation lead to malfunction.

Bring the device to room temperature before operating.

Condensation

When condensation is on the device, do not expose the HMI device to direct radiation from a heater.

If condensation has developed, wait approximately 4 hours until the HMI device has dried completely before switching it on.
The following points must be adhered to in order to ensure a fault-free and safe operation of the HMI device:

- Proper transportation and storage
- Proper installation and mounting
- Careful operation and maintenance

The warranty for the HMI device will be deemed void if these stipulations are not heeded.

### 3.2 Ambient conditions for operation

#### Mechanical and climatic ambient conditions

The HMI device is designed for use in a location protected from the effects of the weather. The ambient conditions meet the requirements for DIN IEC 60721-3-3:

- Mechanical requirements according to class 3M3
- Climatic requirements according to class 3K3

#### Use with additional protective measures

You may only use the HMI device at the following locations with additional measures:

- In locations with a high degree of ionizing radiation
- In locations with difficult operating conditions, for example due to:
  - Corrosive vapors, gases, oils or chemicals
  - Electrical or magnetic fields of high intensity
- In systems that require special monitoring, for example:
  - Elevators
  - Systems in especially hazardous rooms

#### Damping shock and vibration

If the HMI device is subjected to impermissibly strong shocks or vibrations, you must take appropriate measures to reduce amplitudes or acceleration. In such situations, use vibration damping or vibration absorber systems for the HMI device and accessories.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
</table>

**Setting down the HMI device**

If you place the HMI device on a surface with a high natural frequency, malfunctions may occur as a result.

When storing the HMI device, make sure that the HMI device is only stored on a surface that does not exceed the permissible ambient conditions.
Testing mechanical ambient conditions

The following table provides information on the type and scope of tests for mechanical ambient conditions performed for the HMI device.

<table>
<thead>
<tr>
<th>Test</th>
<th>Physical variable</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vibration IEC 60068-2-6 Test Fc</td>
<td>Vibration</td>
<td>1 octave/min 10 cycles per axis</td>
</tr>
<tr>
<td></td>
<td>Frequency range</td>
<td>5 to 8.4 Hz: Deflection 3.5 mm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8.4 to 150 Hz Vibration acceleration 9.8 m/s</td>
</tr>
<tr>
<td>Shock IEC 60068-2-27</td>
<td>Shock form</td>
<td>half-sine</td>
</tr>
<tr>
<td></td>
<td>Acceleration</td>
<td>30 g</td>
</tr>
<tr>
<td></td>
<td>Duration</td>
<td>11 ms</td>
</tr>
<tr>
<td></td>
<td>Number of shocks</td>
<td>3 per axis</td>
</tr>
<tr>
<td>Permanent shock IEC 60068-2-27</td>
<td>Shock form</td>
<td>half-sine</td>
</tr>
<tr>
<td></td>
<td>Acceleration</td>
<td>10 g</td>
</tr>
<tr>
<td></td>
<td>Duration</td>
<td>16 ms</td>
</tr>
<tr>
<td></td>
<td>Shock cycle</td>
<td>1 s to 3 s</td>
</tr>
<tr>
<td></td>
<td>Number of shocks</td>
<td>1000 ± 10</td>
</tr>
<tr>
<td>Impact IEC 60068-2-75</td>
<td>Impact stress</td>
<td>1 Nm, once With an impact test device similar to DIN VDE 0740, Part 1, Section 19.2 at room temperature.</td>
</tr>
<tr>
<td>Drop EN 60068-2-32</td>
<td>Fall height</td>
<td>1.2 m Valid for the HMI device with/without rechargeable battery</td>
</tr>
</tbody>
</table>

Climatic ambient conditions for the HMI device

The following table shows the permitted ambient climatic conditions for operation of the HMI device.

<table>
<thead>
<tr>
<th>Ambient conditions</th>
<th>Permitted range</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>0 to 40° C</td>
<td>–</td>
</tr>
<tr>
<td>Humidity, relative</td>
<td>5 to 85 %, no condensation</td>
<td>Stress level 2 according to IEC 61131-2</td>
</tr>
<tr>
<td>Humidity, absolute</td>
<td>1 to 25 g/m³</td>
<td>–</td>
</tr>
<tr>
<td>Atmospheric pressure</td>
<td>1 060 to 700 hPa</td>
<td>Corresponds to an elevation of –1000 to 2000 m</td>
</tr>
<tr>
<td>Pollutant concentration</td>
<td>SO₂ &lt; 0.5 vpm, relative humidity &lt; 60%, no condensation</td>
<td>Test: 10 cm³/m³; 10 days</td>
</tr>
<tr>
<td></td>
<td>H₂S &lt; 0.1 vpm, relative humidity &lt; 60%, no condensation</td>
<td>Test: 1 cm³/m³; 10 days</td>
</tr>
</tbody>
</table>
Climatic ambient conditions for the charging station

The following table shows the permitted climatic ambient conditions for use of the charging station.

<table>
<thead>
<tr>
<th>Ambient conditions</th>
<th>Permitted range</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>0 to 40° C</td>
<td>–</td>
</tr>
<tr>
<td>Storage/transport temperature</td>
<td>–20 to 60° C</td>
<td>–</td>
</tr>
<tr>
<td>Humidity, relative</td>
<td>5 to 85 %, no condensation</td>
<td>Stress level 2 according to IEC 61131-2</td>
</tr>
<tr>
<td>Humidity, absolute</td>
<td>1 to 25 g/m³</td>
<td>–</td>
</tr>
<tr>
<td>Atmospheric pressure</td>
<td>1060 to 700 hPa</td>
<td>Corresponds to an elevation of –1000 to 2000 m</td>
</tr>
<tr>
<td>Pollutant concentration</td>
<td>SO₂ &lt; 0.5 vpm, relative humidity &lt; 60%, no condensation</td>
<td>Test: 10 cm³/m³; 10 days</td>
</tr>
<tr>
<td></td>
<td>H₂S &lt; 0.1 vpm, relative humidity &lt; 60%, no condensation</td>
<td>Test: 1 cm³/m³; 10 days</td>
</tr>
</tbody>
</table>

Ambient climatic conditions for the transponder

The following table shows the permitted ambient climatic conditions for operation of the transponder.

<table>
<thead>
<tr>
<th>Ambient conditions</th>
<th>Permitted range</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>0 to 50° C</td>
<td>–</td>
</tr>
<tr>
<td>Storage/transport temperature</td>
<td>–20 to 60° C</td>
<td>–</td>
</tr>
<tr>
<td>Humidity, relative</td>
<td>5 to 85 %, no condensation</td>
<td>Stress level 2 according to IEC 61131-2</td>
</tr>
<tr>
<td>Humidity, absolute</td>
<td>1 to 25 g/m³</td>
<td>–</td>
</tr>
<tr>
<td>Atmospheric pressure</td>
<td>1060 to 700 hPa</td>
<td>Corresponds to an elevation of –1000 to 2000 m</td>
</tr>
<tr>
<td>Pollutant concentration</td>
<td>SO₂ &lt; 0.5 vpm, relative humidity &lt; 60%, no condensation</td>
<td>Test: 10 cm³/m³; 10 days</td>
</tr>
<tr>
<td></td>
<td>H₂S &lt; 0.1 vpm, relative humidity &lt; 60%, no condensation</td>
<td>Test: 1 cm³/m³; 10 days</td>
</tr>
</tbody>
</table>
3.3 Insulation resistance, protection class and degree of protection

Insulation resistance

Insulation resistance is demonstrated in the type test with the following test voltages in accordance with IEC 61131-2:

<table>
<thead>
<tr>
<th>Circuits with a nominal voltage of Uₑ to other circuits or ground</th>
<th>Test voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 50 V</td>
<td>500 VDC</td>
</tr>
</tbody>
</table>

Protection class of the HMI device

<table>
<thead>
<tr>
<th>HMI device</th>
<th>Protection class according to IEC 60417-DB-HS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front and rear panel</td>
<td>Protection class III</td>
</tr>
</tbody>
</table>

Degree of protection of the HMI device

NOTICE

Degree of protection IP65 for HMI device

When enclosure openings or the connection compartment are not closed, the HMI device does not meet the specified degree of protection.

Ensure that the enclosure is closed as specified by the regulations.

<table>
<thead>
<tr>
<th>Device</th>
<th>Degree of protection in accordance with IEC 60529</th>
</tr>
</thead>
<tbody>
<tr>
<td>HMI device, front and rear panel</td>
<td>IP65</td>
</tr>
<tr>
<td>Charging station</td>
<td>IP65</td>
</tr>
<tr>
<td>Transponder</td>
<td>IP65</td>
</tr>
</tbody>
</table>
Planning application

3.4 WLAN properties

3.4 WLAN properties

Adhere to the installation guidelines when installing the WLAN. You can find more additional information in the System manual "Basics on Setting up an Industrial Wireless LAN" (http://support.automation.siemens.com/WW/view/en/9975764).

Plan the WLAN for a maximum of four HMI devices.

When adding a WLAN participant, make sure that you observe the conditions described in the document "Wireless LAN in a PROFINET IO Environment". The conditions vary depending on the operating mode and the requirement for PNIO refresh times. See Guideline for the Use of Industrial Wireless LAN in a PROFINET IO Environment (http://support.automation.siemens.com/WW/view/en/31938420).

NOTICE

Communication interference possible

Communication interference cannot be excluded if you do not check the local wireless conditions prior to start-up.

Check your local wireless conditions prior to start-up. When planning the wireless channels, mode 802.11a is preferable.

Ad hoc network

An ad hoc network cannot be used in conjunction with the HMI device.

See also

Coexistence of the frequency bands (Page 51)
3.5 Equipping a plant with transponders

3.5.1 Dividing plant into zones

A system in a project can be divided into zones. A zone is a divided area for local operation and monitoring. A configured zone is independently recognized by the HMI device. For example, a change of the process image can be configured for entering or leaving a zone. A certain production process is executed in a configured zone, for example, parts assembly. Zone-bound process images are displayed for this on the HMI device.

Planning zones in the project

The following rules apply:

- 254 zones can be configured.
- A zone requires at least one transponder.
- A zone can be formed by a maximum of 255 transponders.
- Zones must not overlap.

A zone is defined by the maximum permitted distance of the HMI device from one or more transponders. The same maximum distance applies to all transponders in a zone. The assignment of transponders to zones is defined in the project.

The following image shows a packaging system with two zones:

1. Zone 1, formed by 2 transponders
2. Zone 2, formed by 1 transponder

Planning the transponder assignment

The following rule applies:

- Each transponder can only be assigned to one zone.
3.5 Equipping a plant with transponders

3.5.2 Zone quality

The transponder broadcasts its ID in accordance with its radiation characteristic. Compare section "Radiation characteristics of the transponder system (Page 264)". Depending on the project, the HMI device limits this range from 2 to 8 meters. The "zone quality" object identifies the location of the HMI device in terms of the zone.

In the following figure, the distance is specified in % and relates to the configured dimension of a zone. The configured dimension can be 2 to 8 meters.

The HMI device is located at a central position along the bold dashed line. The "zone quality" object shows 100 %. The display of the object changes dynamically whenever the HMI device is moved from this line towards or away from the transponder.

Once the HMI device is moved beyond the range shown, a quality of "0%" will be detected. The pointer of the "zone quality" object is located in the red range.

Note

The transponder system measures the distance with a tolerance of approximately 60 cm.

If the distance between the HMI device and a transponder is less than 60 cm, then the zone may occasionally be detected.

This effect is independent of the zone dimension you have configured in WinCC flexible.
3.6 Mounting location and clearance of charging station

Selecting the mounting location

The charging station is designed for vertical installation.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mount location of the charging station</strong></td>
</tr>
<tr>
<td>If the permissible ambient conditions are exceeded at the mounting location of the charging station, functional disruptions may result.</td>
</tr>
<tr>
<td>During the selection of the mounting location, observe the permissible ambient conditions for operation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Charging the rechargeable battery</strong></td>
</tr>
<tr>
<td>When charging a rechargeable battery, the ambient temperature or battery temperature should not exceed 40 °C. The higher the temperature, the longer it will take for the rechargeable battery to fully charge.</td>
</tr>
<tr>
<td>Select a location with a low ambient temperature for the charging station.</td>
</tr>
</tbody>
</table>

Select a location with the following characteristics for installing the charging station:

- Not directly below an access point
- Easily and safely accessible
- No exposure to direct sunlight
- It is easy to hook in and remove the HMI device in the charging station
- Ergonomic operation of the HMI device in the charging station is ensured
Maintaining clearances

The following clearance is required around the charging station:

All dimensions in mm
3.7 Coexistence of the frequency bands

Coexistence in the 2.4-GHz-band

The use of the HMI device does not affect the communication with other devices or only negligibly so. This applies to the following communication networks:

- **WLAN**
  
  When adding a WLAN participant, make sure that you observe the conditions described in the document "Wireless LAN in a PROFINET IO Environment". The conditions vary depending on the operating mode and the requirement for PNIO refresh times. See section "WLAN properties" (Page 46).

- **Communication protocols used in the 2.4 GHz band for the LAN in an office environment and for devices, such as smoke detectors or barcode scanners**
  
  For their simultaneous operation in the 2.4 GHz band, you will have to plan the wireless channels accordingly – see "SCALANCE W-700" Configuration Manual (http://support.automation.siemens.com/WW/view/en/42784493). Otherwise sufficient bandwidth for communications cannot be guaranteed.

**Note**

The iPCF and iPCF-MC systems cannot coexist in the 2.4 GHz band. This rule is also valid for WLAN channels in the 4.9 GHz frequency range.

- **ZigBee devices**

Coexistence with other communication networks

Moreover, coexistence is ensured for the following communication networks:

- **Coexistence in the 5-GHz-band**
  
  Planning for the radio channels of all WLAN systems in use is required to ensure sufficient bandwidth for communication.

- **WirelessHART**
  

**See also**

3.8 Planning information security

Information security is a vital aspect in automation engineering particularly to ensure the availability and interference-free operation of industrial plants. To ensure communication and information security via WLAN for the HMI device, you need to protect the communication system from attack.

Expect:

- Attacks from the outside
  
  To protect against external attacks, you must protect the WLAN in the same way you would protect office communication, namely with a firewall.

- Attacks from the inside

  Investigations have shown that the majority of attacks on information security are executed from inside the plant. To ensure information security, you need to take action for:
  
  - Configuration and parameter settings
    
    Possible objectives of an attack are the project and the parameter settings of the HMI device.
  
  - Productive operation data
    
    Data transfer between HMI device and access point is protected by the AES encryption mechanism. Manipulation of productive data is prevented in this manner.

**Note**

An encryption mechanism is not activated for the supplied access points and HMI devices. Activate the encryption mechanism when you commission the system.

Organizational measures

Organizational measures that ensure information security are described in the following document:

- IEC 61784-3-3:2007 Functional safety field busses – Additional specifications for CPF 3

Specify the organizational measures you must implement in accordance with your plant's requirements to achieve the highest possible information security for communication via WLAN. In doing so, take into consideration:

- Configuration phase
- Process control phase

Check the interplay of the specified measures.

Checklist

Perform the following tasks for application planning and confirm the implementation of each step in the following checklist.
## 3.8 Planning information security

### Access point

<table>
<thead>
<tr>
<th>Task</th>
<th>Additional information</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the installation site and antenna characteristics of the access point in such a manner that only the desired area is supplied with wireless capacity. In this regard note that wireless waves spread out horizontally as well as vertically.</td>
<td>Access point operating instructions &quot;SINEMA E&quot; planning program <a href="http://www.siemens.com/sinema">http://www.siemens.com/sinema</a></td>
<td></td>
</tr>
<tr>
<td>Install the access points at locations secured against attack, for example, in suspended ceilings. This can prevent manipulation at the access point or at the Ethernet connection to the LAN.</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>Always use cable connections to configure access points.</td>
<td>–</td>
<td></td>
</tr>
<tr>
<td>Change the SSID setting.</td>
<td>Assigning WLAN communication parameters (Page 119)</td>
<td></td>
</tr>
</tbody>
</table>

### Communication network

<table>
<thead>
<tr>
<th>Task</th>
<th>Additional information</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check the installation environment for potential radio interference of the WLAN using a spectrum analyzer and WLAN measurement programs. Specify corresponding remedies if any sources of interference are found. Record the results.</td>
<td>–</td>
<td></td>
</tr>
</tbody>
</table>
### 3.8 Planning information security

#### HMI device

<table>
<thead>
<tr>
<th>Task</th>
<th>Additional information</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use a password to protect the Control Panel and Taskbar of the HMI device against unauthorized access.</td>
<td>Section &quot;Entering and deleting a password (Page 114)&quot;</td>
<td></td>
</tr>
<tr>
<td>Enable the data channel used to transfer the project to the HMI device only during the transfer of the project.</td>
<td>Section &quot;Programming the data channel (Page 144)&quot;</td>
<td></td>
</tr>
<tr>
<td>Enable encryption for data transmission in the WLAN configuration. Change the default password for accessing the WLAN configuration in the Web Based management.</td>
<td>Section &quot;Assigning WLAN communication parameters (Page 119)&quot;</td>
<td></td>
</tr>
</tbody>
</table>

#### F-CPU and safety program

<table>
<thead>
<tr>
<th>Task</th>
<th>Additional information</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safeguard access to the F-CPU and safety program by means of passwords.</td>
<td>Programming and operation manual &quot;S7 Distributed Safety - Configuring and Programming&quot; (<a href="http://support.automation.siemens.com/WW/view/en/22099875">http://support.automation.siemens.com/WW/view/en/22099875</a>), section &quot;Protection against attack&quot;</td>
<td></td>
</tr>
</tbody>
</table>

#### WinCC flexible ES

<table>
<thead>
<tr>
<th>Task</th>
<th>Additional information</th>
<th>Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protect WinCC flexible Es with general IT technologies. Examples:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Protect the PC where the ES is installed on the operating system level with a password.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• To encrypt files, folders, and partitions use appropriate encryption software.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Assign the access right for a drive only to a specific group of people.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Encrypt the data with mechanisms provided by MS Windows.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can find additional information on the topic of data security in the following publications:

- System manual "Fundamentals - Industrial Wireless LAN", section "Information security of wireless communication in accordance with IEEE 802.11".
- Brochure "Wireless Communication Systems and their Security Aspects" published by the German Federal Agency for Security in Information Technology
4 Installing and wiring devices

4.1 Check the scope of delivery

Check the scope of delivery for completeness and visible signs of transport damage.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not use damaged parts</td>
</tr>
<tr>
<td>If you use defective parts from the scope of delivery, you may experience malfunctions.</td>
</tr>
<tr>
<td>If you find defective parts in the scope of delivery, contact your Siemens partner. Only install undamaged parts.</td>
</tr>
</tbody>
</table>

4.2 Mounting the charging station

Requirement

- 4 x M6 fillister head screws, with nuts if required
- When mounting on a conductive surface: 4 spacer sleeves from the package delivered with the charging station
- An ideal mounting location with an adequate amount of free space was selected for the charging station, see "Mounting location and clearance of charging station (Page 49)"

Procedure

Follow these steps:

1. Place the charging station onto the mounting surface.
2. Mark the fastening holes with a marking-off tool.
3. Drill 4 holes or 4 M6 threaded holes in the mounting surface.
4. If you are mounting the charging station on a conductive surface e.g. on sheet metal, then glue the four spacing sleeves supplied to the back of the charging station on the four mounting holes.
5. Mount the charging station with four M6 fillister head screws.
### 4.3 Connecting the charging station

#### Requirements
- The power supply is switched off.
- The charging station is installed as specified in this document.
- Three-core cable, flexible, 0.75 mm²
- End sleeves
- 1 connector, included in accessories pack of the charging station

#### Configuration of the connector

The following figure shows the structure of the connector:

![Connector Diagram](image)

**Pin Assignment of female contact insert**

<table>
<thead>
<tr>
<th>Pin</th>
<th>Assignment of female contact insert</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+24 VDC</td>
</tr>
<tr>
<td>2</td>
<td>n. c.</td>
</tr>
<tr>
<td>3</td>
<td>GND 24 V</td>
</tr>
<tr>
<td>4</td>
<td>PE</td>
</tr>
</tbody>
</table>

#### Procedure – Installing the connector

Proceed as follows:
1. Fit end sleeves on the wire ends.
2. Push the pressure screw, clamping basket, seal, and coupling sleeve onto the cable.
3. Fasten the wires to the contacts in the female contact insert.
4. Install the connector.
4.4 Mounting the transponder

Requirements

- 2 x M4 cylinder head screws, with nuts if required
- An ideal position was selected for the transponder, see chapter “Dividing plant into zones (Page 47)”

Procedure

Proceed as follows:
1. Place the transponder onto the mounting surface.
2. Mark the fastening holes with a marking-off tool.
3. Drill two through-holes or two threaded holes, M4.
4. Attach the transponder.

4.5 Setting the transponder ID and inserting the batteries

Requirements

- Torx screwdriver, size T10
- Screwdriver, size 0
- 3 1.5 V AA mignon batteries – included in the transponder accessory kit

Procedure – opening the transponder

Note

Observe the notes about the EGB in chapter “ESD guideline (Page 271)”!
Proceed as follows:

1. Loosen the four marked screws.

2. Lay the cover aside.

   The screws are in the cover so that they cannot be lost.

   The following image shows the location of the rotary coding switch and the battery component.
Example for an ID

The following image shows the example of the ID 3A27H - 14 887 in a decimal format.

![Example Image]

LSB
- Rotary coding switches for first decade, lowest value byte
  - Set value: 7

MSB
- Rotary coding switches for fourth decade, highest value byte
  - Set value: 3

Procedure – inserting the battery and setting ID

Proceed as follows:
1. Insert the batteries in the battery compartment corresponding with the polarity label.
2. Set the assigned ID with the help of a screwdriver.

The values permitted are 1 to FFFE, i.e. 1 to 65,534 in decimal format. Please note the MSB and LSB markings on the printed circuit board. Refer to your plant documentation for additional information.

Procedure – closing the transponder

Proceed as follows:
1. Place the cover on the transponder.
2. Tighten the four screws.

**NOTICE**

**Damage to treading possible**

The transponder housing is made of plastic. Therefore, the mounting hole threads cannot handle the same amount of stress as a comparable metallic housing. If the screws are tightened more than 20 times, there is risk of damage to the threads.

Do not exceed 0.4 to 0.5 Nm of torque when tightening the screws.
4.6 Connecting the HMI device

4.6.1 Safety instructions

**CAUTION**

Only use for approved devices
Non-approved devices may cause malfunctions.
Operate the HMI device exclusively with the approved devices, see chapter:
- Check the scope of delivery (Page 55)
- Accessories (Page 16)

Malfunction possible
If the HMI device is switched on and lying on its front, any one of the operator controls can trigger a malfunction.
Switch off the HMI device whenever possible.

Damage to the HMI device by foreign objects and liquids
Damage may occur to the HMI device if it is opened by unauthorized personnel. Prevent the ingress of foreign particles or liquids into the HMI device or the PCB.
The connection and battery compartments may only be opened by skilled personnel.

**NOTICE**

Do not exceed the bridging time
The backup capacitor supplies power to the HMI device when you remove the main battery. The HMI device is switched off automatically if you exceed the maximum backup time of 50 seconds. This triggers a shutdown or rampdown of an integrated HMI device.
Do not exceed the buffer time.

Opening the connection or battery compartment
The HMI device does not meet degree of protection IP65 when the connection or battery compartment is open.
Do not open the connection or battery compartment if dust or moisture can enter the device.
4.6.2 Opening and closing the battery and terminal compartment

The connection compartment may not be opened while the HMI device is in operation. This will not interrupt the power supply to the HMI device.

Requirements

- Torx driver, size 2

Procedure – opening the terminal compartment

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wiring to charging contacts</strong></td>
</tr>
<tr>
<td>The connection bay cover is connected to the HMI device’s housing by wiring. This can be damaged during opening.</td>
</tr>
<tr>
<td>Carefully open the connection bay cover.</td>
</tr>
</tbody>
</table>

Note

First open the battery compartment cover and take out the main battery. Remove the connection bay cover.

If the power supply unit is connected, the parts of the HMI device will be under voltage.

Proceed as follows:

1. Pull up the locking latch on the battery compartment cover.

2. Open the battery compartment cover.
   The main battery is visible.

3. Remove the main battery using the ribbon.

4. Unscrew the six screws approximately 1 cm out of the connection bay cover.
   The cover of the connection compartment is equipped with captive screws.

5. Remove the connection bay cover.
Result

The connection bay is open.

Procedure for closing the connection bay and battery compartment

| CAUTION |
| Degree of protection IP65 |
| Ensure that the seals belonging to the connection bay cover and battery compartment cover are present during mounting. |
| After completing the connections, check whether the covers are fitted on the USB interface and the terminal for the power supply unit. |

| Wiring to charging contacts |
| If the line to the charging contacts is stuck, this may result in functional problems. |
| When closing the connection bay cover, be careful not to trap the wiring at the charging contacts. |

| Connection compartment |
| If parts other than the main battery and memory card remain in the connection bay, this may result in functional problems. |
| Only use the connection bay to insert the memory card and main battery! |

| Mounting hole threads |
| The HMI device housing is made of plastic. Therefore, the mounting hole threads cannot handle the same amount of stress as a comparable metallic housing. If the screws are tightened more than 20 times, there is risk of damage to the threads. |
| Do not exceed 0.4 to 0.5 Nm of torque when tightening the screws. |
Proceed as follows:
1. Place the connection bay cover on the connection bay. Be careful with the wiring to the charging contacts.
2. Tighten the 6 screws on the connection bay cover.
3. Insert the main battery.
4. Insert the battery compartment cover. The fastener of the battery compartment cover must engage below the locking latch.

**Result**

The connection bay and battery compartment of the HMI device are now closed.

### 4.6.3 Ports and reset button

The following figure shows the interfaces and reset button of the HMI device.

![Diagram of HMI device interfaces](image)

- ① Reset button
- ② RJ45 socket
- ③ Cable connector for wiring to charging contacts
- ④ USB interface
- ⑤ Connection for power supply

The USB socket and the connector for the power supply unit are shown as plugs. All unsaved data will be lost when you press the reset button. Press the reset button only when the HMI device is no longer working properly and no longer responds to input.
4.6 Connecting the HMI device

4.6.4 Inserting a memory card

The following can be saved to the memory card of the HMI device:

- Logs
- Recipes
- Operating system
- Applications
- Additional specifications

The memory card can be inserted and removed during operation. Do not remove the memory card while data is being accessed by an application, for example during backup or recipe transfer.

Note
The micro memory card of the SIMATIC S7 PLC cannot be used.

Requirements

- The battery compartment of the HMI device is open.
- The main rechargeable battery has been removed.
- The connection bay on the HMI device is open.
Procedure for inserting a memory card

**Note**
Read the information provided in chapter "Opening and closing the battery and terminal compartment (Page 61)".
Observe the notes about the EGB in chapter "ESD guideline (Page 271)".

Proceed as follows:
1. Insert the memory card into the slot.
   Observe the memory card symbol on the slot when inserting the card. An arrow on the memory card indicates the front side and the direction of insertion.

Procedure – using a memory card for the first time

**Note**
The first time you use a memory card, the HMI device will prompt you to format it. All data is lost on the memory card during formatting.
Back up existing data, if necessary, before you use the memory card in the HMI device.

Proceed as follows:
1. Cancel the formatting procedure by pressing “ESC”.
2. Remove the memory card from the slot.
3. Back up data that are still needed.
4. Insert the memory card into the slot.
5. Format the memory card.

Procedure for unplugging a memory card

Proceed as follows:
1. Pull the memory card out of the slot.
2. Close the connection bay.
3. Insert the main battery.
4. Close the HMI device’s battery compartment.
5. Store the memory card in a safe place.
4.6.5 Inserting, charging and changing the main battery

4.6.5.1 Safety instructions

---

**CAUTION**

Handling rechargeable batteries

There is a risk of fire and, in extreme cases, explosion in the following situations:

- Incorrect charging and discharging of the rechargeable battery
- Reverse polarity
- Short-circuit

Always charge the battery in the HMI device only or in the charging station that has been approved for the HMI device.

The following applies to lithium-ion rechargeable batteries:

- Do not crush
- Do not heat or burn
- Do not short-circuit
- Do not disassemble
- Do not immerse in liquids – the rechargeable battery may rupture or burst.
- Store unused rechargeable batteries away from the following items which can cause the contacts to be bridged.
  - Paper clips
  - Coins
  - Keys
  - Nails
  - Screws or other small metal objects

Contact with battery fluid

Improper handling of the rechargeable battery can lead to fluid spillage.

Avoid contact with the battery fluid. If battery fluid comes in contact with skin, rinse it off with water. If battery fluid comes into contact with the eyes, seek medical advice.

---

**NOTICE**

Use only approved batteries

If you use non-approved batteries, malfunctions may occur as a result.

Only use the rechargeable batteries approved for the HMI device.

**Fully charge the main rechargeable battery before first use**

If you attempt to use a main rechargeable battery in the HMI device in its factory state, the HMI device will not start.

Fully charge the main rechargeable battery before inserting it in the HMI device.
4.6.5.2 Replacing the main rechargeable battery

You can replace the main battery during operation. A capacitor takes over power supply duties while the main rechargeable battery is being replaced. The maximum buffer time is 50 seconds.

If you exceed the buffer time, the HMI device will switch off.

---

**Note**

Keep charged main batteries in stock.

Use a new main battery if the operation time of the HMI device has been cut to half with the main battery currently used.

The following features are disabled during the buffer time:

- Display backlighting
- The function keys and associated LEDs
- The LED display
- The illuminated pushbuttons and handwheel
- USB interface

**Requirement**

- The battery compartment is open.

**Procedure**

Proceed as follows:

1. Remove the main battery using the ribbon.
   
   Read the section "Safety instructions (Page 33)".

2. Insert a new main battery.

3. Close the battery compartment.

4.6.5.3 Charging the main rechargeable battery

The main battery is delivered uncharged. The main battery is loaded as soon as the HMI device is in the charging station.

---

**Note**

Read the information provided in chapter "Safety instructions (Page 33)".

Observe the notes about the EGB in chapter "ESD guideline (Page 271)".

Please note that a battery is subject to a natural self-discharge. Self-discharge will eventually lead to complete discharge if the battery is not used for a long time. Read the chapter "Maintenance and care (Page 249)".
Requirements

- The connection compartment is open.
- The battery compartment is open.

Procedure

**Note**

When charging a rechargeable battery, the ambient temperature or battery temperature should not exceed 40 °C. The higher the temperature, the longer it will take for the rechargeable battery to fully charge.

Select a location with a low ambient temperature for the charging station. Let the rechargeable battery cool before charging it.

Proceed as follows:

1. Place the main battery into the battery compartment.

2. Close the battery compartment.

3. Insert the HMI device into the charging station.

   The battery is charged once the HMI device illuminates the "BAT" LED. See chapter "LED display (Page 79)".
4.6.5.4 Displaying the battery charge status

The main rechargeable battery features an LED display. The respective LEDs indicate the battery charge status.

Requirements

- The main battery has been removed.

Procedure

Proceed as follows:

1. Press the button.

   The LED display stays lit for approximately 5 seconds after you release the button. The number of lit LEDs indicates the charging state.

<table>
<thead>
<tr>
<th>Number of LEDs</th>
<th>Flashes for</th>
<th>Lights for</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0 to 19 % of the charge capacity</td>
<td>20 to 39 % of the charge capacity</td>
</tr>
<tr>
<td>2</td>
<td>-</td>
<td>40 to 59 % of the charge capacity</td>
</tr>
<tr>
<td>3</td>
<td>-</td>
<td>60 to 79 % of the charge capacity</td>
</tr>
<tr>
<td>4</td>
<td>-</td>
<td>80 to 96 % of the charge capacity</td>
</tr>
<tr>
<td>5</td>
<td>-</td>
<td>97 to 100% of the charge capacity</td>
</tr>
</tbody>
</table>

If all the LEDs light up, the main rechargeable battery is fully charged.

Note

When storing batteries, pay attention to the notes in the chapter "Maintenance and care (Page 249)".
4.6 Connecting the HMI device

4.6.6 Connecting the PLC

Introduction

Only use approved components to connect a SIMATIC S7 PLC. You can find more information on this on the Internet in Industry Mall (http://mall.automation.siemens.com).

Configuration graphic

The following figure shows the possible connection between the HMI device and the PLC.

See also


4.6.7 Connecting the configuration PC

The HMI device and configuration PC must be located inside the WLAN range. The WLAN must have sufficient signal strength.

Note

You must connect the HMI device to the configuring PC in infrastructure mode. An ad hoc network is not possible.
4.6 Connecting the HMI device

Configuration graphic

The following figure illustrates the possible connections between the HMI device and the configuring PC.

NOTICE

Adhere to the USB connection sequence

You will not be able to transfer a project to the HMI device if you do not adhere to the connection sequence.

Observe the following sequence when connecting by USB:
1. HMI device
2. PC

USB host-to-host cable

You will not be able to transfer a project to the HMI device if you use the driver for the USB host-to-host cable.

Use only the driver for the USB host-to-host cable that is included in the WinCC flexible package.

Note

Point-to-point connection

Use a cross cable for a point-to-point connection. The HMI device and the PC can also be subscribers in a local area network.

Connection via WLAN

In its factory state, the WLAN interface of the HMI device is disabled. Before you access the HMI device from the configuration PC via WiFi, you need to appropriately configure the access point and HMI device in infrastructure mode. An ad hoc wireless network is not possible.
Restoring the factory settings

To update the operating system and reset to factory settings, you must connect the HMI device to the configuring PC via the RJ45 interface. Only connect a configuration PC directly to the HMI device as long as it is necessary. Additional information is available in the "Restoring factory settings (Page 177)" section.

See also

Opening and closing the battery and terminal compartment (Page 61)

4.6.8 Connecting a printer

A printer is connected to the HMI device through WLAN. It is not possible to connect a printer to the HMI device's USB interface.

Information about printers that were tested and approved with HMI devices can be found online under "Printers approved for SIMATIC Panels and Multi Panels (http://support.automation.siemens.com/WW/view/en/11376409)".

Configuration graphic

The following figure illustrates the possible connections between the HMI device and a printer.

![Configuration graphic](image-url)

Observe the documentation for the respective printer during connection.
4.6.9 Connecting a USB device

You can connect the following devices to the USB port of the HMI device:

- External mouse
- External keyboard
- USB memory stick

Only connect industrial devices.

**NOTICE**

Device with a separate power supply

If you connect a device with a separate power supply to the USB port, this may result in functional disruptions.

Only connect a configuration PC or PC to the USB port.

Load of USB interface

Malfunctions may occur on a USB device that presents an electrical overload to the USB port.

Adhere to the values for the maximum load on the USB port. You can find the values in the chapter "Mobile Panel 277 IWLAN (Page 255)".

Access to USB port

The USB port is disabled while the main battery is being changed. The data transmission to a USB memory stick is not possible.

Ensure no one tries to access the USB port while the main rechargeable battery is being replaced.

Note

Devices without a separate power supply connected to the USB port increase the power load. This will reduce the service life of the HMI device.

See also

Interface description (Page 257)
4.6 Connecting the HMI device

4.6.10 Connecting the power supply unit

The power supply unit supplies the power to the HMI device.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use only approved power supplies</strong></td>
</tr>
<tr>
<td>If you use an unapproved power supply, damage may occur to the HMI device.</td>
</tr>
<tr>
<td>Only use the power supply approved for the HMI device.</td>
</tr>
<tr>
<td><strong>Danger of overheating</strong></td>
</tr>
<tr>
<td>There is a risk of overheating if you cover the power supply and thereby inhibit the air circulation.</td>
</tr>
<tr>
<td>Do not cover the power supply unit.</td>
</tr>
</tbody>
</table>

| Note |
| Unplug the mains connector of the power supply to ensure complete electrical isolation. |
| The power supply unit is designed for operation on grounded power supply networks (TN systems to VDE 0100, Part 300, or IEC 364-3). |
| Operation is not authorized on ungrounded or impedance-grounded power networks (IT systems). |

| Procedure |
| Proceed as follows: |
| 1. Connect the power supply to the HMI device. |
| 2. Connect the power supply unit to the mains with the correct power supply cable. |
4.7 Switching on and testing the HMI device

When the HMI device is initially put into operation, there is no project. Ethernet is set as the data transfer channel.

Requirement

- A charged main battery is inserted in the HMI device.

Procedure

Proceed as follows:

1. Briefly press the "ON/OFF" button.
   
   The "PWR" LED lights up – see section "LED display (Page 79)". The display then lights. A progress bar is displayed during startup.

   The loader is displayed once the operating system has started.

   ![Loader Screen]

   The "BAT" LED indicates that a main battery is present and charged. The HMI device automatically switches to "Transfer" mode if the following two requirements are met:
   
   - No project is loaded on the device.
   - At least one data channel has been configured.

   The following dialog appears:

   ![Transfer Dialog]

2. Press the "Cancel" button.
   
   The transfer is canceled. The Loader appears.
Result

The HMI device is ready for operation when the loader displays one of the following dialogs:

- "Transfer" dialog

4.8 Switching off the HMI device

The following procedure applies to an HMI device on which there is no project. The way the device is switched off therefore differs from that of an integrated HMI device.

Procedure

Proceed as follows:

1. Press the "ON/OFF" button on the HMI device at least 4 seconds.

   The HMI device switches off.
Operator controls and displays

5

5.1 Overview

The standard input unit on the HMI device is the touch screen. All operator controls required for operation appear in one or more HMI screens on the display after the project starts.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Damage to the touch screen</td>
</tr>
<tr>
<td>Never press the touch screen with a pointed or sharp object. Avoid applying sudden pressure to the touch screen with a hard object. Both these will substantially reduce the service life of the touch screen and can even lead to total failure.</td>
</tr>
<tr>
<td>Only press the operating objects on the touch screen of the HMI device with a finger or a touch pen.</td>
</tr>
<tr>
<td>Damage to the keyboard</td>
</tr>
<tr>
<td>Do not touch the keys with a pointed or sharp object. Avoid applying sudden pressure to the keys with a hard object. Both these will substantially reduce the service life of the keyboard and can even lead to total failure.</td>
</tr>
<tr>
<td>Use only your fingers to operate the keys of your HMI device.</td>
</tr>
</tbody>
</table>
Operator controls and displays

5.1 Overview

Operator controls and their functions

The following image shows the operating elements and the display on the HMI device. Depending on the delivered HMI device, differences to the following image may exist.

① Handwheel, optional
② LED display
③ Membrane keyboard
④ Display with touch screen
⑤ Key "ON/OFF"
⑥ Illuminated pushbutton, optional
⑦ Key-operated switch, optional

The functions assigned to the function keys, the handwheel, the key-operated switch and the illuminated pushbuttons are determined during configuration. The above-mentioned operator controls do not function outside of a project.
5.2 LED display

An LED display consisting of five LEDs is located on the front of the HMI device. The LED display shows the operating states for the HMI device and the communication.

Meaning of LEDs

The LED display is activated when the HMI device is switched on.

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Function</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFE</td>
<td>-</td>
<td>Without</td>
<td>-</td>
</tr>
<tr>
<td>PWR</td>
<td>Green</td>
<td>Power</td>
<td>Lights or blinks: If the HMI device is turned on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Lights up in the following cases:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The main battery is inserted and charged.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The HMI device is in the charging station.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• The HMI device is connected to the power supply unit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Flashes: If the HMI device is in &quot;screen off&quot; mode.</td>
</tr>
<tr>
<td>COM</td>
<td>Green</td>
<td>Communication</td>
<td>Off: If the WLAN interface of the HMI device is disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Flashes: When the HMI device attempts to connect to the WLAN.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>On: If the HMI device and access point are interconnected via WLAN.</td>
</tr>
<tr>
<td>RNG</td>
<td>-</td>
<td>Without</td>
<td>-</td>
</tr>
</tbody>
</table>

Refer to the plant documentation for additional information on the meaning of the LEDs.

The "BAT" LED signals the following states based on the type of power supply:
### 5.2 LED display

<table>
<thead>
<tr>
<th>Power supply</th>
<th>BAT LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rechargeable battery operation, HMI device on</td>
<td>① ② ③ ④</td>
</tr>
<tr>
<td>Rechargeable battery operation, HMI device off</td>
<td>□ □ □ □</td>
</tr>
<tr>
<td>Power supply unit, HMI device on</td>
<td>□ □ □ □ !</td>
</tr>
<tr>
<td>Power supply unit, HMI device off</td>
<td>□ □ □ □ !</td>
</tr>
<tr>
<td>Charging station</td>
<td>□ □ □ □ !</td>
</tr>
</tbody>
</table>

① Charge at < 6% of charge capacity
② Charge at ≥ 6% of charge capacity
③ Maximum charge
④ Rechargeable battery not in the HMI device
⑤ Rechargeable battery temperature too high
⑥ Possible faults:
  - Short circuit, discharge current > 8.0 A
  - Overload, discharge current > 4.0 A
  - Overload, charge current > 2.8 A
  - Charging error, cell voltage > 4.3 V
  - Charging error, cell voltage < 3.0 V

Note the following:
- An error event always has priority.
  - If an error occurs, the "BAT" LED signals according to column ⑥.
- If the main battery is not fully charged, the "BAT" LED signals according to column ⑤.
- If the main battery is fully charged, the "BAT" LED signals according to column ③.
5.3 Power management

The HMI device is equipped with a power management function. If you do not operate the HMI device within a configured time period, power management will switch the HMI device to power saving mode. This extends the operating period of the HMI device until the next time the main battery is replaced or the next time it is charged.

Operating modes in power management

Power management has two operating modes:

- Reduced brightness
  - Reduces the brightness of the touch screen.

  **Note**
  When the HMI device is docked in the charging station, "reduced brightness" mode will be enabled automatically after two minutes.
  If you have specified a waiting period of less than two minutes for activation of the "reduced brightness" mode in the WinCC flexible project, then the configure time frame will be effective.

- Screen off
  - The touch screen is switched off.
  - The illuminated pushbutton and handwheel are disabled.
  - Other power save measures are activated.
  - An existing keyswitch will remain available.

For information about the assignment of power management parameters, refer to the WinCC flexible Online Help.

**Note**

The "screen off" mode is not available while the HMI device is logged on to a plant.
Power management for the HMI device provides the following operating modes:

<table>
<thead>
<tr>
<th>Operating mode</th>
<th>LED</th>
<th>Action</th>
<th>Follow-up operating mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>&quot;PWR&quot; is off. &quot;BAT&quot; is off.</td>
<td>Briefly press Taste &quot;ON/OFF&quot;</td>
<td>ON</td>
</tr>
<tr>
<td>ON</td>
<td>&quot;PWR&quot; lights up.</td>
<td>Automatically, if no actions are performed within a configured time period.</td>
<td>Reduced brightness</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Briefly press Taste &quot;ON/OFF&quot;</td>
<td>Screen off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Press Taste &quot;ON/OFF&quot; for at least 4 sec.</td>
<td>OFF</td>
</tr>
<tr>
<td>Reduced brightness</td>
<td>&quot;PWR&quot; lights up. The brightness of the touch screen is reduced.</td>
<td>Operation on the touch screen</td>
<td>ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Briefly press Taste &quot;ON/OFF&quot;</td>
<td>Screen off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Automatically, after a configured time interval if no operations are carried out</td>
<td>Screen off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Press Taste &quot;ON/OFF&quot; for at least 4 sec.</td>
<td>OFF</td>
</tr>
<tr>
<td>Screen off</td>
<td>&quot;PWR&quot; flashes. The touch screen is switched off.</td>
<td>Briefly press Taste &quot;ON/OFF&quot;</td>
<td>ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Briefly press Taste &quot;ON/OFF&quot; and then press it again for at least 4 sec.</td>
<td>OFF</td>
</tr>
</tbody>
</table>

5.4 Operator controls

5.4.1 Operating the handwheel

The handwheel is an optional operator control. The handwheel can be turned without a stop and does not have a zero position. To facilitate operation, the handwheel has a small recess.
5.4.2 Operating the key-operated switch

Introduction
The key-operated switch is an optional operator control. The keyswitch is used to lock functions that you can trigger by means of the HMI device.

Operating the key-operated switch
The following figure shows the three switch positions of the key-operated switch, I-0-II.

The key can be removed in the switch setting 0.
Remove the key after use. If the HMI device falls down, you can avoid damaging the key through this.

Note
The key to the key-operated switch is supplied together with the HMI device. The key does not have an HMI device-dependent coding. This means that the key can be used on any HMI device.
5.4.3 Operating the illuminated push-button

The function of the illuminated pushbutton is defined in the current project. Refer to the plant documentation for additional information on the function.

5.4.4 Evaluation of the operator controls

5.4.4.1 Overview

The following information can be transferred between the HMI device and the PLC:

- Direction pulses of the handwheel
- Switching state of the function keys
- Key operated switch state
- Switching state of the illuminated pushbutton
- Switching state of the function keys and illuminated pushbutton LEDs

There are two ways of transmitting information:

- Direct keys
- System functions of WinCC flexible

Note

The following sections are intended for the configuration engineer.

5.4.4.2 Evaluating operator controls as direct keys

You can configure the operator controls of the HMI device as direct keys. The switching state of the following operator controls are available directly in the IO area of the PLC:

- Direction pulses of the handwheel
- The switching state of the function keys
- The switching state of the key-operated switch
- The switching state of the illuminated pushbuttons
Byte assignment

The following figure shows the assignment of the keys (inputs) and LEDs (outputs) to the bytes in the PLC process image.

<table>
<thead>
<tr>
<th>Button bits</th>
<th>LED bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 6 5 4 3 2 1 0</td>
<td>7 6 5 4 3 2 1 0</td>
</tr>
<tr>
<td>n</td>
<td>F8 F7 F6 F5 F4 F3 F2 F1</td>
</tr>
<tr>
<td>n + 1</td>
<td>F16 F15 F14 F13 F12 F11 F10 F9</td>
</tr>
<tr>
<td>n + 2</td>
<td>T2 T1 S1 S0</td>
</tr>
<tr>
<td>n + 3</td>
<td>T2 T1</td>
</tr>
<tr>
<td>n + 4</td>
<td>I7 I6 I5 I4 I3 I2 I1 I0</td>
</tr>
<tr>
<td>n + 5</td>
<td>D7 D6 D5 D4 D3 D2 D1 D0</td>
</tr>
<tr>
<td>n + 6</td>
<td>7 6 5 4 3 2 1 0</td>
</tr>
<tr>
<td>n + 7</td>
<td>15 14 13 12 11 10 9 8</td>
</tr>
<tr>
<td>n + 8</td>
<td>23 22 21 20 19 18 17 16</td>
</tr>
<tr>
<td>n + 9</td>
<td>31 30 29 28 27 26 25 24</td>
</tr>
</tbody>
</table>

F  Bit for function key
S  Bit for key-operated switch
T1 Bit for left illuminated pushbutton
T2 Bit for right illuminated pushbutton
I  Bit for handwheel pulses, forwards
D  Bit for handwheel pulses, backwards

The bytes "n+6" to "n+9" contain the direct key bits for the touchscreen buttons.
Refer to your plant documentation for additional information.

Bit assignment

The following tables show the bit coding for function keys, key-operated switch, illuminated pushbutton and handwheel:

- Bit coding of function keys

<table>
<thead>
<tr>
<th>Switch state</th>
<th>F1 to F18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not pressed</td>
<td>0</td>
</tr>
<tr>
<td>Pressed</td>
<td>1</td>
</tr>
</tbody>
</table>

- Bit coding of function key LEDs

<table>
<thead>
<tr>
<th>Switch state</th>
<th>F1 to F18</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED not illuminated</td>
<td>0</td>
</tr>
<tr>
<td>LED is illuminated</td>
<td>1</td>
</tr>
</tbody>
</table>
5.4 Operator controls

- Bit coding of key-operated switch

<table>
<thead>
<tr>
<th>Switch state</th>
<th>S1</th>
<th>S0</th>
<th>Key position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position 0</td>
<td>0</td>
<td>0</td>
<td>In middle position</td>
</tr>
<tr>
<td>Position I</td>
<td>0</td>
<td>1</td>
<td>Turned in clockwise direction up to stop</td>
</tr>
<tr>
<td>Position II</td>
<td>1</td>
<td>0</td>
<td>Turned counter-clockwise up to stop</td>
</tr>
</tbody>
</table>

- Bit coding of illuminated pushbuttons

<table>
<thead>
<tr>
<th>Switch state</th>
<th>T1</th>
<th>T2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not pressed</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Pressed</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

- Bit coding of illuminated pushbutton LEDs

<table>
<thead>
<tr>
<th>Switching state LED</th>
<th>T1</th>
<th>T2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>On permanently</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

- Bit coding of the handwheel
  - A setpoint is not specified for the handwheel.
  - After start-up of the HMI device, the bytes "n+4" to "n+5" are set to zero.

Turning the handwheel triggers positive or negative pulses, depending on the direction of rotation. The number of positive pulses are stored in bits I0 to I7. The number of negative pulses are stored in bits D0 to D7. The values are entered in binary format, where bit 0 is the lowest and bit 7 is the highest valued bit.

A complete handwheel revolution yields 50 pulses.

- Every pulse of the handwheel is added to byte "n+4" or "n+5", depending on the direction of rotation. There are no negative values. When the possible value range is exceeded, there is an overflow:

  If a value of 255 is increased by one pulse, a value of 0 results.

Example for the bit assignment of the handwheel

The following table includes an example for rotation direction determination. The pulses are stored in bytes "n+4" and "n+5" and are measured during the points in time t₁ to t₂.

The numbers in the following table represent a byte in the PLC.

<table>
<thead>
<tr>
<th>Evaluation time</th>
<th>Handwheel</th>
<th>Evaluation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pulses, forwards</td>
<td>Pulses, backwards</td>
</tr>
<tr>
<td>t₁</td>
<td>255 (±1)</td>
<td>245 (±11)</td>
</tr>
<tr>
<td>t₂</td>
<td>10</td>
<td>245 (±11)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.4 Operator controls

Operational panel Mobile Panel 277 IWLAN V2

Operating Instructions, 10/2010, A5E02480233-01

### Evaluation time

<table>
<thead>
<tr>
<th>Evaluation time</th>
<th>Handwheel</th>
<th>Evaluation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pulses, forwards</td>
<td>Pulses, backwards</td>
</tr>
</tbody>
</table>
| \( t_3 \)      | 10         | 4          | Pulses, forwards: 0  
|                 |            |            | Pulses, backwards: 15  
|                 |            |            | Resulting value: \(-15\)  |
| \( t_4 \)      | 15         | 5          | Pulses, forwards: 5  
|                 |            |            | Pulses, backwards: 1  
|                 |            |            | Resulting value: +4  |

The difference in pulses at times \( t_n \) and \( t_{n+1} \) allows you to determine the resulting value and thus the direction of rotation.

Establish the following values:

- Number of pulses, forwards
  - At time \( t_n \)
  - At time \( t_{n+1} \)

- Number of pulses, backwards
  - At time \( t_n \)
  - At time \( t_{n+1} \)

From this, you determine the resulting value. This is calculated as:

\[
Pulses, \text{ forwards, } t_{n+1} - Pulses, \text{ forwards, } t_n - Pulses, \text{ backwards, } t_{n+1} + Pulses, \text{ backwards, } t_n = \text{ Resulting value}
\]

**Consider the response time**

**NOTICE**

**Sample cycle time**

If the scan cycle is large, the entered impulses will not immediately have an effect on the PLC. A reaction in the system is not caused.

In the PLC, set a scan cycle \( \leq 100 \text{ ms} \).

The bytes "n+4" and "n+5" must be retrieved on the PLC side within a second and cyclically. This setting ensures that no more than 256 pulses can be added between two scans of the handwheel. You need to turn the handwheel approximately 4.5 turns to generate 256 pulses.

The rotary pulse encoder supplies a maximum of 200 pulses per second.
5.4.4.3 Controlling the LEDs of the function keys via system functions

Introduction
LEDs are integrated in the HMI device's function keys F1 to F18. The PLC can be directly communicated with the integrated LEDs.
An LED can transmit the following light signals:
- Off
- Flashing slowly
- Flashing quickly
- On
In the expiring project, the light signals can signalize to the operator that the function key should be pressed.

Bit assignment
The following table shows the possible light signals and the corresponding entries in bit n+1 and bit n of the LED tags.

<table>
<thead>
<tr>
<th>Bit n+1</th>
<th>Bit n</th>
<th>Light signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Off</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>Flashing quickly</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>Flashing slowly</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>ON (continuous)</td>
</tr>
</tbody>
</table>

5.4.4.4 Controlling the handwheel via system functions

Introduction
The handwheel is an optional operator control of the HMI device. You can enter incremental values in a running project with the handwheel.

Note
Do not configure limit values in WinCC flexible for tags assigned to the handwheel.

Evaluate incremental values
If the signals of the handwheel are assigned to a WinCC flexible tag, then the forward and backward increments will be set off against each other. The absolute value of the increments is given. The maximum or minimum value of increments entered until the overflow is reached depends on the type of tag assigned.
A complete handwheel revolution yields 50 pulses. The rotary pulse encoder supplies a maximum of 200 pulses per second.
Example

- The handwheel has a starting value of 120 increments.
- You rotate the wheel 10 increments forwards and 3 increments backwards.
  This results in a new value of 127 increments.

5.4.4.5 Controlling key-operated switches via system functions

Introduction
The key-operated switch is an optional operator control of the HMI device. The key-operated switch serves to lock functions in a running project which can be triggered by means of the HMI device.

Bit assignment
The following table shows the bit assignment for the tag of the key-operated switch:

<table>
<thead>
<tr>
<th>Bit 1</th>
<th>Bit 0</th>
<th>Switch setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Central position</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>Turned in clockwise direction up to stop</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>Turned counter-clockwise up to stop</td>
</tr>
</tbody>
</table>

Note
If you use a tag of the "Boolean" type for the key-operated switch, the following assignment applies:
- Status "0": Central position of the key-operated switch
- Status "1": Key-operated switch turned clockwise or counter-clockwise to the stop

5.4.4.6 Controlling and evaluating illuminated mushroom pushbuttons via system functions

Introduction
The illuminated pushbuttons are optional operator controls of the HMI device. The PLC can be directly communicated with the integrated LED.

An LED can transmit the following light signals:
- Off
- Flashing slowly
- Flashing quickly
- On

In the expiring project, the light signals can signalize to the operator that the illuminated pushbutton should be pressed.
5.5 Labeling the function keys

Introduction
You can label the function keys as required for your project. Use labeling strips to do so.

Note
Do not write on the keyboard to label the function keys.

Printing labeling strips
WinCC flexible comes with a range of labeling strip templates. You will find further information regarding the location of the templates in the WinCC flexible Online Help.

Any printable and writable foil can be used as labeling strips. Use transparent foil so that the LEDs of the function keys can be seen. The permitted thickness of the labeling strip is 0.13 mm. Paper should not be used as labeling strips.
Labeling strip dimensions

Labeling strip on right:

2 x 45°

All dimensions in mm

Labeling strip on left:

2 x 45°

Labeling strip at bottom:

2 x 45°
**Procedure**

The following steps apply for the initial attaching of labeling strips.
Proceed as follows:

1. Lay the HMI device on its reverse side.
2. Remove the label from the cover caps.
3. Unscrew both cover caps.
4. Pull the labeling strips out of the guides.
5. Inscribe the labeling strips in accordance with the system.
   Wait for the printed labeling strips to dry before you insert them.
6. Push the labeling strips into the guides.
7. Screw both cover caps back on.
   Screwed on cover caps with inserted rubber seals satisfy degree of protection IP65. You can order the cover caps – see chapter "Accessories (Page 16)."
8. Place the label on to the cover caps.

**Note**

Should the exchange of labeling strips become necessary, these can be reordered from your Siemens representative.
5.6 Holding, operating and setting down the HMI device

Holding and operating the HMI device

The HMI device is equally easy to hold and operate for right-handers and left-handers because it is designed symmetrically. The free hand can be used to operate the operator controls on the front side.

The method of holding the HMI device shown in the following figure enables you to control movements in the plant to be monitored during servicing, for example.

Setting down the HMI device

A charging station is available for safe accommodation of the HMI device.

The HMI device can be used as a stationary device when it is placed in the charging station. The following figure shows how the HMI device is placed in the charging station.
5.7 Charging station

5.7.1 Charging the main battery in the charging compartment

The charging station has two charging compartments, each of which can charge one main battery. The main batteries are charged independently of each other.

Procedure for inserting the battery into the charging compartment

Proceed as follows:
1. Pull up the locking latch on the charging compartment cover. The cover can now be opened.
2. Place the main battery into the charging compartment.
3. Close the charging compartment. The main battery is charged whenever the charging station is connected to the power supply unit.

Procedure for removing the battery from the charging compartment

Proceed as follows:
1. Pull up the locking latch on the charging compartment cover. The cover can now be opened.
2. Remove the main battery using the ribbon.
3. Test the charge state of the LED display of the main battery.
4. Close the charging compartment.
5.7.2 LED-displays on the charging station

The LED display consists of three LEDs.

The LEDs have the following meaning:

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAT 1</td>
<td>Green/red</td>
<td>Off</td>
<td>No main battery in charging bay 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes green</td>
<td>Main battery is being charged in charging bay 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lit green</td>
<td>Main battery is being charged up to 95% in charging bay 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes red</td>
<td>Overcurrent, overvoltage, or overtemperature at the main battery in charging bay 1</td>
</tr>
<tr>
<td>POWER</td>
<td>Green/red</td>
<td>Off</td>
<td>No voltage at the charging bay</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes green</td>
<td>An HMI device is docked in the charging station and has charging contact</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lit green</td>
<td>Charging station is on rated power range</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lit red</td>
<td>Low voltage at the charging station</td>
</tr>
<tr>
<td>BAT 2</td>
<td>Green/red</td>
<td>Off</td>
<td>No main battery in charging bay 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes green</td>
<td>Main battery is being charged in charging bay 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lit green</td>
<td>Main battery is being charged up to 95% in charging bay 2.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Flashes red</td>
<td>Overcurrent, overvoltage, or overtemperature at the main battery in charging bay 2</td>
</tr>
</tbody>
</table>

Note

LED indication of overvoltage

All three LEDs go dark to indicate overvoltage at the charging station. Check the power supply to the charging station for overvoltage.
5.7.3 Locking the charging station

Introduction

The lock prevents unauthorized removal of the HMI device from the charging station.

Procedure for locking the charging station

Proceed as follows:

1. Slide the lock down to the appropriate cut-out in the charging station.
2. Turn the key by 90 degrees.
3. Remove the key.

The charging station is locked. You cannot remove the HMI device. The main battery in the HMI device is charged whenever the charging station is connected to the power supply unit.

Procedure for unlocking the charging station

Proceed as follows:

1. Insert the key into the lock barrel.
2. Turn the key by 90 degrees.
3. Slide the lock upwards.

You can remove the HMI device.
6.1 Desktop and Loader

Once the HMI device is switched on and booted, the display shows the desktop with the Loader.

1. Desktop
2. Loader
3. Start menu
4. Icon for screen keyboard
5. Icon for displaying IP information about the WLAN/LAN connection
Loader

The following figure shows the Loader.

![Loader diagram]

The buttons on the Loader have the following function:

- "Transfer" button – This switches the HMI device to "Transfer" mode.
  The transfer mode can only be activated when at least one data channel has been enabled for the transfer.

- "Start" button – This starts the project on the HMI device.
  When you do not perform any operation, the project starts automatically based on the settings in the Control Panel after a delay time.

- "Control Panel" button – This opens the Control Panel.
  You can make a variety of settings in the Control Panel, for example, the settings for the transfer.

- "Taskbar" button – This opens the taskbar and the Windows CE Start menu.
  The Loader will reappear when the project is closed on the HMI device.

Password protection

You can protect the Control Panel and taskbar from unauthorized access.

If password protection is configured, the "secure mode" message is displayed on the desktop. If the password is not entered, only the "Transfer" and "Start" buttons are operable. You can find additional information on Secure Mode in the section "Enabling and disabling SecureMode (Page 101)."

NOTICE

Keeping the password

If the password is no longer available, you are forced to update the operating system to regain access to the Control Panel and the Windows CE taskbar.

Backup password to protect it against loss. You can find additional information on updating the operating system in the section "Updating the operating system (Page 175)."
Internet Explorer

Internet Explorer for Windows CE is installed on the HMI device.

For more detailed information, refer to the Microsoft website.

Note

Internet Explorer for Windows CE and the Internet Explorer on a PC differ in terms of functionality.

Internet Explorer for Windows CE has separate proxy settings that are independent of the settings in the Control Panel of the HMI device.

For more detailed information, refer to the Microsoft website.
Status bar

When you click the icon in the status bar, the following dialog appears:

![WLAN Configuration Dialog]

- **① Address type**
- **② IP address**
- **③ Subnet mask**
- **④ Button for details**
- **⑤ Button to refresh the display**

The dialog contains information on the current WLAN or LAN connection.

6.2 Operating desktop and loader

The following operator control options are made available for the Windows CE interface and Control Panel:

- **Touch screen**
  
  The operator controls shown in the dialogs are touch-sensitive. Touch objects are operated in the same way as mechanical keys. You activate an operator control by pressing on it with your finger. To double-click them, touch an operator control twice in succession.

- **USB keyboard**
  
  You can operate the Windows CE interface and Control Panel with an external keyboard in exactly the same manner as with the screen keyboard of the HMI device.

- **USB mouse**
  
  You can operate the Windows CE interface and Control Panel with an external mouse in exactly the same manner as with the touch screen of the HMI device.
6.3 **Enabling and disabling SecureMode**

SecureMode prevents unauthorized access to the desktop and the taskbar of the HMI device. In SecureMode, all functions on the desktop and the taskbar of the HMI device are locked.

**Enabling SecureMode**

You have the following options for enabling SecureMode:

- Assign a password in the Control Panel for the HMI device.
- If no password has been assigned for the HMI device, double-click the following icon on the desktop.

![SecureMode icon]

SecureMode is enabled. The text "secure mode" appears on the desktop.

**Disabling SecureMode**

You can disable SecureMode as follows:

- If a password is assigned for the HMI device, then delete it.
- If no password has been assigned for the HMI device, operate the "Taskbar" button once in the Loader.

6.4 **Control Panel**

6.4.1 **Overview**

You have the following options for opening the Control Panel:

- During the startup phase
  
  Open the Control Panel in the Loader by pressing the "Control Panel" button.
- In the Windows CE start menu
  
  - Press the following key on the alphanumeric screen keyboard twice:

![Control Panel icon]

  - Open the Control Panel with "Settings > Control Panel".

The following figure shows the open Control Panel.
### 6.4 Control Panel

#### 6.4.2 Functions in the Control Panel

The following table shows references to the functional descriptions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Functional description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Backup/Restore icon" /></td>
<td>Saving to external storage medium – backup (Page 157)</td>
</tr>
<tr>
<td><img src="image2.png" alt="Backup/Restore icon" /></td>
<td>Restoring from external storage medium – Restore (Page 159)</td>
</tr>
<tr>
<td><img src="image3.png" alt="Certificates icon" /></td>
<td>Importing, displaying and deleting certificates (Page 155)</td>
</tr>
<tr>
<td><img src="image4.png" alt="Date/Time icon" /></td>
<td>Setting the date and time (Page 127)</td>
</tr>
<tr>
<td><img src="image5.png" alt="Input Panel icon" /></td>
<td>Using the screen keyboard in the Control Panel (Page 104)</td>
</tr>
<tr>
<td><img src="image6.png" alt="Network ID icon" /></td>
<td>Changing general settings (Page 152)</td>
</tr>
<tr>
<td><img src="image7.png" alt="Network ID icon" /></td>
<td>Setting the proxy server (Page 153)</td>
</tr>
<tr>
<td><img src="image8.png" alt="Network ID icon" /></td>
<td>Changing privacy settings (Page 154)</td>
</tr>
<tr>
<td><img src="image9.png" alt="Network ID icon" /></td>
<td>Setting the character repeat rate of the screen keyboard (Page 109)</td>
</tr>
<tr>
<td><img src="image10.png" alt="Network ID icon" /></td>
<td>Setting the double-click (Page 110)</td>
</tr>
<tr>
<td><img src="image11.png" alt="Network ID icon" /></td>
<td>Specifying the IP address and name server (Page 148)</td>
</tr>
<tr>
<td><img src="image12.png" alt="Network ID icon" /></td>
<td>Specifying the logon data (Page 149)</td>
</tr>
<tr>
<td><img src="image13.png" alt="Backup/Restore icon" /></td>
<td>Backing up registry information and temporary data (Page 128)</td>
</tr>
<tr>
<td><img src="image14.png" alt="Backup/Restore icon" /></td>
<td>Changing display brightness (Page 108)</td>
</tr>
<tr>
<td><img src="image15.png" alt="Backup/Restore icon" /></td>
<td>Displaying information about the HMI device (Page 130)</td>
</tr>
<tr>
<td><img src="image16.png" alt="Backup/Restore icon" /></td>
<td>Starting the HMI device again (Page 112)</td>
</tr>
<tr>
<td><img src="image17.png" alt="Backup/Restore icon" /></td>
<td>Display firmware (Page 131)</td>
</tr>
<tr>
<td><img src="image18.png" alt="Backup/Restore icon" /></td>
<td>Calibrating the touch screen (Page 111)</td>
</tr>
<tr>
<td><img src="image19.png" alt="Backup/Restore icon" /></td>
<td>Display the charging status and temperature of the rechargeable battery (Page 131)</td>
</tr>
<tr>
<td><img src="image20.png" alt="Backup/Restore icon" /></td>
<td>Selecting transponders (Page 132)</td>
</tr>
<tr>
<td><img src="image21.png" alt="Backup/Restore icon" /></td>
<td>Activate memory management (Page 133)</td>
</tr>
<tr>
<td><img src="image22.png" alt="Backup/Restore icon" /></td>
<td>Activating vibration alarm (Page 134)</td>
</tr>
</tbody>
</table>
6.4 Control Panel

6.4.3 Operating the Control Panel

You operate the Control Panel with the touch screen of the HMI device or a USB mouse.

Requirement

- The current project is closed.
- The loader appears.

Procedure

Proceed as follows:
1. Open the Control Panel.
2. Execute the function by double-clicking on the icon.
   The corresponding dialog is displayed.
3. Open a tab.
   The content of the dialog changes.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Functional description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Entering and deleting a password (Page 114)</td>
</tr>
<tr>
<td></td>
<td>Changing the printer properties (Page 135)</td>
</tr>
<tr>
<td></td>
<td>Enabling PROFINET IO (Page 143)</td>
</tr>
<tr>
<td></td>
<td>Regional and language settings (Page 136)</td>
</tr>
<tr>
<td></td>
<td>Setting the screen saver (Page 137)</td>
</tr>
<tr>
<td></td>
<td>Displaying general system properties (Page 139)</td>
</tr>
<tr>
<td></td>
<td>Specifying the computer name of the HMI device (Page 147)</td>
</tr>
<tr>
<td></td>
<td>Displaying memory distribution (Page 140)</td>
</tr>
<tr>
<td></td>
<td>Programming the data channel (Page 144)</td>
</tr>
<tr>
<td></td>
<td>Setting the location of the project (Page 141)</td>
</tr>
<tr>
<td></td>
<td>Setting the delay time for the project (Page 142)</td>
</tr>
<tr>
<td></td>
<td>Configuring e-mail (Page 150)</td>
</tr>
<tr>
<td></td>
<td>Assigning WLAN communication parameters (Page 119)</td>
</tr>
</tbody>
</table>
4. Press the required operator control.

5. Use the OK button to confirm your entries. The entry is applied.
   To cancel the entry, press the X button. The dialog closes.

6. Press X.
   The Control Panel closes. The loader appears.

6.4.4 Using the screen keyboard in the Control Panel

If you do not use an external keyboard, use the screen keyboard to enter numeric and alphanumeric characters. As soon as you touch a text box, a numeric or alphanumeric screen keyboard is displayed, depending on the type of the text box.

Display methods for the screen keyboard

You can change the type of display for the screen keyboard and move the position on the screen.

- Numerical screen keyboard

- Alphanumerical screen keyboard
The alphanumerical screen keyboard has the following levels.
- Normal level
- Shift level
  The shift level includes uppercase letters.
- Special character level

**Note**
The ' character (button between ";" and "\") appears only when followed by a space. If the ' character is followed by a letter, then the result will be an accent, such as "á".

- Reduced screen keyboard

**Procedure for moving the screen keyboard**
Proceed as follows:
1. Touch the icon.
2. Without lifting your finger, move the screen keyboard on the touch screen.
3. When the desired position is reached, release the icon.

**Procedure for adjusting the size of the screen keyboard**

**Note**
The icon only appears on the screen keyboard if in the "Siemens HMI InputPanel" dialog you have selected the "Show Resize button" check box.

Proceed as follows:
1. Touch the icon.
2. To adjust the size of the screen keyboard, maintain contact.
3. When the size you want is reached, release contact with the icon.
Changing the display of the screen keyboard

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Switching between the numerical and alphanumerical keyboard</td>
</tr>
<tr>
<td></td>
<td>Switching between the normal level and Shift level of the alphanumerical screen keyboard</td>
</tr>
<tr>
<td>Alt Gr</td>
<td>Switchover to special characters</td>
</tr>
<tr>
<td></td>
<td>Switching from full display to reduced display</td>
</tr>
<tr>
<td></td>
<td>Switching from reduced display to full display</td>
</tr>
<tr>
<td></td>
<td>Closing of reduced display of the screen keyboard</td>
</tr>
</tbody>
</table>

Entering data

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Delete character left of cursor</td>
</tr>
<tr>
<td></td>
<td>Delete character right of cursor</td>
</tr>
<tr>
<td></td>
<td>Confirm input</td>
</tr>
<tr>
<td></td>
<td>Cancel input</td>
</tr>
</tbody>
</table>

Opening the Windows CE taskbar

You open the Windows CE taskbar with the key.
6.4.5 Configuring operation

6.4.5.1 Configuring the screen keyboard
You can use this function to change the layout and the position of the screen keyboard.

Requirement
You have opened the "Siemens HMI Input Panel - Options" dialog with the "InputPanel" icon.

![Input Panel Options Dialog]

1. Check box for displaying the button in the screen keyboard
2. Button for displaying the screen keyboard
3. Button for saving the screen keyboard settings

Procedure
Proceed as follows:
1. If you want to change the size of the screen keyboard, select the "Show Resize Button" check box.
   The button is displayed in the screen keyboard you want to open.
2. If you want to prevent the size of the screen keyboard from being changed, clear the "Show Resize Button" check box.
   The button is removed from the screen keyboard you want to open.
3. You can use the "Open Input Panel" button to open the screen keyboard.
4. If you want to switch between the numeric and alphanumeric screen keyboard, press the key.
5. If you want to change the position of the screen keyboard, use the mouse pointer to select a free space between the keys.
   Release the mouse pointer when the required position has been reached.
6. If you want to increase or decrease the size of the keyboard screen, place the mouse pointer over the button.
7. Change the size of the screen keyboard by dragging it with the mouse pointer.
8. Release the mouse pointer when the required size has been reached.
9. If you want to save the settings, press "Save".
10. Confirm your entries.
   The dialog closes. The screen keyboard settings have been modified.

6.4.5.2 Changing display brightness
You can use this function to change the brightness of the display.

Requirement
You have opened the "Display" tab in the "OP Properties" dialog using the "OP" icon.

![Image of OP Properties dialog]

Procedure
Proceed as follows:
1. If you want to increase the brightness, press the "UP" button.
   The brightness changes in steps each time you press the key.
2. If you want to decrease the brightness, press the "DOWN" button.
3. Confirm your entries.
   The dialog closes.

Result
The brightness of the display has been changed.
6.4.5.3 Setting the character repeat rate of the screen keyboard

You can use this function to set the character repeat and associated delay for the screen keyboard.

Requirement

You have opened the "Keyboard Properties" dialog using the "Keyboard" icon.

Procedure

Proceed as follows:

1. If you want to enable character repetition, select the "Enable character repeat" check box.
2. If you want to change the delay, press a button or the slider in the "Repeat delay" group.
   Moving the slider to the right will shorten the delay. Moving to the left will extend the delay.
3. If you want to change the repeat rate, press a button or the slider in the "Repeat rate" group.
   Moving the slider to the right will accelerate the repeat rate. Moving to the left will slow down the repeat rate.
4. Check the settings for the touch control by touching the test field.
   The screen keyboard is displayed.
5. Move the screen keyboard as needed.
6. Press an alphanumeric key and keep it pressed down.
   Check the implementation of the character repetition and the rate of the character repetition in the test box.
7. If the settings are not perfect, correct them.
8. Confirm your entries.
   The dialog closes. The character repetition and delay are set.
6.4.5.4 Setting the double-click

You start applications in the Control Panel and in Windows CE with a double-click. A double-click corresponds to two brief touches.

In the "Mouse Properties" dialog, make the following adjustments for operation with the touch screen or external mouse:

- Interval between two touch contacts on the touch screen
- Interval between the two clicks of a double-click

Requirement

You have opened the "Mouse Properties" dialog using the "Mouse" icon.

Procedure

Proceed as follows:

1. Double-click the pattern.

   After the double-click the grid is shown in inverse colors. White boxes become gray. The timeframe for the double-click is saved.

2. Check the double-click.

   Press on the icon twice in succession to do this. If the double-click is recognized, the icon is displayed as follows:

3. If the settings are not perfect, correct them.

   To do this, repeat steps 1 and 2.

4. Confirm your entries.

   The dialog closes. The double-click adjustment is completed.
6.4.5.5 Calibrating the touch screen

Depending on the mounting position and viewing angle, parallax may occur on the touch screen. To prevent any resulting operating errors, you may need to calibrate the touch screen during the startup phase or during runtime.

Requirement

You have opened the “Touch” tab of the "OP Properties" dialog using the "OP" icon.

![Image of OP Properties dialog]

Procedure

Proceed as follows:

1. Press "Recalibrate".

   The following dialog appears:

   ![Calibration instructions]

2. Briefly touch the center of the calibration crosshairs.

   The calibration crosshairs are then displayed at four more positions. Briefly touch the middle of the calibration crosshairs for each position.
Once you have touched all the positions of the calibration crosshairs, the following dialog appears:

```
New calibration settings have been measured.
Tape the screen to register saved data.
Wait for 30 seconds to cancel saved data and keep the current setting.
```

Time limit: 30 sec

3. Touch the touch screen.
   The calibration is saved. The "Touch" tab is displayed once again in the "OP Properties" dialog. If you do not touch the touch screen within the time shown, your original setting will be retained.

4. Close the dialog.
   The touch screen of the HMI device is calibrated.

6.4.5.6 **Starting the HMI device again**

You need to start the HMI device again in the following situations:

- **You have enabled or disabled the PROFINET IO direct keys** – see section "Enabling PROFINET IO (Page 143)".

- **You have changed the time zone and activated daylight saving time** – see section "Setting the date and time (Page 127)".

- **You have enabled the screen saver again** – see section "Setting the screen saver (Page 137)".

**Note**

All volatile data are lost when the HMI device is started again. Check the following:

- The project on the HMI device is complete.
- No data is being written to the flash memory.
Configuring the HMI device

6.4 Control Panel

Requirement

- You have opened the "Device" tab in the "OP Properties" dialog using the "OP" icon.

<table>
<thead>
<tr>
<th>OP Properties</th>
<th>Ok</th>
<th>X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persistent Storage</td>
<td>Display</td>
<td>Device</td>
</tr>
<tr>
<td>Devices: Mobile Panel 277 IWLAN V2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Version: V01.00.00.00_01.04</td>
<td></td>
<td></td>
</tr>
<tr>
<td>bootloader Version: 0.97</td>
<td></td>
<td></td>
</tr>
<tr>
<td>bootloader Date: 18.08.2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flashsize: 64 MB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAC-Address: 08-00-06-29-d8-bd</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reboot</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- If you want to restore the factory setting:
  The HMI device is connected to a configuration PC via PROFINET.

Procedure

Proceed as follows:

1. If you want to restart the HMI device, press "Reboot".
   The following message is displayed:

   - If you run this function, all data which has not been backed up will be lost. Close all applications before you restart the device. Press the "Prepare for Reset" button to load the operating system and factory settings.

   - Button for restart

   - Button for restoring factory settings and for restart

   2. Press one of the buttons.
      - If you want to restart the HMI device, press "Reboot".
        The HMI device starts immediately.
      - To restore the HMI device to factory settings and then restart it, press "Prepare for Reset".
        You are given the option of restoring the factory settings on the HMI device using ProSave. The HMI device then restarts.
      - If you do not want to restart the HMI device, press "No".
        The message closes. There will be no restart.
6.5 Entering and deleting a password

You can use this function to set and remove password protection. The password protection includes access to the following objects:

- Control Panel
- Windows CE taskbar
- Desktop icons

Requirements

You have opened the "Password Properties" dialog using the "Password" icon.

![Password Properties dialog]

**NOTICE**

**Keeping the password**

If the password is no longer available, you have no access to the Control Panel and the Windows CE taskbar.

Backup password to protect it against loss.

Procedure for configuring a password

**Note**

The following characters are prohibited in passwords:

- Blank
- The two special characters ' "

Proceed as follows:

1. Enter a password in the "Password" text box.
2. Repeat the password entry in the "Confirm password" text box.
3. Confirm your entries.
   - The dialog closes.
Result
You cannot open the Control Panel, Windows CE taskbar, and desktop icons without entering a password.
SecureMode is enabled.

Procedure for removing a password
Proceed as follows:
1. Delete the information in the "Password" and "Confirm password" text boxes.
2. Confirm your deletions.
   The dialog closes.

Result
Password protection is cancelled. You can access the Control Panel, Windows CE taskbar, and desktop icons.
SecureMode is disabled.

6.6 WLAN communication

6.6.1 Overview
Similar to an access point, you configure the WLAN parameters of the HMI device in Web Based Management. You have the following options for configuration:

- Using wizards to set the parameters for WLAN communication.
- Advanced settings for all parameters of the "System", "Interfaces", "Security" and "I-Features" menus.

Note
Due to the different approvals (Certificate of Broadcasting and Communication Equipment) issued for the USA and other regions, Siemens provides two versions of the HMI device.

The following chapters describe:

- How to set up WLAN parameter using wizards
- Setup of the iPCF-MC parameters for Rapid Roaming in the "I-Features" menu of Web Based Management.

**Note**

Set the parameters for all access points that communicate with the HMI device before you begin configuration of the WLAN connection of the HMI device.

### Buttons in Web Based Management

The following buttons are provided in Web Based Management of the HMI device to facilitate data input:

- **Browser buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function in Web Based Management</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="One page back" /></td>
<td>One page back</td>
</tr>
<tr>
<td><img src="image" alt="One page forward" /></td>
<td>One page forward</td>
</tr>
<tr>
<td><img src="image" alt="Stop loading page" /></td>
<td>Stop loading page</td>
</tr>
<tr>
<td><img src="image" alt="Refresh page" /></td>
<td>Refresh page</td>
</tr>
<tr>
<td><img src="image" alt="Go to home page" /></td>
<td>Go to home page</td>
</tr>
<tr>
<td><img src="image" alt="Open Online Help" /></td>
<td>Open Online Help</td>
</tr>
<tr>
<td><img src="image" alt="Open screen keyboard for data input" /></td>
<td>Open screen keyboard for data input</td>
</tr>
<tr>
<td><img src="image" alt="Close Web Based Management" /></td>
<td>Close Web Based Management</td>
</tr>
</tbody>
</table>

- **Buttons to display and hide the menu tree**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Hiding the menu tree" /></td>
<td>Hiding the menu tree</td>
</tr>
<tr>
<td><img src="image" alt="Displaying the menu tree" /></td>
<td>Displaying the menu tree</td>
</tr>
</tbody>
</table>

When you start one of the wizards in the menu tree, the menu tree will automatically be minimized.
6.6 WLAN communication

Requirements

You have opened the "Authorization" dialog using the "WLAN Settings" icon.

![Authorization dialog](image)

Procedure

Proceed as follows:

1. Select the "Admin" entry from the "User name" selection list.
   - If you select the "User" entry, you only have read access to the configuration data of the WLAN device.
   - Enter your password. If no password is set, the default passwords of the factory state will be in effect:
     - If you have selected "Admin", enter "admin".
     - If you have selected "User", enter "user".

2. Press "Log On".
   - Logon starts.

Note

The password for the "admin" user is different for the U.S. version of the WLAN device. You can obtain the required password from the Siemens support personnel.
3. After initial logon as "Admin", change the password for the administrator under "System > Passwords".

The password may consist of up to 31 characters. The ASCII code 0x20 to 0x7e is used for creating passwords.

The following characters are supported:
- Numbers 0 to 9
- Letters abcedfghijklmnopqrstuvwxyz ABCDEFGHIJKLMNOPQRSTUVWXYZ
- The special characters !$%^&\()\*+.\-;<>?:@[\]^_`{|}~
- The space character

4. Apply the settings with the "Set Value" button.

Result

You can set the WLAN parameters using the wizards and the iPCF-MC parameters for Rapid Roaming in the "I-Features" menu of Web Based Management.
6.6.2 Assigning WLAN communication parameters

In the following steps, you are shown how to assign the parameters for WLAN communication between the HMI device and access point.

Requirement

You are logged on to the "Authorization" dialog.

Procedure

Proceed as follows:

1. Select "Wizards > Basic".

2. Select the country in which you are operating the HMI device from the "Country code" drop-down list box.

The corresponding channel allocation and setting for power level is automatic.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country code</td>
</tr>
<tr>
<td>The country setting is required for operation complying with the approvals. Selecting a country that does not match the country in which the HMI device is operated may be punishable by law.</td>
</tr>
</tbody>
</table>

Select the country in which you are operating the HMI device from "Country code". The approvals for the HMI device are listed on the rear panel and in the product information for "Mobile Panel 277 IWLAN V2, Mobile Panel 277F IWLAN V2, Mobile Panel 277F IWLAN (RFID Tag)" in Total documentation Mobile Panels 277 Wireless (http://support.automation.siemens.com/WW/view/en/26268960/133300).
3. Press the "Next" button.
   
   Another dialog is displayed.
   
   - "Connect to any SSID" check box
     
     If this box is checked, the HMI device connects to the access point which provides the best possible data transfer and to which a connection is permitted based on the security settings specified under "Security".
   
   - "SSID" text box
     
     Enter the name of the network in this text box. The network name must match the network name that is entered in the configuration of access points, with which the HMI device communicates.

   **Note**
   
   The HMI device allows the use of all characters except the percent sign for the SSID. For reasons of compatibility, do not use language-specific characters such as German umlauts or special characters. The character string for the SSID may not contain more than 32 characters.

   - Selection list "Wireless mode"
     
     Use the transfer procedure, which is set in the configuration of access points, with which the HMI device communicates.

4. Press the "Next" button.
   
   Another dialog is displayed.
   
   - "Outdoor Client mode" check box
     
     You can use the HMI device to operate in either indoor or outdoor mode. In indoor mode, all nationally approved channels and power levels for operation in a building are available. In outdoor mode, the selection of country-specific channels and power levels for operation outdoors is restricted.
     
     Select the "Outdoor Client mode" check box if you want to operate the HMI device outdoors.

5. Press the "Next" button.
   
   Another dialog is displayed.

6. Press "Finish".
   
   The settings in the "Basic" Wizard are saved.
7. Select "Wizards > Security".

8. Enter your password.
   If you prefer not to change the "Admin Password" password, press "Next".

9. Press the "Next" button.

The Security Wizard enables you to set security-related parameters without detailed knowledge of security technologies in wireless networks.
6.6 WLAN communication

**Note**

The HMI device can be operated without configuration of security-related parameters. Depending on the properties of your network, this will increase the risk of unauthorized access. Therefore, go through every page of the Security Wizard to enable the basic security features.

In the "Security" Wizard, apply the following settings from the configuration of access points, with which the HMI device communicates.

- Select the security level for the WLAN from the "Security level" selection list.
  

- Select the encryption method from the "Cipher" selection list.
  
  The encryption protects the data to be transferred from interception and manipulation. You can disable encryption in the "Encryption" option box only if you have selected "Open System" for authentication in the "Basic WLAN" menu. All other security procedures include both authentication and encryption.

10. Press the "Next" button.

   Another dialog is displayed.

   If you have selected a security level that requires a key, specify the initialization key in the "Pass phrase" text box.

11. Press the "Next" button.

   Another dialog is displayed.

12. Press the "Finish" button.

   The settings in the "Security" Wizard are saved.
13. Select "System > Restart".

You can use the "Restart WLAN interface to apply changes" link for quick navigation to this menu command.

14. Press "Restart WLAN".

The restart of the WLAN interface is performed.

**Note**

The "Restore Factory Defaults and Restart WLAN" button resets all parameters of the WLAN interface to their factory state. The WLAN interface is then restarted.

15. Press the "Exit" button.

Web Based Management will be closed.

**Result**

The WLAN connection was configured. A WLAN connection can be set up successfully if the configuration of the access points and wireless HMI device is consistent.

The MAC address of the HMI device is entered in the access point at the "Information > WLAN > Client List" menu command.
Assigning iPCF-MC parameters

In the following step, you are shown how to assign the iPCF-MC parameters for Rapid Roaming in the "I-Features" menu of Web Based Management.

iPCF was developed to achieve fast handover times when moving between radio cells. However, iPCF achieves optimum performance only with RCoax cables. The iPCF-MC procedure enables short handover times even when mobile clients, numerous cells, or a large number of channels are in use.

Note
iPCF and iPCF-MC are incompatible and cannot be used simultaneously for an HMI device.

Requirement
You are logged on to the "Authorization" dialog.

Procedure
Proceed as follows:
1. Select "I-Features > iPCF-MC".
2. Make the following settings:

- Select the "iPCF-MC enabled" check box.
- Select the "Strong AES-CCM" check box if you want to use "Strong AES-CCM" encryption.
  
  The AES-CCM encryption method is only possible in iPCF mode. Make sure that a 128-bit WEP key is defined with the "Security > Keys" menu command. After you have selected the "Strong AES-CCM encryption" check box, the display changes to "128 bit AES" in the "Security > Keys" menu command. The device uses AES-CCM.
- Enter a value for "Background scan interval".
  
  This parameter determines the time between two background scans of the HMI device. Data is entered in iPCF cycles.

  If you select two, for example, then the client performs a background scan only at every second iPCF cycle. A small value for the background scan interval is the basis for fast roaming. However, high throughput cannot be achieved with this setting. A high value should be selected for higher data throughput.

**NOTICE**

**Access point in "iPCF-MC" mode**

If the access point was operated in "iPCF-MC" mode while "iPCF-MC" was disabled, select the "Interfaces > WLAN > Advanced" menu and check the "Background scan mode" setting. If the "Scan always" entry is enabled, PROFINET communication can be interrupted.

Select the "Scan if idle" entry.

3. Press the "Set Values" button.

   The parameters will be applied.
4. Select "System > Restart".

You can use the "Restart WLAN interface to apply changes" link for quick navigation to this menu command.

5. Press the "Restart WLAN" button.

The WLAN interface is restarted.

**Note**

The "Restore Factory Defaults and Restart WLAN" button resets all parameters of the WLAN interface to their factory state. The WLAN interface is then restarted.

6. Press the "Exit" button.

Web Based Management is closed.

**Result**

You have configured the WLAN connection parameters. A WLAN connection can be set up successfully if the configuration of the access points and wireless HMI device is consistent.

The MAC address of the HMI device is entered in the access point at the "Information > WLAN > Client List" menu command.
6.7 General settings

6.7.1 Setting the date and time

You can use this function to set the date and time. The HMI device has an internal buffered clock.

Requirement

You have opened the "Date/Time Properties" dialog using the "Date/Time Properties" icon.

![Diagram of Date/Time Properties dialog]

1. Date selection box
2. Text box for the time
3. Time zone selection box
4. Check box used to activate daylight saving time
5. Button for applying changes

Procedure

Proceed as follows:
1. Select the applicable time zone for the HMI device from the "Time Zone" selection box.
2. Press "Apply".
   The time of day shown in the "Current Time" box is adjusted correspondingly to the selected time zone.
3. Set the date in the selection box.
4. Set the current time of day in the "Current Time" text box.
5. Press "Apply".
   The entry is made.

Note

The system does not automatically switch between standard time and daylight saving time.
6. If you want to switch from winter to summer time, select the "Daylight savings time currently in effect" check box.
   When you press the "Apply" button, the time is brought forward by one hour.

7. If you want to switch from summer to winter time, clear the "Daylight savings time currently in effect" check box.
   When you press the "Apply" button, the time is moved backwards by one hour.

8. Confirm your entries.
   The dialog closes.

Result

The settings for the data and time of day have now been changed.

The HMI device must be restarted after changes in the following cases:

- You have changed the time zone setting
- You have changed the "Daylight savings time currently in effect" check box setting

See section "Starting the HMI device again" (Page 112).

Synchronizing the date and time with the PLC

The date and time of the HMI device can be synchronized with the PLC if this has been configured in the project and the PLC program.

You can find additional information in the "WinCC flexible" system manual.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synchronizing the date and time</strong></td>
</tr>
<tr>
<td>If the data and time is not synchronized and time-based reactions are triggered by the HMI device, malfunctions in the PLC may occur.</td>
</tr>
<tr>
<td>Synchronize the date and time if time-based reactions are triggered in the PLC.</td>
</tr>
</tbody>
</table>

6.7.2 Backing up registry information and temporary data

You can install and remove your own programs on the HMI devices under Windows CE. You need to back up the registry settings to flash memory after installation or removal.

You can also save the data in the memory buffer to flash memory.
You have opened the "Persistent Storage" tab in the "OP Properties" dialog using the "OP" icon.

### Requirement

- **1.** Backs up the current registry information to the flash memory. The HMI device loads the saved registry information the next time it boots.
- **2.** Button for saving registry information
- **3.** Button for saving temporary files
- **4.** Backs up all the files in temporary storage to the flash memory (for example, from the "Program Files" directory). These files are written back when the HMI device is started. The "Temp" directory is not saved.
- **5.** Automatically repairs the file system errors on the memory card when the HMI device starts up and when a memory card is inserted.

### Procedure

Proceed as follows:

1. If you want the file system errors to be repaired automatically, select the "Automatically repair file system errors ..." check box.
   - If the check box is cleared, the file system will only be repaired after prompting.
2. Click the necessary buttons.
3. Confirm your entries.
   - The dialog closes.

### Result

At the next startup, the HMI device will use the registry entries and temporary files and the specifications they contain.
6.7.3 Displaying information about the HMI device

You can use this function to display device-specific information. You will need this information if you contact Technical Support (http://support.automation.siemens.com/WW/view/en/4000024).

Requirement

You have opened the "Device" tab in the "OP Properties" dialog using the "OP" icon.

<table>
<thead>
<tr>
<th>OP Properties</th>
<th>OK</th>
<th>X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device:</td>
<td>Mobile Panel 277 IWLAN V2</td>
<td>①</td>
</tr>
<tr>
<td>Image Version:</td>
<td>V01.00.00.00_01.34</td>
<td>②</td>
</tr>
<tr>
<td>Bootloader Version:</td>
<td>0.97</td>
<td>③</td>
</tr>
<tr>
<td>Bootloader Release Date:</td>
<td>10.8.2010</td>
<td>④</td>
</tr>
<tr>
<td>Hasbeze:</td>
<td>64 MB</td>
<td>⑤</td>
</tr>
<tr>
<td>MAC Address:</td>
<td>00:00:00:29:db:bc</td>
<td>⑥</td>
</tr>
</tbody>
</table>

① HMI device name  
② Version of the HMI device image  
③ Version of the boot loader  
④ Boot loader release date  
⑤ Size of the internal flash memory in which the HMI device image and project are stored  
⑥ MAC address of the HMI device  
⑦ See chapter "Starting the HMI device again (Page 112)."

Note

The size of the internal flash memory does not correspond to the available working memory for a project.
6.7.4 Display firmware

You can use this function to obtain information about the firmware used on the HMI device.

**Requirement**

You have opened the "Firmware" tab in the "OP Properties" dialog using the "OP" icon.

- Firmware for the WLAN module
- Firmware for the effective range module

6.7.5 Display the charging status and temperature of the rechargeable battery

You can use this function to view the charging status and temperature of the main battery.

**Requirements**

- The main battery is installed.
- You have opened the "Battery" tab in the "OP Properties" dialog using the "OP" icon.

**Procedure**

If you want to refresh the display, press the "Update" button.
6.7 General settings

6.7.6 Selecting transponders

This chapter applies to the transponder system.

Use the "Transponder" dialog to specify the channel, i.e. frequency band, that the HMI device uses to communicate with the transponder.

Requirement

You opened the "OP Properties" dialog, "Transponder" tab using the "OP" icon.

Procedure

Proceed as follows:

1. Select the required WLAN channel from the list.
   You can select the following:
   - Auto (all channels)
     Based on the frequency hopping method, the WLAN is scanned for an unused frequency range in the 2.4 GHz band. A free channel is selected automatically.
   - List of several frequency ranges in the 2.4 GHz band.
     You can select a discrete frequency range from the list. In this case, you and not the HMI device specify the channel to be used.

2. Confirm with "OK".
   Your entry is saved and the dialog is closed.

Result

You have completed the configuration of the frequency range for the HMI device – transponder communication.
6.7.7 Activate memory management

If memory management is activated, the HMI device will automatically close the project if the memory needs reorganizing during the active project.

If the project is closed due to this setting, then a message will be displayed on the HMI device. You have to start the project again.

NOTICE

Memory management

If you do not activate memory management, malfunctions can occur during the runtime of the project.

Select memory management in the "OP Properties" dialog.

Requirement

You have opened the "Memory Monitoring" tab in the "OP Properties" dialog using the "OP" icon.

![OP Properties dialog](image)

1. Percent of maximum memory used since the last startup of the HMI device
2. Percentage of memory currently used
3. Check box for selecting memory management

Procedure

Proceed as follows:

1. If you want to enable memory management, then select the check box.
2. Confirm your entries.
   The dialog closes.

Result

Memory management is activated.
6.7.8 Activating vibration alarm

Introduction

You can activate a vibration alarm for the HMI device. The vibration alarm will be triggered in the current project under the following circumstances:

- The charge status of the main battery is low.
- The signal strength in the WLAN drops below 60%.

Requirement

You have opened the dialog "OP Properties", dialog box "Vibration Alarm" tab by touching the "OP" icon.

Procedure

Proceed as follows:

1. Select the "Enable Vibration Alarm" check box.
2. Confirm your entries.
   - The dialog closes.

Result

The vibration alarm is activated.
6.7.9 Changing the printer properties

Introduction
The HMI device can print on local printers or network printers. You can print hardcopies and reports on a network printer. Line printing of alarms is not possible on a network printer.

The list of current printers and required settings for HMI devices can be found on the Internet under "http://support.automation.siemens.com/WW/view/en/11376409".

Requirements
You have opened the "Printer Properties" dialog with the "Printer" icon.

![Printer Properties dialog]

---

1. Selection list for the printer
2. Selection list for the interface
3. Network address of the printer
4. Paper format selection list
5. "Orientation" group with radio buttons for print orientation
6. Check box to improve the color quality (only for Brother HL 2700 printers)
7. Color printing check box
8. Print quality check box

Procedure
Proceed as follows:
1. Select a printer from the "Printer Language" selection list.
2. Select the port for the printer from the "Port" selection list.
3. If you wish to print via the network, enter the printer's network address in the "Network" text box.
4. Select a paper format in the "Paper Size" selection list.
5. Activate a radio button in the "Orientation" group.
   - "Portrait" for portrait
   - "Landscape" for landscape

6. Select the print quality.
   - Select the "Draft Mode" check box if you wish to print in draft mode.
   - Deactivate the "Draft Mode" check box if you wish to print with higher quality.

7. If the printer selected can print in color and you wish it to do so, select the "Color" check box.

8. If you use the Brother HL 2700 printer model, enable the "CMY" check box. In this way you can increase the color quality when printing.

9. Confirm your entries.
   The dialog closes.

Result
The settings for the printer have now been changed.

6.7.10 Regional and language settings
Information such as the date, time and decimal points are displayed differently in different countries. You can adapt the display format to meet the requirements of various regions.

The country-specific settings apply to the current project. If the project language is changed, the country-specific settings are also changed.

Requirement
You have opened the "Regional Settings" tab in the "Regional and Language Settings" dialog box using the "Regional Settings" icon.
Procedure

Proceed as follows:

1. Select the region from the selection box ①.

2. Navigate to the "Number", "Currency", "Time" and "Date" tabs one after the other.

3. Set the required regional settings in the selection field of these tabs.

4. Confirm your entries.

   The dialog closes.

Result

The required regional settings for the HMI device have been changed.

6.7.11  Setting the screen saver

Power management settings in the WinCC flexible project

To save power, the HMI device has a power management function with the following states:

- "Reduced brightness"
- "Screen off"

The relevant time intervals are set in the WinCC flexible project. Power management is automatically activated if the HMI device is not operated within the specified period of time.

Touch the touch screen to disable the "reduced brightness" operating state.

To clear the "screen off" operating state, briefly press the ON/OFF key.

Settings in the Control Panel

In addition to the settings in the WinCC flexible project, you can set the following time periods in the Control Panel:

- For the automatic activation of the screen saver
- For the automatic reduction in the display's backlighting.

The screen saver and backlighting are automatically activated if the display is not touched within the specified period of time.

The screen saver switches off with the following events:

- By touching the touch screen
The reduction of the backlighting is also canceled. The function assigned to the button is not triggered in this case.

**NOTICE**

**Reducing backlighting**
The brightness of the backlighting decreases incrementally during its operational life. You can activate backlighting reduction to not shorten the service life of the backlighting unnecessarily.

**Activating the screen saver**
The display contents that do not change for long periods can remain dimly visible in the background. This effect is reversible, however.

Activate the screen saver. When the screen saver is active, the backlighting is also reduced.

**Requirements**

You have opened the "Screensaver" dialog using the "ScreenSaver" icon.

![Screensaver dialog]

1. Time interval in minutes until backlighting is reduced
2. Period of time in minutes before the screen saver is activated
3. Option buttons for the screensaver

**Procedure**

Proceed as follows:

1. Enter the interval in minutes after which the backlighting is to be reduced.
   The minimum to maximum time is 5 minutes to 71582 minutes.

**Note**

A time setting in the Control Panel for activating the "Reduced brightness" operating state only takes effect if the setting in it is shorter than the time specified in the project for the "Reduced brightness" mode.

The value "0" in the Control Panel means:

- An activation period specified in the project for the "Reduced brightness" mode will be applied.
- If no activation period is specified in the project for the "Reduced brightness" mode, then reduction of the backlighting will be disabled. With external power supply backlighting will be dimmed after two minutes.
2. Enter a time in minutes when the screen saver will be activated.
   The minimum to maximum time is 5 minutes to 71582 minutes.
   Entering "0" disables the screen saver.
3. Select the type of screen saver:
   – Use the "Standard" option to enable the Windows CE default screen saver.
   – Use the "Blank Screen" option to enable an empty screen as the screen saver.
4. Confirm your entries.
   The dialog closes.

Result

The screen saver and the reduced backlighting for the HMI device is set. You need to restart
the HMI device after you have reset the screen saver. The selection of the screen saver
takes effect following a restart.

6.7.12 Displaying general system properties

Use this function to display the general system information relating to the operating system,
processor and memory.

Requirement

You have opened the "General" tab in the "System Properties" dialog box using the "System"
icon.

![System Properties]

① Information on the version and copyright of Microsoft Windows CE
② Details on processor and size of internal Flash memory

The displayed data relates to the specific device. The information ② may therefore deviate
from this HMI device.
6.7.13 Displaying memory distribution

You can use this function to display the allocation and thereby the size of the individual memory areas on the HMI device.

**Requirement**

You have opened the "Memory" tab in the "System Properties" dialog using the "System" icon.

![System Properties](image)

1. Cache memory, available and used
2. RAM, available and used

**NOTICE**

Malfunction possible

If you change the allocation of the memory, malfunctions may occur.

Do not change the memory allocation in the "Memory" tab.

When using WinCC flexible options, a change to the memory allocation can be required. For additional information, refer to the online help of WinCC flexible.
6.7.14 Setting the location of the project

There are various storage locations available for storing the compressed source file of your project. The following describes how you can set the storage location.

Requirement

You have opened the "Directories" tab in the "Transfer Settings" dialog box using the "Transfer" icon.

![Transfer Settings dialog box]

① Directory where the project file is saved
② Directory where the compressed source file of your project is saved
③ Storage location and initialization file of the HMI device for process operation

**NOTICE**

Project does not start

If you change the entry in the "Project File" and "Path" text boxes, the project may not open the next time the HMI device starts.

Do not change the entries in the "Project File" and "Path" text boxes.

Procedure

Proceed as follows:

1. Select a memory location from the "Project Backup" text box.
   
   The storage location can be a memory card or a location in the local network. During the next backup process, the project's source file is stored in the specified location.

2. Confirm your entries.
   
   The dialog closes.

Result

The storage location for the HMI device is now set.
6.7.15 Setting the delay time for the project

You can use this function to set a delay time. The delay time determines how long the loader appears after the HMI device starts and before the project opens.

Requirement

You have opened the "Directories" tab in the "Transfer Settings" dialog box using the "Transfer" icon.

![Transfer Settings Dialog Box]

NOTICE

Project does not start

If you change the entry in the "Project File" and "Path" text boxes, the project may not open the next time the HMI device starts.

Do not change the entries in the "Project File" and "Path" text boxes.

Procedure

Proceed as follows:

1. Select the desired delay time in seconds from the "Wait [sec]" selection box.
   
   The project starts immediately with the value "0".

   Note
   
   To launch the Loader after the project opens, an operator control must be configured in the project with the "Close project" function.

2. Confirm your entries.
   
   The dialog closes.

Result

The delay time for the HMI device is now set.
6.8 Enabling PROFINET IO

The HMI device communicates with the PLC via Ethernet. PROFINET IO must be enabled so that you can use the following functions:

- Use of PROFINET IO direct keys

Requirement

You have opened the "PROFINET" dialog using the "PROFINET" icon.

Procedure

Proceed as follows:

1. Select the "PROFINET IO enabled" check box.

2. Enter the device name of the HMI device.
   The device name must be unique and satisfy the DNS conventions within the local network. These include:
   - Restriction to 127 characters in total (letters, digits, hyphen or point)
   - A name component within the device name, e.g. a string between two points, may not exceed 63 characters.
   - Special characters such as umlauts, brackets, underscores, slashes, spaces etc. are not permitted. The hyphen is the one exception.
   - The device name must not start or end with the "-" character.
   - The device name must not take the form n.n.n.n (n = 0 to 999).
   - The device name must not start with the character string "port-xyz-" (x, y, z = 0 to 9).

3. Confirm your entries.
   The dialog closes.

4. Restart the HMI device – see section "Starting the HMI device again" (Page 112).

Result

PROFINET IO is enabled.
6.9 Programming the data channel

You can use this function to configure the transfer mode. A project can only be transferred from the configuration PC to the HMI device when at least one data channel is configured and enabled on the HMI device.

If you block all data channels, the HMI device is protected against unintentional overwriting of the project data and HMI device image.

Requirements

The "Channel" tab in the "Transfer Settings" dialog has been opened with the "Transfer Settings" icon.

Procedure

Proceed as follows:
1. Select the "Enable Channel" check box in the "Channel 2" group to enable the data channel.
2. Select the interface for the data channel from the selection list.
3. Enter further parameters if required.
   - Applies to "ETHERNET":
     You can use the "Advanced" button to open the settings for addressing the HMI device. You can find the required information in the section "Specifying the IP address and name server (Page 148)".
   - Applies to "USB":
     No information is needed for "USB".

4. Confirm your entries.
   The dialog closes.

**Result**

The data channel is configured.

**6.10 Configuring network operation**

**6.10.1 Overview**

You can use this function to configure the HMI device for data communication in a PROFINET network via the Ethernet port.

**Note**

The HMI device can only be used in PROFINET networks.

The HMI device has client functionality in the local network. This means that users can access files of a node with TCP/IP server functionality from the HMI device via the local network. However, you cannot access data on the HMI device from a PC via the local network, for example.


The connection to a local network offers the following options, for example:

- Exporting or importing of recipe data records on or from a server
- Storing alarm and data logs
- Transferring a project
- Printing via the local network
- Backing up data
Addressing computers

Computers are usually addressed using computer names within a PROFINET network. These computer names are translated from a DNS or WINS server to TCP/IP addresses. This is why a DNS or WINS server is needed for addressing via computer names when the HMI device is in a PROFINET network.

The corresponding servers are generally available in PROFINET networks.

Note

The use of TCP/IP addresses to address PCs is not supported by the operating system. Contact your network administrator for more information.

Determine the following parameters:

• Does the local network use DHCP for dynamic assignment of addresses?
  If not, get a TCP/IP address for the HMI device.

• Which TCP/IP address does the default gateway have?

• If a DNS network is used, what is the address of the name server?

• If a WINS network is used, what is the address of the name server?

Configuration includes:

• Specifying the computer name of the HMI device

• Specifying the IP address and name server

• Specifying the logon data

• Configuring e-mail

The configuration work is described in the following sections.
6.10.2 Specifying the computer name of the HMI device

You can use this function to assign a computer name to the HMI device. The computer name is used to identify the HMI device in the local network.

Requirement

You have opened the "Device Name" tab in the "System Properties" dialog box using the "System" icon.

![System Properties Dialog Box](image)

1. Computer name of the HMI device
2. Description for the HMI device (optional)

**NOTICE**

Computer name must be unique

Communication errors may occur in the local network if you assign a computer name more than once.

Enter a unique computer name in the "Device name" text box.

Procedure

Proceed as follows:

1. Enter the computer name for the HMI device in the "Device name" text box.
   Enter the name without spaces.
2. If necessary, enter a description for the HMI device in the "Device description" text box.
3. Confirm your entries.
   The dialog closes.

Result

The computer name for the HMI device is now set.
6.10.3 Specifying the IP address and name server

You can use this function to make the settings for addressing the HMI device in the local network. Ask your network administrator for the required information.

Requirement

You have opened the following display using the "Network&Dial-Up Connections" icon.

![WLAN Settings dialog](image)

Procedure

Proceed as follows:

1. Press the "WLAN" icon.
   
   The 'WLAN' Settings dialog is displayed.

   ![WLAN Settings dialog](image)

2. If you need automatic address assignment, select the "Obtain an IP address via DHCP" radio button.

3. If you need manual address assignment, select the "Specify an IP address" radio button.

   **NOTICE**

   **IP address must be unique**
   
   An address conflict will occur if more than one device is assigned the same IP address in the local network.
   
   Assign a unique IP address to each HMI device in the local network.

   **Reserved IP addresses**
   
   The following IP addresses are reserved for internal communication with the WLAN module:
   
   - 169.254.2.253
   - 169.254.2.254
   
   Do not use these reserved IP addresses.
4. If you have selected manual address assignment, enter the corresponding addresses in the "IP Address," "Subnet Mask" text boxes and if necessary in "Default Gateway."

5. If a name server is used in the local network, open the "Name Servers" tab.

6. Enter the respective addresses in the text boxes.

7. Confirm your entries.
   The dialog closes.

8. If you want to change the Ethernet parameters, open the "Ethernet Parameters" tab.

   The Control Panel is displayed again.

Result

The address parameters of the HMI device have been set.

6.10.4 Specifying the logon data

Use this function to enter the information for logging on to the local network.
Ask your network administrator for the required information.

Requirement

You have opened the "Network ID" dialog box using the "Network ID" icon.
6.10 Configuring network operation

Procedure

Proceed as follows:
1. Enter your user name in the "User name" text box.
2. Enter your password in the "Password" text box.
3. In the "Domain" input field, enter the name of your assigned domain.
4. Confirm your entries.
   The dialog closes.

Result

The logon data has now been set.

6.10.5 Configuring e-mail

You can use this function to set the SMTP server, sender name and e-mail account for e-mail service. Ask your network administrator for the required information.

Requirement

You have opened the "Email" tab in the "WinCC flexible Internet Settings" dialog using the "WinCC Internet Settings" icon.

![WinCC flexible Internet Settings dialog](image)

1. Setting the SMTP server
2. Name of the sender and e-mail account
3. "Advanced" button for advanced settings

Note

Additional tabs may appear in the "WinCC flexible Internet Settings" dialog. This depends on the options that have been enabled for operating the local network in the project.
Procedure

Proceed as follows:

1. Specify the SMTP server.
   - Select the "Use the default of the project file" option if you want to use the SMTP server configured in the project.
   - Clear the "Use the default of the project file" option if you do not want to use the SMTP server configured in the project. Specify the required SMTP server.

2. Enter the name for the sender in the "Name of sender" text box.
   - The computer name is practical as the sender name – see section "Specifying the computer name of the HMI device (Page 147)".

3. Enter the e-mail account for your e-mail in the "eMail address of sender" text box.
   - Some e-mail providers will only let you send e-mails if you specify the e-mail account. The "eMail address of sender" text box can remain empty if your e-mail provider lets you send e-mails without checking the account.

4. Use the "Advanced" button to open advanced settings for the sending of e-mails via an SMTP server.

   ![Advanced Email Settings]

   - Options for authentication on the SMTP server
   - Encryption options

   Specify an option for authentication on the SMTP server.
   - Select the "Use the default of the project file" option if you want to use authentication data specified in the project.
   - If you use an SMTP server that does not require authentication, select the "Disable authentication" option.
   - Select the "Use panel settings for authentication" option if you want to use the authentication data specified in the settings of the HMI device instead of those in the project.

   Specify the encryption method.
   - Select the "Use the default of the project file" option if you want to use the encryption method specified in the project.
   - Select the "Enable SSL" option if you want to use SSL encryption.
   - Select the "Disable SSL" option if you do not want to use encryption.
5. Apply the advanced settings with the "OK" button.
6. Confirm your entries.
   The dialog closes.

Result
The e-mail settings have been changed.

6.11 Changing internet settings

6.11.1 Changing general settings
You can use this function to set the homepage and search engine page for an Internet connection via the Internet Explorer. Ask your network administrator for the required information.

Requirement
You have opened the "General" tab in the "Internet Options" dialog box using the "Internet Options" icon.

<table>
<thead>
<tr>
<th>Internet Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
</tr>
<tr>
<td>Start Page:</td>
</tr>
<tr>
<td>Search Page:</td>
</tr>
<tr>
<td>User Agent (requires browser restart):</td>
</tr>
<tr>
<td>Cache Size (in KB):</td>
</tr>
</tbody>
</table>

Procedure
Proceed as follows:
1. Enter the homepage for the Internet browser in the "Start Page" text box.
2. Enter the address of the default search engine in the "Search Page" text box.
3. Enter the display format of the Internet pages in the "User Agent" text box.
   The following display formats can be selected:
   – Default (Windows CE)
   – Same as Pocket PC
   – Same as Windows XP

   **Note**
   The "Default (Windows CE)" display format is optimized for Internet pages on a HMI device with the Windows CE operating system. "Default (Windows CE)" is therefore the most suitable.

4. Enter the required amount of cache in the "Cache" text box.
5. If you want to delete the cache, press the "Clear Cache" button.
6. If you want to delete the history, press the "Clear History" button.
7. Confirm your entries.
   The dialog closes.

**Result**
The general parameters for the Internet browser have been set. The settings take effect the next time you start the Internet Explorer.

### 6.11.2 Setting the proxy server

Use this function to configure the type of Internet access. Ask your network administrator for the required information.

**Requirement**
You have opened the "Connection" tab in the "Internet Options" dialog box using the "Internet Options" icon.
Configuring the HMI device

6.11 Changing internet settings

Procedure

Proceed as follows:

1. Select the "Use LAN (no autodial)" check box.
2. If you are using a proxy server, in the "Network" group, select the "Access the Internet using a proxy server" check box.
   Specify the address and port of the proxy server.
3. If you want to bypass the proxy server for local addresses, select the "Bypass proxy server for local addresses" check box.
4. Confirm your entries.
   The dialog closes.

Result

The parameters for the LAN connection have been made.

6.11.3 Changing privacy settings

Cookies contain information sent by a Web server to a browser. The cookie is sent back when the Web server is accessed at a later time. This step involves sending stored information for subsequent access.

Data can be sent encrypted for greater data security on the Internet. Common encryption protocols include SSL and TLS. You can activate or deactivate the usage of encryption protocols.

Ask your network administrator for the required information.

Requirement

You have opened the "Privacy" tab in the "Internet Options" dialog box using the "Internet Options" icon.

![Internet Options dialog box with privacy settings configured]

Mobile Panel 277 IWLAN V2
Operating Instructions, 10/2010, A5E02480233-01
Procedure

Proceed as follows:

1. Select the required cookie behavior by means of the radio buttons.
   - "Accept"
     Cookies are stored without request.
   - "Block"
     Cookies will not be stored.
   - "Prompt"
     Cookies will be stored on request.

2. If you want allow cookies which are restricted to a single session, select the "Always allow session cookies" check box.

3. Change to the "Advanced" tab.

4. Activate the required encryption protocol.

5. Confirm your entries.
   The dialog closes.

Result

The accepted cookies and the required encryption protocol are set.

6.11.4 Importing, displaying and deleting certificates

You can use this function to import, display and delete certificates. The certificates differ as follows:

- Certificates that you trust
- Own certificates
- Other certificates

A digital certificate consists of structured data, which confirms ownership and other properties of a public key. Ask your network administrator about the certificates required for your application.
**Requirement**

You have opened the "Certificates" dialog box with the "Certificates" icon.

![Certificates dialog box](image)

**Procedure**

Proceed as follows:

1. Select the type of certificate from the selection box:
   - "Trusted Authorities" for reliable certificates
   - "My Certificates" for your own certificates
   - "Other Certificates" for other certificates

2. If you want to import a certificate, press the "Import" button.
   A dialog with information about the source opens.
   - Select the required source.
   - Close the dialog.

3. If you want to display the properties of the selected certificate, press the "View" button.
   The following dialog appears:

![Certificate properties dialog box](image)

4. If you want to delete a certificate, first select it.
5. Confirm by pressing the "Remove" button in the "Certificates" dialog.

**Note**
The entry is deleted immediately and without further inquiry.
If you want to again use a deleted certificate, you need to import it again from a storage medium.

6. Confirm your entries.
The dialog closes.

**Result**
The number of saved certificates has changed.

### 6.12 Saving to external storage medium – backup

You can use this function to back up the operating system, applications and data from the internal flash memory of the HMI device to an external storage medium. See section "Displaying information about the HMI device (Page 130)".

The following external storage media can be used:
- Memory card
- USB memory stick

**Requirement**
- Storage medium with sufficient free capacity is inserted in the memory card slot.
  See section "**Inserting a memory card** (Page 64)".
- Data that might be overwritten are saved.
- You have opened the "Backup/Restore" dialog box using the "Backup/Restore" icon.
**Configuring the HMI device**

6.12 **Saving to external storage medium – backup**

**Procedure**

Proceed as follows:

1. Click the "BACKUP" button.
   
   The "Select Storage Card" dialog box is displayed. The "--- no storage card available ---" message appears if there is no memory card in the HMI device or it is defective. Insert a memory card or insert another one.

2. Select the storage medium for backup from the "Please select a Storage Card" list box.

3. Click the "Start Backup" button.
   
   The HMI device checks the storage medium.
   
   If the "This storage card..." message appears, you need a storage medium of greater capacity. Acknowledge this message. Backup is aborted at this point. Insert a storage medium with a greater capacity and restart the backup process.
   
   If the "You may have an old backup on the storage card. Do you want to delete it?" message appears, there is already a backup on the storage medium. If you do not want to overwrite the backup, press the "No" button. Otherwise, click the "Yes" button.
   
   Several messages are displayed in sequence during the backup process:
   
   – Saving registry data
   
   – Copy files
   
   A progress bar shows the status of the backup process. When the backup process is completed, the "The operation completed successfully." message is displayed.

4. Acknowledge this message.
   
   The dialog closes.

**Result**

The HMI device data is now saved on the storage medium.
6.13 Restoring from external storage medium – Restore

Use this function to restore data from a storage medium to the HMI device.

A restore operation deletes the old data from flash memory of the HMI device on confirmation. The data stored on the storage medium is then copied to the internal flash memory.

Requirement

- The storage medium with the backup data is inserted in the HMI device. See section "Inserting a memory card (Page 84)".
- You have opened the "Backup/Restore" dialog box using the "Backup/Restore" icon.

### NOTICE

Data loss

All data on the HMI device will be deleted during a restore operation. License keys will be deleted after query.

Back up the HMI device's data before restoring if required.

Memory card with data backup

If several storage media with data backups are inserted, the data cannot be restored.

Remove the storage medium with the data backups you do not need.
Configuring the HMI device
6.13 Restoring from external storage medium – Restore

Procedure

Proceed as follows:

1. Click the "RESTORE" button.

   The "Storage Card" dialog box opens.

   ① No memory card available
   ② Only one memory card with a backup is permitted. No memory card detected. Insert a
   memory card and press the "Refresh" button.

2. Select the storage medium with the backup from the "Storage Card with Backup
   detected" selection box.

   The "--- no storage card available ---" message appears if there is no storage medium in
   the HMI device or it is defective.

3. If the "--- no storage card available ---" message appears, press the "Cancel" button.

   Restoring is then aborted.
   – Insert a storage medium or another one.
   – Click the "Refresh" button.

   The content of the selection box changes.
   – Select the storage medium with the backup from the "Storage Card with Backup
   detected" selection box.

4. Click the "Start Restore" button.

   Restoring is started.

5. The data to be restored is checked.

   The following messages are displayed in sequence during the check.
   – "Starting Restore"
   – "Checking data"

   When the data has been checked, the following message is displayed:
   "You are starting RESTORE now. All files (except files on storage cards) and the registry
   will be erased. Are you sure?"

6. If you do not want to permit that data are deleted from the HMI device, abort the restore
   process by pressing the "ESC" button.
7. Start to restore the data by selecting "Yes".
   The following messages are displayed in sequence during the restore:
   - "Deleting files on flash"
   - "Restore CE Image"
   A progress bar shows the status of the restore process.
   When restore is completed, the following message is displayed:
   "Restore successfully finished. Press ok, remove your storage card and reboot your device."

8. Remove the storage medium.

9. Acknowledge this message.
   The HMI device starts again.

**Result**

The data from the storage medium is now on the HMI device.

**Note**

After the restore, check whether it is necessary to calibrate the touch screen.
Configuring the HMI device

6.13 Restoring from external storage medium – Restore
Commissioning a project

7.1 Using an existing project

A WinCC flexible project can be reused for a Mobile Panel 277 IWLAN V1:

Take the following action to adapt this WinCC flexible project:

- Perform an HMI device replacement.

You can find additional information in the WinCC flexible online help or in the "WinCCF flexible migration" user manual.

7.2 Operating modes

The HMI device may be in the following operating modes:

- Offline
- Online
- Transfer

Enable the "offline" and "online" modes as follows:

- On the configuration PC
- On the HMI device, when the corresponding operator control is configured.

"Offline" operating mode

In this operating mode, the HMI device and the PLC do not communicate via the connections configured in the WinCC flexible project. You can operate the active project on the HMI device. Data of the project will not be transferred.

"Online" operating mode

In this mode, the HMI device and PLC communicate. You can operate the plant on the HMI device according to your system configuration.

"Transfer" mode

In this mode, you can transfer a project from the configuration PC to the HMI device or backup and restore HMI device data, for example.

Changing the operating mode

The configuration engineer must have configured an appropriate operator control to allow a change of the operating mode on the HMI device during ongoing operation.

More detailed information is available in your plant documentation.
7.3 Available data channels

The following table shows the possible routes for data communication between the HMI device and configuration PC.

The Ethernet data channel is used for communication via WLAN and LAN (RJ45).

<table>
<thead>
<tr>
<th>Type</th>
<th>Data channel</th>
<th>HMI device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup</td>
<td>USB</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ethernet</td>
<td>Yes</td>
</tr>
<tr>
<td>Restoring</td>
<td>USB</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ethernet</td>
<td>Yes</td>
</tr>
<tr>
<td>Updating the operating system</td>
<td>USB</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ethernet</td>
<td>Yes</td>
</tr>
<tr>
<td>Updating the operating system with restore of factory setting</td>
<td>USB</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Ethernet via the RJ45 interface</td>
<td>Yes</td>
</tr>
<tr>
<td>Transferring a project</td>
<td>USB</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ethernet</td>
<td>Yes</td>
</tr>
<tr>
<td>Install or remove WinCC flexible option</td>
<td>USB</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ethernet</td>
<td>Yes</td>
</tr>
<tr>
<td>License key transferring or transferring back</td>
<td>USB</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Ethernet</td>
<td>Yes</td>
</tr>
</tbody>
</table>

7.4 Preparing and backing up a project

7.4.1 Overview

In order to operate a plant, you need to transfer the corresponding WinCC flexible project to the HMI device.

Transferring the project to the HMI device

You can transfer a project to an HMI device as follows:

- Transfer from the configuration PC
- Restore from a PC using ProSave
  
  In this case, an archived project is transferred from a PC to the HMI device.
  WinCC flexible need not be installed on this PC.

Commissioning and recommissioning

When the HMI device is commissioned there is no project at first. The HMI device is also in this state after the operating system has been updated.

When recommissioning, any project already on the HMI device is replaced.
7.4 Preparing and backing up a project

7.4.2 Transfer

7.4.2.1 Overview

The following types of transfer can be performed:

- Transfer
  - Transfer of a project to the HMI device.
- Backtransfer
  - Backup of a project from the HMI device to the configuration PC.

Transfer

When the configuration phase is completed, transfer the runtime project from the configuration PC to the HMI device.

You can start the "Transfer" mode manually on the HMI device.

- When the HMI device starts up
  - You start the "Transfer" mode with the appropriate button in the loader.
- During ongoing operation
  - Start the "Transfer" mode manually with a configured operator control.

The transferred project is written directly to the internal flash memory of the HMI device.

Backtransfer

You have the option to transfer the compressed project file together with the runtime project to the HMI device. If necessary, the compressed project file can be transferred back to the configuration PC and edited.

The HMI device must be equipped with an external memory to which the compressed project file can be saved.

NOTICE

Compressed project file and runtime project

If you only transfer the runtime project, there is the risk that the runtime project will not be identical to an existing compressed project file. WinCC flexible does not check if the two are identical.

Therefore, always transfer the compressed project file together with the runtime project.
Starting manual transfer

You can manually switch the HMI device to "Transfer" mode as follows:

- With a configured operator control during ongoing operation
- In the Loader of the HMI device

Requirement

- The project you want to transfer is open on the configuration PC in WinCC flexible.
- The HMI device is connected to this configuration PC.
- The data channel is configured on the HMI device.
- The HMI device is in "Transfer" mode

Procedure

Proceed as follows:

1. On the configuration PC, select the "Transfer settings" command in the "Project > Transfer" menu in WinCC flexible.
   The "Select devices for transfer" dialog is displayed.
2. Select the HMI device in the left area of the dialog.
3. Select the type of connection between the HMI device and the configuration PC.
4. Configure the connection.
5. Set the transfer parameters in the right area of the dialog.
6. If you wish to transfer the compressed project file together with the executable project to the HMI device, select the "Enable backtransfer" check box.
7. Start transfer in WinCC flexible with "Transfer".
   The configuration PC checks the connection to the HMI device. The project is transferred to the HMI device. If the connection is not available or is defective, an error message is displayed on the configuration PC.
   When the transfer is completed successfully, the project can be found on the HMI device. The transferred project is then started automatically.
## 7.4.2.3 Starting automatic transfer

If automatic transfer is selected, the HMI device automatically switches to "Transfer" mode during operation as soon as a transfer is initiated on the connected configuring PC.

### NOTICE

**Undesired system responses**

If automatic transfer has been selected on the HMI device and a transfer is then initiated on the configuring PC, the current project is automatically terminated following a prompt. The HMI device then automatically switches to "Transfer" mode. The transfer mode can trigger undesired responses in the system. After the commissioning phase, deactivate the automatic transfer so that the HMI device cannot be inadvertently switched to transfer mode.

### Note

You can issue a password in the Control Panel to restrict access to the transfer settings and thus avoid unauthorized modifications.

Automatic transfer is particularly suited for the test phase of a new project since transfer is completed without interfering with the HMI device.

### Requirement

- The project that you want to transfer on the configuration PC is opened in WinCC.
- The HMI device is connected to this configuring PC.
- The data channel is programmed on the HMI device.
- The automatic transfer is enabled in the data channel.
- The project is started on the HMI device.

### Procedure

Proceed as follows:

1. On the configuring PC, select the "Transfer settings" command in the menu "Project > Transfer" in WinCC flexible.
   - The "Select devices for transfer" dialog opens.
2. Select the HMI device in the left area of the dialog.
3. Select the type of connection between the HMI device and the configuring PC.
4. Configure the connection.
5. Set the transfer parameters in the right area of the dialog.
6. If you wish to transfer the compressed project file together with the executable project to the HMI device:
   - Select the "Enable backtransfer" check box.
7. Start transfer in WinCC flexible with "Transfer".
   The configuring PC checks the connection to the HMI device.
8. Confirm the next dialog.
   When the transfer is completed successfully, the project can be found on the HMI device.
   The transferred project is then started automatically.

### 7.4.2.4 Starting backtransfer

#### Requirement
- No project is open on the configuration PC in WinCC flexible.
- The HMI device is connected to this configuration PC.
- The data channel is configured on the HMI device.
- The HMI device is in "Transfer" mode
- The memory card with the compressed project file is inserted in the HMI device.

#### Procedure

Proceed as follows:

1. On the configuration PC, select the "Communication settings" command in the "Project >
   Transfer" menu in WinCC flexible.
   The "Communication Settings" dialog is displayed.
2. Select the type of HMI device.
3. Select the type of connection between the HMI device and the configuration PC.
4. Configure the connection.
5. Close the dialog with "OK".
6. Select the "Transfer" > "Backtransfer" command in the "Project" menu.
   The "Backtransfer" dialog is displayed.
7. Click "OK" to start the backtransfer process.
   The configuration PC checks the connection to the HMI device. The compressed project
   file is transferred back from the HMI device to the configuration PC. If the connection is
   not available or is defective, an error message is displayed on the configuration PC.
   After successful backtransfer, the project is opened on the configuration PC in
   WinCC flexible.
7.4.3 Testing a project

There are two options to test a project:

- Test the project on the configuring PC
  
  You can test a project at a configuring PC, using a simulator. You can find additional information in the "WinCC flexible" user manual or in the WinCC flexible online help.

- Offline testing of the project on the HMI device
  
  Offline testing means that communication between the HMI device and PLC connections, which have been configured in WinCC flexible, is down while the test is being carried out.

- Online testing of the project on the HMI device
  
  Online testing means that the HMI device and PLC communicate with each other during testing.

Perform the tests, starting with the "Offline test", followed by the "Online test".

**Note**

You should always test the project on the HMI device on which the project will be used.

Check the following:

- WLAN
- Zone recognition
- Check the hierarchy of the HMI images
- Validate the representation of the HMI images
- Check the input objects
- Enter the tag values

The test increases the certainty that the project will run error-free on the HMI device.

**Requirement – Offline test**

- The project has been transferred to the HMI device.
- The HMI device is in "Offline" mode.

**Procedure**

**Note**

Direct keys are also active in "offline" mode.
NOTICE

Direct key immediately effective
If you trigger an operator control with direct key functionality in an active project, the corresponding function is always executed, regardless of the screen display at the time. Exception: Function keys are inactive while a safety-related message is displayed. Avoid pressing a direct key unintentionally.

Proceed as follows:
1. In the "Offline" operating mode on the HMI device, test individual project functions that do not depend on the controller.
   PLC tags are not updated in this case.
2. Test the operating elements and visualization of the project as far as possible without connecting to the PLC.

Requirement – Online test
- The project has been transferred to the HMI device.
- The HMI device is in "Online" mode.

Procedure
Proceed as follows:
1. In the "Online" operating mode on the HMI device, test individual project functions that depend on the controller.
   PLC tags are updated in this case.
2. Test all functions that depend on communication.
3. Test the operating elements and views of the project.

7.4.4 Backup and restore

7.4.4.1 Overview
You can back up and restore the following data from the internal flash memory of the HMI device to a PC:
- Project and HMI device image
- Password list
- Recipe data
- License keys
You have the following possibilities for backing up or restoring data:

- With WinCC flexible
- Alongside with ProSave
- Through the control panel

An external storage medium is required for backup and restore via the Control Panel.

**NOTICE**

**Reset to factory settings required**

If a restore operation is interrupted due to power failure on the HMI device, the operating system of the HMI device may be corrupted!

In this case, you have to restore the factory settings on the HMI device. See section "Restoring factory settings (Page 177)".

**Note**

If a message appears on the HMI device warning you of a compatibility conflict during the restore operation, the operating system must be updated.

### 7.4.4.2 Backing up with WinCC flexible

**Requirements**

- No project is open on the configuration PC in WinCC flexible.
- The HMI device is connected to this configuration PC.
- The data channel is configured on the HMI device.

**Procedure**

Proceed as follows:

1. On the configuration PC, select the "Transfer settings" command from the "Project > Transfer" menu in WinCC flexible.
   The "Transfer settings" dialog is displayed.
2. Select the type of HMI device.
3. Select the type of connection between the HMI device and the configuration PC.
4. Configure the connection.
5. Close the dialog with "OK".
6. Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible.
   The "Backup Settings" dialog is displayed.
7. Select the data to be backed up.
8. Select a destination folder and a file name for the "filename.psb" backup file.
9. Set "Transfer" mode on the HMI device.
10. Start backup in WinCC flexible with "OK".
11. Follow the instructions in WinCC flexible.
   A status view opens to indicate the progress of the operation. The system outputs a
   message when the backup is completed.

Result
The relevant data is now backed up on the configuration PC.

7.4.4.3 Backing up with ProSave

Requirement
- The HMI device is connected to a PC on which ProSave is installed.
- The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. Start ProSave from the Windows start menu.
2. Select the HMI device type in the "General" tab.
3. Select the type of connection between the HMI device and the PC.
4. Configure the connection.
5. Select the data you want to back up in the "Backup" tab.
6. Select a destination folder and a file name for the "filename.psb" backup file.
7. Set "Transfer" mode on the HMI device.
8. Start the backup in ProSave with "Start Backup".
9. Follow the instructions in ProSave.
   A status view opens to indicate the progress of the operation. The system outputs a
   message when the backup is completed.

Result
The relevant data is now backed up on the configuration PC.
7.4.4.4 Restoring with WinCC flexible

Requirement

- No project is open on the configuration PC in WinCC flexible.
- The HMI device is connected to this configuration PC.
- You have assigned the data channel parameters on the HMI device.

Procedure

Proceed as follows:

1. In WinCC flexible, select the "Transfer settings" command from the "Project > Transfer" menu.
   
   The "Transfer settings" dialog is displayed.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuration PC.

4. Configure the connection.

5. Close the dialog with "OK".

6. Select the "Restore" command in the menu "Project > Transfer" in WinCC flexible.
   
   The "Restore Settings" dialog is displayed.

7. Select the "filename.psb" backup file to be restored from the "Open" field.
   
   You can see the HMI device for which the backup file was created and the type of backup data the file contains.

8. Set "Transfer" mode on the HMI device.

9. Start the restore operation in WinCC flexible with "OK" on the configuration PC.
   
   If there are license keys both on the HMI device and in the backup, a dialog box will appear. Use this dialog to establish whether you want to overwrite the license keys or abort the restore process.
   
   - If necessary, abort the backup and save the license keys of the HMI device.
   
   - Then start the restore procedure again.

10. Follow the instructions in WinCC flexible.

   A status view opens to indicate the progress of the operation.

Result

When the restore is successfully completed, the data previously backed up on the PC will now be available on the HMI device.
7.4.4.5 Restoring with ProSave

Requirement

- The HMI device is connected to a PC on which ProSave is installed.
- The data channel is configured on the HMI device.

Procedure

Proceed as follows:
1. Start ProSave from the Windows start menu.
2. Select the HMI device type in the "General" tab.
3. Select the type of connection between the HMI device and the PC.
4. Configure the connection.
5. Select the "filename.psb" backup file you want to restore from the "Restore" tab.
   You can see the HMI device for which the backup file was created and the type of backup data the file contains.
6. Set "Transfer" mode on the HMI device.
7. Start the restore in ProSave with "Start Restore".
   If there are license keys both on the HMI device and in the backup, a dialog box will appear. Use this dialog to establish whether you want to overwrite the license keys or abort the restore process.
   - If necessary, abort the restore process and save the license keys of the HMI device.
   - Then start the restore process again.
8. Follow the instructions in ProSave.
   A status view opens to indicate the progress of the operation.

Result

When the restore is successfully completed, the data previously backed up on the PC will now be available on the HMI device.
7.4.5 Updating the operating system

7.4.5.1 Overview

A compatibility conflict may occur when transferring a project to the HMI device. The reason for this problem is that there are different versions of the configuration software and the HMI device image on the HMI device. The transfer is aborted in case of different versions. A message indicating such a compatibility conflict will be displayed on the configuration PC.

You have the following options to remedy the compatibility problem:

- Update the HMI device image if the project was created with the most recent version of the configuration software.
- Transfer a version that is compatible with the version of HMI device image if you do not want to adapt the project to the most recent version of the configuration program.

**NOTICE**

Data loss

All data on the HMI device, such as the project and passwords, will be deleted when you update the operating system.

Back up the stored data before you update the operating system.

**Note**

The license keys on the HMI device will be retained when updating the operating system without resetting to factory settings.

After the update, you may have to recalibrate the touch screen.

7.4.5.2 Updating the operating system using WinCC flexible

**Requirements**

- No project is open on the configuration PC in WinCC flexible.
- The HMI device is connected to this configuration PC.
- The data channel is configured on the HMI device.

**Procedure**

Proceed as follows:

1. In WinCC flexible, select the "Transfer settings" command from the "Projekt > Transfer" menu.
   
   The "Transfer settings" dialog is displayed.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuration PC.

4. Configure the connection.
5. Close the dialog with "OK".
6. In WinCC flexible, select the command "OS Update" from the "Projekt > Transfer" menu.
7. Under "Image path", select the HMI device image file "filename.img".
   The HMI device image files are available under "WinCC flexible Images" in the
   WinCC flexible installation folder or on the WinCC flexible installation CD.
   The output area provides you with information on the version of the HMI device image file
   once it has been successfully opened.
8. Set "Transfer" mode on the HMI device.
9. In WinCC flexible, select "Update OS" to run the operating system update on the
    configuration PC.
10. Follow the instructions in WinCC flexible.
    During the operating system update a status view opens to indicate progress. A message
    is displayed when the operating system update is successfully completed.

Result

The updated operating system is now on the HMI device.

7.4.5.3 Updating the operating system using ProSave

Requirement

- The HMI device is connected to a PC on which ProSave is installed.
- The data channel is configured on the HMI device.

Procedure

Proceed as follows:
1. Start ProSave from the Windows start menu.
2. Select the HMI device type in the "General" tab.
3. Select the type of connection between the HMI device and the PC.
4. Configure the connection.
5. Select the "OS Update" tab.
6. Under "Image path", select the HMI device image file "filename.img".
   The HMI device image files are available under "WinCC flexible Images" in the
   WinCC flexible installation folder or on the WinCC flexible installation CD.
   The output area provides you with information on the version of the HMI device image file
   once it has been successfully opened.
7. Set "Transfer" mode on the HMI device.
8. Select "Update OS" to run the operating system update on the PC.

9. Follow the instructions in ProSave.
   During the operating system update a status view opens to indicate progress. A message is displayed when the operating system update is successfully completed.

**Result**

The updated operating system is now on the HMI device.

### 7.4.6 Restoring factory settings

#### 7.4.6.1 Overview

You have to perform an operating system update with restore of the factory setting if the HMI device does not yet have an operating system or if the HMI device operating system is corrupt.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data loss</strong></td>
</tr>
<tr>
<td>The license keys on the HMI device will be deleted when resetting to factory settings.</td>
</tr>
<tr>
<td>Back up stored license keys before you restore the factory settings on the HMI device.</td>
</tr>
</tbody>
</table>

**Activating the WLAN**

Functional errors cannot be excluded if you activate a WLAN that was reset to factory settings and the LAN cable is still connected.

Disconnect the LAN cable before you activate the WLAN.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The parameters of the data channels are reset when the factory setting is restored. Reassign the data channel parameters before you start a transfer.</td>
</tr>
<tr>
<td>The reset includes the IP address and Profinet name of the panel.</td>
</tr>
</tbody>
</table>
7.4.6.2 Restoring the factory settings using WinCC flexible.

Requirements

- No project is open on the configuring PC in WinCC flexible.
- The HMI device is connected to this configuration PC over the standard Ethernet cable.
- Have the MAC address of the Ethernet interface on your HMI device to hand.
  - The MAC address is displayed briefly when the HMI device is turned on.
  - The MAC address is displayed in the "PROFINET" dialog in the Control Panel.

Procedure – setting the PC interface

1. Select "Start > Control Panel > Set PG / PC interface" on the configuration PC.
2. Select "S7ONLINE (STEP7) -> TCP / IP" from the "Application access point" area.
3. Select the interface which is connected to the HMI device from the "Interface parameterization used" area.
4. Confirm your entries.

Procedure – resetting to factory settings

Proceed as follows:

1. On the configuration PC, select the "Transfer settings" command from the "Project > Transfer" menu in WinCC flexible.

   The "Transfer settings" dialog opens.

2. Select the type of HMI device and "Ethernet/Wireless" at the "Mode" entry.
3. Enter an IP address.

**NOTICE**

**Possible address conflicts with incorrect IP address**

Do not use a dynamic IP configuration for "Reset to factory settings". Specify a unique IP address in which the configuration PC is located. The HMI device will be assigned to the specified address for the duration of the update process.

If the HMI device has already been used with WinCC flexible or ProSave you can use the existing IP address for "Reset to factory settings."

** Reserved IP addresses**

The following IP addresses are reserved for internal communication with the WLAN module:
- 169.254.2.253
- 169.254.2.254

Do not use these reserved IP addresses.

4. Confirm your entries.

5. In WinCC flexible, select the command "Update OS" in the "Project > Transfer" menu.

6. Activate the "Reset to factory settings" check box.

   A text box opens where you can enter the MAC address.

7. Enter the HMI device’s MAC address in the text box.

8. In "Image path", select the HMI device image file "*.img".

    The HMI device image files are available under "WinCC flexible Images" in the WinCC flexible installation folder or on the WinCC flexible installation CD.

    In the output area, you are provided information on the version of the HMI device image file after it is opened.

9. In WinCC flexible, select "Update OS" on the configuring PC to run the operating system update.

10. In the Control Panel of the HMI device, open the "OP Properties" dialog and select the "Device" tab.

11. Click on the "Reboot" button.

    A query is opened.

12. Click on the "Prepare for Reset" button.

13. On the configuration PC, follow the instructions in WinCC flexible.

    During the operating system update a status view opens to indicate progress.

**Result**

A message is displayed when the operating system update is successfully completed.
This operation has deleted the project data from the HMI device. The factory settings are reset.

---

**Note**

If you can no longer call the Control Panel on the HMI device, as the operating system is missing, switch off the HMI device. Then reset to factory settings and restart the HMI device.

If the HMI device doesn’t start up, switch it off and then on again.

---

**Note**

After the restore, you may have to calibrate the touch screen.

---

### 7.4.6.3 Restoring the factory settings with ProSave

**Requirement**

- The HMI device is connected over the Ethernet to a PC on which ProSave is installed.
- Have the MAC address of the Ethernet interface on your HMI device to hand.
  - The MAC address is displayed briefly when the HMI device is turned on.
  - The MAC address is displayed in the "PROFINET" dialog in the Control Panel.

**Procedure - Setting the PC interface**

1. Select the menu command "Start > Control Panel > Set PG/PC interface" on the configuration PC.
2. Select "S7ONLINE (STEP7) -> TCP/IP" from the "Application access point" area.
3. Select the interface which is connected to the HMI device from the "Interface parameterization used" area.
4. Confirm your entries.
Procedure - Restoring factory settings

Proceed as follows:

1. From the Windows Start menu, start ProSave on the PC.

2. Select the HMI device type from the "General" tab, and select "Ethernet" from the Connection area.

3. Enter an IP address.

**NOTICE**

Possible address conflicts with incorrect IP address
Do not use a dynamic IP configuration for "Reset to factory settings".

Specify a unique IP address of the subnet in which the configuration PC is located. This subnet has to be a different one than the WLAN subnet. For the duration of the update process, the HMI device is automatically assigned to the specified address of ProSave.

If the HMI device has already been used with WinCC flexible or ProSave you can use the existing IP address for "Reset to factory settings."

Reserved IP addresses
The following IP addresses are reserved for internal communication with the WLAN module:
- 169.254.2.253
- 169.254.2.254

Do not use these reserved IP addresses.

4. Change to the "OS Update" tab.

5. Activate the "Reset to factory settings" check box.
   A text box opens where you can enter the MAC address.

6. Enter the HMI device's MAC address in the text box.
7. In "Image path", select the HMI device image file "*.img".
   The HMI device image files are available under "WinCC flexible Images" in the
   WinCC flexible installation folder or on the WinCC flexible installation CD.
   The output area provides you with information on the version of the HMI device image file
   once it has been successfully opened.
8. Select "Update OS" on the PC to start the "Reset to factory settings" process.
9. In the Control Panel of the HMI device, open the "OP Properties" dialog and select the
   "Device" tab.
10. Click on the "Reboot" button.
    A query is opened.
11. Click on the "Prepare for Reset" button.
12. Follow the instructions in ProSave.
    During the operating system update a status view opens to indicate progress.

Result

A message is displayed when the operating system update is successfully completed.
There is now no project data on the HMI device. The factory settings are restored.

Note

If you can no longer open the Control Panel on the HMI device because the operating
system is missing, switch off the HMI device. Then restore the factory settings and restart
the HMI device.

If the HMI device does not start up, switch it off and on again.

Calibrating the touch screen

After the reset, you may have to recalibrate the touch screen.
7.4.7 Installing and removing software options

7.4.7.1 Overview

With WinCC flexible-options, you can expand the functional scope of the HMI device. This chapter describes the installation and deinstallation of WinCC flexible options.

Note
In order to use a WinCC flexible option, a license key may be required. The license key unlocks the option for use.

7.4.7.2 Installing with WinCC flexible

Requirement

- No project is open on the configuration PC in WinCC flexible.
- The HMI device is connected to this configuration PC.
- The data channel is configured on the HMI device.

Procedure

Proceed as follows:

1. Select the "Communication settings" command in the "Project > Transfer" menu in WinCC flexible.
   The "Communication Settings" dialog is displayed.
2. Select the type of HMI device.
3. Select the type of connection between the HMI device and the configuration PC.
4. Configure the connection.
5. Close the dialog with "OK".
6. Select the "Options" command in the "Project > Transfer" menu in WinCC flexible.
7. Select the desired option under "Available options".
8. Set "Transfer" mode on the HMI device.
9. Start the installation of the option in WinCC flexible on the configuration PC with the ">>" button.
10. Follow the instructions in WinCC flexible.
    A status display appears indicating the progress of the installation.

Result

The WinCC flexible-option has now been installed on the HMI device.
7.4.7.3 Removing with WinCC flexible

Requirement

- No project is open on the configuration PC in WinCC flexible.
- The HMI device is connected to this configuration PC.
- The data channel is configured on the HMI device.

Procedure

Proceed as follows:

1. Select the "Communication Settings" command in the menu "Project > Transfer" in WinCC flexible.
   The "Communication Settings" dialog is displayed.
2. Select the type of HMI device.
3. Select the type of connection between the HMI device and the configuration PC.
4. Configure the connection.
5. Close the dialog with "OK".
6. Select the "Options" command in the "Project > Transfer" menu in WinCC flexible.
7. Press the "Device status" button to update the display.
8. Select the desired option under "Installed options".
9. Set "Transfer" mode on the HMI device.
10. Start the removal of the option in WinCC flexible on the configuration PC with the "<<" button.
11. Follow the instructions in WinCC flexible.
   A status display appears indicating the progress of the removal.

Result

The WinCC flexible-option has now been removed from the HMI device.
7.4.7.4 Installing with ProSave

Requirement
- The HMI device is connected to a PC on which ProSave is installed.
- The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. Start ProSave from the Windows start menu.
2. Select the HMI device type in the "General" tab.
3. Select the type of connection between the HMI device and the PC.
4. Configure the connection.
5. Select the "Options" tab.
6. Select the desired option under "Available options".
7. Set "Transfer" mode on the HMI device.
8. Start the installation of the option in ProSave with the ">>" button.
9. Follow the instructions in ProSave.
   A status display appears indicating the progress of the installation.

Result
The WinCC flexible-option has now been installed on the HMI device.

7.4.7.5 Removing with ProSave

Requirement
- The HMI device is connected to a PC on which ProSave is installed.
- The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. Start ProSave from the Windows start menu.
2. Select the HMI device type in the "General" tab.
3. Select the type of connection between the HMI device and the PC.
4. Configure the connection.
5. Select the "Options" tab.
6. Press the "Device status" button to update the display.
7. Select the desired option under "Installed options".
8. Set "Transfer" mode on the HMI device.
9. Start the removal of the option in ProSave with the "<=" button.
10. Follow the instructions in ProSave.

A status display appears indicating the progress of the removal.

Result

The WinCC flexible-option has now been removed from the HMI device.

7.4.8 Transferring license keys back and forth

7.4.8.1 Overview

With the purchase of a WinCC flexible option, you also buy a specific usage license with an associated license key. Once you have installed an add-on, transfer a license key to the HMI device. The license key unlocks the option for use. The license key can then be transferred from the HMI device back to the storage location.

Note

The license key can only be transferred using the Automation License Manager or WinCC flexible.
7.4.8.2 Transfer license keys

Requirement

- No WinCC flexible project is open on the configuration PC.
- The HMI device is connected to the configuration PC.
- A data channel is configured on the HMI device.
- A storage medium with the license key is available.

Procedure

Proceed as follows:

1. Switch to "Transfer" mode on the HMI device.
2. When transferring using WinCC flexible:
   - Select the "Transfer" > "License Keys" command in the "Project > Transfer" menu. The Automation License Manager is displayed.
3. For transfers using the Automation License Manager:
   - Start the Automation License Manager via the Windows Start menu.
4. Select the "Connect HMI device" command in the "Edit > Connect Target System" menu.
   - The "Connect Target System" dialog is displayed.
5. Under "Device type", select the HMI device type.
6. Select the type of connection from the "Connection" box.
7. Configure the connection.
8. Confirm by clicking "OK".
   - The connection to the HMI device is established. The connected HMI device is displayed in the left window of the Automation License Manager.
9. Select the source drive in the left window.
   - The right window displays the available license keys.
10. Drag and drop the selected license key from the right window to the HMI device in the left window.
    - The selected license keys are transferred to the HMI device.
7.4.8.3 Transfer license keys back

Requirement

- No WinCC flexible project is open on the configuration PC.
- The HMI device is connected to the configuration PC.
- A data channel is configured on the HMI device.
- The license key on a storage medium.

Procedure

Proceed as follows:

1. Switch to "Transfer" mode on the HMI device.
2. When transferring back using WinCC flexible:
   - Select the "License Keys" command in the "Project > Transfer" menu.
   - The Automation License Manager is displayed.
3. When transferring back using the Automation License Manager:
   - Start the Automation License Manager via the Windows Start menu.
4. Select the "Connect HMI device" command in the "Edit > Connect Target System" menu.
   - The "Connect Target System" dialog is displayed.
5. Under "Device type", select the HMI device type.
6. Select the type of connection from the "Connection" box.
7. Configure the connection.
8. Confirm by clicking "OK".
   - The connection to the HMI device is established. The connected HMI device is displayed in the left window of the Automation License Manager.
9. Select the HMI device in the left window.
   - The right window displays the available license keys.
10. Drag and drop the selected license key from the right window to the drive in the left window.
    - The selected license keys will be transferred back to the storage location.
Commissioning the plant

8.1 Overview
The acceptance of the plant involves the following:
- Zones

8.2 Acceptance of the plant
All of the relevant application-specific standards and the procedure described in this section must be observed in the course of final acceptance of the plant.

Requirement
- The hardware configuration has been created in HW Config.
- A backup of the STEP 7 project has been created.

Acceptance of the PLC
- Printing and archiving the hardware configuration.
- Check the following parameters in the hardware configuration:
- Save the hardware configuration with the STEP 7 project.
8.3 Transponder system

8.3.1 Testing zones

If zones were configured for a monitored system, test to see if the HMI device recognizes all zones.

Requirement

- The project is started.
- The transponders have been fitted and the IDs are set
- The operating elements "Zone label" and "Zone quality" are present.

Procedure

Check the following parameters:

- Are the configured zone limits operating as planned?
- Do the moving parts influence the communication between the transponder - HMI device?
  Investigate all positions of moving parts.
- Is WLAN available throughout the entire zone?
Operating a project

9.1 Starting the project

In the following chapters, the operating and display elements that can be configured in WinCC flexible and their importance and meaning are explained.

Note
Some operations with the project may require in-depth knowledge about the specific plant on the part of the operator. Proceed with caution, for example, when you use jog mode. Refer to your plant documentation for additional information.

Requirement
In order to switch on the HMI device and start the project, the following requirements must be met:

- The main battery is charged and inserted in the HMI device.
  If a main battery is not available, place the HMI device into the charging station.
- The project has been transferred to the HMI device.
- The radio signal from the WLAN is sufficiently strong.

Procedure
Proceed as follows:

1. Press the "ON/OFF" button.
   The HMI device performs the following tasks:
   - The HMI device starts.
   - The "PWR" LED lights up.
   - The "BAT" LED shows the remaining charge of the main battery.
   - The WLAN connection is established.
   - Once the HMI device has established the WLAN connection, the "COM" LED lights up.
   The loader appears.
2. Start the project using the "Start" button or wait until the project is automatically started after the set delay time.
   The HMI device displays the start screen of the project.

Result
You can operate the plant with the HMI device.
9.2 Operator input options

Introduction

Some operations with the project may require in-depth knowledge about the specific plant on the part of the operator. Proceed with caution, for example, when you use jog mode. More detailed information is available in your plant documentation.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unintentional action</td>
</tr>
<tr>
<td>If you press several operator controls at once, you may trigger an unintentional action.</td>
</tr>
<tr>
<td>Do not carry out several operations simultaneously.</td>
</tr>
<tr>
<td>• When using the touch screen:</td>
</tr>
<tr>
<td>Always touch only one operating element on the screen</td>
</tr>
<tr>
<td>• When using an external keyboard:</td>
</tr>
<tr>
<td>Do not press more than two keys simultaneously</td>
</tr>
</tbody>
</table>

Operator input options

Once the project is transferred to the HMI device, you can operate and monitor active processes during the process control phase. You have the following operating options:

- Touch screen
  The operating elements shown in the project images are touch-sensitive. Touch objects are operated in the same way as mechanical keys. You trigger an operator control by pressing it with your finger. To double-click them, touch an operating element twice in succession.

  **Note**
  Observe the notes about the operation in chapter "Overview (Page 77)".

- External input device
  The use of external input devices is recommended for the commissioning phase. The following external input devices can be connected through the USB port:
  - Keyboard
    You can use an external keyboard to operate a project in exactly the same way as with the screen keyboard.

    **Note**
    The function keys of the external keyboard are disabled.

  - Mouse
    You can use an external mouse to operate a project in exactly the same way as with the touch screen of the HMI device.
Feedback from an operator control

The HMI device provides optical feedback as soon as it detects that an operating element has been selected. The operating element receives the focus and is selected. This selection is independent of any communication with the PLC. Therefore this selection does not indicate whether the relevant action is actually executed or not.

The selection of an operator control can deviate from the standard. More detailed information is available in your plant documentation.

The type of optical operation feedback depends on the operator control:

- **Buttons**
  
  The HMI device outputs different views of the "Pressed" and "Unpressed" states, provided the configuration engineer has configured a 3D effect:
  
  - "Pressed" state
    
    ![Pressed state](image)
  
  - "Not pressed" state
    
    ![Not pressed state](image)

  The configuration engineer determines the appearance of a marked field, for example, line width and color for the focus.

- **Invisible button**
  
  By default, invisible buttons are not displayed as pressed when they are touched. No optical operation feedback is provided in this case.

  The configuration engineer may, however, configure invisible buttons so that their outline appears as lines when touched. This outline remains visible until you select another operating element.

- **I/O field**
  
  When you select an I/O field, the content of the I/O field is displayed against a colored background. With touch operation, a screen keyboard is displayed for the entering of values.
9.3 Direct keys

A direct key on the HMI device is a direct way to set a bit in the I/O area of the controller. A direct key enables an operation with a fast response time. Fast response time is essential, for example, for jogging mode.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leaving the WLAN</td>
</tr>
<tr>
<td>Note that leaving the WLAN area will cause the PROFINET IO device to fail and therefore result in a PLC stop.</td>
</tr>
<tr>
<td>Determine suitable programming measures in the PLC, in order to prevent a PLC stop.</td>
</tr>
<tr>
<td>Refer to your plant documentation for additional information.</td>
</tr>
<tr>
<td>Direct key immediately effective</td>
</tr>
<tr>
<td>If you trigger an operator control with direct key functionality in an active project, the corresponding function is always executed, regardless of the screen display at the time.</td>
</tr>
<tr>
<td>Exception: Function keys are inactive, while a safety-related message is displayed.</td>
</tr>
<tr>
<td>Avoid pressing a direct key unintentionally.</td>
</tr>
</tbody>
</table>

Note

A direct key is active under the condition that one of the following two operating modes is set:

- HMI device in "Online" mode.
- The HMI device is in "Offline" mode.

The following objects can be configured as a direct key:

- Button
- Function keys
- Screen number
- Handwheel
- Illuminated pushbutton
- Keyswitch

Additional information is available in the "WinCC flexible, Communication" system manual.
9.4 Setting the project language

The HMI device supports multilingual projects. You must have configured a corresponding operator control which lets you change the language setting on the HMI device during runtime.

The project always starts with the language set in the previous session.

Requirement

- The required language for the project must be available on the HMI device
- The language switching function must be logically linked to a configured operator control such as a button

Selecting a language

You can change project languages at any time. Language-specific objects are immediately output to the screen in the new language when you switch languages.

The following options are available for switching the language:

- A configured operator control switches from one language to the next in a list
- A configured operator control directly sets the desired language

More detailed information is available in your plant documentation.

9.5 Operating the screen keyboard in the project

If you do not use an external keyboard, use the screen keyboard to enter numeric and alphanumeric characters. As soon as you touch a text box, a numeric or alphanumeric screen keyboard is displayed, depending on the type of the text box.

Display methods for the screen keyboard

You can change the type of display for the screen keyboard and move its position on the screen.

- Numerical screen keyboard

![Screen Keyboard Example]
• Alphanumerical screen keyboard

The alphanumerical screen keyboard has the following levels.

– Normal level
– Shift level
  The shift level includes uppercase letters.
– Special character level

**Note**
The ' character (button between ":;" and "\") appears only when followed by a space. If the ' character is followed by a letter, then the result will be an accent, such as "á".

• Reduced screen keyboard

**Note**
When the screen keyboard is open, PLC job 51, "Select screen" has no function.
The screen keyboard display is independent of the configured project language. Language switching in the project has no influence on the alphanumerical screen keyboard. This means you cannot enter Cyrillic or Asian characters.

Procedure for moving the screen keyboard

Proceed as follows:

1. Touch the symbol and move the screen keyboard on the touch screen.

2. When the desired position is reached, release the icon.
**Procedure for adjusting the size of the screen keyboard**

**Note**

The icon only appears on the screen keyboard if in the "Siemens HMI InputPanel" dialog you have selected the "Show Resize button" check box.

Proceed as follows:
1. Touch the symbol and drag the screen keyboard to the appropriate size.
2. When the size you want is reached, release contact with the icon.

**Changing the display of the screen keyboard**

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Insert Image Here]</td>
<td>Switching between the numerical and alphanumerical keyboard</td>
</tr>
<tr>
<td>![Insert Image Here]</td>
<td>Switching between the normal level and Shift level of the alphanumerical screen keyboard</td>
</tr>
<tr>
<td>![Insert Image Here]</td>
<td>Switch over to special characters</td>
</tr>
<tr>
<td>![Insert Image Here]</td>
<td>Switching from full display to reduced display</td>
</tr>
<tr>
<td>![Insert Image Here]</td>
<td>Switching from reduced display to full display</td>
</tr>
<tr>
<td>![Insert Image Here]</td>
<td>Closing of reduced display of the screen keyboard</td>
</tr>
</tbody>
</table>

**Entering data**

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Insert Image Here]</td>
<td>Delete character left of cursor</td>
</tr>
<tr>
<td>![Insert Image Here]</td>
<td>Delete character right of cursor</td>
</tr>
<tr>
<td>![Insert Image Here]</td>
<td>Confirm entry and close the screen keyboard</td>
</tr>
<tr>
<td>![Insert Image Here]</td>
<td>Cancel input</td>
</tr>
</tbody>
</table>
Note

Data input - numerical text box
- Hexadecimal values
  When you enter a value in hexadecimal format, the alphanumerical screen keyboard opens.
- Decimal places
  The configuration engineer can define the number of decimal places for a numerical text box. The number of decimal places is checked when you enter a value in this type of I/O field.
  - Decimal places in excess of the limit are ignored.
  - Empty decimal places are filled with "0".
- Limits
  A tag can be configured with limits. If you enter a value outside these limits, it will be rejected.
  If an alarm view is configured, a system event is triggered and the original value is displayed again.

Data input – date and time
When entering the date and time, note that their format is determined by the configured project language.

Opening the Windows CE taskbar

You open the Windows CE taskbar with the key.

Displaying infotext

The configuration engineer uses infotext to provide additional information and operating instructions. There may be infotext for HMI screens and operator controls in the project.

The infotext for an I/O field may contain, for example, information on the value to be entered.
The screen keyboard appears on the HMI device touch screen when you touch an operator control that requires input. If an infotext was configured for the current operator control, call up the infotext with the button. If no infotext is available for the current operator control, the infotext for the current HMI screen will be displayed.

**Note**
If an infotext was configured for the current control object as well as the current HMI screen, you can switch between both infotexts by touching the infotext window.

Close the infotext window with the button.

Depending on the project, infotext can also be called by an operator control configured for this purpose. For additional information, refer to the online help of WinCC flexible.

### 9.6 Device-specific displays

#### 9.6.1 Showing the battery charge

The "Battery" object indicates the remaining charge of the main rechargeable battery. Charge the main rechargeable battery in time or replace it. Read the information provided in section "Safety instructions (Page 66)."

The amount of charge for the main rechargeable battery is shown by the "Battery" object as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Meaning</th>
<th>Charge level</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Green Icon" /></td>
<td>Green</td>
<td>The main rechargeable battery is sufficiently charged.</td>
<td>&gt; 20 %</td>
</tr>
<tr>
<td><img src="image" alt="Yellow Icon" /></td>
<td>Yellow</td>
<td>The charge is low. The main rechargeable battery must be charged or replaced.</td>
<td>6% to 20 %</td>
</tr>
<tr>
<td><img src="image" alt="Red Icon" /></td>
<td>Red</td>
<td>The charge is very low. The main rechargeable battery must be charged or replaced.</td>
<td>&lt; 6 %</td>
</tr>
</tbody>
</table>
9.6 Device-specific displays

9.6.2 Displaying WLAN quality

The "WLAN quality" object indicates the signal strength of the wireless network at the location of the HMI device. The HMI device measures the signal strength and depicts it with the "WLAN quality" object.

Requirement

A connection was successfully set up between the HMI device and access point.

"WLAN quality" object

The signal strength of wireless network is indicated by the "WLAN quality" object as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Signal strength</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="No signal icon" /></td>
<td>No wireless connection</td>
<td>No signal</td>
</tr>
<tr>
<td><img src="image" alt="Very weak signal icon" /></td>
<td>Very weak wireless signal</td>
<td>≤ 20 %</td>
</tr>
<tr>
<td><img src="image" alt="Weak signal icon" /></td>
<td>Weak wireless signal</td>
<td>&gt; 20 %</td>
</tr>
<tr>
<td><img src="image" alt="Sufficient signal icon" /></td>
<td>Sufficient strength of the wireless signal</td>
<td>≤ 40 %</td>
</tr>
<tr>
<td><img src="image" alt="Strong signal icon" /></td>
<td>Strong wireless signal</td>
<td>&gt; 40 %</td>
</tr>
<tr>
<td><img src="image" alt="Very strong signal icon" /></td>
<td>Very strong wireless signal</td>
<td>&gt; 80 %</td>
</tr>
</tbody>
</table>

Note

A WLAN quality of at least 60% is required for operating and monitoring.
9.6.3 Display "zone name" object

The "Zone name" object shows the names of the zone in which the HMI device is currently located.

The zone is displayed by the "zone label" object as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Zonename]</td>
<td>The HMI device is within the indicated zone.</td>
</tr>
<tr>
<td>![gray]</td>
<td>The HMI device is not inside any zone.</td>
</tr>
</tbody>
</table>

9.6.4 Display "zone quality" object

The "zone quality" object shows if the HMI device is in the center of the zone or at the edge of the zone. Unlike with "WLAN quality", the HMI device does not measure signal strength. The HMI device calculates the quality of the wireless signal from the distance between it and the assigned transponders.

The "Zone name" object indicates which zone this concerns.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Quality</th>
</tr>
</thead>
<tbody>
<tr>
<td>![zone]</td>
<td>The HMI device is within a zone.</td>
<td>&gt; 15 %</td>
</tr>
<tr>
<td>![zone]</td>
<td>The HMI device is at the limits of a zone.</td>
<td>1% to 15%</td>
</tr>
<tr>
<td>![gray]</td>
<td>The HMI device is not within any zone.</td>
<td>0 %</td>
</tr>
</tbody>
</table>

9.7 Project security

9.7.1 Overview

Design of the security system

The configuration engineer can protect the operation of a project by implementing a security system. The security system is based on authorizations, user groups and users.

If operator controls protected by a password are pressed, the HMI device first requests that you log on. A logon screen is displayed in which you enter your user name and password. After logging on, you can press the operator controls for which you have the necessary authorizations.
The logon dialog can be set up by the configuration engineer via an individual operator control. Similarly, an operator control can be configured for logoff. After logging off, objects with password protection can no longer be operated – you need to log on again.

Refer to your plant documentation for additional information.

Central user administration using SIMATIC Logon

Users, user groups and authorizations can be stored on a central server.

If user administration cannot contact the server, an error message is displayed. If this is the case, you can only log on locally. More detailed information is available in your plant documentation.

The operation of SIMATIC Logon differs as follows:

- The simple user display is not supported
- Users cannot be deleted
- You cannot change your logout time
- When changing the password, you must enter it twice for security reasons
- The domain name is also indicated in the "User" field

User groups and authorizations

Project-specific user groups are created by the configuration engineer. The "Administrators" and "PLC User" groups are included in all projects by default. User groups are assigned authorizations. Authorization required for an operation is specifically defined for each individual object and function in the project.

Users and passwords

Each user is assigned to exactly one user group.

The following persons are allowed to create users and assign them passwords:

- The configuration engineer during configuration
- The administrator on the HMI device
- A user with user management authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.

Logoff times

A logoff time is specified in the system for each user. If the time between any two user actions, such as entering a value or changing screens, exceeds this logoff time, the user is automatically logged off. The user must then log on again to continue to operate objects assigned password protection.
Backup and restore

Note
Backup and restore is not available to central user administration with SIMATIC Logon.

The user data is encrypted and saved on the HMI device to protect it from loss due to power failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be backed up and restored. This prevents you having to enter all of the data again on another HMI device.

**NOTICE**

The currently valid user data is overwritten in the following cases:
- Depending on the transfer settings, when the project is transferred again
- Upon restore of a backed-up project
- Upon import of the user administration via an operator control.
  
  More detailed information is available in your plant documentation.

The retransferred or restored user data and passwords are valid with immediate effect.

Number of characters for user, password and user view

<table>
<thead>
<tr>
<th>Number of characters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Length of user name, maximum</td>
<td>40</td>
</tr>
<tr>
<td>Length of password, minimum</td>
<td>3</td>
</tr>
<tr>
<td>Length of password, maximum</td>
<td>24</td>
</tr>
<tr>
<td>Entries in user view, maximum</td>
<td>50</td>
</tr>
</tbody>
</table>
9.7 Project security

9.7.2 User View

The user view is used to show user accounts configured on the HMI device.

- If you are an administrator or a user with administrator rights, you can see all user accounts configured on the HMI device in the user view.
- If you are a user without user management rights, you can only see your personal user account.

The authorizations of a user after logging on depends on the user group to which the user belongs.

More detailed information is available in your plant documentation.

A simple or extended user view can be configured in the project. The two user views offer the same functions. The presentation of information differs.

Simple user view

If you are not logged onto the HMI device, the only entry contained in the simple user view is "<ENTER>".

If you are logged onto the HMI device, the simple user view only displays the user name and user group.

<table>
<thead>
<tr>
<th>Admin</th>
<th>Group (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC User</td>
<td>Group (1)</td>
</tr>
<tr>
<td>User 1</td>
<td>Group (1)</td>
</tr>
<tr>
<td>&lt;new user&gt;</td>
<td></td>
</tr>
</tbody>
</table>

Extended user view

The extended user view displays information about the users.

<table>
<thead>
<tr>
<th>User</th>
<th>Password</th>
<th>Group</th>
<th>Logoff time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td>**********</td>
<td>Group (1)</td>
<td>5</td>
</tr>
<tr>
<td>PLC User</td>
<td>**********</td>
<td>Group (1)</td>
<td>5</td>
</tr>
<tr>
<td>User 1</td>
<td>**********</td>
<td>Group (1)</td>
<td>5</td>
</tr>
</tbody>
</table>

The extended user view contains the following columns:

- Users
- Password
- Group
- Logoff time
9.7.3 User logon

Use the logon dialog of the HMI device to log onto the security system. Enter your user name and password in the logon dialog.

The logon dialog opens in the following cases:

- You press an operator control with password protection
- You press an operator control that was configured for displaying the logon dialog
- Select the "<ENTER>" entry in the simple user view
- Select a blank entry in the extended user view
- The logon dialog will be automatically displayed when the project is started, depending on the configuration

More detailed information is available in your plant documentation.

Requirement

- The logon dialog is open.

Procedure

Proceed as follows:

1. Enter the user name and password.
   Touch the corresponding text box. The alphanumerical screen keyboard is displayed.
   
   **Note**
   The user name is not case-sensitive.
   The password is case-sensitive.

2. Select "OK" to confirm logon.

Result

After successful logon to the security system, you can execute password-protected functions on the HMI device for which you have authorizations.

If you enter a wrong password, an error message is displayed when an alarm window has been configured.
9.7 Project security

9.7.4 User logoff

Requirement

- You have logged into the security system of the HMI device.

Procedure

You have the following options for logging off:

- Press an operator control that is configured for logging off the security system.
- If you do not operate a project and exceed the logoff time, your user account will be locked.

Your user account will be automatically logged off if you enter an incorrect password.

Result

You are no longer logged onto the project. In order to use an operator control in the security system, you need to log on again.

9.7.5 Creating users

You create a user with both the simple and enhanced user display.

Requirement

- A configured screen with user display is shown.
- You have user management authorization or you are the administrator.

Note

The following characters are prohibited in passwords:

- Blank
- Special characters * ? . % / "
Procedure – Creating a user in the simple user view

Proceed as follows:

1. Touch the "<New User>" entry in the user view.
   The following dialog appears:

   ![User dialog]

2. Enter the desired user name and password.
   Touch the corresponding text box. The alphanumerical screen keyboard is displayed.

3. Touch the "OK" button.
   The following dialog appears:

   ![Group dialog]

4. Assign the user to a group.
   In order to do so, open the "Group" drop down list box by means of the ▼ button. Select ▲ and ▼ to scroll in the drop down list box.

5. Touch the required entry in the drop down list box.
   The selected entry is then accepted as input.

6. Touch the text box "Logoff time".
   The screen keyboard is displayed.

7. Enter a value between 0 and 60 for the logoff time in minutes.
   The value 0 stands for "no automatic logoff."

8. Touch the "OK" button to confirm your entries.
Procedure – Creating a user in the extended user view

Proceed as follows:

1. Double-click the desired field in the blank line of the user view.
   The screen keyboard is displayed.
2. Enter the respective user data in the field:
   - Assign the user to one of the groups from the drop down list box.
   - Enter a value between 0 and 60 for the logoff time in minutes.
     The value 0 stands for "no automatic logoff."

Result

The new user is created.

9.7.6 Changing user data

You have opened a screen with a user view. The data you are allowed to change depends on your authorization:

Requirement

- You are an administrator or a user with user management authorization.
  In these cases you are allowed to change the data for all the users on the HMI device in the user view:
  - User name
  - Group assignment
  - Password
  - Logoff time

- You are a user without user management authorization.
  In this case you are only allowed to change your personal user data:
  - Password
  - Logoff time, if configured

Note

You can only change the logoff time and password for the "Admin" user.
You can only change the logoff time for the "PLC_User". This user is used for logging on via the PLC
Procedure

The procedure applies to simple and extended user view alike.

Proceed as follows:
1. In the user view, touch the user whose user data you want to change
2. When entering the data, use exactly the same procedure as for creating a user

Result

The user data for the user is changed.

9.7.7 Deleting users

Requirement

- You have opened a screen with a user view.
- You are an administrator or you have permission for user management.

Procedure

Note

The "Admin" and "PLC_User" users exist by default. You cannot delete these users.

1. Delete the entered user name.

Result

The affected user can no longer use the operator controls with permission.

9.8 Function keys

Function key assignment is defined during configuration. The configuration engineer can assign function keys globally and locally. The local assignment function takes priority over the global setting.

Function keys with global function assignment

A globally assigned function key always triggers the same action on the HMI device or in the PLC irrespective of the screen displayed. Such an action is, for example, the enabling of an image. Exception: Function keys are inactive, while a safety-related message is displayed.
Function keys with local function assignment

A function key with local function assignment is screen-specific and is therefore only effective within the active screen. The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one.

The configuration engineer can assign function keys in such a way so that you can operate an operating element with a function key. This includes, for example, the alarm view, trend view, recipe view or status/PLC.

Multi-key operation

Unwanted actions may be triggered, if the operator unintentionally actuates a key combination.

⚠️ CAUTION

Unintentional actions
In "Online" mode, simultaneous operation of more than two keys may cause unintentional actions in the plant.

Do not press more than two keys simultaneously

9.9 Bar

The bar is a dynamic display object. The bar displays a value from the PLC as a rectangular area. A bar eases the recognition of:

- Distance of the current value from the configured limit value
- A set point value has been reached

The bar can display values such as fill levels or batch counts.

The layout of the bar depends on the configuration:

- The bar may feature a scale of values
- A configured limit can be marked through a line.
- A color envelope can signalize a limit being exceeded or not reached.
9.10 Gauge

The gauge is a dynamic display object. The gauge displays numerical values in analog form by means of a pointer. This enables an operator at the HMI device to see at a glance if the boiler pressure is in the normal range, for example.

The layout of the gauge depends on the configuration:

- A trailing pointer can display the maximum value reached so far on the scale. The trailing pointer is reset when the screen is reloaded.
- The label on the scale can show the measured variable, for example boiler pressure and the physical unit, for example bar.

9.11 Operating the slider control

The slider control can be used to monitor and change process values within a defined range. The slider control can also be configured without a slider. In this case, you cannot enter a value. The slider control is then only used for displaying values.

The layout of the slider control depends on the configuration:

- The slider control can contain a label and a setting range.
- The current value can be displayed in the value display below the area of the slider control.
9.12 Operating the switch

The switch is an operating element and display object with two predefined switching states, for example "On" and "Off". Switches can signalize the state of a plant section, for example if a motor is running or not. At the same time, you can use the switch to change the state of the corresponding plant section via the HMI device, for example from "On" to "Off".

The layout of the switch depends on the configuration:

- **Switch with slider**
  The two states are displayed by the position of the slider

- **Switch with text or graphic**
  The switch states can be labeled with text or graphics.

<table>
<thead>
<tr>
<th>Switch state 0</th>
<th>Switch state 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backward</td>
<td>Up</td>
</tr>
</tbody>
</table>

**Procedure - Switch with Slider**

1. Move the slider to the other position or double-click the slider area
   The switch changes its appearance. The associated value is switched.

**Procedure - Slider with Text or Graphic**

1. Touch the switch
   The switch changes its appearance. The associated value is switched.
9.13 Operating the Trend View

Trends continuously display the current process data or process data from a log. The layout and operation of the trend view depends on the configuration. The following can be configured:

- Appearance of the trend view, the axes, value ranges and labels
- Operating options of the trend view
- Limits for the trend view
- Display of a limit violation through a color change

A trend view can display several trends.

You can read the respective trend values from the value table.

- If the ruler is displayed
  The trend value of the position of the ruler displayed in the value table.
- If the ruler is hidden
  The newest trend values are displayed in the value table.

Operating buttons

The following elements of the trend view can be operated:

- Time interval - enlarge or reduce
- Display area - scroll forward or back
- Trend display - stop or continue
- Ruler - move
- Ruler - display or hide.

The following table shows the trend view buttons:
### Operating the Trend View

#### Button Key combination Function

<table>
<thead>
<tr>
<th>Button</th>
<th>Key combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Stops or continues trend recording.</td>
</tr>
<tr>
<td></td>
<td>CTRL + Z</td>
<td>Enlarges the displayed time section.</td>
</tr>
<tr>
<td></td>
<td>CTRL + -</td>
<td>Reduces the displayed time section.</td>
</tr>
<tr>
<td></td>
<td>SHIFT +  ←</td>
<td>Scrolls one display area backward (to the left).</td>
</tr>
<tr>
<td></td>
<td>SHIFT +  →</td>
<td>Scrolls one display area forward (to the right).</td>
</tr>
<tr>
<td></td>
<td>CTRL + ENTER</td>
<td>Scrolls back to the beginning of the trend recording. The start values of the trend recording are displayed there.</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT +  ←</td>
<td>Moves the ruler backward (to the left).</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT +  →</td>
<td>Moves the ruler forward (to the right).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shows or hides the ruler.</td>
</tr>
</tbody>
</table>

Moreover, function keys or operating elements can be configured for the operation of the trend display. Refer to your plant documentation for additional information.

#### Procedure - touch operation

Proceed as follows:

1. Touch the required button in the trend view.
2. Touch and drag the ruler.
   The size of the ruler changes.

#### Procedure - touch operation

Proceed as follows:

1. Open the desired button using the TAB key.
2. Press the ENTER key.
9.14 Operating the status force

You read or write access values of the connected PLC directly with Status Force. Status force allows you to monitor or change addresses of the PLC program, etc. You don't need to connect an additional programming device or additional PC to the PLC.

Note
Status force can only be used in combination with SIMATIC S7.

With status/control, you can:

- Change the column sequence
- Read the status values of the connected controller
- Enter values and transfer them to the controller

The layout of Status Force depends on the configuration. The figure shows the general layout of Status Force. A value can be monitored or controlled on every line.

The configuration engineer specifies which columns appear in Status Force. The table shows the significance of all configurable columns.

<table>
<thead>
<tr>
<th>Column</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Connection&quot;</td>
<td>The PLC whose address ranges must be displayed.</td>
</tr>
<tr>
<td>&quot;Type&quot;, &quot;DB Number&quot;, &quot;Offset&quot;, &quot;Bit&quot;</td>
<td>The address range of the value</td>
</tr>
<tr>
<td>&quot;Data type&quot;, &quot;Format&quot;</td>
<td>The data type of the value</td>
</tr>
<tr>
<td>&quot;Status value&quot;</td>
<td>The value read from the specified address.</td>
</tr>
<tr>
<td>&quot;Control value&quot;</td>
<td>The value to be written to the specified address.</td>
</tr>
</tbody>
</table>

Refer to your plant documentation for additional information.
Operating a project

9.14 Operating the status force

Operating buttons

Depending on your configuration, you can operate the trend view using the following buttons:

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Read button" /></td>
<td>&quot;Read&quot; button&lt;br&gt;Updates the display in the &quot;Status value&quot; column.&lt;br&gt;This button engages when it is pressed. You cannot operate any text boxes until the button is actuated again and the refresh is stopped.</td>
</tr>
<tr>
<td><img src="image" alt="Write button" /></td>
<td>&quot;Write&quot; button&lt;br&gt;Applies the new value in the &quot;Control value&quot; column. The control value is written to the PLC.</td>
</tr>
</tbody>
</table>

Procedure - changing the column sequence

Proceed as follows:
1. Touch the column header which you wish to exchange with a different column header
2. Keeping the touch screen pressed, move the column heading to the column heading you wish to exchange it with
   The columns are displayed in the modified sequence.

Procedure for reading the status value

Proceed as follows:
1. Enter the address and the desired format of a value for each line. Touch the respective columns to display the screen keyboard.
2. Press ![Read button](image).
   All values are read cyclically by the PLC and entered in the "Status value" column.
3. Touch ![Read button](image) button.
   The cyclical reading from the PLC is completed.

Requirement - controlling values

- The "Control value" column must be available
- The "Write" button must be available
Procedure

Proceed as follows:
1. Enter the address of a value for each line.
2. Touch the corresponding column.
   The screen keyboard is displayed.
3. Enter the desired value in the "Control value" column.
4. Press \[ \text{button} \].
   The values from the "Control value" column are transferred once to the PLC.

9.15 Operating the Sm@rtClient view

The Sm@rtClient view enables you to monitor and remotely operate the current project of a remote HMI device. With the correct configuration, several equal priority HMI devices can access a remote HMI device.

Note
If another HMI device accesses your HMI device via the Sm@rtClient view, this leads to an additional load on your HMI device.

The Sm@rtClient view can be operated as follows:

- Starting remote control
- Forcing permission
- Ending remote operation

In the Sm@rtClient view, the remote HMI is displayed with the complete layout. Depending on the configuration, you can monitor and also operate this screen. You can also operate the function keys like buttons on an HMI device with a touch screen.

On a Sm@rtClient view which is configured for monitoring mode, you can monitor the affected HMI device. You cannot access to control.

Note
It is not possible to operate the direct keys of the remote HMI device from the local HMI device.
The available operator controls depend on the HMI devices used:

- **Same type of HMI devices**
  
  You can operate the project of the remote HMI device with the operator controls of your HMI device.

- **Button operation from a local touchscreen**
  
  All the keys of the remote HMI device are displayed as buttons on the touch screen. You can touch them to operate them.

- **Touch operation from a local HMI device using keys**
  
  You operate the buttons in the usual manner.

**Procedure - starting remote control**

Proceed as follows:

1. On the HMI device change to the screen with the Sm@rtClient view.
   
   The following options are available for establishing the connection to the remote HMI device:
   
   - The connection is established automatically.
   
   - The connection must be established by touching the appropriate button.

   Depending on the configuration, you may be required to enter the address of the remote HMI device and a password.

   **NOTICE**

   **Unencrypted password transmission with http**

   If a password is stored in the configuration, this password can be transmitted without encrypting.

   In order to transmit the password in an encrypted manner, operate Sm@rtService and Sm@rtAccess through a secured protocol, for example, vpn or https.

2. The current screen of the project running on the remote device is displayed on the screen of your HMI device.

3. You can now monitor and control this screens according to your configuration.

   Scroll bars are displayed if the screen of the remote HMI device is larger than that of the current HMI device.

**Forcing permission**

If several HMI devices have access to a HMI device, only one HMI device has operating permission at any one time.
Two cases must be distinguished for this calculation:

- If another HMI device is already controlling the remote HMI device, if configured accordingly, you can force operating permission for the remote HMI device
  - You are trying to operate the remote HMI device
    A dialog box opens.
  - Enter the required password for forcing remote operation.
    You are now authorized to operate the remote HMI device

- If another HMI device is accessing your HMI device via the Sm@rtClient view, you can force local operating permission for your HMI device
  - Touch the screen of your HMI device five times consecutively
    You are given permission to operate your local HMI device

Procedure - ending remote control

The steps depend on the project. Refer to your plant documentation for additional information.

In general - proceed as follows:
1. Touch a button configured for this action
2. Exit the screen containing the Sm@rtClient view
3. Touch an operating element operating position for a longer period of time.
   This opens a menu.
4. Select the "Close" menu command.

---

9.16 Operate alarm view and alarm window

9.16.1 Overview

Alarms

Alarms indicate events and states on the HMI device which have occurred in the system, in the process or on the HMI device itself. A status is reported when it is received.

An alarm could trigger one of the following alarm events:

- Incoming
- Outgoing
- Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user.
An alarm may contain the following information:

- Date
- Time
- Alarm text
- Location of fault
- State
- Alarm class
- Alarm number
- Alarm group
- Diagnostics capability

### Alarm classes

Alarms are assigned to various alarm classes:

- **Error**
  
  Alarms in this class must always be acknowledged. Error alarms normally indicate critical errors within the plant such as "Motor temperature too high"

- **Operation**
  
  Warning alarms usually indicate states of a plant such as "Motor switched on"

- **System**
  
  System alarms indicate states or events which occur on the HMI device

- **SIMATIC diagnostic alarms**
  
  SIMATIC diagnostic alarms show states and events of the SIMATIC S7 or SIMOTION PLCs

- **User-specific alarm classes**
  
  The properties of this alarm class must be defined in the configuration

More detailed information is available in your plant documentation.

### Alarm groups

The configuration engineer can group alarms into alarm groups. When you acknowledge an individual alarm of an alarm group, you acknowledge all alarms which belong to the same alarm group.

### Alarm buffer

The alarm events are stored in an internal buffer. The size of this alarm buffer depends on the HMI device type.
Alarm report

The configuration engineer can activate alarm reporting on the project. In this case, alarm events are output directly on the connected printer.

The configuration engineer can define whether each individual alarm is logged. An alarm of this type is printed when the alarm events "Incoming" and "Outgoing" occur.

If you want to print alarms of the "System" alarm class, you have to print the contents of the associated alarm buffer. For this case the configuration engineer has to configure an operating element for printing the alarm buffer.

Alarm log

Alarm events are stored in an alarm log, provided this log file is configured. The capacity of the log file is limited by the storage medium and system limits.

9.16.2 Recognizing pending alarms

You can recognize pending alarms that must be acknowledged by means of the alarm indicator.

The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring acknowledgment, depending on the configuration. The configuration determines whether an alarm has to be acknowledged or not. This is also defined by the alarm class which an alarm belongs to.

The following image shows an alarm indicator for three pending alarms.

The alarm indicator flashes as long as alarms are pending for acknowledgment. The number displayed indicates the number of pending alarms. The configuration engineer can assign functions to be executed when the alarm indicator is operated.

Usually, the alarm indicator is only used for error alarms. More detailed information is available in your plant documentation.
9.16.3 Alarm view

9.16.3.1 Overview

Alarms are displayed in the alarm view or in the alarm window on the HMI device. The message window, in contrast to the message display, is independent of the displayed process image.

9.16.3.2 Displaying alarms

Alarm view

Depending on the configuration, the alarm view is displayed as follows:

- As a single line.
  
  Alarm numbers and alarm texts are displayed as single lines.
- As simple alarm view
- As extended alarm view

For the configuration, which information is displayed for which messages are displayed for the simple and expanded message displays.

Depending on the configuration, alarms from alarm logs are also displayed in the alarm view.

Simple alarm view

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button]</td>
<td>![Display infotexts for an alarm]</td>
</tr>
<tr>
<td>![Button]</td>
<td>![Edit alarm]</td>
</tr>
<tr>
<td>![Button]</td>
<td>![Acknowledge alarm]</td>
</tr>
<tr>
<td>![Button]</td>
<td>![Select the next or previous alarm in the list]</td>
</tr>
<tr>
<td>![Button]</td>
<td>![Scroll one page up or down]</td>
</tr>
</tbody>
</table>
Extended alarm view

<table>
<thead>
<tr>
<th>No.</th>
<th>Time</th>
<th>Date</th>
<th>Status</th>
<th>Alarm Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12:04:59</td>
<td>19.04.2005</td>
<td>K</td>
<td>Motor 23 too hot</td>
</tr>
</tbody>
</table>

The buttons have the following function:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Display infotexts for an alarm</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Edit alarm</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Acknowledge alarm</td>
</tr>
</tbody>
</table>

Alarm class icons

In order to label the different alarm classes, icons can be configured.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Alarm class</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Error</td>
</tr>
<tr>
<td>Without a symbol</td>
<td>Operation</td>
</tr>
<tr>
<td>Symbol depending on the project</td>
<td>User-defined alarm classes</td>
</tr>
<tr>
<td>S7</td>
<td>SIMATIC or SIMOTION diagnostic alarm</td>
</tr>
<tr>
<td>$</td>
<td>System</td>
</tr>
</tbody>
</table>

Refer to your plant documentation for additional information.

Procedure - change column sequence in the expected alarm display

Depending on the project, you can change the column sequence for messages on the HMI device.

Proceed as follows:

1. Touch the column header which you wish to exchange with a different column header.
2. Keeping the touch screen pressed, move the column heading to the column heading you wish to exchange it with.

The column sequence of the messages is changed.

Procedure - change sorting in the expected alarm display

Depending on the project, you can change the sorting for messages on the HMI device.
**Operating a project**

### 9.16 Operate alarm view and alarm window

**9.16.3.3 Display alarm window**

The alarm window is independent of the process screen. Depending on the configuration, the alarm window opens automatically as soon as a new alarm is pending for acknowledgment. The alarm window can be configured so that it only closes after all the alarms have been acknowledged.

The layout and the operation of the alarm window are the same as for the alarm view. Refer to your plant documentation for additional information.

### 9.16.4 Display infotexts for an alarm

**Introduction**

An alarm can be assigned an infotext.

**Procedure**

Proceed as follows:

1. Touch the desired alarm in the alarm view or the alarm window. The alarm is selected.
2. Touch the button in the simple alarm view or in the extended alarm view. A dialog with configured infotext is displayed.
3. Press The dialog box closes.

### 9.16.5 Acknowledge alarm

**Introduction**

Depending on the project, an alarm can be acknowledged with a function key or with a button in the alarm display or in the alarm window.

More detailed information is available in your plant documentation.

**Requirement**

- The alarm to be acknowledged is displayed in the alarm window or the alarm view.
**Procedure**

Proceed as follows:

1. Touch the desired alarm in the alarm view or the alarm window.
   The alarm is selected.
2. Touch the \[\text{I}\] button in the simple alarm view or \[\text{I}\] in the extended alarm view.

**Result**

The alarm was acknowledged. If the alarm belongs to an alarm group, all the alarms of the associated group were acknowledged.

### 9.16.6 Edit alarm

**Introduction**

The configuration engineer can assign additional functions to each alarm. These functions are executed when the alarm is processed.

---

**Note**

When you edit an unacknowledged alarm, it is acknowledged automatically.

**Requirements**

- The alarm to be edited is displayed in the alarm window or the alarm view.

**Procedure**

Proceed as follows:

1. Touch the desired alarm in the alarm view or the alarm window.
   The alarm is selected.
2. Touch the \[\text{I}\] button in the simple alarm view or \[\text{I}\] in the extended alarm view.

   The system executes the additional functions of the alarm. Refer to your plant documentation for additional information.
9.17 Operating recipes

9.17.1 Overview

Introduction
Recipes are used when different variants of a product are manufactured with the same process. In this case, the product variants differ in terms of their type and quantity of the components, but not in terms of the manufacturing process sequence. The configuration engineer can store the combination of each individual product variant in a recipe.

Field of application
Recipes can be used everywhere the same product components are used in variable combinations to create different product variants.

Examples:
- Beverage industry
- Food processing industry
- Pharmaceutical industry
- Paint industry
- Building materials industry
- Steel industry

9.17.2 Structure of a recipe

Recipes
The recipe collection for the production of a product family can be compared to a file cabinet. A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet.

Example:
In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe, for example, for the flavors orange, grape, apple and cherry.
Recipe data records

The drawers of the file cabinet are filled with suspension folders. The suspension folders in the drawers represent records required for manufacturing various product variants.

Example:

Product variants of the flavor apple might be a soft drink, a juice or nectar, for example.

<table>
<thead>
<tr>
<th>Drawer</th>
<th>Recipe</th>
<th>Product variants of apple flavored drinks</th>
</tr>
</thead>
<tbody>
<tr>
<td>② Suspension folder</td>
<td>Recipe data record</td>
<td>Apple drink</td>
</tr>
<tr>
<td>③ Suspension folder</td>
<td>Recipe data record</td>
<td>Apple nectar</td>
</tr>
<tr>
<td>④ Suspension folder</td>
<td>Recipe data record</td>
<td>Apple juice</td>
</tr>
</tbody>
</table>
Elements

In the figure showing the file cabinet, each suspension folder contains the same number of sheets. Each sheet in the suspension folder corresponds to an element of the recipe data record. All the records of a recipe contain the same elements. The records differ, however, in the value of the individual elements.

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The records for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in production.

9.17.3 Recipes in the Project

Overview

If recipes are used in a project, the following components interact:

- Recipe view / recipe screen
  On the HMI device, recipes are displayed and edited in the recipe view or in a recipe screen.
  - The recipe data records from the internal memory of the HMI device are displayed and edited in the recipe view.
  - The values of the recipe tags are displayed and edited in the recipe screen.
  Depending on the configuration, the values displayed in the recipe view are synchronized with the values of recipe tags.

- HMI device recipe memory
  Recipes are saved in the form of data records in the HMI device recipe memory.
The recipe data can also be saved in recipe tags.

- Recipe tags
  The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe values are stored in recipe tags. Depending on the configuration, the values of the recipe tags are exchanged with the PLC.
The recipe tags can be synchronized with the recipe data records so that the same values are saved in both.

- External memory medium
  The memory cards or USB sticks are external memory media for recipe data records. The recipe data records are exported from the HMI device recipe memory and are saved on the external memory medium in a *.csv file. The records can be reimported from the external memory medium to the recipe memory.
Data flow

The following figure shows the data flow in a project with recipes.

1. Editing, saving or deleting a recipe data record
2. Display recipe data record
3. Synchronize or do not synchronize recipe tags
4. Display and edit recipe tags in the recipe screen
5. Write records from the recipe view to the PLC or read records from the PLC and display them in the recipe view
6. Recipe tags are sent to the PLC online or offline
7. Export or import recipe data record to external memory medium.

9.17.4 Recipe displays

Displaying recipes

You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view

A recipe view is a screen object used to manage recipe data records. The recipe view shows recipe data records in tabular form.

Depending on the configuration, the recipe view is displayed as follows:

- As extended recipe view
- As simple recipe view

The configuration engineer also defines which operator controls are displayed in the recipe view.
Extended recipe view

The following figure shows an example of the extended recipe view.

① Selection box for the recipe
② Selection box for the recipe data record
③ Element name
   The element name designates a specific element in the recipe data record
④ Display field
   This show the number of the selected recipe or the selected recipe data record
⑤ Value of the element
⑥ Buttons for editing a recipe data record
⑦ Status bar for display of the status messages

Simple recipe view

The simple recipe view consists of three areas:

- Recipe list
- Data record list
- Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on the configuration, the simple recipe view starts with the recipe list or data record list.
The following figure shows an example of the record list.

1. Number of the recipe data record
2. Recipe data records
3. Buttons for changing the displayed list and calling the menu

Display of values

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Changing the recipe data record in the background</strong></td>
</tr>
<tr>
<td>Applies to the processing of a recipe data record:</td>
</tr>
<tr>
<td>If values of the corresponding recipe data record are changed by a PLC job, the recipe view is not updated automatically.</td>
</tr>
<tr>
<td>To update the recipe view, reselect the respective recipe data record.</td>
</tr>
</tbody>
</table>

Recipe screen

A recipe screen allows the correlation between the plant and the recipe data to be displayed in graphic form. The configuration engineer combines I/O fields and screen objects to form a custom input screen. The configuration engineer can distribute the I/O fields of a recipe over several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe screen can be operated using buttons configured accordingly.
9.17 Operating recipes

The following figure shows an example of the recipe screen.

1. Element name and associated values
   The element name designates a specific element in the recipe data record
2. Buttons for editing a recipe data record
3. Modified recipe view
4. Buttons for transferring recipe data

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe values are exchanged with the PLC immediately or later via these tags.

A configured recipe view can itself be a component of a recipe screen. You must synchronize the tags in order to synchronize data between the tags of the recipe screen and the recipe data records displayed in the recipe view. Synchronization of tags is only possible in the extended recipe view.

More detailed information is available in your plant documentation.

9.17.5 Recipe Values in the HMI Device and the PLC

Introduction

You can change the values of a recipe on the HMI device. The production process can be controlled by this.

Depending on the configuration, the recipe values are displayed, edited and saved in different ways:

- If you are editing recipes with a recipe view in your project, the values are saved in recipe data records.
- If you are editing recipes in a recipe screen in your project, the values are saved in recipe tags.

Differences may occur between the display values in the recipe view and the values saved in the associated tags in an ongoing project when you edit recipes with a recipe view and in a recipe screen. To prevent this, the recipe data record values must be synchronized with the values of the recipe tags.
You have however the option to perform synchronization operations at any time. Synchronization only takes place if the configuration engineer has activated the respective settings for a recipe.

**Note**
Recipe tags can only be synchronized in the extended recipe view.

### Synchronizing recipe tags

Synchronization of the recipe tags depends on the configuration:

- **Automatic synchronization**
  
The values of the recipe view are synchronized with the associated recipe tags. In this case, changes to values in the recipe view have an immediate effect on the values of the associated recipe tags. The values are only synchronized, when an operating element that is outside the recipe view is operated.

- **Synchronization by the user**
  
The values of the recipe view and the associated recipe tags are not synchronized automatically. The configuration engineer has assigned the same function to the button or a different operating element in the recipe view. The recipe tags and the recipe view are only synchronized when you operate the buttons or the appropriate operating element.

### Recipe tags online / offline

The configuration engineer can configure a recipe so that changes to the values of the recipe tags do not have an immediate effect on the current process.

Synchronization of the recipe values between the HMI device and the PLC depends on whether the configuration engineer has selected the settings "Tags online" or the setting "Tags offline" for a recipe.

- **"Tags online:"**
  
  This setting has the following effect:
  
  - When you change recipe values in the recipe screen, these changes are applied immediately by the PLC and immediately influence the process.
  
  - If recipe values are changed in the PLC, the changed values are displayed immediately in the recipe screen.

- **"Tags offline"**
  
  With this setting, changed recipe values are not synchronized immediately between the HMI device and the PLC.

  In this case, the configuration engineer must configure operating elements for transferring the values to the PLC or reading them from the PLC in a recipe screen. The recipe values are only synchronized between HMI device and PLC when you operate the appropriate operating element.
9.17.6 Operating the recipe view

9.17.6.1 Overview

Operating the recipe view

The recipe view can be operated as follows:

- Enter values for the recipe elements
- Create recipe data records
- Save recipe data records or save them under a new name
- Delete recipe data records
- Synchronize values of the recipe view with the associated recipe tags
- Transfer recipe data records from the PLC and to the PLC

Operator controls of the recipe view

The following table shows the operator controls of the recipe view.

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create new recipe data record" /></td>
<td>Creates a new recipe data record. If a start value is configured, it is shown in the text box.</td>
</tr>
<tr>
<td><img src="image" alt="Save displayed values of recipe data record" /></td>
<td>Saves the displayed values of the recipe data record. The storage location is predefined by the project.</td>
</tr>
<tr>
<td><img src="image" alt="Recipe data record saved under different name" /></td>
<td>The recipe data record is saved under a different name irrespective of the recipe view. A dialog box opens in which the name is entered.</td>
</tr>
<tr>
<td><img src="image" alt="Delete displayed recipe data record" /></td>
<td>The displayed recipe data record is deleted.</td>
</tr>
<tr>
<td><img src="image" alt="Synchronize values" /></td>
<td>The values of the recipe view are synchronized with the associated recipe tags. The values changed during editing are written to the associated recipe tags. Subsequently all the values of the tags are read out and updated in the table.</td>
</tr>
<tr>
<td><img src="image" alt="Recipe values from PLC" /></td>
<td>The recipe values from the PLC are displayed in the recipe view.</td>
</tr>
<tr>
<td><img src="image" alt="Recipe values transferred" /></td>
<td>The values of the set recipe data record displayed in the recipe view are transferred to the PLC.</td>
</tr>
</tbody>
</table>

Operating the recipe screen

You operate the recipes in a recipe screen with the operator controls provided by the configuration engineer.

More detailed information is available in your plant documentation.
9.17.6.2 Creating a recipe data record

Introduction

You create a new recipe data record by modifying an existing record. You then save the modified data record under a new name.

Requirements

- A screen with a recipe view is displayed

Procedure

Proceed as follows:

1. Select the recipe for which you want to create a new recipe data record.

2. Touch.

   A new recipe data record with the next available number is created.
   If you change the new data record number to an existing data record number, the existing data record is overwritten.

3. Enter values for the elements of the data record.
   The elements of the recipe data record can be assigned default values depending on the configuration.

4. Touch.

5. Enter a name for the data record.
   The data record is saved under the new name.
   If the recipe data record already exists, a dialog is opened. In this dialog, specify whether the existing data record is to be overwritten.

Result

The created recipe data record is saved to the selected recipe.
9.17.6.3 Editing a recipe data record

Introduction
Edit the values of the recipe data records and save them in a recipe view.

Synchronization with the PLC
If you want to display the current recipe values from the PLC in the recipe view, you first have to read the current values from the PLC with 🔄. The values changed in the recipe view only become effective when the amended data record is transferred to the PLC by means of the 🔄 button.

Requirements
- A screen with a recipe view is displayed

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the desired recipe data record.
2. Select the recipe data record you want to change.
3. Change the data record as required.
4. Save your changes by means of the 🔄 button.
   If you want to save the recipe data record under a different name, touch the 🔄 key.
5. The recipe data record is saved.

Result
The edited recipe data record has now been saved in the selected recipe.
9.17.6.4 Deleting a recipe data record

Introduction
You can delete all the data records of a recipe which are not required.

Requirements
- A screen with a recipe view is displayed

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the desired recipe data record.
2. Select the recipe data record you want to delete.
3. Touch 

Result
The recipe data record is deleted.

9.17.6.5 Synchronizing tags

Introduction
The values of the recipe elements can be saved to recipe tags, depending on the configuration.

Differences may occur between the display values in the recipe view and the actual values of tags in an ongoing project. Synchronize the tags to equalize such differences.

Synchronization always includes all the variables which belong to a recipe data record.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changed tag name</td>
</tr>
</tbody>
</table>
Tags and the value of the recipe data record cannot be assigned to each other if the tag name of the tag to be synchronized has been changed. The tags in question are not synchronized.

| Note |
Recipe tags can only be synchronized in the enhanced recipe view.
9.17 Operating recipes

Requirements

- A screen with a recipe view is displayed

Procedure

Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the desired recipe data record.
2. Select the recipe data record you want to synchronize.
3. Touch 

Result

The elements of the recipe data record are synchronized with the recipe tags.
If the values of the recipe view and the tag do not match, the more current value is accepted.

9.17.6.6 Reading a recipe data record from the PLC

Introduction

In the current project, the values which are also stored in the recipes in the HMI device can be changed directly in the plant. This is the case, for example, if a valve was opened further directly at the plant than is stored in the recipe. The values of the recipe data records saved in the HMI device possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the recipe view.

Requirement

- A screen with a recipe view is displayed
Procedure

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired recipe data record.
2. Select the recipe data record to which you want to apply the values from the PLC.
3. Touch .
   The values are read from the PLC.
4. If you want to store the displayed values in the HMI device, touch the button.

Result

The values were read from the PLC, displayed on the HMI device and saved to the selected recipe data record.

9.17.6.7 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the values to the PLC.
The display values in the recipe view are always transferred to the PLC.

Requirements

- A screen with a recipe view is displayed

Procedure

Proceed as follows:

1. Select the recipe which contains the desired recipe data record.
2. Select the recipe data record whose values you want to transfer to the PLC.
3. Touch .

Result

The display values in the recipe view were transferred to the PLC and take effect in the process.
9.17.7 Operating the simple recipe view

9.17.7.1 Overview

Introduction

The simple recipe view consists of three areas:

- Recipe list
- Data record list
- Element list

You can use the context menu to operate each of these display areas.

Editing recipe display

The simple recipe view can be processed as follows:

- Enter values for the recipe elements
- Create recipe data records
- Save recipe data records or save them under a new name
- Delete recipe data records
- Transfer recipe data records from the PLC and to the PLC

Operator controls of the simple recipe view

Toggle between the display areas and the context menus to operate the simple recipe views.

The following table shows the operation of the display area.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touching an entry</td>
<td>The next lower display area opens.</td>
</tr>
<tr>
<td>←</td>
<td>The next higher display area opens.</td>
</tr>
<tr>
<td>←</td>
<td>The context menu of the display area opens.</td>
</tr>
</tbody>
</table>

The following table shows the operation of the context menu.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>The menu is closed.</td>
</tr>
<tr>
<td></td>
<td>The display area opens.</td>
</tr>
<tr>
<td>Touch the menu command</td>
<td>The menu command is executed.</td>
</tr>
</tbody>
</table>
Context menus of the simple recipe view

- **Recipe list**

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>A new recipe data record is created for the selected recipe. If a start value is configured, it is shown in the text box.</td>
</tr>
<tr>
<td>Displaying infotext</td>
<td>The infotext configured for the simple recipe view is displayed.</td>
</tr>
<tr>
<td>Open</td>
<td>The record list of the selected recipe opens.</td>
</tr>
</tbody>
</table>

- **Data record list**

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>A new recipe data record is created for the selected recipe. If a start value is configured, it is shown in the text box.</td>
</tr>
<tr>
<td>Delete</td>
<td>The selected record is deleted.</td>
</tr>
<tr>
<td>Save as</td>
<td>The selected record is saved under a different name irrespective of the simple recipe view. A dialog box opens in which the name is entered.</td>
</tr>
<tr>
<td>Rename</td>
<td>The selected data record is renamed. A dialog box opens in which the name is entered.</td>
</tr>
</tbody>
</table>

- **Element list**

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>The selected record is saved.</td>
</tr>
<tr>
<td>To PLC</td>
<td>The displayed values of the selected data record are transferred from the HMI device to the PLC.</td>
</tr>
<tr>
<td>From PLC</td>
<td>The recipe values from the PLC are displayed on the HMI device in the recipe view.</td>
</tr>
<tr>
<td>Save as</td>
<td>The selected data record is saved under a new name. A dialog box opens in which the name is entered.</td>
</tr>
</tbody>
</table>

**Operating Menus**

Touch the desired menu command. The command is executed.

**Operating the recipe screen**

You operate the recipes in a recipe screen with the operator controls provided by the configuration engineer.

Refer to your plant documentation for additional information.
9.17.7.2 Creating a recipe data record

Introduction
Create a new recipe data record in the recipe list or in the record list. Then enter the values for the new record in the element list and save the record.

Requirement
- A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:
1. Select the recipe for which you want to create a new recipe data record.
2. Open the recipe list menu.
3. Select the menu command "New".
   - Creates a new record The element list of the new record is displayed.
4. Enter values for the elements of the data record.
   - The tags of the record can be assigned default values depending on the configuration.
5. Open the menu of the element list and select the command "Save".
6. Enter a name for the new record.
7. Confirm your entries.
   - If you change the new data record number to an existing data record number, the existing data record is overwritten.

Result
The created recipe data record is saved to the selected recipe.

9.17.7.3 Editing a recipe data record

Introduction
Edit the values of the recipe data records in a simple recipe view.

If you want to display the current recipe values from the PLC in the simple recipe view, you first have to read the current values from the PLC with the menu command "From PLC" in the element list.

The values changed in the recipe view only take effect in the PLC when you transfer the edited data record to the PLC with the menu command "To PLC".
9.17 Operating recipes

Requirement

- A screen with a simple recipe view is displayed.

Procedure

Proceed as follows:
1. Select the recipe which contains the desired recipe data record.
2. Open the data record list.
3. Select the recipe data record you want to change.
4. Open the element list.
5. Change the values of the records as required.
6. Save your changes with the menu command "Save".
   The recipe data record is saved.

Result

The edited recipe data record has now been saved in the selected recipe.

9.17.7.4 Deleting a recipe data record

Introduction

You can delete all the data records which are not required.

Requirement

- A screen with a simple recipe view is displayed.

Procedure

Proceed as follows:
1. Select the recipe which contains the desired recipe data record.
2. Open the data record list.
3. Select the data record you want to delete.
4. Open the menu.
5. Select the menu command "Delete".

Result

The data record is deleted.
9.17.7.5 Reading a recipe data record from the PLC

Introduction

The values of recipe elements are exchanged with the PLC via tags. In the current project, the values which are also stored in the recipes in the HMI device can be changed directly in the plant. This is the case, for example, if a valve was opened further directly at the plant than is stored in the recipe. The values of the tags on the HMI device possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the recipe view.

Requirement

• A screen with a simple recipe view is displayed.

Procedure

Proceed as follows:
1. Select the recipe which contains the desired recipe data record.
2. Select the element list of the recipe data record to which you want to apply the values from the PLC.
3. Open the menu.
4. Select the menu item "From PLC".
   The values are read from the PLC.
5. If you want to save the displayed values in the HMI device, select the menu item "Save".

Result

The values were read from the PLC, displayed on the HMI device and saved to the selected recipe data record.

9.17.7.6 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirement

• A screen with a simple recipe view is displayed.
**Procedure**

Proceed as follows:

1. Select the recipe which contains the desired recipe data record.
2. Select the element list of the recipe data record whose values you want to transfer to the PLC.
3. Open the menu.
4. Select the menu item "To PLC".

**Result**

The values of the recipe data record were transferred to the PLC and take effect in the process.

**9.17.8 Exporting a recipe data record**

**Introduction**

You can export one or more recipe data records to a CSV file, depending on the configuration. After export, the values in the recipe data record can be further processed in a spreadsheet program such as MS Excel. The degree to which you can influence the export depends on the configuration:

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export recipe data</td>
</tr>
<tr>
<td>The USB interface is deactivated while the main battery is being changed.</td>
</tr>
<tr>
<td>During the main battery change, do not transfer any data to a USB memory stick.</td>
</tr>
</tbody>
</table>

**Requirement**

- A screen with a recipe view is displayed
- An operating element with the function "Export record" has been configured.
- The following tags are configured equally in the recipe view and for the "Export record" operating element.
  - Recipe number
  - Data record number
Procedure

Proceed as follows:
1. Select the recipe which contains the desired recipe data record.
2. Select the recipe data record you want to export.
3. Operate the operator control which was configured for export, for example the "Export data record" button.

The data record is exported as a CSV file to an external data medium.

Refer to your plant documentation for additional information.

9.17.9 Importing a recipe data record

Introduction

You can import values from a CSV file to a recipe data record, depending on the configuration.

If the structure of the CSV file differs from the structure of the recipe, deviations are handled as follows:

- Any additional values in the CSV file will be rejected
- The system applies the configured default value to the recipe data record if the CSV file contains an insufficient number of values
- If the CSV file contains values of the wrong data type, the configured default value is set in the recipe data record

Example:

The imported CSV file contains values that were entered as floating point numbers
However, the corresponding tag expects an integer value. In this case, the system discards the imported value and uses the configured default

Requirements

- An operating element with the function "Import data record" has been configured, for example a button
- A screen with a recipe view is displayed

Procedure

Proceed as follows:
1. Select the recipe which contains the recipe data record to be imported.
2. Operate the operating element with the function "Import data record".

The record is imported from an external data medium as a CSV file and then displayed in the recipe view.
9.17.10 Examples

9.17.10.1 Entering a recipe data record

Introduction

You would like to enter production data on the HMI device without interrupting the process in the plant. For this reason, the production data should not be transferred to the PLC.

Procedure

Proceed as follows:

1. Call the recipe view or a recipe screen.
2. Select the desired recipe data record.
3. Enter the values of the elements.
4. Save the recipe data record.

The recipe data record is saved in the internal memory of the HMI device.

The following figure shows the data flow schematically.

① Display recipe data record
② Save recipe data record
③ Tags are synchronized
④ Display and edit recipe tags in the recipe screen
⑤ Tags are offline
9.17.10.2 Manual production sequence

Introduction
You request the production data of different workpieces from the PLC and display this data on the screen of the HMI device for inspection. You want to correct the transferred production data in the recipe view or the recipe screen if necessary.

Procedure
A scanner connected to the PLC reads the barcode of a workpiece. The barcode names correspond to the names in the recipe data record. Based on the barcode name, the PLC can read the required recipe data record. The recipe data record is displayed for inspection on the HMI device. You can now edit and save the recipe data record. Then transfer the edited recipe data record to the PLC again.

The following figure shows the data flow schematically.

The recipe data record is read from the PLC and written to the PLC again following changes
Display and edit recipe tags in the recipe screen
Tags are synchronized
Recipe data records are saved in the recipe memory of the HMI device

9.18 Closing the project
The procedure for closing the active project is identical to the procedure for removing the HMI device.
10.1 Maintenance and care

Introduction

Read sections “Safety instructions (Page 33)” of the safety notes for information on service and maintenance.

Scope of maintenance

The HMI device is designed for maintenance-free operation. Remember to include accessories and peripheral equipment in the maintenance.

The scope of maintenance includes:

- Storing the main battery
  
  A lithium-ion rechargeable battery loses more than 50% of its charging capacity within three years.
  
  Store rechargeable batteries at 40 to 60% of their capacity to ensure optimal service life. Manufacturers recommend storage at 15° C – which is optimal for aging and self-discharge.
  
  Charge the battery every six months to 40 to 60% of its charge capacity.

- Exchanging the transponder batteries
  
  Replace the transponder batteries at least every 5 years.
  
  The changing of batteries is described in section “Setting the transponder ID and inserting the batteries (Page 57).”

Scope of maintenance

The scope of maintenance includes:

- Cleaning the touch screen
- Cleaning the membrane keypad
Procedure - maintenance

**CAUTION**

**Damage possible**

Using compressed air or steam cleaners, or aggressive solutions or scouring agents will damage the HMI device.

Use a cleaning cloth dampened with a cleaning agent to clean the equipment. Only use water with a little liquid soap or a screen cleaning foam.

Proceed as follows:

1. Switch off the HMI device.
2. Spray the cleaning solution onto a cleaning cloth.
   - Do not spray directly onto the HMI device.
3. Clean the HMI device.
   - When cleaning the display, wipe inwards from the edge of screen.

10.2 **Spare parts and repairs**

If the unit needs to be repaired, ship the HMI device to the Return Center in Fürth.

The address is:

Siemens AG
Industry Sector
Returns Center
Siemensstr. 2
90766 Fürth
Germany

You can find more detailed information on the Internet at Spare parts and repairs (http://support.automation.siemens.com/WW/view/en/16611927).
Technical specifications

11.1 Dimension drawings

11.1.1 Mobile Panel 277 IWLAN

Front view

All dimensions in mm
Side view

You can find additional images in the Internet at:

11.1.2  Charging station

You can find additional images in the Internet at:
11.1 Dimension drawings

11.1.3 Transponder

You can find additional images in the Internet at:
11.2 Specifications

11.2.1 Mobile Panel 277 IWLAN

**HMI device**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum weight with main battery, without packaging</td>
<td>2.2 kg</td>
</tr>
<tr>
<td>Drop height with main battery, max.</td>
<td>1.2 m</td>
</tr>
</tbody>
</table>

**Display**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Color TFT LC display</td>
</tr>
<tr>
<td>Display area, active</td>
<td>151.66 mm × 113.74 mm (7.5&quot;)</td>
</tr>
<tr>
<td>Resolution</td>
<td>640 x 480 pixels</td>
</tr>
<tr>
<td>Colors, displayable</td>
<td>65536</td>
</tr>
<tr>
<td>Brightness control</td>
<td>Yes</td>
</tr>
<tr>
<td>Backlighting</td>
<td>CCFL</td>
</tr>
<tr>
<td>Half Brightness Life Time, typical</td>
<td>50000 h</td>
</tr>
<tr>
<td>Pixel error class according to DIN EN ISO 13406-2</td>
<td>II</td>
</tr>
</tbody>
</table>

**Input device**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Touch screen, analog, resistive Membrane keyboard</td>
</tr>
<tr>
<td>Function keys</td>
<td>18, with LEDs</td>
</tr>
<tr>
<td>Key &quot;ON/OFF&quot;</td>
<td>1</td>
</tr>
<tr>
<td>Handwheel (optional)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>50 pulses per rotation</td>
</tr>
<tr>
<td>Key-operated switch (optional)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>3 switch settings</td>
</tr>
<tr>
<td>Illuminated pushbutton (optional)</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>LED separately controllable</td>
</tr>
</tbody>
</table>

**Memory**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application memory</td>
<td>6 MB</td>
</tr>
</tbody>
</table>
### Technical specifications

#### 11.2 Specifications

<table>
<thead>
<tr>
<th>Interfaces</th>
<th></th>
</tr>
</thead>
</table>
| USB, 1 × | • USB host; conforms to USB standard 1.1 (supporting low-speed and full-speed USB devices)  
• Maximum load 100 mA |
| WLAN, 1 × | For PROFINET WLAN |
| RJ45, 1 × | For PROFINET LAN |

<table>
<thead>
<tr>
<th>Power supply</th>
<th></th>
</tr>
</thead>
</table>
| Power supply, through | • Main battery  
• Charging station  
• Power supply unit |
| Bridging time | 50 s |
| Internal clock, buffer time, approx. | 4 d |

<table>
<thead>
<tr>
<th>Frequency ranges</th>
<th></th>
</tr>
</thead>
</table>
| WLAN | 5180 MHz to 5835 MHz  
17 dBm  
2412 MHz to 2484 MHz  
20 dBm |
| Impedance | 50 Ω |
| Radio link to transponder | 2400 MHz to 2483 MHz  
Approx. 83°  
-1.50 dBm (0.7 mW) EIRP  
-3.65 dBm (0.4 mW) ERP |
11.2.2 Interface description

USB

The figure below shows the pin assignment of the USB interface.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5 VDC, out (max. 100 mA)</td>
</tr>
<tr>
<td>2</td>
<td>USB-DN</td>
</tr>
<tr>
<td>3</td>
<td>USB-DP</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
</tr>
</tbody>
</table>

RJ45

The figure below shows the pin assignment of the RJ45 interface.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TD+</td>
</tr>
<tr>
<td>2</td>
<td>TD−</td>
</tr>
<tr>
<td>3</td>
<td>RD+</td>
</tr>
<tr>
<td>4</td>
<td>Not used</td>
</tr>
<tr>
<td>5</td>
<td>Not used</td>
</tr>
<tr>
<td>6</td>
<td>RD−</td>
</tr>
<tr>
<td>7</td>
<td>Not used</td>
</tr>
<tr>
<td>8</td>
<td>Not used</td>
</tr>
</tbody>
</table>
WLAN

Operation of a WLAN interface in the 2.4 GHz and 5 GHz frequency ranges. The interface is compatible with the following standards:

- IEEE 802.11a
- IEEE 802.11h
- IEEE 802.11b
- IEEE 802.11g

**Note**

The specifications in the following two tables relate to the WLAN card in the HMI device, antenna losses not taken into account.

**Input power of the WLAN card**

<table>
<thead>
<tr>
<th>WLAN standard</th>
<th>Data transfer rate</th>
<th>Input power</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEEE 802.11a, IEEE 802.11h</td>
<td>54 Mbps</td>
<td>–74 dBm</td>
</tr>
<tr>
<td></td>
<td>48 Mbps</td>
<td>–75 dBm</td>
</tr>
<tr>
<td></td>
<td>36 Mbps</td>
<td>–80 dBm</td>
</tr>
<tr>
<td></td>
<td>24 Mbps</td>
<td>–83 dBm</td>
</tr>
<tr>
<td></td>
<td>18 Mbps</td>
<td>–86 dBm</td>
</tr>
<tr>
<td></td>
<td>12 Mbps</td>
<td>–88 dBm</td>
</tr>
<tr>
<td></td>
<td>9 Mbps</td>
<td>–89 dBm</td>
</tr>
<tr>
<td></td>
<td>6 Mbps</td>
<td>–90 dBm</td>
</tr>
<tr>
<td>IEEE 802.11g</td>
<td>54 Mbps</td>
<td>–76 dBm</td>
</tr>
<tr>
<td></td>
<td>48 Mbps</td>
<td>–77 dBm</td>
</tr>
<tr>
<td></td>
<td>36 Mbps</td>
<td>–82 dBm</td>
</tr>
<tr>
<td></td>
<td>24 Mbps</td>
<td>–85 dBm</td>
</tr>
<tr>
<td></td>
<td>18 Mbps</td>
<td>–88 dBm</td>
</tr>
<tr>
<td></td>
<td>12 Mbps</td>
<td>–91 dBm</td>
</tr>
<tr>
<td></td>
<td>9 Mbps</td>
<td>–92 dBm</td>
</tr>
<tr>
<td></td>
<td>6 Mbps</td>
<td>–93 dBm</td>
</tr>
<tr>
<td>IEEE 802.11b</td>
<td>11 Mbps</td>
<td>–90 dBm</td>
</tr>
<tr>
<td></td>
<td>5.5 Mbps</td>
<td>–92 dBm</td>
</tr>
<tr>
<td></td>
<td>2 Mbps</td>
<td>–94 dBm</td>
</tr>
<tr>
<td></td>
<td>1 Mbps</td>
<td>–98 dBm</td>
</tr>
</tbody>
</table>
### Output power of the WLAN card

<table>
<thead>
<tr>
<th>WLAN standard</th>
<th>Data transfer rate</th>
<th>Output power</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEEE 802.11a, IEEE 802.11h, frequency range: 5.18 GHz to 5.7 GHz</td>
<td>54 Mbps</td>
<td>13.5 dBm</td>
</tr>
<tr>
<td></td>
<td>48 Mbps</td>
<td>15 dBm</td>
</tr>
<tr>
<td></td>
<td>36 Mbps</td>
<td>16 dBm</td>
</tr>
<tr>
<td></td>
<td>6 Mbps to 24 Mbps</td>
<td>17 dBm</td>
</tr>
<tr>
<td>IEEE 802.11a, IEEE 802.11h, frequency range: 4.92 GHz to 5.16 GHz and 5.745 GHz to 5.825 GHz</td>
<td>54 Mbps</td>
<td>11.5 dBm</td>
</tr>
<tr>
<td></td>
<td>48 Mbps</td>
<td>13 dBm</td>
</tr>
<tr>
<td></td>
<td>36 Mbps</td>
<td>14 dBm</td>
</tr>
<tr>
<td></td>
<td>6 Mbps to 24 Mbps</td>
<td>15 dBm</td>
</tr>
<tr>
<td>IEEE 802.11g, frequency range: 2.412 GHz to 2.484 GHz</td>
<td>54 Mbps</td>
<td>16 dBm</td>
</tr>
<tr>
<td></td>
<td>48 Mbps</td>
<td>17 dBm</td>
</tr>
<tr>
<td></td>
<td>36 Mbps</td>
<td>17 dBm</td>
</tr>
<tr>
<td></td>
<td>6 Mbps to 24 Mbps</td>
<td>17 dBm</td>
</tr>
<tr>
<td>IEEE 802.11b</td>
<td>11 Mbps</td>
<td>20 dBm</td>
</tr>
<tr>
<td></td>
<td>5.5 Mbps</td>
<td>20 dBm</td>
</tr>
<tr>
<td></td>
<td>2 Mbps</td>
<td>20 dBm</td>
</tr>
<tr>
<td></td>
<td>1 Mbps</td>
<td>20 dBm</td>
</tr>
</tbody>
</table>

### 11.2.3 Main rechargeable battery

<table>
<thead>
<tr>
<th>Main rechargeable battery</th>
<th>Lithium ion accumulator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>Operation time of the HMI device with rechargeable battery</td>
<td></td>
</tr>
<tr>
<td>• During normal operation</td>
<td>• Approx. 4 h</td>
</tr>
<tr>
<td>• In powered-down state, not placed in charging station</td>
<td>• Approx. 15 days</td>
</tr>
<tr>
<td>Charging cycles</td>
<td>500</td>
</tr>
<tr>
<td>Charging time</td>
<td>Approx. 4 h ¹</td>
</tr>
</tbody>
</table>

¹ The effective charging time depends on the ambient temperature. The higher the ambient temperature, the longer the charging time.
### 11.2 Specifications

#### 11.2.4 Charging station

**Weight**

<table>
<thead>
<tr>
<th>Weight without packing</th>
<th>Approx. 1.1 kg</th>
</tr>
</thead>
</table>

**Power supply**

<table>
<thead>
<tr>
<th>Nominal voltage</th>
<th>+24 VDC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range, permissible</td>
<td>19.2 V to 28.8 V (–20%, +20%)</td>
</tr>
<tr>
<td>Transients, maximum permissible</td>
<td>35 V (500 ms)</td>
</tr>
<tr>
<td>Time between two transients, minimum</td>
<td>50 sec</td>
</tr>
</tbody>
</table>

- **Current consumption with Mobile Panel**
  - Typical
  - Constant current, maximum
  - Power on current surge \( I_2t \)
    - Approx. 1.5 A
    - Approx. 1.8 A
    - Approx. 1.7 A\(^2\)s

- **Current consumption with Mobile Panel and main battery in the charging compartments**
  - Typical
  - Constant current, maximum
  - Power on current surge \( I_2t \)
    - Approx. 2.8 A
    - Approx. 3.4 A
    - Approx. 1.7 A\(^2\)s

**Fuse, internal**

- Electronic

#### 11.2.5 Transponder

<table>
<thead>
<tr>
<th>Weight without batteries</th>
<th>0.3 kg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply</td>
<td>3 AA mignon batteries, 1.5 V</td>
</tr>
<tr>
<td>Operating life of batteries in normal operation</td>
<td>5 years</td>
</tr>
</tbody>
</table>

- **Radio link to HMI device**
  - Frequency range
    - 2400 MHz to 2483 MHz
  - Transmission angle
    - Approx. 93°

- **Type**
  - Passive
11.3 WLAN radiation characteristics of the HMI device

This section contains illustrations on the radiation characteristics of various antennas.

Note
The radiation characteristics were determined under optimum conditions in a low reflection room in an antenna lab.

11.3.1 Radiation characteristic in the 2.4 GHz band

<table>
<thead>
<tr>
<th>Antenna type</th>
<th>Dual band WLAN antenna</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarization</td>
<td>Vertical and horizontal</td>
</tr>
<tr>
<td>Frequency range</td>
<td>2.4 GHz to 2.483 GHz</td>
</tr>
<tr>
<td>Antenna gain, max.</td>
<td>3 dBi</td>
</tr>
<tr>
<td>Impedance</td>
<td>50 Ω</td>
</tr>
</tbody>
</table>

Range of the transmitter based on angle

The figure below shows the coordinate system applied to the HMI device.

The figure below shows the range of the transmitter based on angle.
11.3 WLAN radiation characteristics of the HMI device

**Range at 2.45 GHz**

![Graph showing range at 2.45 GHz](image)

**11.3.2 Radiation characteristic in the 5 GHz band**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antenna type</td>
<td>Dual port patch antenna</td>
</tr>
<tr>
<td>Polarization</td>
<td>Vertical and horizontal</td>
</tr>
<tr>
<td>Frequency range</td>
<td>5.0 GHz to 5.6 GHz</td>
</tr>
<tr>
<td>Antenna gain, max.</td>
<td>5 dBi</td>
</tr>
<tr>
<td>Impedance</td>
<td>50 Ω</td>
</tr>
</tbody>
</table>

**Range of the transmitter based on angle**

The figure below shows the coordinate system applied to the HMI device.

![Coordinate system](image)

The figures below show the range of the transmitter for the various frequencies in the 5 GHz band based on angle.
Range at 5.0 GHz

Range at 5.3 GHz

Range at 5.6 GHz
11.4 Radiation characteristics of the transponder system

This section contains illustrations on the radiation characteristics of various antennas.

---

**Note**

The radiation characteristics were determined under optimum conditions in a low reflection room in an antenna lab.

---

### 11.4.1 Radiation characteristic of HMI device

The radiation characteristics are in regards to the antennas for the transponder system.

<table>
<thead>
<tr>
<th>Antenna type</th>
<th>Dual port patch antenna</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarization</td>
<td>Vertical and horizontal</td>
</tr>
<tr>
<td>Frequency range</td>
<td>2400 MHz to 2483 MHz</td>
</tr>
<tr>
<td>Antenna gain in principle ray direction, max.</td>
<td>Port 1: 2.6 dBiC</td>
</tr>
<tr>
<td></td>
<td>Port 2: 2.7 dBiC</td>
</tr>
<tr>
<td>Impedance</td>
<td>50 Ω</td>
</tr>
<tr>
<td>Full widths at half maximum, horizontal at 2.45 GHz</td>
<td>83°</td>
</tr>
<tr>
<td>Full widths at half maximum, vertical at 2.45 GHz</td>
<td>80°</td>
</tr>
</tbody>
</table>

---

**Range of the transmitter based on angle**

The figure below shows the coordinate system applied to the HMI device.
The figure below shows the range of the transmitter based on angle.
The figure below shows the HMI device range depending on the angular displacement to the main count direction in the z direction:
11.4.2 Radiation characteristic of the transponder

The radiation characteristic relates to the antennas for the transponder system.

<table>
<thead>
<tr>
<th>Antenna type</th>
<th>Dual port patch antenna</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polarization</td>
<td>Vertical and horizontal</td>
</tr>
<tr>
<td>Frequency range</td>
<td>2.4 GHz to 2.483 GHz</td>
</tr>
<tr>
<td>Antenna gain in principle ray direction, max.</td>
<td>Port 1: 2.6 dBiC</td>
</tr>
<tr>
<td></td>
<td>Port 2: 2.7 dBiC</td>
</tr>
<tr>
<td>Impedance</td>
<td>50 Ω</td>
</tr>
<tr>
<td>Full widths at half maximum, horizontal at 2.45 GHz</td>
<td>93°</td>
</tr>
<tr>
<td>Full widths at half maximum, vertical at 2.45 GHz</td>
<td>90°</td>
</tr>
</tbody>
</table>

Range of the transmitter based on angle

The following figure shows the coordinate system applied to the transponder.

![Coordinate system diagram]
The figure below shows the range of the transmitter based on angle.
The following figure shows the transponder range depending on the angular displacement to the main count direction in the z direction:
Technical specifications

11.4 Radiation characteristics of the transponder system
Appendix

A.1 ESD guideline

What does ESD mean?

An electronic module is equipped with highly integrated electronic components. Due to their design, electronic components are highly sensitive to overvoltage and thus to the discharge of static electricity. Such electronic components are labeled as electrostatic sensitive devices (ESD).

The following abbreviations are commonly used for electrostatic sensitive devices:

- ESD – Electrostatic Sensitive Device
- ESD – Electrostatic Sensitive Device (internationally recognized term)

Electrostatic charge

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Electrostatic charge</strong></td>
</tr>
<tr>
<td>ESDs may be destroyed by voltages far below the level perceived by human beings. If you are not discharged electrostatically, the voltage that you transfer when touching a component or the contact points of a module can already cause damage.</td>
</tr>
<tr>
<td>The damage to an ESD caused by overvoltage is usually not recognized immediately. The damage only becomes apparent after a long period of operation.</td>
</tr>
<tr>
<td>Discharge any electrostatic charge of your body before you touch the ESD.</td>
</tr>
</tbody>
</table>

Anyone who is not connected conductively to their surroundings is subject to electrostatic charge.
The following diagram shows the maximum voltage values to which a person can be charged electrostatically. The values depend on the material and humidity. The shown values are in conformity with the specifications of EN 61000-4-2.

![Diagram showing maximum voltage values vs. relative humidity.]

① Synthetic materials  
② Wool  
③ Antistatic materials such as wood or concrete

Protective measures against discharge of static electricity

**CAUTION**

**Grounding measures**

There is no equipotential bonding without grounding. An electrostatic charge is not discharged and may damage the ESD.

When working with electrostatic sensitive devices, make sure that the person and the workplace are properly grounded.

Note the following:

- Only touch the ESD if it is absolutely necessary.
- When you touch ESD modules, avoid touching the pins or the PCB tracks.  
  This precaution reduces the risk of damaging an ESD.
- Discharge electrostatic electricity from your body if you are performing measurements on an ESD.  
  To do so, touch a grounded metal object before you carry out the measurement.
- Always use grounded measuring instruments.
A.2 System alarms

Introduction
System alarms on the HMI device provide information about internal states of the HMI device and PLC.

The following overview shows the causes of system alarms and how to eliminate the cause of error.

Some of the system alarms described in this section are relevant to individual HMI devices based on their range of features.

Note
System alarms are only indicated if an alarm window was configured. System alarms are output in the language currently set on your HMI device.

System alarm parameters
System alarms may contain encrypted parameters which are relevant to troubleshooting because they provide a reference to the source code of the runtime software. These parameters are output after the text "Error code:"

Displaying the "System alarms" editor
You can find the text content of the system alarm in WinCC flexible. The "System alarms" editor is not displayed by default in WinCC flexible.

1. Enable the "System alarms" editor under "Options > Setting... > Workbench > Settings for Project Window" with "Display all entries".
2. Select the "System alarms" editor under "Alarms" in the project view.
   The system alarms are sorted numerically in the "System alarms" editor.
Configuring events for system alarms

You can configure the "Incoming" event for the following system alarm in the "System alarms" editor.

<table>
<thead>
<tr>
<th>System alarms</th>
<th>10000</th>
<th>150000</th>
<th>230300</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>10000 to 10006</td>
<td>150000</td>
<td>230300 to 230308</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150001</td>
<td></td>
</tr>
<tr>
<td>20000</td>
<td>160000</td>
<td></td>
<td>240000</td>
</tr>
<tr>
<td></td>
<td>160000</td>
<td></td>
<td>240000 to 240005</td>
</tr>
<tr>
<td></td>
<td>160001</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>160010 to 160014</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30000</td>
<td>170000</td>
<td></td>
<td>250000</td>
</tr>
<tr>
<td></td>
<td>170000 to 170004</td>
<td></td>
<td>250000 to 250003</td>
</tr>
<tr>
<td></td>
<td>170007</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40000</td>
<td>180000</td>
<td></td>
<td>260000</td>
</tr>
<tr>
<td></td>
<td>180000 to 180002</td>
<td></td>
<td>260000 to 260009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>260012 to 260014</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>260028</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>260030</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>260033 to 260045</td>
</tr>
<tr>
<td>50000</td>
<td>190000</td>
<td></td>
<td>270000</td>
</tr>
<tr>
<td></td>
<td>190000 to 190002</td>
<td></td>
<td>270000 to 270003</td>
</tr>
<tr>
<td></td>
<td>190004 to 190013</td>
<td></td>
<td></td>
</tr>
<tr>
<td>60000</td>
<td>190100</td>
<td></td>
<td>280000</td>
</tr>
<tr>
<td></td>
<td>190100 to 190102</td>
<td></td>
<td>280000 to 280004</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>70000</td>
<td>200000</td>
<td></td>
<td>290000</td>
</tr>
<tr>
<td></td>
<td>200000 to 200005</td>
<td></td>
<td>290000 to 290008</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290010 to 290014</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290020 to 290027</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290040 to 290042</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290044</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290050 to 290065</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290070 to 290073</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290075</td>
</tr>
<tr>
<td>80000</td>
<td>200100</td>
<td></td>
<td>300000</td>
</tr>
<tr>
<td></td>
<td>200100 to 200105</td>
<td></td>
<td>300000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>300001</td>
</tr>
<tr>
<td>90000</td>
<td>210000</td>
<td></td>
<td>310000</td>
</tr>
<tr>
<td></td>
<td>210000 to 210006</td>
<td></td>
<td>310000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>310001</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>110000</td>
<td>The print job could not be started or was canceled due to an unknown error.</td>
<td>Check the printer settings, cable connections and the power supply.</td>
</tr>
<tr>
<td></td>
<td>Faulty printer setup. Or: No authorization is available for accessing the</td>
<td>Set up the printer once again. Obtain a network printer authorization.</td>
</tr>
<tr>
<td></td>
<td>network printer. Power supply failure during data transfer.</td>
<td>If the error persists, contact the Hotline!</td>
</tr>
<tr>
<td>120000</td>
<td>No printer is installed or a default printer has not been set up.</td>
<td>Install a printer and/or select it as the default printer.</td>
</tr>
<tr>
<td>130000</td>
<td>Overflow of the graphics buffer for printing. Up to two graphics are buffered.</td>
<td>Allow sufficient intervals between successive print jobs.</td>
</tr>
<tr>
<td>140000</td>
<td>The Windows printing system reports an error.</td>
<td>Repeat the action if necessary.</td>
</tr>
</tbody>
</table>

### 10000 - Printer alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>10000</td>
<td>The print job could not be started or was canceled due to an unknown error.</td>
<td>Check the printer settings, cable connections and the power supply.</td>
</tr>
<tr>
<td></td>
<td>Faulty printer setup. Or: No authorization is available for accessing the</td>
<td>Set up the printer once again. Obtain a network printer authorization.</td>
</tr>
<tr>
<td></td>
<td>network printer. Power supply failure during data transfer.</td>
<td>If the error persists, contact the Hotline!</td>
</tr>
<tr>
<td>10001</td>
<td>No printer is installed or a default printer has not been set up.</td>
<td>Install a printer and/or select it as the default printer.</td>
</tr>
<tr>
<td>10002</td>
<td>Overflow of the graphics buffer for printing. Up to two graphics are buffered.</td>
<td>Allow sufficient intervals between successive print jobs.</td>
</tr>
<tr>
<td>10003</td>
<td>Graphics can now be buffered again.</td>
<td>--</td>
</tr>
<tr>
<td>10004</td>
<td>Overflow of the buffer for printing lines in text mode (e.g. alarms). Up to</td>
<td>Allow sufficient intervals between successive print jobs.</td>
</tr>
<tr>
<td></td>
<td>1000 lines are buffered.</td>
<td>--</td>
</tr>
<tr>
<td>10005</td>
<td>Text lines can now be buffered again.</td>
<td>--</td>
</tr>
<tr>
<td>10006</td>
<td>The Windows printing system reports an error.</td>
<td>Repeat the action if necessary.</td>
</tr>
</tbody>
</table>
## A.2 System alarms

### 20000 - Global script alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>20010</td>
<td>An error has occurred in the specified script line. Execution of the script was therefore aborted. Note the system alarm that may have occurred prior to this.</td>
<td>Select the specified script line in the configuration. Ensure that the tags used are of the allowed types. Check system functions for the correct number and types of parameters.</td>
</tr>
<tr>
<td>20011</td>
<td>An error has occurred in a script that was called by the specified script. Execution of the script was therefore aborted in the called script. Note the system alarm that may have occurred prior to this.</td>
<td>In the configuration, select the script that has been called directly or indirectly by the specified script. Ensure that the tags used are of the allowed types. Check system functions for the correct number and types of parameters.</td>
</tr>
<tr>
<td>20012</td>
<td>The configuration data is inconsistent. The script could therefore not be generated.</td>
<td>Recompile the configuration.</td>
</tr>
<tr>
<td>20013</td>
<td>The scripting component of WinCC flexible Runtime is not correctly installed. Therefore, no scripts can be executed.</td>
<td>Reinstall WinCC flexible Runtime on your PC. Rebuild your project with &quot;Project &gt; Compiler &gt; Generate&quot; and transfer the project to the HMI device.</td>
</tr>
<tr>
<td>20014</td>
<td>The system function returns a value that is not written in any return tag.</td>
<td>Select the specified script in the configuration. Check whether the script name has been assigned a value.</td>
</tr>
<tr>
<td>20015</td>
<td>Too many successive scripts have been triggered in short intervals. When more than 20 scripts are queued for processing, any subsequent scripts are rejected. In this case, the script indicated in the alarm is not executed.</td>
<td>Find what is triggering the scripts. Extend the times, e.g. the polling time of the tags which trigger the scripts.</td>
</tr>
</tbody>
</table>

### 30000 - Alarms for IFwSetValue: SetValue()

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>30010</td>
<td>The tag could not accept the function result, e.g. when it has exceeded the value range.</td>
<td>Check the tag type of the system function parameter.</td>
</tr>
<tr>
<td>30011</td>
<td>A system function could not be executed because the function was assigned an invalid value or type in the parameter.</td>
<td>Check the parameter value and tag type of the invalid parameter. If a tag is used as a parameter, check its value.</td>
</tr>
<tr>
<td>30012</td>
<td>A system function could not be executed because the function was assigned an invalid value or type in the parameter.</td>
<td>Check the parameter value and tag type of the invalid parameter. If a tag is used as a parameter, check its value.</td>
</tr>
</tbody>
</table>

### 40000 - Linear scaling alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>40010</td>
<td>The system function could not be executed since the parameters could not be converted to a common tag type.</td>
<td>Check the parameter types in the configuration.</td>
</tr>
<tr>
<td>40011</td>
<td>The system function could not be executed since the parameters could not be converted to a common tag type.</td>
<td>Check the parameter types in the configuration.</td>
</tr>
</tbody>
</table>
## Appendix

### A.2 System alarms

#### 50000 - Data server alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>50000</td>
<td>The HMI device is receiving data faster than it is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>capable of processing. Therefore, no further data is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>accepted until all current data have been processed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data exchange then resumes.</td>
<td></td>
</tr>
<tr>
<td>50001</td>
<td>Data exchange has been resumed.</td>
<td></td>
</tr>
</tbody>
</table>

#### 60000 - Win32 function alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>60000</td>
<td>This alarm is generated by the &quot;DisplaySystemAlarms&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>function. The text to be displayed is transferred to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the function as a parameter.</td>
<td></td>
</tr>
<tr>
<td>60010</td>
<td>The file could not be copied in the direction defined</td>
<td>Restart the system function or check the paths of the</td>
</tr>
<tr>
<td></td>
<td>because one of the two files is currently open or the</td>
<td>source/target files. Using Windows NT/XP: The user</td>
</tr>
<tr>
<td></td>
<td>source/target path is not available. It is possible</td>
<td>running WinCC flexible Runtime must be granted</td>
</tr>
<tr>
<td></td>
<td>that the Windows user has no access rights to one of</td>
<td>access rights to the files.</td>
</tr>
<tr>
<td></td>
<td>the two files.</td>
<td></td>
</tr>
<tr>
<td>60011</td>
<td>An attempt was made to copy a file to itself. It is</td>
<td>Check the path of the source/target file. Using</td>
</tr>
<tr>
<td></td>
<td>possible that the Windows user has no access rights</td>
<td>Windows NT/XP with NTFS: The user running WinCC</td>
</tr>
<tr>
<td></td>
<td>to one of the two files.</td>
<td>flexible Runtime must be granted access rights to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>files.</td>
</tr>
</tbody>
</table>

#### 70000 - Win32 function alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>70010</td>
<td>The application could not be started because it</td>
<td>Check whether the application exists in the specified</td>
</tr>
<tr>
<td></td>
<td>could not be found in the path specified or there is</td>
<td>path or close other applications.</td>
</tr>
<tr>
<td></td>
<td>insufficient memory space.</td>
<td></td>
</tr>
<tr>
<td>70011</td>
<td>The system time could not be modified. The error</td>
<td>Check the time which is to be set. Using Windows NT/</td>
</tr>
<tr>
<td></td>
<td>alarm only appears in connection with area pointer</td>
<td>XP with WinCC flexible Runtime must be granted</td>
</tr>
<tr>
<td></td>
<td>&quot;Date/time PLC&quot;. Possible causes:</td>
<td>the system time of the operating system.</td>
</tr>
<tr>
<td></td>
<td>• An invalid time was transferred in the job</td>
<td></td>
</tr>
<tr>
<td></td>
<td>mailbox.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The Windows user has no right to modify the system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>time.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the first parameter in the system alarm is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>displayed with the value 13, the second parameter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>indicates the byte containing the incorrect value.</td>
<td></td>
</tr>
<tr>
<td>70012</td>
<td>An error occurred when executing the function &quot;StopRuntime&quot;</td>
<td>Close all programs currently running. Then close</td>
</tr>
<tr>
<td></td>
<td>with the option &quot;Runtime and operating system&quot;.</td>
<td>Windows.</td>
</tr>
<tr>
<td></td>
<td>Windows and WinCC flexible Runtime are not closed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>One possible cause is that other programs cannot be</td>
<td></td>
</tr>
<tr>
<td></td>
<td>closed.</td>
<td></td>
</tr>
</tbody>
</table>
### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>70013</td>
<td>The system time could not be modified because an invalid value was entered. Incorrect separators may have been used.</td>
<td>Check the time which is to be set.</td>
</tr>
<tr>
<td>70014</td>
<td>The system time could not be modified. Possible causes:</td>
<td>Check the time which is to be set. Using Windows NT/XP: Users running WinCC flexible Runtime must be granted the right to modify the system time of the operating system.</td>
</tr>
<tr>
<td></td>
<td>• An invalid time was transferred.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The Windows user has no right to modify the system time.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows rejects the setting request.</td>
<td></td>
</tr>
<tr>
<td>70015</td>
<td>The system time could not be read because Windows rejects the reading function.</td>
<td>--</td>
</tr>
<tr>
<td>70016</td>
<td>An attempt was made to select a screen by means of a system function or job. This is not possible because the screen number specified does not exist. Or: A screen could not be generated due to insufficient system memory. Or: The screen is blocked. Or: Screen call has not been executed correctly.</td>
<td>Check the screen number in the function or job with the screen numbers configured. Assign the number to a screen if necessary. Check the details for the screen call and whether the screen is blocked for specific users.</td>
</tr>
<tr>
<td>70017</td>
<td>Date/time is not read from the area pointer because the address set in the PLC is either not available or has not been set up.</td>
<td>Change the address or set up the address in the PLC.</td>
</tr>
<tr>
<td>70018</td>
<td>Acknowledgment that the password list has been successfully imported.</td>
<td>--</td>
</tr>
<tr>
<td>70019</td>
<td>Acknowledgment that the password list has been successfully exported.</td>
<td>--</td>
</tr>
<tr>
<td>70020</td>
<td>Acknowledgment for activation of alarm reporting.</td>
<td>--</td>
</tr>
<tr>
<td>70021</td>
<td>Acknowledgment for deactivation of alarm reporting.</td>
<td>--</td>
</tr>
<tr>
<td>70022</td>
<td>Acknowledgment to starting the Import Password List action.</td>
<td>--</td>
</tr>
<tr>
<td>70023</td>
<td>Acknowledgment to starting the Export Password List action.</td>
<td>--</td>
</tr>
<tr>
<td>70024</td>
<td>The range of values of the tag was exceeded in the system function. No calculation of the system function.</td>
<td>Check and correct the calculation.</td>
</tr>
<tr>
<td>70025</td>
<td>The range of values of the tag was exceeded in the system function. No calculation of the system function.</td>
<td>Check and correct the calculation.</td>
</tr>
<tr>
<td>70026</td>
<td>No other screens are stored in the internal screen memory. No other screens can be selected.</td>
<td>--</td>
</tr>
<tr>
<td>70027</td>
<td>The backup of the RAM file system has been started.</td>
<td>--</td>
</tr>
<tr>
<td>70028</td>
<td>The files from the RAM have been copied in the Flash memory. The files from the RAM have been copied in the Flash memory. Following a restart, these saved files are copied back to the RAM file system.</td>
<td>--</td>
</tr>
<tr>
<td>Number</td>
<td>Effect/causes</td>
<td>Remedy</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>70029</td>
<td>Backup of the RAM file system has failed. No backup copy of the RAM file system has been made.</td>
<td>Check the settings in the &quot;Control Panel &gt; OP&quot; dialog and save the RAM file system using the &quot;Save Files&quot; button in the &quot;Persistent Storage&quot; tab.</td>
</tr>
<tr>
<td>70030</td>
<td>The parameters configured for the system function are faulty. The connection to the new PLC was not established.</td>
<td>Compare the parameters configured for the system function with the parameters configured for the PLCs and correct them as necessary.</td>
</tr>
<tr>
<td>70031</td>
<td>The PLC configured in the system function is not an S7 PLC. The connection to the new PLC was not established.</td>
<td>Compare the S7 PLC name parameter configured for the system function with the parameters configured for the PLC and correct them as necessary.</td>
</tr>
<tr>
<td>70032</td>
<td>The object configured with this number in the tab order is not available in the selected screen. The screen changes but the focus is set to the first object.</td>
<td>Check the number of the tab order and correct it if necessary.</td>
</tr>
<tr>
<td>70033</td>
<td>An e-mail cannot be sent because a TCP/IP connection to the SMTP server no longer exists. This system alarm is generated only at the first attempt. All subsequent unsuccessful attempts to send an e-mail will no longer generate a system alarm. The event is regenerated when an e-mail has been successfully sent in the meantime. The central e-mail component in WinCC flexible Runtime attempts, in regular intervals (1 minute), to establish the connection to the SMTP server and to send the remaining e-mails.</td>
<td>Check the network connection to the SMTP server and re-establish it if necessary.</td>
</tr>
<tr>
<td>70034</td>
<td>Following a disruption, the TCP/IP connection to the SMTP server could be re-established. The queued e-mails are then sent.</td>
<td>--</td>
</tr>
</tbody>
</table>
| 70036  | No SMTP server for sending e-mails is configured. An attempt to connect to an SMTP server has failed and it is not possible to send e-mails. WinCC flexible Runtime generates the system alarm after the first attempt to send an e-mail. | Configure an SMTP server:  
In WinCC flexible Engineering System using "Device settings > Device settings"  
In the Windows CE operating system using "Control Panel > Internet Settings > E-mail > SMTP Server" |
| 70037  | An e-mail cannot be sent for unknown reasons. The contents of the e-mail are lost. | Check the e-mail parameters (recipient etc.). |
| 70038  | The SMTP server has rejected sending or forwarding an e-mail because the domain of the recipient is unknown to the server or because the SMTP server requires authentication. The contents of the e-mail are lost. | Check the domain of the recipient address or disable the authentication on the SMTP server if possible. SMTP authentication is currently not used in WinCC flexible Runtime. |
| 70039  | The syntax of the e-mail address is incorrect or contains illegal characters. The contents of the e-mail are discarded. | Check the e-mail address of the recipient. |
| 70040  | The syntax of the e-mail address is incorrect or contains illegal characters. | -- |
| 70041  | The import of the user management was aborted due to an error. Nothing was imported. | Check your user management or transfer it again to the panel. |
### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>70042</td>
<td>The range of values of the tag was exceeded while executing the system function. The system function was not calculated.</td>
<td>Check and correct the calculation.</td>
</tr>
<tr>
<td>70043</td>
<td>The range of values of the tag was exceeded while executing the system function. The system function was not calculated.</td>
<td>Check and correct the calculation.</td>
</tr>
<tr>
<td>70044</td>
<td>An error occurred while sending the e-mails. The e-mails were not sent.</td>
<td>Check the SMTP settings and the error message in the system alarm.</td>
</tr>
<tr>
<td>70045</td>
<td>Cannot load a file required for encrypting the e-mail.</td>
<td>Update the operating system and Runtime.</td>
</tr>
<tr>
<td>70046</td>
<td>The server does not support encryption.</td>
<td>Select an SMTP server that supports encryption.</td>
</tr>
<tr>
<td>70047</td>
<td>The SSL versions of the HMI device and SMTP server may not be compatible.</td>
<td>Contact your network administrator or the operator of the SMTP server.</td>
</tr>
</tbody>
</table>

#### 80000 - Log alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>80001</td>
<td>The log specified is filled to the size defined (in percent) and must be stored elsewhere.</td>
<td>Store the file or table by executing a ‘move’ or ‘copy’ function.</td>
</tr>
<tr>
<td>80002</td>
<td>A line is missing in the specified log.</td>
<td>--</td>
</tr>
<tr>
<td>80003</td>
<td>The copying process for logging was not successful.</td>
<td>--</td>
</tr>
<tr>
<td>80006</td>
<td>Since logging is not possible, this causes a permanent loss of the functionality.</td>
<td>In the case of databases, check whether the corresponding data source exists and start up the system again.</td>
</tr>
<tr>
<td>80009</td>
<td>A copying action has been completed successfully.</td>
<td>--</td>
</tr>
<tr>
<td>8010</td>
<td>Since the storage location was incorrectly entered in WinCC flexible, this causes a permanent loss of the functionality.</td>
<td>Configure the storage location for the respective log again and restart the system when the full functionality is required.</td>
</tr>
<tr>
<td>8012</td>
<td>Log entries are stored in a buffer. If the values are read to the buffer faster than they can be physically written (using a hard disk, for example), overloading may occur and recording is then stopped.</td>
<td>Archive fewer values. Or: Increase the logging cycle.</td>
</tr>
<tr>
<td>8013</td>
<td>The overload status no longer applies. Archiving resumes the recording of all values.</td>
<td>--</td>
</tr>
<tr>
<td>8014</td>
<td>The same action was triggered twice in quick succession.</td>
<td>--</td>
</tr>
<tr>
<td>8015</td>
<td>This system alarm is used to report DOS or database errors to the user.</td>
<td>--</td>
</tr>
<tr>
<td>8016</td>
<td>The logs are separated by the system function “CloseAllLogs” and the incoming entries exceed the defined buffer size. All entries in the buffer are deleted.</td>
<td>Reconnect the logs.</td>
</tr>
<tr>
<td>Number</td>
<td>Effect/causes</td>
<td>Remedy</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>80017</td>
<td>The number of incoming events cause a buffer overflow. This can be caused, for example, by several copying actions being activated at the same time. All copy jobs in the buffer are deleted.</td>
<td>Stop the copy action.</td>
</tr>
<tr>
<td>80019</td>
<td>The connection between WinCC flexible and all logs were closed, for example, after executing the system function &quot;CloseAllLogs&quot;. Entries are written to the buffer and are then written to the logs when a connection is re-established. There is no connection to the storage location and the storage medium may be replaced, for example.</td>
<td>--</td>
</tr>
<tr>
<td>80020</td>
<td>The maximum number of simultaneously copy operations has been exceeded. Copying is not executed.</td>
<td>Wait until the current copying actions have been completed, then restart the last copy action.</td>
</tr>
<tr>
<td>80021</td>
<td>An attempt was made to delete a log which is still busy with a copy action. Deletion has not been executed.</td>
<td>Wait until the current copying actions have been completed, then restart the last action.</td>
</tr>
</tbody>
</table>
| 80022  | An attempt was made to use the system function "StartSequenceLog" to start a sequence log for a log which is not configured as a sequence log. No sequence log file is created. | In the project, check  
- if the "StartSequenceLog" system function was properly configured.  
- if the tag parameters are properly provided with data on the HMI device. |
| 80023  | An attempt was made to copy a log to itself. The log is not copied.            | In the project, check  
- if the "CopyLog" system function was properly configured.  
- if the tag parameters are properly provided with data on the HMI device. |
<p>| 80024  | The &quot;CopyLog&quot; system function does not allow copying when the target log already contains data (&quot;Mode&quot; parameter). The log is not copied. | Edit the &quot;CopyLog&quot; system function in the project if necessary. Before you initiate the system function, delete the destination log file. |
| 80025  | You have canceled the copy operation. Data written up to this point are retained. The destination log file (if configured) is not deleted. The cancellation is reported by an error entry $RT_ERR$ at the end of the destination log. | --                                                                      |
| 80026  | This alarm is output after all logs are initialized. Values are written to the logs from then on. Prior to this, no entries are written to the logs, irrespective whether WinCC flexible Runtime is active or not. | --                                                                      |
| 80027  | The internal Flash memory has been specified as the storage location for a log. This is not permissible. No values are written to this log and the log file is not created. | Configure &quot;Storage Card&quot; or a network path as the storage location.       |
| 80028  | The alarm returns a status report indicating that the logs are currently being initialized. No values are logged until the alarm 80026 is output. | --                                                                      |</p>
<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>80029</td>
<td>The number of logs specified in the alarm could not be initialized. The logs are initialized. The faulty log files are not available for logging jobs.</td>
<td>Evaluate the additional system alarms related to this alarm. Check the configuration, the ODBC (Open Database Connectivity) and the specified drive.</td>
</tr>
<tr>
<td>80030</td>
<td>The structure of the existing log file does not match the expected structure. Logging is stopped for this log.</td>
<td>Delete the existing log data manually, in advance.</td>
</tr>
<tr>
<td>80031</td>
<td>The log in CSV format is corrupted.</td>
<td>Delete the faulty file.</td>
</tr>
<tr>
<td>80032</td>
<td>Logs can be assigned events. These are triggered as soon as the log is full. WinCC flexible Runtime is started and the log is already full, the event is not triggered. The log specified no longer logs data because it is full.</td>
<td>Close WinCC flexible Runtime delete the log, then restart WinCC flexible Runtime. Or: Configure a button which contains the same actions as the event and press it.</td>
</tr>
<tr>
<td>80033</td>
<td>&quot;System Defined&quot; is set in the data log file as the data source name. This causes an error. No data is written to the database logs, whereas the logging to the CSV logs works.</td>
<td>Reinstall SQL Sever 2005 Express.</td>
</tr>
<tr>
<td>80034</td>
<td>An error has occurred in the initialization of the logs. An attempt has been made to create the tables as a backup. This action was successful. A backup has been made of the tables of the corrupted log file and the cleared log was restarted.</td>
<td>No action is necessary. However, it is recommended to save the backup files or delete them in order to make the space available again.</td>
</tr>
<tr>
<td>80035</td>
<td>An error has occurred in the initialization of the logs. An attempt has been made to create backups of the tables and this has failed. No logging or backup has been performed.</td>
<td>It is recommended to save the backups or to delete them in order to release memory.</td>
</tr>
<tr>
<td>80044</td>
<td>The export of a log was interrupted because Runtime was closed or due to a power failure. It was detected that the export needed to be resume when Runtime restarted.</td>
<td>The export resumes automatically.</td>
</tr>
</tbody>
</table>
| 80045  | The export of a log was interrupted due to an error in the connection to the server or at the server itself. | The export is repeated automatically. Check:  
  • The connection to the server.  
  • If the server is running.  
  • If there is enough free space on the server. |
| 80046  | The destination file could not be written while exporting the log.            | Check whether there is enough space on the server and if you have permission to create the log file. |
| 80047  | The log could not be read while exporting it.                                | Check whether the storage medium is correctly inserted.                |
| 80049  | The log could not be renamed while preparing to export it. The job can not be completed." | Check whether the storage medium is correctly inserted and if there is sufficient space on the medium. |
| 80050  | The log which shall be exported is not closed. The job can not be completed. | Make sure the "CloseAllLogs" system function is called before using the "ExportLog" system function. Change the configuration as required. |
| 80051  | The log to be copied contains an invalid checksum. The log was not copied.    | Select a log with a valid checksum. The selected log may have been manipulated. |
| 80052  | The log cannot be read.                                                      | Check the log and the specified path.                                  |
| 80053  | The closed log cannot be read.                                               | Open the log.                                                          |
## A.2 System alarms

### 90000 - FDA alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>90024</td>
<td>No operator actions can be logged due to lack of space on the storage medium for log. The operator action will therefore not be executed.</td>
<td>Make more space available by inserting an empty storage medium or swapping out the log files on the server using &quot;ExportLog&quot;.</td>
</tr>
<tr>
<td>90025</td>
<td>No user actions can be logged because of error state of the archive. Therefore the user action will not be executed.</td>
<td>Check whether the storage medium is correctly inserted.</td>
</tr>
<tr>
<td>90026</td>
<td>No operator actions can be logged because the log is closed. The operator action will therefore not be executed.</td>
<td>Before further operator actions are carried out, the log must be opened again using the system function &quot;OpenAllLogs&quot;. Change the configuration as required.</td>
</tr>
<tr>
<td>90028</td>
<td>The password you entered is incorrect.</td>
<td>Enter the correct password.</td>
</tr>
<tr>
<td>90029</td>
<td>Runtime was closed during ongoing operation (perhaps due to a power failure) or a storage medium in use is incompatible with Audit Trail. An Audit Trail is not suitable if it belongs to another project or has already been logged.</td>
<td>Ensure that you are using the correct storage medium.</td>
</tr>
<tr>
<td>90030</td>
<td>Runtime was closed during ongoing operation (perhaps due to a power failure).</td>
<td>--</td>
</tr>
<tr>
<td>90031</td>
<td>Runtime was closed during ongoing operation (perhaps due to a power failure).</td>
<td>--</td>
</tr>
<tr>
<td>90032</td>
<td>Running out of space on the storage medium for log.</td>
<td>Make more space available by inserting an empty storage medium or swapping out the log files on the server using &quot;ExportLog&quot;.</td>
</tr>
<tr>
<td>90033</td>
<td>No more space on the storage medium for log. As of now, no more operator actions requiring logging will be executed.</td>
<td>Make more space available by inserting an empty storage medium or swapping out the log files on the server using &quot;ExportLog&quot;.</td>
</tr>
<tr>
<td>90039</td>
<td>You do not have the necessary authorization to perform this action.</td>
<td>Adapt or upgrade your authorizations.</td>
</tr>
<tr>
<td>90040</td>
<td>Audit Trail is switched off because of a forced user action.</td>
<td>Activate the &quot;Audit Trail&quot; again using the system function &quot;StartLog&quot;.</td>
</tr>
<tr>
<td>90041</td>
<td>A user action which has to be logged has been executed without a logged on user.</td>
<td>A user action requiring logging should only be possible with permission. Change the configuration by setting a required authorization for the input object.</td>
</tr>
<tr>
<td>90044</td>
<td>A user action which has to be confirmed was blocked, because there is another user action pending.</td>
<td>Repeat the user action if necessary.</td>
</tr>
<tr>
<td>90048</td>
<td>The Audit Trail cannot be printed while data relevant to the audit is being logged.</td>
<td>Stop logging using the system function &quot;StopLogging&quot;.</td>
</tr>
<tr>
<td>90049</td>
<td>Access to required file is not possible.</td>
<td>Check the network connection or the storage medium.</td>
</tr>
<tr>
<td>90056</td>
<td>The recipe was not imported because the file contains no checksum.</td>
<td>Select a file with a checksum.</td>
</tr>
<tr>
<td>90057</td>
<td>The recipe was not imported because the file contains an invalid checksum. The selected file may have been manipulated.</td>
<td>Select a file with a valid checksum.</td>
</tr>
</tbody>
</table>
### 110000 - Offline function alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>110000</td>
<td>The operating mode was changed. &quot;Offline&quot; mode is now set.</td>
<td>--</td>
</tr>
<tr>
<td>110001</td>
<td>The operating mode was changed. &quot;Online&quot; mode is now set.</td>
<td>--</td>
</tr>
<tr>
<td>110002</td>
<td>The operating mode was not changed.</td>
<td>Check the connection to the PLCs. Check whether the address area for the area pointer 88 &quot;Coordination&quot; in the PLC is available.</td>
</tr>
<tr>
<td>110003</td>
<td>The operating mode of the specified PLC was changed by the system function &quot;SetConnectionMode&quot;. The operating mode is now &quot;offline&quot;.</td>
<td>--</td>
</tr>
<tr>
<td>110004</td>
<td>The operating mode of the specified PLC has been changed by the system function &quot;SetConnectionMode&quot;. The operating mode is now &quot;online&quot;.</td>
<td>--</td>
</tr>
<tr>
<td>110005</td>
<td>An attempt was made to use the system function SetConnectionMode to switch the specified PLC to &quot;online&quot; mode, although the entire system is in &quot;offline&quot; mode. This changeover is not allowed. The PLC remains in &quot;offline&quot; mode.</td>
<td>Switch the complete system to &quot;online&quot; mode, then execute the system function again.</td>
</tr>
</tbody>
</table>
| 110006  | The content of the "project version" area pointer does not match the user version configured in WinCC flexible. WinCC flexible Runtime is therefore closed.                                                     | Check the following:  
  - The project ID entered on the PLC.  
  - The project ID entered in WinCC flexible.                                                                                                                   |

### 120000 - Trend alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>120000</td>
<td>The trend is not displayed because you configured an incorrect axis to the trend or an incorrect trend.</td>
<td>Change the configuration.</td>
</tr>
<tr>
<td>120001</td>
<td>The trend is not displayed because you configured an incorrect axis to the trend or an incorrect trend.</td>
<td>Change the configuration.</td>
</tr>
<tr>
<td>120002</td>
<td>The trend is not displayed because the tag assigned attempts to access an invalid PLC address.</td>
<td>Check whether the data area for the tag exists in the PLC, the configured address is correct and the value range for the tag is correct.</td>
</tr>
</tbody>
</table>
### 130000 - System information alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>130000</td>
<td>The action was not executed.</td>
<td>Close all other programs. Delete files no longer required from the hard disk.</td>
</tr>
<tr>
<td>130001</td>
<td>The action was not executed.</td>
<td>Delete files no longer required from the hard disk.</td>
</tr>
<tr>
<td>130002</td>
<td>The action was not executed.</td>
<td>Close all other programs. Delete files no longer required from the hard disk.</td>
</tr>
<tr>
<td>130003</td>
<td>No data medium found. The operation is canceled.</td>
<td>Check, for example, if&lt;br&gt;• The correct data medium is being accessed&lt;br&gt;• The data medium is inserted</td>
</tr>
<tr>
<td>130004</td>
<td>The data medium is write-protected. The operation is canceled.</td>
<td>Check whether access has been made to the correct data carrier. Remove the write protection.</td>
</tr>
<tr>
<td>130005</td>
<td>The file is read only. The operation is canceled.</td>
<td>Check whether access has been made to the correct file. Edit the file attributes if necessary.</td>
</tr>
<tr>
<td>130006</td>
<td>Access to file failed. The operation is canceled.</td>
<td>Check, for example, if&lt;br&gt;• The correct file is being accessed&lt;br&gt;• The file exists&lt;br&gt;• Another action is preventing simultaneous access to the file.</td>
</tr>
<tr>
<td>130007</td>
<td>The network connection is interrupted. Records cannot be saved or read over the network connection.</td>
<td>Check the network connection and eliminate the cause of error.</td>
</tr>
<tr>
<td>130008</td>
<td>The storage card is not available. The specified data records cannot be saved to / read from the storage card.</td>
<td>Insert the storage card.</td>
</tr>
<tr>
<td>130009</td>
<td>The specified folder does not exist on the storage card. Any files saved to this directory are not backed up when you switch off the HMI device.</td>
<td>Insert the storage card.</td>
</tr>
<tr>
<td>130010</td>
<td>The maximum nesting depth can be exhausted when, for example, a value change in a script results in the call of another script and the second script in turn has a value change that results in the call of yet a further script etc. The configured functionality is not supported.</td>
<td>Check the configuration.</td>
</tr>
<tr>
<td>130013</td>
<td>The storage card is not available. The specified data records cannot be saved to / read from the storage card.</td>
<td>Insert the storage card.</td>
</tr>
</tbody>
</table>
## 140000 - Connection alarms chns7: Connection + device

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>140000</td>
<td>An online connection to the PLC is established.</td>
<td>--</td>
</tr>
<tr>
<td>140001</td>
<td>The online connection to the PLC was shut down.</td>
<td>--</td>
</tr>
<tr>
<td>140003</td>
<td>No tag updating or writing is executed.</td>
<td>Check the connection and if the PLC is switched on. Check the parameter definitions in the Control Panel using &quot;Set PG/PC interface&quot;. Restart the system.</td>
</tr>
<tr>
<td>140004</td>
<td>No tag update or write operations are executed because the access point or the module configuration is faulty.</td>
<td>Verify the connection and check whether the PLC is switched on. Check the access point or the module configuration (MPI, PPI, PROFIBUS) in the Control Panel with &quot;Set PG/PC interface&quot;. Restart the system.</td>
</tr>
<tr>
<td>140005</td>
<td>No tag updating or writing is executed because the HMI device address is incorrect (possibly too high).</td>
<td>Use a different HMI device address. Verify the connection and check whether the PLC is switched on. Check the parameter definitions in the Control Panel using &quot;Set PG/PC interface&quot;. Restart the system.</td>
</tr>
<tr>
<td>140006</td>
<td>No tag updating or writing is executed because the baud rate is incorrect.</td>
<td>Select a different baud rate in WinCC flexible (according to module, profile, communication peer, etc.).</td>
</tr>
<tr>
<td>140007</td>
<td>Tags are not updated or written because the bus profile is incorrect (see %1). The following parameters could not be written to the registry:</td>
<td>Check the user-defined bus profile. Check the connection and if the PLC is switched on. Check the parameter definitions in the Control Panel using &quot;Set PG/PC interface&quot;. Restart the system.</td>
</tr>
<tr>
<td></td>
<td>1: Tslot</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2: Tqui</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3: Tset</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4: MinTsdr</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5: MaxTsdr</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6: Trdy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7: Tid1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8: Tid2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9: Gap Factor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10: Retry Limit</td>
<td></td>
</tr>
<tr>
<td>140008</td>
<td>No tag updating or writing is executed because baud rate is incorrect.</td>
<td>Check the connection and if the PLC is switched on. Check the parameter definitions in the Control Panel using &quot;Set PG/PC interface&quot;. Restart the system.</td>
</tr>
<tr>
<td></td>
<td>The following parameters could not be written to the registry:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0: General error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: Wrong version</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2: Profile cannot be written to the registry.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3: The subnet type cannot be written to the registry.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4: The target rotation time cannot be written to the registry.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5: Faulty highest address (HSA).</td>
<td></td>
</tr>
<tr>
<td>140009</td>
<td>Tags are not updated or written because the module for S7 communication was not found.</td>
<td>Reinstall the module in the Control Panel using &quot;Set PG/PC interface&quot;.</td>
</tr>
<tr>
<td>Number</td>
<td>Effect/causes</td>
<td>Remedy</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>140010</td>
<td>No S7 communication partner found because the PLC is shut down.</td>
<td>Switch the PLC on. DP/T: If only one master is connected to the network, disable &quot;PG/PC is the only master&quot; in &quot;Set PG/PC interface&quot;. If several masters are connected to the network, enable these. Do not change any settings, for this will cause bus errors.</td>
</tr>
<tr>
<td></td>
<td>DP/T: The option &quot;PG/PC is the only master&quot; is not set in the Control Panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>under &quot;Set PG/PC interface.&quot;</td>
<td></td>
</tr>
<tr>
<td>140011</td>
<td>No tag updating or writing is executed because communication is down.</td>
<td>Check the connection and that the communication partner is switched on.</td>
</tr>
<tr>
<td>140012</td>
<td>There is an initialization problem (e.g. when WinCC flexible Runtime was</td>
<td>Restart the HMI device. Or: Run WinCC flexible Runtime, then start your other applications.</td>
</tr>
<tr>
<td></td>
<td>closed in Task Manager). Or: Another application (e.g. STEP7) with different</td>
<td></td>
</tr>
<tr>
<td></td>
<td>bus parameters is active and the driver cannot be started with the new bus</td>
<td></td>
</tr>
<tr>
<td></td>
<td>parameters (transmission rate, for example).</td>
<td></td>
</tr>
<tr>
<td>140013</td>
<td>The MPI cable is disconnected and, thus, there is no power supply.</td>
<td>Check the connections.</td>
</tr>
<tr>
<td>140014</td>
<td>The configured bus address is in already in use by another application.</td>
<td>Edit the HMI device address in the PLC configuration.</td>
</tr>
<tr>
<td>140015</td>
<td>Wrong transmission rate Or: Faulty bus parameters (e.g. HSA) Or: OP address</td>
<td>Correct the relevant parameters.</td>
</tr>
<tr>
<td></td>
<td>&gt; HSA or: Wrong interrupt vector (interrupt does not arrive at the driver)</td>
<td></td>
</tr>
<tr>
<td>140016</td>
<td>The hardware does not support the configured interrupt.</td>
<td>Change the interrupt number.</td>
</tr>
<tr>
<td>140017</td>
<td>The set interrupt is in use by another driver.</td>
<td>Change the interrupt number.</td>
</tr>
<tr>
<td>140018</td>
<td>The consistency check was disabled by SIMOTION Scout. Only a corresponding</td>
<td>Enable the consistency check with SIMOTION Scout and once again download the project to the PLC.</td>
</tr>
<tr>
<td></td>
<td>note appears.</td>
<td></td>
</tr>
<tr>
<td>140019</td>
<td>SIMOTION Scout is downloading a new project to the PLC. Connection to the</td>
<td>Wait until the end of the reconfiguration.</td>
</tr>
<tr>
<td></td>
<td>PLC is canceled.</td>
<td></td>
</tr>
<tr>
<td>140020</td>
<td>The version in the PLC and that of the project (FWX file) do not match.</td>
<td>The following remedies are available: Download the current version to the PLC using SIMOTION Scout. Regenerate the project using WinCC flexible ES, close WinCC flexible Runtime and restart with a new configuration.</td>
</tr>
<tr>
<td></td>
<td>Connection to the PLC is canceled.</td>
<td></td>
</tr>
</tbody>
</table>
### 150000 - Connection alarms chnAS511: Connection

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| 150000 | No more data is read or written. Possible causes:  
- The cable is defective.  
- The PLC does not respond, is defective, etc.  
- The wrong port is used for the connection.  
- System overload | Ensure that the cable is plugged in, the PLC is operational, the correct port is being used. Restart the system if the system alarm persists. |
| 150001 | Connection is up because the cause of the interruption has been eliminated. | -- |

### 160000 - Connection alarms IVar (WinLC) / OPC: Connection

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| 160000 | No more data is read or written. Possible causes:  
- The cable is defective.  
- The PLC does not respond, is defective, etc.  
- The wrong port is used for the connection.  
- System overload | Ensure that the cable is plugged in, the PLC is operational, the correct port is being used. Restart the system if the system alarm persists. |
| 160001 | Connection is up because the cause of the interruption has been eliminated. | -- |
| 160010 | No connection to the server because the server identification (CLS-ID) cannot be determined. Values cannot be read or written. | Check access rights. |
| 160011 | No connection to the server because the server identification (CLS-ID) cannot be determined. Values cannot be read or written. | Check, for example, if  
- The server name is correct.  
- The computer name is correct.  
- The server is registered. |
| 160012 | No connection to the server because the server identification (CLS-ID) cannot be determined. Values cannot be read or written. | Check, for example, if  
- The server name is correct.  
- The computer name is correct.  
- The server is registered.  
Note for advanced users: Interpret the value from HRESULT. |
| 160013 | The specified server was started as InProc server. This has not been released and may possibly lead to incorrect behavior because the server is running in the same process area as the WinCC flexible Runtime software. | Configure the server as OutProc Server or Local Server. |
| 160014 | Only one OPC server project can be started on a PC/MP. An alarm is output when an attempt is made to start a second project. The second project has no OPC server functionality and cannot be located as an OPC server by external sources. | Do not start a second project with OPC server functionality on the computer. |
### 170000 - S7 dialog alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>170000</td>
<td>S7 diagnostics events are not indicated because it is not possible to log on to the S7 diagnostics functions at this device. The service is not supported.</td>
<td>--</td>
</tr>
<tr>
<td>170001</td>
<td>The S7 diagnostics buffer cannot be viewed because communication with the PLC is shut down.</td>
<td>Set the PLC to online mode.</td>
</tr>
<tr>
<td>170002</td>
<td>The S7 diagnostics buffer cannot be viewed because reading of the diagnostics buffer (SSL) was canceled with error.</td>
<td>--</td>
</tr>
<tr>
<td>170003</td>
<td>An S7 diagnostics event cannot be visualized. The system returns internal error %2.</td>
<td>--</td>
</tr>
<tr>
<td>170004</td>
<td>An S7 diagnostics event cannot be visualized. The system returns an internal error of error class %2, error number %3.</td>
<td>--</td>
</tr>
<tr>
<td>170007</td>
<td>It is not possible to read the S7 diagnostics buffer (SSL) because this operation was canceled with an internal error of class %2 and error code %3.</td>
<td>--</td>
</tr>
</tbody>
</table>

### 180000 - Misc/common alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>180000</td>
<td>A component/OCX received configuration data with a version ID which is not supported.</td>
<td>Install a newer component.</td>
</tr>
<tr>
<td>180001</td>
<td>System overload because too many actions running in parallel. Not all the actions can be executed, some are rejected.</td>
<td>Several remedies are available:</td>
</tr>
</tbody>
</table>
|         | • Generate the alarms at a slower rate (polling).  
|         | • Initiate scripts and functions at greater intervals.  
|         | If the alarm appears more frequently: Restart the HMI device.                                                                                                                                         |                                |
| 180002  | The screen keyboard could not be activated. Possible causes:  
|         | “TouchInputPC.exe” was not registered due to a faulty Setup.                                                                                                                                             | Install WinCC flexible Runtime again. |

### 190000 - Tag alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>190000</td>
<td>It is possible that the tag is not updated.</td>
<td>--</td>
</tr>
<tr>
<td>190001</td>
<td>The tag is updated after the cause of the last error state has been eliminated (return to normal operation).</td>
<td>--</td>
</tr>
<tr>
<td>190002</td>
<td>The tag is not updated because communication with the PLC is down.</td>
<td>Select the system function &quot;SetOnline&quot; to go online.</td>
</tr>
</tbody>
</table>
## Appendix
### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>190004</td>
<td>The tag is not updated because the configured tag address does not exist.</td>
<td>Check the configuration.</td>
</tr>
<tr>
<td>190005</td>
<td>The tag is not updated because the configured PLC type does not exist for this tag.</td>
<td>Check the configuration.</td>
</tr>
<tr>
<td>190006</td>
<td>The tag is not updated because it is not possible to map the PLC type in the data type of the tag.</td>
<td>Check the configuration.</td>
</tr>
<tr>
<td>190007</td>
<td>The tag value is not modified because the connection to the PLC is interrupted or the tag is offline.</td>
<td>Set online mode or reconnect to the PLC.</td>
</tr>
<tr>
<td>190008</td>
<td>The threshold values configured for the tag have been violated, for example, by</td>
<td>Observe the configured or current threshold values of the tag.</td>
</tr>
<tr>
<td></td>
<td>• A value entered</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• A system function</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• A script</td>
<td></td>
</tr>
<tr>
<td>190009</td>
<td>An attempt has been made to assign the tag a value which is outside the permitted range of values for this data type. For example, a value of 260 was entered for a byte tag or a value of -3 for an unsigned word tag.</td>
<td>Observe the range of values for the data type of the tags.</td>
</tr>
<tr>
<td>190010</td>
<td>Too many values are written to the tag (for example, in a loop triggered by a script). Values are lost because only up to 100 actions are saved to the buffer.</td>
<td>The following remedies are available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Increase the time interval between multiple write actions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Do not use an array tag longer than 6 words when you configure an acknowledgment on the HMI device using &quot;Acknowledgment HMI&quot;.</td>
</tr>
<tr>
<td>190011</td>
<td>Possible cause 1: The value entered could not be written to the configured PLC tag because the high or low limit was exceeded. The system discards the entry and restores the original value. Possible cause 2: The connection to the PLC was interrupted.</td>
<td>Make sure that the value entered lies within the range of values of the control tags.</td>
</tr>
<tr>
<td>190012</td>
<td>It is not possible to convert a value from a source format to a target format, for example: An attempt is being made to assign a value to a counter that is outside the valid, PLC-specific value range. A tag of the type Integer should be assigned a value of the type String.</td>
<td>Check the range of values or the data type of the tags.</td>
</tr>
<tr>
<td>190013</td>
<td>The user has entered a string that is longer than the tag. The string is automatically shortened to the permitted length.</td>
<td>Only enter strings that do not exceed the permitted tag length.</td>
</tr>
</tbody>
</table>
## Appendix

### A.2 System alarms

### 190100 - Area pointer alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| 190100 | The area pointer is not updated because the address configured for this pointer does not exist. Type  
1 Warnings  
2 Errors  
3 PLC acknowledgment  
4 HMI device acknowledgment  
5 LED mapping  
6 Trend request  
7 Trend transfer 1  
8 Trend transfer 2  
No.: Consecutive number displayed in WinCC flexible ES. | Check the configuration. |
| 190101 | The area pointer is not updated because it is not possible to map the PLC type to the area pointer type. Parameter type and no.: see alarm 190100 | -- |
| 190102 | The area pointer is updated after the cause of the last error state has been eliminated (return to normal operation). Parameter type and no.: See alarm 190100. | -- |

### 200000 - PLC coordination alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>200000</td>
<td>Coordination is not executed because the address configured in the PLC does not exist/is not set.</td>
<td>Change the address or set up the address in the PLC.</td>
</tr>
<tr>
<td>200001</td>
<td>Coordination is canceled because the write access to the address configured in the PLC is not possible.</td>
<td>Change the address or set the address in the PLC at an area which allows write access.</td>
</tr>
<tr>
<td>200002</td>
<td>Coordination is not carried out at the moment because the address format of the area pointer does not match the internal storage format.</td>
<td>Internal error</td>
</tr>
<tr>
<td>200003</td>
<td>Coordination can be executed again because the last error state is eliminated (return to normal operation).</td>
<td>--</td>
</tr>
<tr>
<td>200004</td>
<td>The coordination may not be executed.</td>
<td>--</td>
</tr>
</tbody>
</table>
| 200005 | No more data is read or written. Possible causes:  
• The cable is defective.  
• The PLC does not respond, is defective, etc.  
• System overload | Ensure that the cable is plugged in and the PLC is operational. Restart the system if the system alarm persists. |
### 210000 - PLC job alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>210000</td>
<td>Jobs are not processed because the address configured in the PLC does not exist/has not been set up.</td>
<td>Change the address or set up the address in the PLC.</td>
</tr>
<tr>
<td>210001</td>
<td>Jobs are not processed because read/write access to the address configured in the PLC is not possible.</td>
<td>Change the address or set up the address in the PLC in an area which allows read/write access.</td>
</tr>
<tr>
<td>210002</td>
<td>Jobs are not executed because the address format of the area pointer does not match the internal storage format.</td>
<td>Internal error</td>
</tr>
<tr>
<td>210003</td>
<td>The job buffer is processed again because the last error status has been eliminated (return to normal operation).</td>
<td>--</td>
</tr>
<tr>
<td>210004</td>
<td>It is possible that the job buffer will not be processed.</td>
<td>--</td>
</tr>
<tr>
<td>210005</td>
<td>A control request with an illegal number was initiated.</td>
<td>Check the PLC program.</td>
</tr>
<tr>
<td>210006</td>
<td>An error occurred while attempting to execute the control request. As a result, the control request is not executed. Observe the next/previous system alarms.</td>
<td>Check the parameters of the control request. Recompile the configuration.</td>
</tr>
</tbody>
</table>

### 220000 - WinCC channel adapter alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>220001</td>
<td>The tag is not downloaded because the associated communication driver / HMI device does not support the download of Boolean/discrete data types.</td>
<td>Change the configuration.</td>
</tr>
<tr>
<td>220002</td>
<td>The tag is not downloaded because the associated communication driver / HMI device does not support write access to the data type BYTE.</td>
<td>Change the configuration.</td>
</tr>
<tr>
<td>220003</td>
<td>The communication driver cannot be loaded. The driver may not be installed.</td>
<td>Install the driver by reinstalling WinCC flexible Runtime.</td>
</tr>
<tr>
<td>220004</td>
<td>Communication is down and no update data is transferred because the cable is not connected or defective etc.</td>
<td>Check the connection.</td>
</tr>
<tr>
<td>220005</td>
<td>Communication is up.</td>
<td>--</td>
</tr>
<tr>
<td>220006</td>
<td>The connection between the specified PLC and the specified port is active.</td>
<td>--</td>
</tr>
</tbody>
</table>
### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>220007</td>
<td>The connection to the specified PLC is interrupted at the specified port.</td>
<td>Check whether&lt;br&gt;• The cable is plugged in&lt;br&gt;• The PLC is OK&lt;br&gt;• The correct port is used&lt;br&gt;• Your configuration is OK (port parameters, protocol settings, PLC address). Restart the system if the system alarm persists.</td>
</tr>
<tr>
<td>220008</td>
<td>The communication driver cannot access or open the specified port. The port may be in use by another application or the port used is not available on the destination device. There is no communication with the PLC.</td>
<td>Close all the applications which access this port and restart the computer.&lt;br&gt;Use another port of the system.</td>
</tr>
<tr>
<td>230000</td>
<td>The value entered could not be accepted. The system discards the entry and restores the previous value. Either&lt;br&gt;• The value range has been exceeded&lt;br&gt;• Illegal characters have been entered&lt;br&gt;• The maximum permitted number of users has been exceeded.</td>
<td>Enter a practical value or delete any unneeded users.</td>
</tr>
<tr>
<td>230002</td>
<td>The currently logged in user has not the required authorization. The system therefore discards the input and restored the previous value.</td>
<td>Log on as a user with appropriate authorization.</td>
</tr>
<tr>
<td>230003</td>
<td>Changeover to the specified screen failed because the screen is not available/configured. The current screen remains selected.</td>
<td>Configure the screen and check the screen selection function.</td>
</tr>
<tr>
<td>230005</td>
<td>The value range of the tag has been exceeded in the I/O field. The original value of the tag is retained.</td>
<td>Observe the range of values for the tag when entering a value.</td>
</tr>
<tr>
<td>230100</td>
<td>During navigation in the web browser, the system returned a message which may be of interest to the user. The web browser continues to run but may not (fully) show the new page.</td>
<td>Navigate to another page.</td>
</tr>
<tr>
<td>230200</td>
<td>The connection to the HTTP channel was interrupted due to an error. This error is explained in detail by another system alarm. Data is no longer exchanged.</td>
<td>Check the network connection.&lt;br&gt;Check the server configuration.</td>
</tr>
<tr>
<td>230201</td>
<td>The connection to HTTP channel was established. Data is exchanged.</td>
<td>--</td>
</tr>
</tbody>
</table>

---

**230000 - View alarms**

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>230000</td>
<td>The value entered could not be accepted. The system discards the entry and restores the previous value. Either&lt;br&gt;• The value range has been exceeded&lt;br&gt;• Illegal characters have been entered&lt;br&gt;• The maximum permitted number of users has been exceeded.</td>
<td>Enter a practical value or delete any unneeded users.</td>
</tr>
<tr>
<td>230002</td>
<td>The currently logged in user has not the required authorization. The system therefore discards the input and restored the previous value.</td>
<td>Log on as a user with appropriate authorization.</td>
</tr>
<tr>
<td>230003</td>
<td>Changeover to the specified screen failed because the screen is not available/configured. The current screen remains selected.</td>
<td>Configure the screen and check the screen selection function.</td>
</tr>
<tr>
<td>230005</td>
<td>The value range of the tag has been exceeded in the I/O field. The original value of the tag is retained.</td>
<td>Observe the range of values for the tag when entering a value.</td>
</tr>
<tr>
<td>230100</td>
<td>During navigation in the web browser, the system returned a message which may be of interest to the user. The web browser continues to run but may not (fully) show the new page.</td>
<td>Navigate to another page.</td>
</tr>
<tr>
<td>230200</td>
<td>The connection to the HTTP channel was interrupted due to an error. This error is explained in detail by another system alarm. Data is no longer exchanged.</td>
<td>Check the network connection.&lt;br&gt;Check the server configuration.</td>
</tr>
<tr>
<td>230201</td>
<td>The connection to HTTP channel was established. Data is exchanged.</td>
<td>--</td>
</tr>
</tbody>
</table>
### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| 230202  | WININET.DLL has detected an error. This error is usually generated if it is not possible to connect to the server or if the server denies access because the client could not authenticate itself. A rejected server certificate could also cause a communication error in secure SSL connections. For details, refer to the error text in the alarm. This text is always output in the language of your Windows installation, as it is returned by the Windows operating system. Process values are not exchanged. The part of the alarm which is returned by the Windows operating system may not be displayed, for example "An error has occurred." WININET.DLL returns the following error: Number: 12055 Text:HTTP: <no error text available>. | Depending on the cause: When an attempt to connect fails or a timeout error occurs:  
- Check the network connection and the network.  
- Check the server address.  
- Check whether the WebServer is actually running on the destination station. Faulty authorization:  
- The configured user name and/or password do not match those on the server. Establish consistency  
When the server certificate is rejected:  
Certificate signed by an unknown CA ( ):  
- Either ignore this item in your project, or  
- Install a certificate that has been signed with a root certificate known to the client computer. The date of the certificate is invalid:  
- Either ignore this item in your project, or  
- Install a certificate with a valid date on the server. Invalid CN (Common Name or Computer Name):  
- Either ignore this item in your project, or  
- Install a certificate with a name that corresponds to that of the server address. |
| 230203  | Although a connection can be made to the server, the HTTP server refuses to connect because  
- WinCC flexible Runtime is not running on the server or  
- The HTTP channel is not supported (503 Service unavailable). Other errors can only occur if the Webserver does not support the HTTP channel. The language of the alarm text depends on the Webserver. Data is not exchanged. | Error 503 Service unavailable:  
Check if WinCC flexible Runtime is running on the server and if the HTTP channel is supported. |
| 230301  | An internal error has occurred. An English text explains the error in more detail. This may be caused by insufficient memory. OCX does not work.                                                                                                                                                                                                  | --                                                                                                                                                                                                   |
| 230302  | The name of the remote server cannot be resolved. The attempt to connect failed.                                                                                                                                                                                                                                                                  | Check the configured server address. Check whether the DNS service is available on the network. |
| 230303  | The remote server is not running on the addressed computer. Wrong server address. The attempt to connect failed.                                                                                                                                                                                                                                           | Check the configured server address. Check whether the remote server is running on the target computer. |
| 230304  | The remote server on the addressed computer is incompatible with VNCOCX. The attempt to connect failed.                                                                                                                                                                                                                                              | Use a compatible remote server. |
### Appendix

#### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>230305</td>
<td>The authentication has failed because the password is incorrect. The attempt to connect failed.</td>
<td>Configure the correct password.</td>
</tr>
</tbody>
</table>
| 230306 | Error in the connection to the remote server. This may occur as a result of network problems. The attempt to connect failed. | Check whether  
• The bus cable is plugged in  
• There are network problems.                                        |
| 230307 | The connection to the remote server was shut down because  
• The remote server was shut down, or  
• The user instructed the server to close all connections.  
The connection is closed. | --                                                                    |
| 230308 | This alarm provides information on the connection status. An attempt is made to connect. | --                                                                    |

#### 240000 - Authorization alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| 240000 | WinCC flexible Runtime is operating in demo mode.  
You have no authorization or your authorization is corrupted. | Install the authorization.                                              |
| 240001 | WinCC flexible Runtime is operating in demo mode.  
Too many tags are configured for the installed version. | Load an adequate authorization / power pack.                           |
| 240002 | WinCC flexible Runtime is operating with a time-limited emergency authorization. | Restore the full authorization.                                         |
| 240004 | Error while reading the emergency authorization.  
WinCC flexible Runtime is operating in demo mode. | Restart WinCC flexible Runtime, install the authorization or repair the authorization (see Commissioning Instructions Software Protection). |
| 240005 | The Automation License Manager has detected an internal system fault.  
Possible causes:  
• A corrupt file  
• A defective installation  
• No free space for the Automation License Manager etc. | Reboot the HMI device or PC. If this does not solve the problem, remove the Automation License Manager and install it again. |
## Appendix

### A.2 System alarms

#### 250000 - S7 Force alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>250000</td>
<td>The tag in the specified line in &quot;Status Force&quot; is not updated because the address configured for this tag is not available.</td>
<td>Check the set address and then verify that the address is set up in the PLC.</td>
</tr>
<tr>
<td>250001</td>
<td>The tag in the specified line in &quot;Status Force&quot; is not updated because the PLC type configured for this tag does not exist.</td>
<td>Check the set address.</td>
</tr>
<tr>
<td>250002</td>
<td>The tag in the specified line in &quot;Status Force&quot; is not updated because it is not possible to map the PLC type in the tag type.</td>
<td>Check the set address.</td>
</tr>
<tr>
<td>250003</td>
<td>An attempt to connect to the PLC failed. The tags are not updated.</td>
<td>Check the connection to the PLC. Check that the PLC is switched on and is online.</td>
</tr>
</tbody>
</table>

#### 260000 - Password system alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>260000</td>
<td>An unknown user or an unknown password has been entered in the system.</td>
<td>Log on to the system as a user with a valid password.</td>
</tr>
<tr>
<td></td>
<td>The current user is logged off from the system.</td>
<td></td>
</tr>
<tr>
<td>260001</td>
<td>The logged in user does not have sufficient authorization to execute the protected functions on the system.</td>
<td>Log on to the system as a user with sufficient authorization.</td>
</tr>
<tr>
<td>260002</td>
<td>This alarm is triggered by the system function &quot;TrackUserChange&quot;.</td>
<td>--</td>
</tr>
<tr>
<td>260003</td>
<td>The user has logged off from the system.</td>
<td>--</td>
</tr>
<tr>
<td>260004</td>
<td>The user name entered into the user view already exists in the user management.</td>
<td>Select another user name because user names have to be unique in the user management.</td>
</tr>
<tr>
<td>260005</td>
<td>The entry is discarded.</td>
<td>Enter a shorter user name.</td>
</tr>
<tr>
<td>260006</td>
<td>The entry is discarded.</td>
<td>Use a shorter or longer password.</td>
</tr>
<tr>
<td>260007</td>
<td>The logon timeout value entered is outside the valid range of 0 to 60 minutes.</td>
<td>Enter a logon timeout value between 0 and 60 minutes.</td>
</tr>
<tr>
<td></td>
<td>The new value is discarded and the original value is retained.</td>
<td></td>
</tr>
<tr>
<td>260008</td>
<td>An attempt was made to read a PTProRun.pwl file created with ProTool V 6.0 in WinCC flexible.</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Reading the file was canceled due to incompatibility of the format.</td>
<td></td>
</tr>
<tr>
<td>260009</td>
<td>You have attempted to delete the user &quot;Admin&quot; or &quot;PLC User&quot;. These users are fixed components of the user management and cannot be deleted.</td>
<td>If you need to delete a user, because perhaps you have exceeded the maximum number permitted, delete another user.</td>
</tr>
<tr>
<td>260012</td>
<td>The passwords entered in the &quot;Change Password&quot; dialog and the confirmation field are not identical. The password has not been changed. User will be logged off.</td>
<td>You have to log on to the system again. Then enter the identical password twice to be able to change the password.</td>
</tr>
<tr>
<td>Number</td>
<td>Effect/causes</td>
<td>Remedy</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>260013</td>
<td>The password entered in the &quot;Change Password&quot; dialog is invalid because it is already in use. The password has not been changed. User will be logged off.</td>
<td>You have to log on to the system again. Then enter a new password that has not been used before.</td>
</tr>
<tr>
<td>260014</td>
<td>You have tried unsuccessfully to log on three times in succession. You will be locked out and assigned to group no. 0.</td>
<td>You can log on to the system with your correct password. Only an administrator can change the assignment to a group.</td>
</tr>
<tr>
<td>260024</td>
<td>The password you entered does not meet the necessary security guidelines.</td>
<td>Enter a password that contains at least one number.</td>
</tr>
<tr>
<td>260025</td>
<td>The password you entered does not meet the necessary security guidelines.</td>
<td>Enter a password that contains at least one special character.</td>
</tr>
<tr>
<td>260028</td>
<td>Upon system start-up, an attempt to log on, or when trying to change the password of a SIMATIC log-on user, the system attempts to access the SIMATIC Logon Server. If attempting to log on, the new user is not logged in. If a different user was logged on before, then this user is logged off.</td>
<td>Check the connection to the SIMATIC Logon Server and its configuration; for example: 1. Port number 2. IP address 3. Server name 4. Functional transfer cable Or use a local user.</td>
</tr>
<tr>
<td>260030</td>
<td>The SIMATIC Logon user could not change his password on the SIMATIC Logon Server. The new password may not comply with the password regulations on the server or the user does not have the right to change his password. The old password remains and the user is logged off.</td>
<td>Log in again and choose a different password. Check the password rules on the SIMATIC Logon Server.</td>
</tr>
<tr>
<td>260033</td>
<td>The action change password or log on user could not be carried out.</td>
<td>Check the connection to the SIMATIC Logon Server and its configuration; for example: 1. Port number 2. IP address 3. Server name 4. Functional transfer cable Or use a local user.</td>
</tr>
<tr>
<td>260034</td>
<td>The last logon operation has not yet ended. A user action or a logon dialog can therefore not be called. The logon dialog is not opened. The user action is not executed.</td>
<td>Wait until the logon operation is complete.</td>
</tr>
<tr>
<td>260035</td>
<td>The last attempt to change the password was not completed. A user action or a logon dialog can therefore not be called. The logon dialog is not opened. The user action is not executed.</td>
<td>Wait until the procedure is complete.</td>
</tr>
<tr>
<td>260036</td>
<td>There are insufficient licenses on the SIMATIC Logon Server. The logon is not authorized.</td>
<td>Check the licensing on the SIMATIC Logon Server.</td>
</tr>
</tbody>
</table>
### Appendix

#### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>260037</td>
<td>There is no license on the SIMATIC Logon Sever. A logon is not possible. It is not possible to log on via the SIMATIC Logon Server, only via a local user.</td>
<td>Check the licensing on the SIMATIC Logon Server.</td>
</tr>
<tr>
<td>260040</td>
<td>The system attempts to access the SIMATIC Logon Server upon system start-up or when trying to change the password. If attempting to log on, the new user is not logged in. If a different user was logged on before, then this user is logged off.</td>
<td>Check connection to the domain and its configuration in the Runtime security settings editor. Or use a local user.</td>
</tr>
<tr>
<td>260043</td>
<td>It was not possible to log the user on to the SIMATIC Logon Server. The user name or the password could be incorrect or the user does not have sufficient rights to log on. The new user is not logged in. If a different user was logged on before, then this user is logged off.</td>
<td>Try again. If necessary, check the password data on the SIMATIC Logon Server.</td>
</tr>
<tr>
<td>260044</td>
<td>It was not possible to log the user on to the SIMATIC Logon Server as his account is blocked. The new user is not logged in. If a different user was logged on before, then this user is logged off.</td>
<td>Check the user data on the SIMATIC Logon Server.</td>
</tr>
<tr>
<td>260045</td>
<td>The SIMATIC Logon user is not associated to any or several groups. The new user is not logged in. If a different user was logged on before, then this user is logged off.</td>
<td>Check the user data on the SIMATIC Logon Server and the configuration in your WinCC flexible project. A user may only be assigned to one group.</td>
</tr>
</tbody>
</table>

#### 270000 - System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>270000</td>
<td>A tag is not indicated in the alarm because it attempts to access an invalid address in the PLC.</td>
<td>Check whether the data area for the tag exists in the PLC, the configured address is correct and the value range for the tag is correct.</td>
</tr>
<tr>
<td>270001</td>
<td>There is a device-specific limit as to how many alarms may be queued for output (see the operating instructions). This limit has been exceeded. The view no longer contains all the alarms. However, all alarms are written to the alarm buffer.</td>
<td>--</td>
</tr>
<tr>
<td>270002</td>
<td>The view shows alarms of a log for which there is no data in the current project. Wildcards are output for the alarms.</td>
<td>Delete older log data if necessary.</td>
</tr>
<tr>
<td>270003</td>
<td>The service cannot be set up because too many devices want to use this service. A maximum of four devices may execute this action.</td>
<td>Reduce the number of HMI devices which want to use the service.</td>
</tr>
</tbody>
</table>
## A.2 System alarms

### Mobile Panel 277 IWLAN V2

#### Number Effect/causes Remedy

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>270004</td>
<td>Access to persistent buffer is not possible. Alarms cannot be restored or saved.</td>
<td>If the problems persist at the next startup, contact Customer Support (delete Flash).</td>
</tr>
<tr>
<td>270005</td>
<td>Persistent buffer damaged: Alarms cannot be restored.</td>
<td>If the problems persist at the next startup, contact Customer Support (delete Flash).</td>
</tr>
<tr>
<td>270006</td>
<td>Project modified: Alarms cannot be restored from the persistent buffer.</td>
<td>The project was generated and transferred new to the HMI device; The error should no longer occur when the device starts again.</td>
</tr>
<tr>
<td>270007</td>
<td>A configuration problem is preventing the restore (a DLL is missing, a directory is unknown, etc.).</td>
<td>Update the operating system and then transfer your project again to the HMI device.</td>
</tr>
</tbody>
</table>

### 280000 - DPHMI alarms Connection

#### Number Effect/causes Remedy

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>280000</td>
<td>Connection is up because the cause of the interruption has been eliminated.</td>
<td>--</td>
</tr>
</tbody>
</table>
| 280001 | No more data is read or written. Possible causes:  
- The cable is defective  
- The PLC does not respond, is defective, etc.  
- The wrong port is used for the connection  
- System overload | Check whether  
- The cable is plugged in  
- The PLC is OK  
- The correct port is used.  
Restart the system if the system alarm persists. |
| 280002 | The connection used requires a function block in the PLC. The function block has responded. Communication is now enabled. | -- |
| 280003 | The connection used requires a function block in the PLC. The function block has not responded. | Check whether  
- The cable is plugged in  
- The PLC is OK  
- The correct port is used.  
Restart the system if the system alarm persists. Remedy depends on the error code:  
1: The function block must set the COM bit in the response container.  
2: The function block must not set the ERROR bit in the response container.  
3: The function block must respond within the specified time (timeout).  
4: Go online to the PLC. |
| 280004 | The connection to the PLC is interrupted. There is no data exchange at present. | Check the connection parameters in WinCC flexible. Ensure that the cable is plugged in, the PLC is operational, the correct port is being used. Restart the system if the system alarm persists. |
## A.2 System alarms

### 290000 - Recipe system alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>290000</td>
<td>The recipe tag could not be read or written. It is assigned the start value. The alarm can be entered in the alarm buffer for up to four more failed tags if necessary. After that, alarm 290003 is output.</td>
<td>Check in the configuration that the address has been set up in the PLC.</td>
</tr>
<tr>
<td>290001</td>
<td>An attempt has been made to assign a value to a recipe tag which is outside the value range permitted for this type. The alarm can be entered in the alarm buffer for up to four more failed tags if necessary. After that, alarm 290004 is output.</td>
<td>Observe the value range for the tag type.</td>
</tr>
<tr>
<td>290002</td>
<td>It is not possible to convert a value from a source format to a target format. The alarm can be entered in the alarm buffer for up to four more failed recipe tags if necessary. After that, alarm 290005 is output.</td>
<td>Check the value range or type of the tag.</td>
</tr>
<tr>
<td>290003</td>
<td>This alarm is output when alarm number 290000 is triggered more than five times. In this case, no further separate alarms are generated.</td>
<td>Check in the configuration that the tag addresses have been set up in the PLC.</td>
</tr>
<tr>
<td>290004</td>
<td>This alarm is output when alarm number 290001 is triggered more than five times. In this case, no further separate alarms are generated.</td>
<td>Observe the value range for the tag type.</td>
</tr>
<tr>
<td>290005</td>
<td>This alarm is output when alarm number 290002 is triggered more than five times. In this case, no further separate alarms are generated.</td>
<td>Check the value range or type of the tag.</td>
</tr>
<tr>
<td>290006</td>
<td>The threshold values configured for the tag have been violated by values entered.</td>
<td>Observe the configured or current threshold values of the tag.</td>
</tr>
<tr>
<td>290007</td>
<td>There is a difference between the source and target structure of the recipe currently being processed. The target structure contains an additional data recipe tag which is not available in the source structure. The data recipe tag specified is assigned its start value.</td>
<td>Insert the specified data recipe tag in the source structure.</td>
</tr>
<tr>
<td>290008</td>
<td>There is a difference between the source and target structure of the recipe currently being processed. The source structure contains an additional data recipe tag which is not available in the target structure and therefore cannot be assigned. The value is rejected.</td>
<td>Remove the specified data recipe tag in the specified recipe from the project.</td>
</tr>
<tr>
<td>290010</td>
<td>The storage location configured for the recipe is not permitted. Possible causes: Illegal characters, write protection, data carrier out of space or does not exist.</td>
<td>Check the configured storage location.</td>
</tr>
</tbody>
</table>
### Appendix

#### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>290011</td>
<td>The record with the specified number does not exist.</td>
<td>Check the source for the number (constant or tag value).</td>
</tr>
<tr>
<td>290012</td>
<td>The recipe with the specified number does not exist.</td>
<td>Check the source for the number (constant or tag value).</td>
</tr>
<tr>
<td>290013</td>
<td>An attempt was made to save a record under a record number which already exists. The action is not executed.</td>
<td>The following remedies are available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Check the source for the number (constant or tag value).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• First, delete the record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Change the &quot;Overwrite&quot; function parameter.</td>
</tr>
<tr>
<td>290014</td>
<td>The file specified to be imported could not be found.</td>
<td>Check:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The file name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ensure that the file is in the specified directory.</td>
</tr>
<tr>
<td>290020</td>
<td>Alarm reporting that the download of records from the HMI device to the PLC has started.</td>
<td>--</td>
</tr>
<tr>
<td>290021</td>
<td>Alarm reporting that the download of records from the HMI device to the PLC was completed.</td>
<td>--</td>
</tr>
<tr>
<td>290022</td>
<td>Alarm reporting that the download of records from the HMI device to the PLC was canceled due to an error.</td>
<td>Check in the configuration whether:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The tag addresses are configured in the PLC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The recipe number exists</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The record number exists</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The &quot;Overwrite&quot; function parameter is set</td>
</tr>
<tr>
<td>290023</td>
<td>Alarm reporting that the download of records from the PLC to the HMI device has started.</td>
<td>--</td>
</tr>
<tr>
<td>290024</td>
<td>Alarm reporting that the download of records from the PLC to the HMI device was completed.</td>
<td>---</td>
</tr>
<tr>
<td>290025</td>
<td>Alarm reporting that the download of records from the PLC to the HMI device was canceled due to an error.</td>
<td>Check in the configuration whether:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The tag addresses are configured in the PLC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The recipe number exists</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The record number exists</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The &quot;Overwrite&quot; function parameter is set</td>
</tr>
<tr>
<td>290026</td>
<td>An attempt has been made to read/write a record although the record is not free at present. This error may occur in the case of recipes for which downloading with synchronization has been configured.</td>
<td>Set the record status to zero.</td>
</tr>
<tr>
<td>290027</td>
<td>Unable to connect to the PLC at present. As a result, the record can neither be read nor written. Possible causes: No physical connection to the PLC (no cable plugged in, cable is defect) or the PLC is switched off.</td>
<td>Check the connection to the PLC.</td>
</tr>
<tr>
<td>290030</td>
<td>This alarm is output after you selected screen which contains a recipe view in which a record is already selected.</td>
<td>Reload the record from the storage location or retain the current values.</td>
</tr>
<tr>
<td>290031</td>
<td>While saving, it was detected that a record with the specified number already exists.</td>
<td>Overwrite the record or cancel the action.</td>
</tr>
</tbody>
</table>
## Appendix

### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>290032</td>
<td>While exporting records it was detected that a file with the specified name already exists.</td>
<td>Overwrite the file or cancel the process.</td>
</tr>
<tr>
<td>290033</td>
<td>Confirmation request before deleting records.</td>
<td>--</td>
</tr>
<tr>
<td>290040</td>
<td>A record error with error code %1 that cannot be described in more detail occurred. The action is canceled. It is possible that the record was not installed correctly on the PLC.</td>
<td>Check the storage location, the record, the &quot;Data record&quot; area pointer and if necessary, the connection to the PLC. Restart the action after a short time. If the error persists, contact Customer Support. Forward the relevant error code to Customer Support.</td>
</tr>
<tr>
<td>290041</td>
<td>A record or file cannot be saved because the storage location is full.</td>
<td>Delete files no longer required.</td>
</tr>
<tr>
<td>290042</td>
<td>An attempt was made to execute several recipe actions simultaneously. The last action was not executed.</td>
<td>Trigger the action again after waiting a short period.</td>
</tr>
<tr>
<td>290043</td>
<td>Confirmation request before storing records.</td>
<td>--</td>
</tr>
<tr>
<td>290044</td>
<td>The data store for the recipe has been destroyed and is deleted.</td>
<td>--</td>
</tr>
<tr>
<td>290050</td>
<td>Alarm reporting that the export of records has started.</td>
<td>--</td>
</tr>
<tr>
<td>290051</td>
<td>Alarm reporting that the export of records was completed.</td>
<td>--</td>
</tr>
<tr>
<td>290052</td>
<td>Alarm reporting that the export of records was canceled due to an error.</td>
<td>Ensure that the structure of the records at the storage location and the current recipe structure on the HMI device are identical.</td>
</tr>
<tr>
<td>290053</td>
<td>Alarm reporting that the import of records has started.</td>
<td>--</td>
</tr>
<tr>
<td>290054</td>
<td>Alarm reporting that the import of records was completed.</td>
<td>--</td>
</tr>
<tr>
<td>290055</td>
<td>Alarm reporting that the import of records was canceled due to an error.</td>
<td>Ensure that the structure of the records at the storage location and the current recipe structure on the HMI device are identical.</td>
</tr>
<tr>
<td>290056</td>
<td>Error when reading/writing the value in the specified line/column. The action was canceled.</td>
<td>Check the specified line/column.</td>
</tr>
<tr>
<td>290057</td>
<td>The tags of the recipe specified were toggled from &quot;offline&quot; to &quot;online&quot; mode. Each change of a tag in this recipe is now immediately downloaded to the PLC.</td>
<td>--</td>
</tr>
<tr>
<td>290058</td>
<td>The tags of the specified recipe were toggled from &quot;offline&quot; to &quot;online&quot; mode. Modifications to tags in this recipe are no longer immediately transferred to the PLC but must be transferred there explicitly by downloading a record.</td>
<td>--</td>
</tr>
<tr>
<td>290059</td>
<td>Alarm reporting that the specified record was saved.</td>
<td>--</td>
</tr>
<tr>
<td>290060</td>
<td>Alarm reporting that the specified record memory was cleared.</td>
<td>--</td>
</tr>
<tr>
<td>Number</td>
<td>Effect/causes</td>
<td>Remedy</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>290061</td>
<td>Alarm reporting that clearing of record memory was canceled due to an error.</td>
<td>--</td>
</tr>
<tr>
<td>290062</td>
<td>The record number is above the maximum of 65536. This record cannot be created.</td>
<td>Select another number.</td>
</tr>
<tr>
<td>290063</td>
<td>This occurs with the system function &quot;ExportDataRecords&quot; when the parameter &quot;Overwrite&quot; is set to No. An attempt has been made to save a recipe under a file name which already exists. The export is canceled.</td>
<td>Check the &quot;ExportDataRecords&quot; system function.</td>
</tr>
<tr>
<td>290064</td>
<td>Alarm reporting that the deletion of records has started.</td>
<td>--</td>
</tr>
<tr>
<td>290065</td>
<td>Alarm reporting that the deletion of records has successfully completed.</td>
<td>--</td>
</tr>
<tr>
<td>290066</td>
<td>Confirmation request before deleting records.</td>
<td>--</td>
</tr>
<tr>
<td>290068</td>
<td>Security request to confirm if all records in the recipe should be deleted.</td>
<td>--</td>
</tr>
<tr>
<td>290069</td>
<td>Security request to confirm if all records in the recipe should be deleted.</td>
<td>--</td>
</tr>
<tr>
<td>290070</td>
<td>The record specified is not in the import file.</td>
<td>Check the source of the record number or record name (constant or tag value).</td>
</tr>
<tr>
<td>290071</td>
<td>During the editing of record values, a value was entered which exceeded the low limit of the recipe tag. The entry is discarded.</td>
<td>Enter a value within the limits of the recipe tag.</td>
</tr>
<tr>
<td>290072</td>
<td>When editing record values, a value was entered which exceeds the high limit of the recipe tag. The entry is discarded.</td>
<td>Enter a value within the limits of the recipe tag.</td>
</tr>
<tr>
<td>290073</td>
<td>An action (e.g. saving a record) failed due to an unknown error. The error corresponds to the status alarm IDS_OUT_CMD_EXE_ERR in the large recipe view.</td>
<td>--</td>
</tr>
<tr>
<td>290074</td>
<td>While saving, it was detected that a record with the specified number already exists but under another name.</td>
<td>Overwrite the record, change the record number or cancel the action.</td>
</tr>
<tr>
<td>290075</td>
<td>A record with this name already exists. The record is not saved.</td>
<td>Please select a different record name.</td>
</tr>
</tbody>
</table>
### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>290110</td>
<td>The default values could not be set due to an error.</td>
<td>--</td>
</tr>
</tbody>
</table>
| 290111   | The Recipes subsystem cannot be used. Recipe views have no content and recipe-specific functions will not be performed. Possible causes:  
  - An error occurred while transferring the recipes.  
  - The recipe structure was changed in ES. When the project was downloaded again, the recipes were not transferred with it. This means that the new configuration data is not being transferred to the old recipes on the device. | Transfer the project to the device again, together with the recipes (the corresponding check box in the Transfer dialog must be checked). |

### 300000 - Alarm_S alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>300000</td>
<td>Faulty configuration of process monitoring (e.g. using PDiag or S7 Graph): More alarms are queued than specified in the specifications of the CPU. No further ALARM_S alarms can be managed by the PLC and reported to the HMI devices.</td>
<td>Change the PLC configuration.</td>
</tr>
<tr>
<td>300001</td>
<td>ALARM_S is not registered on this PLC.</td>
<td>Select a controller that supports the ALARM_S service.</td>
</tr>
</tbody>
</table>

### 310000 - Report system alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>310000</td>
<td>An attempt is being made to print too many reports in parallel. Only one log file can be output to the printer at a given time; the print job is therefore rejected.</td>
<td>Wait until the previous active log was printed. Repeat the print job if necessary.</td>
</tr>
<tr>
<td>310001</td>
<td>An error occurred on triggering the printer. The report is either not printed or printed with errors.</td>
<td>Evaluate the additional system alarms related to this alarm. Repeat the print job if necessary.</td>
</tr>
</tbody>
</table>
## 320000 - Alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>320000</td>
<td>The movements have already been indicated by another device. The movements can no longer be controlled.</td>
<td>Deselect the movements on the other display units and select the motion control screen on the required display unit.</td>
</tr>
<tr>
<td>320001</td>
<td>The network is too complex. The faulty addresses cannot be indicated.</td>
<td>View the network in STL.</td>
</tr>
<tr>
<td>320002</td>
<td>No diagnosable alarm message (error) selected. The unit associated with the alarm message could not be selected.</td>
<td>Select a diagnostics alarm from the ZP_ALARM alarm screen.</td>
</tr>
<tr>
<td>320003</td>
<td>No alarm message (error) exists for the selected unit. The detail view cannot visualize any networks.</td>
<td>Select the defective unit from the overview screen.</td>
</tr>
<tr>
<td>320004</td>
<td>The required signal states could not be read by the PLC. The faulty addresses cannot be found.</td>
<td>Check the consistency between the configuration on the display unit and the PLC program.</td>
</tr>
<tr>
<td>320005</td>
<td>The project contains ProAgent elements which are not installed. ProAgent diagnostic functions cannot be performed</td>
<td>In order to run the project, install the optional ProAgent package.</td>
</tr>
<tr>
<td>320006</td>
<td>You have attempted to execute a function which is not supported in the current constellation.</td>
<td>Check the type of the selected unit.</td>
</tr>
<tr>
<td>320007</td>
<td>No error-triggering addresses were found on the networks. ProAgent cannot indicate any faulty addresses.</td>
<td>Switch the detail screen to STL layout mode and check the status of the addresses and exclusion addresses.</td>
</tr>
<tr>
<td>320008</td>
<td>The diagnostic data stored in the configuration are not synchronized with those in the PLC. ProAgent can only indicate the diagnostic units.</td>
<td>Transfer the project to the HMI device again.</td>
</tr>
<tr>
<td>320009</td>
<td>The diagnostic data stored in the configuration are not synchronized with those in the PLC. The diagnostic screens can be operated as usual. ProAgent may be unable to show all diagnostic texts.</td>
<td>Transfer the project to the HMI device again.</td>
</tr>
<tr>
<td>320010</td>
<td>The diagnostic data stored in the configuration are not synchronized with those in STEP7. The ProAgent diagnostics data is not up-to-date.</td>
<td>Transfer the project to the HMI device again.</td>
</tr>
<tr>
<td>320011</td>
<td>A unit with the corresponding DB number and FB number does not exist. The function cannot be executed.</td>
<td>Check the parameters of the &quot;SelectUnit&quot; function and the units selected in the project.</td>
</tr>
</tbody>
</table>
### A.2 System alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>320012</td>
<td>The &quot;Step sequence mode&quot; dialog is no longer supported.</td>
<td>Use the ZP_STEP step sequence screen from the corresponding standard project for your project. Instead of calling the Overview_Step_Sequence_Mode function, call the &quot;FixedScreenSelection&quot; function using ZP_STEP as the screen name.</td>
</tr>
<tr>
<td>320014</td>
<td>The selected PLC cannot be evaluated for ProAgent. The Alarm view assigned to the &quot;EvaluateAlarmDisplayFault&quot; system function could not be found.</td>
<td>Check the parameters of the &quot;EvaluateAlarmDisplayFault&quot; system function.</td>
</tr>
</tbody>
</table>

### 330000 - GUI alarms

<table>
<thead>
<tr>
<th>Number</th>
<th>Effect/causes</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>330022</td>
<td>Too many dialogs are open on the HMI device.</td>
<td>Close all dialogs you do not require on the HMI device.</td>
</tr>
<tr>
<td>330026</td>
<td>The password will expire after the number of days shown.</td>
<td>Enter a new password.</td>
</tr>
</tbody>
</table>
### Abbreviations

#### B.1 Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI</td>
<td>American National Standards Institution</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>CSV</td>
<td>Comma Separated Values</td>
</tr>
<tr>
<td>CTS</td>
<td>Clear To Send</td>
</tr>
<tr>
<td>DC</td>
<td>Direct Current</td>
</tr>
<tr>
<td>DCD</td>
<td>Data Carrier Detect</td>
</tr>
<tr>
<td>DHCP</td>
<td>Dynamic Host Configuration Protocol</td>
</tr>
<tr>
<td>DIL</td>
<td>Dual-in-Line</td>
</tr>
<tr>
<td>DNS</td>
<td>Domain Name System</td>
</tr>
<tr>
<td>DP</td>
<td>Distributed I/O</td>
</tr>
<tr>
<td>DSR</td>
<td>Data Set Ready</td>
</tr>
<tr>
<td>DTR</td>
<td>Data Terminal Ready</td>
</tr>
<tr>
<td>IO</td>
<td>Input and Output</td>
</tr>
<tr>
<td>EAP</td>
<td>Extensible Authentication Protocol</td>
</tr>
<tr>
<td>ESD</td>
<td>Components and modules endangered by electrostatic discharge</td>
</tr>
<tr>
<td>EMC</td>
<td>Electromagnetic compatibility</td>
</tr>
<tr>
<td>EN</td>
<td>European standard</td>
</tr>
<tr>
<td>ES</td>
<td>Engineering System</td>
</tr>
<tr>
<td>ESD</td>
<td>Components and modules endangered by electrostatic discharge</td>
</tr>
<tr>
<td>GND</td>
<td>Ground</td>
</tr>
<tr>
<td>HF</td>
<td>High Frequency</td>
</tr>
<tr>
<td>HMI</td>
<td>Human Machine Interface</td>
</tr>
<tr>
<td>IEC</td>
<td>International Electronic Commission</td>
</tr>
<tr>
<td>IEEE</td>
<td>Institute of Electrical and Electronics Engineers</td>
</tr>
<tr>
<td>IF</td>
<td>Interface</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>iPCF-MC</td>
<td>Industrial Point Coordination Function Management Channel</td>
</tr>
<tr>
<td>IWLAN</td>
<td>Industrial Wireless Local Area Network</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>MAC</td>
<td>Media Access Control</td>
</tr>
<tr>
<td>MOS</td>
<td>Metal Oxide Semiconductor</td>
</tr>
<tr>
<td>MPI</td>
<td>Multipoint Interface (SIMATIC S7)</td>
</tr>
<tr>
<td>MS</td>
<td>Microsoft</td>
</tr>
</tbody>
</table>
Abbreviations

B.1 Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTBF</td>
<td>Mean Time Between Failures</td>
</tr>
<tr>
<td>n. c.</td>
<td>Not connected</td>
</tr>
<tr>
<td>OP</td>
<td>Operator Panel</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PG</td>
<td>Programming device</td>
</tr>
<tr>
<td>PELV</td>
<td>Protective Extra Low Voltage</td>
</tr>
<tr>
<td>PPI</td>
<td>Point-to-Point Interface (SIMATIC S7)</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>RJ45</td>
<td>Registered Jack Type 45</td>
</tr>
<tr>
<td>RTS</td>
<td>Request to send</td>
</tr>
<tr>
<td>RxD</td>
<td>Receive Data</td>
</tr>
<tr>
<td>SAR</td>
<td>Specific absorption rate</td>
</tr>
<tr>
<td>SD Card</td>
<td>Security Digital Card</td>
</tr>
<tr>
<td>SELV</td>
<td>Safety Extra Low Voltage</td>
</tr>
<tr>
<td>SIL</td>
<td>Safety Integrity Level</td>
</tr>
<tr>
<td>SP</td>
<td>Service Pack</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Controller</td>
</tr>
<tr>
<td>SSID</td>
<td>Service set identifier</td>
</tr>
<tr>
<td>STN</td>
<td>Super Twisted Nematic</td>
</tr>
<tr>
<td>Sub-D</td>
<td>Subminiature D</td>
</tr>
<tr>
<td>TAB</td>
<td>Tabulator</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>TFT</td>
<td>Thin Film Transistor</td>
</tr>
<tr>
<td>TIA</td>
<td>Totally Integrated Automation</td>
</tr>
<tr>
<td>TKIP</td>
<td>Temporal Key Integrity Protocol</td>
</tr>
<tr>
<td>TLS</td>
<td>Transport Layer Security</td>
</tr>
<tr>
<td>TxD</td>
<td>Transmit Data</td>
</tr>
<tr>
<td>UL</td>
<td>Underwriter's Laboratory</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>WAP</td>
<td>Wireless Access Point</td>
</tr>
<tr>
<td>WEP</td>
<td>Wired Equivalent Privacy</td>
</tr>
<tr>
<td>WLAN</td>
<td>Wireless Local Area Network</td>
</tr>
<tr>
<td>WINS</td>
<td>Windows Internet Naming Service</td>
</tr>
<tr>
<td>WPA</td>
<td>Wi-Fi Protected Access</td>
</tr>
</tbody>
</table>
Glossary

"Transfer" mode

"Transfer" is an operating mode of the HMI device in which an executable project is transferred from the configuration PC to an HMI device.

Access point

See Wireless access point.

Ad hoc network

An ad hoc network in information technology refers to a wireless network between two or more mobile devices, for which no fixed infrastructure is necessary. This technique is used with Bluetooth, for example, to spontaneously link mobile phones. Ad hoc mode is also possible for WLAN.

Alarm logging

Output of user-specific alarms to a printer, in parallel to their output to the HMI device screen.

Alarm, acknowledging an

Acknowledgment of an alarm confirms that it has been noted.

Alarm, coming in

Moment at which an alarm is triggered by the PLC or HMI device.

Alarm, going out

Moment at which the initiation of an alarm is reset by the PLC.

Alarm, user-specific

An alarm is configurable object. A user-specific alarm designates a certain operating status of the plant connected to the HMI device via the PLC.

Automation system

An automation system is a controller of the SIMATIC S7 series, such as a SIMATIC S7-300.

Bootloader

Used to start the operating system. Automatically started when the HMI device is switched on. After the operating system has been loaded, the Loader opens.
Glossary

Configuration PC
A configuration PC is a programming device or PC on which HMI projects are created for a plant with a configuration software.

Display duration
Defines whether a system alarm is displayed on the HMI device and the duration of the display.

Engineering software
Use the configuration software to create a project for process visualization. WinCC flexible, for example, is such a configuration software.

Event
An event is configurable object. Functions are triggered by defined incoming events. Events which can be assigned to a button include "Press" and "Release", for example.

Field array
A field is configurable object. A reserved area is used for the input and output of values.

Flash memory
Non-volatile memory with EEPROM chips, used as mobile storage medium or as memory module installed permanently on the motherboard.

Half Brightness Life Time
Time period after which the brightness reaches 50% of the original value. The specified value is dependent on the operating temperature.

HMI device
An HMI device is used for operation and monitoring of production processes. The operating states of the plant are visually depicted on the HMI device. Operator controls on the HMI device enable intervention in the production process of the plant.

HMI device image
An HMI device image is a file that can be transferred from the configuration PC to the HMI device. An HMI device image contains the operating system for a specific HMI device and the runtime components required for the executable project file.
HMI screen

The HMI screens on the HMI device visualize the production process. The HMI screens are configured with WinCC flexible and will be available on the HMI device once the project has been transferred to the HMI device.

Infotext

Infotext is configurable object. It displays information about other objects within a project. Infotext for an alarm, for example, may contain information on the cause of the fault and troubleshooting routines.

Infrastructure mode

An infrastructure network is a wireless LAN, which enables communication among the various devices through a central wireless access point. The terminal devices must log on with their MAC address to the wireless access point and get an IP address assigned, if a DHCP server responds to the requesting device.

IO field

An IO field is configurable object. It enables values to be entered on the HMI device and transferred to the controller, and values to be output from the controller.

IO field, symbolic

A symbolic IO field is configurable object. It enables values to be entered on the HMI device and transferred to the controller, and values to be output from the controller. Contains a list of default entries from which one can be selected.

IT system

This is a particular type of ground connection in a distribution system in electrical engineering for increased resistance to isolation errors.

Object

An object is a configuration component of a project, for example, a screen, alarm or IO field.

Operating element

Component of a project used to enter values and trigger functions. A operator control is a button, for example.

PLC

A PLC is a general term for devices and systems with which the HMI device communicates, for example SIMATIC S7.
Glossary

PLC job
A PLC job triggers a function for the PLC at the HMI device.

Process image
The process image is a memory area in the controller which the HMI device and controller access together. At the beginning of the cyclic control program the signal states of the inputs of the HMI device are transferred to the controller via the process input images, PII. At the end of the cyclic program the process image of the outputs, PIQ is transferred as a signal state to the HMI device.

Process visualization
Visualization of technical processes by means of text and graphic elements. Configured plant screens allow operator intervention in active production processes by means of the input and output of data.

PROFINET
Within the framework of Totally Integrated Automation, PROFINET represents an enhancement of the following bus systems:

- PROFIBUS DP as well-established fieldbus
- Industrial Ethernet as the communication bus on the device level

The experience gained from both systems has been and continues to be integrated in PROFINET. PROFINET as an Ethernet-based automation standard from PROFIBUS International defines a vendor-independent communications and engineering model.

PROFINET IO controller
Device used to address the connected IO devices. This means the IO controller exchanges input and output signals with assigned field devices. The IO controller is often a PLC.

PROFINET IO device
A distributed field device that is assigned to one of the IO controllers (e.g. remote IO, valve terminals, frequency converters, switches).

PROFINET IO
As part of PROFINET, PROFINET IO is a communication solution that is used to implement modular, distributed applications.

PROFINET IO allows you to create automation solutions of the type with which you are familiar from PROFIBUS. PROFINET IO is implemented by the PROFINET standard for automation devices on the one hand, and on the other hand by the STEP 7 engineering software. This means that you have the same application view in STEP 7 regardless of whether you configure PROFINET or PROFIBUS devices. Programming your user program is essentially the same for PROFINET IO and PROFIBUS DP if you use the extended blocks and system status lists for PROFINET IO.
**Project**

A project is the result of a configuration using an configuration software. The project normally contains several HMI screens, in which plant-specific objects are embedded. If it has been configured in WinCC flexible, the project is saved in a project file with the file name extension, "hmi".

You need to distinguish between the project on the configuration PC and the runtime project on an HMI device. A project on the configuration PC may have more languages than can be managed on the HMI device. The project on the configuration PC can also be set up for different HMI devices. Only the runtime project that has been generated for the respective HMI device can be transferred to it.

**Project file**

File generated from the runtime project file for use on the HMI device. The project file is usually not transferred and remains on the configuration PC.

The file name extension of a project file is *.hmi.

**Project file, compressed**

Compressed format of the project file. The compressed project file can be transferred together with the runtime project file to the respective HMI device. Backtransfer must be enabled on the configuration PC for this purpose. The compressed project file is usually saved to an external storage medium.

The file extension of a compressed project file is *.pdz.

**Proof-test interval**

A period after which a component must be set to a safe state. Either the component is replaced by an unused component or full, error-free operation must be demonstrated.

**Recipe**

A recipe is a configurable component of a project. A recipe assembles variables in a fixed data structure. The corresponding data structure can be filled with data in the configuration software or on an HMI device.

Using a recipe ensures that all assigned data is transferred to the PLC synchronously during the transfer of a data record.

**Runtime**

You need the Runtime software to run a project you have created with WinCC flexible on a PC or HMI device.

**Runtime project file**

A runtime project file is a file that is generated from the finished project file for a specific HMI device based on the configuration. It can therefore only be run on a particular HMI device type. The runtime project file is transferred to the corresponding HMI device and used there to operate and monitor a production process.

The file extension of a runtime project file is "fwx".
Screen

See HMI screen.

Screen object

A screen object is a configurable object used to display or operate the plant, for example, a rectangle, I/O field or alarm view.

STEP 7

STEP 7 is the programming software for SIMATIC S7, SIMATIC C7 and SIMATIC WinAC PLCs.

System alarm

A system alarm is assigned to the "System" alarm class. A system alarm refers to internal states on the HMI device and the PLC.

Tab sequence

The tab order is the configured order of the objects that are accessed by successively pressing the "TAB" key.

Tag

Defined memory location to which values can be written to and read from. This can be done from the PLC or the HMI device. Based on whether the tag is interconnected with the PLC or not, we distinguish between "external" tags (process tags) and "internal" tags.

Transfer

Transfer of a runtime project from the configuration PC to the HMI device.

Transponder

A transponder is usually a wireless communication, display, or control device that logs incoming signals and automatically responds to them. The term transponder is derived from transmitter and responder. Transponders can be passive or active.

Wireless access point

A wireless access point is an electronic device that acts as an interface for wireless communication devices. Terminal devices provide a wireless connection to the wireless access point via wireless adapter, which in turn is connected by cable to an installed communication network.
Index

I

/Audit, 23
/ProAgent, 23

A

Absorption rate, 40
Acceptance, 189
Plant, 189
PLC, 189
Accessories
   Accessory kit, 20
   Accessory kit
   Charging station, 18
   Transponder, 20
Acknowledge
   Alarm, 225
   Error alarm, 225
Ad hoc network, 46
Adapting
   Project, 163
Address assignment
   TCP/IP network, 148
Admin, 208, 209
Alarm, 229
   Acknowledge, 225
   Alarm indicator, 221
   Display, 222
   Editing, 225
   Functional scope, 23
   Alarm buffer, 220
   Functional scope, 23
   Alarm class, 220
   Icon, 223
   Alarm event, 219
   Alarm group, 220
   Alarm indicator, 221
   Alarm line, 222
   Alarm log, 221
   Alarm report, 221
   Alarm view, 222
   Extended, 223
   Simple, 222
   Alarm window, 224
   ALARM_S, 23
Ambient conditions, 42
   Climatic, charging station, 44
   Climatic, HMI device, 43
   Climatic, transponder, 44
   Storage, 41
   Testing, 43
   Transport, 41
Applications
   Mobile Panel 277 IWLAN, 13
   Approvals, 34, 119
      Australia, 35
      UL approval, 35
      Wireless approval, 35
Australia
   Approvals, 35
   Authentication, 53
   Authorization, 202
   Automatic
      Transfer, 167
   Automation License Manager, 186
Backlighting
   Reducing, 137, 138
Backtransfer, 165, 168
Backup, 157, 159, 164, 170, 171, 172, 203
   Registry information, 129
   Temporary files, 129
   To external storage device, 157
   With ProSave, 172
   With WinCC flexible, 171
BAT 1
   LED, 95
BAT 2
   LED, 95
Battery
   Inserting, 59
   Used, 5
Bit assignment
   Direct key, 85
   Illuminated pushbutton, 90
   Key-operated switch, 89
Booting, 113
Brightness
   Changing, 108
   Reduced, 81, 137
Byte assignment
Index

<table>
<thead>
<tr>
<th>Direct keys, 85</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibrating</td>
</tr>
<tr>
<td>Touch screen, 111</td>
</tr>
<tr>
<td>Cancel</td>
</tr>
<tr>
<td>Transfer, 75</td>
</tr>
<tr>
<td>Care, 249</td>
</tr>
<tr>
<td>CE approval, 34</td>
</tr>
<tr>
<td>Certificate, 35</td>
</tr>
<tr>
<td>Certificates Stores, 156</td>
</tr>
<tr>
<td>Changing</td>
</tr>
<tr>
<td>Brightness, 108</td>
</tr>
<tr>
<td>User data, 208</td>
</tr>
<tr>
<td>Character repeat</td>
</tr>
<tr>
<td>Screen keyboard, 109</td>
</tr>
<tr>
<td>Charge</td>
</tr>
<tr>
<td>Electrostatic, 271</td>
</tr>
<tr>
<td>Charging station</td>
</tr>
<tr>
<td>Accessory kit, 18</td>
</tr>
<tr>
<td>Charging compartment, 94</td>
</tr>
<tr>
<td>Clearance, 50</td>
</tr>
<tr>
<td>Configuration, 18</td>
</tr>
<tr>
<td>Connecting, 57</td>
</tr>
<tr>
<td>EMC-compliant installation, 38</td>
</tr>
<tr>
<td>LED display, 95</td>
</tr>
<tr>
<td>Lock, 96</td>
</tr>
<tr>
<td>Main dimensions, 253</td>
</tr>
<tr>
<td>Mounting location, 49</td>
</tr>
<tr>
<td>Mounting position, 55</td>
</tr>
<tr>
<td>Charging status</td>
</tr>
<tr>
<td>Displaying, 69</td>
</tr>
<tr>
<td>Rechargeable battery, 131</td>
</tr>
<tr>
<td>Vibration alarm, 134</td>
</tr>
<tr>
<td>Checklist</td>
</tr>
<tr>
<td>Information security, 52</td>
</tr>
<tr>
<td>Clearance</td>
</tr>
<tr>
<td>Charging station, 50</td>
</tr>
<tr>
<td>Climatic environmental conditions, 41</td>
</tr>
<tr>
<td>Closing</td>
</tr>
<tr>
<td>Remote control, 219</td>
</tr>
<tr>
<td>Column sequence</td>
</tr>
<tr>
<td>Alarm view, 223</td>
</tr>
<tr>
<td>COM</td>
</tr>
<tr>
<td>LED, 79</td>
</tr>
<tr>
<td>Commissioning, 164</td>
</tr>
<tr>
<td>Communication link with controller</td>
</tr>
<tr>
<td>Number, 22</td>
</tr>
<tr>
<td>Compatibility conflict, 171, 175</td>
</tr>
<tr>
<td>Computer name</td>
</tr>
<tr>
<td>For network operation, 147</td>
</tr>
<tr>
<td>Unique, 147</td>
</tr>
<tr>
<td>Computers</td>
</tr>
<tr>
<td>Addressing, 146</td>
</tr>
<tr>
<td>Condensation, 41</td>
</tr>
<tr>
<td>Configuration graphic</td>
</tr>
<tr>
<td>Configuration PC, 71</td>
</tr>
<tr>
<td>PLC on Mobile Panel, 70</td>
</tr>
<tr>
<td>Printer, 72</td>
</tr>
<tr>
<td>Configuration PC, 27</td>
</tr>
<tr>
<td>Configuration graphic, 71</td>
</tr>
<tr>
<td>Connecting, 71</td>
</tr>
<tr>
<td>Configuration phase, 27</td>
</tr>
<tr>
<td>Configure</td>
</tr>
<tr>
<td>Screen keyboard, 107</td>
</tr>
<tr>
<td>Connecting</td>
</tr>
<tr>
<td>Configuration PC, 71</td>
</tr>
<tr>
<td>PLC, 70</td>
</tr>
<tr>
<td>Printer, 72</td>
</tr>
<tr>
<td>Connector</td>
</tr>
<tr>
<td>Configuration, 56</td>
</tr>
<tr>
<td>Installing, 56</td>
</tr>
<tr>
<td>Contact person, 5</td>
</tr>
<tr>
<td>Control Panel</td>
</tr>
<tr>
<td>Open, 101</td>
</tr>
<tr>
<td>Operating, 98</td>
</tr>
<tr>
<td>Password protection, 98</td>
</tr>
<tr>
<td>Screen keyboard, 107</td>
</tr>
<tr>
<td>Convention</td>
</tr>
<tr>
<td>Style, 4</td>
</tr>
<tr>
<td>Term, 4</td>
</tr>
<tr>
<td>Cookie, 154</td>
</tr>
<tr>
<td>Country code, 119</td>
</tr>
<tr>
<td>Creating</td>
</tr>
<tr>
<td>Recipe data record, 235, 242</td>
</tr>
<tr>
<td>Users, 206</td>
</tr>
<tr>
<td>D</td>
</tr>
<tr>
<td>Data channel</td>
</tr>
<tr>
<td>Enabling, 144</td>
</tr>
<tr>
<td>Locking, 144</td>
</tr>
<tr>
<td>Parameter assignment, 144</td>
</tr>
<tr>
<td>Data flow, 229</td>
</tr>
<tr>
<td>Data record list, 230, 241</td>
</tr>
<tr>
<td>Date</td>
</tr>
<tr>
<td>Setting, 127</td>
</tr>
<tr>
<td>Synchronizing, 128</td>
</tr>
<tr>
<td>Date format, 136</td>
</tr>
<tr>
<td>Date/time properties, 127</td>
</tr>
<tr>
<td>Default Gateway, 149</td>
</tr>
<tr>
<td>Degree of protection, 45</td>
</tr>
<tr>
<td>Delay time</td>
</tr>
</tbody>
</table>
Index

Setting, 142
Delete
  Certificate, 156
  Recipe data record, 237, 243
Users, 209
DHCP, 148
Direct key, 85
  Bit assignment, 85
  Byte assignment, 85
  Configuring, 194
  Evaluation, 85
  Functional scope, 26
Disabling
  SecureMode, 101
Display
  Alarm, 222
  Infotext, 224
  Technical specifications, 255
Displaying
  Charging status, 89
  Displaying information about the HMI device, 130
  Infotext, 198
  Memory information, 139
  System information, 139, 140
Disposal, 5
Disturbance variable
  Pulse-shaped, 39
  Sinusoidal, 39
DNS, 149
Server, Documentation
  SIMATIC complete, 5
Double-click
  Setting, 110

E
Editing
  Alarm, 225
  Recipe data record, 242
Editor
  System alarms, 273
  Electrostatic charge, 271
  Element list, 230, 241
EMC
  Guideline, 34
  Emission, 38, 40
Enabling
  SecureMode, 101
Encryption protocol, 154
Entering
  By means of function key, 209
Recipe data record, 247
Entering data, 197
Equipment failure, 41
Error alarm
  Acknowledge, 210
Ethernet settings
  IP address, 148
Evaluation
  Direct key, 85
  Handwheel, 88
  LED function key, 88
Exiting the effective range
  Vibration alarm, 134
Exporting
  Recipe data record, 245
Extended alarm view, 223
Extended recipe view, 230
Extended user view, 204

F
Factory setting, 177
  With ProSave, 181
  With WinCC flexible, 178
Fail-safe operation
  Software, 22
Feedback
  Optical, 193
Firmware, 131
Front view, 14, 251
Function
  Additional, 26
Function keys
  Global function assignment, 209
  Input via, 209
  Labeling, 90
  Local function assignment, 210
Functional scope
  Alarm buffer, 23
  ALARM_S, 23
  Alarms, 23
  Device-specific, 26
  Graphics list, 24
  Infotext, 25
  Limit value monitoring, 24
  Log, 25
  Recipe, 24
  Safety, 25
  Scaling, 24
  Screen, 24
  Tag, 24
  Text list, 24
Index

Transponder system, 26

G
Gauge, 211
Graphics list
  Functional scope, 24

H
Handwheel
  Evaluate incremental values, 88
  Evaluation, 88
  Operating, 82
  Response time, 87
Hidden SSID, 53
High frequency radiation, 34
HMI device
  Displaying information, 130
  Holding, 93
  Interfaces, 63
  Operating, 93
  Restart, 113
  Switch off, 76
  Switching on, 75
  Technical specifications, 255
  Usage, 37
HMI Input Panel
  Options, 107
Homepage
  Internet, 152

I
Identification, 149
Illuminated pushbutton
  Bit assignment, 90
  Operating, 84
  Usage, 89
Illustration, 5
Importing
  Certificate, 156
  Recipe data record, 246
Industry Portal, 5
Information
  For the HMI device, 130
  Information security, 52
  Checklist, 52
Infotext
  Display, 224
  Displaying, 198

Functional scope, 25
Input device
  Technical specifications, 255
Inserting
  Battery, 59
Installation
  EMC-compatible, 38
  Transponder, 57
Installation according to the instructions, 33
Installing
  Connector, 56
  WinCC flexible option, 164, 183, 185
  insulation resistance, 45
Interfaces, 63
  Technical specifications, 256
Internet
  E-mail, 150
  Homepage, 152
  Internet browser, 152
  Internet Explorer, 99
  Internet options
    Advanced, 154
    Connection, 153
    General, 152
    Privacy, 154
IP address
  Ethernet, 148
  iPCF, 30
  iPCF-MC, 30
  IWLAN, 13

K
Key control
  Trend view, 214
Keyboard
  External, 100
Key-operated switch
  Bit assignment, 89
  Usage, 89
Keyswitch
  Operating, 83

L
Labeling
  Function keys, 90
Labeling strips, 16
  Attaching, 92
  Dimensions, 91
  Printing, 90
Index

Language change
  Functional scope, 26
Layout
  Slider control, 211
  Sm@rtClient view, 217
LED
  BAT 1, 95
  BAT 2, 95
  COM, 79
  Meaning, 79
  POWER, 95
  PWR, 79
LED display
  Charging station, 95
  Main battery, 69
  Mobile Panel, 79
LED function key
  Bit assignment, 88
  Evaluation, 88
License key, 186
  Transferring, 164, 187
  Transferring back, 164, 188
Limit value monitoring
  Functional scope, 24
Loader
  Buttons, 98
Log
  Functional scope, 25
Logoff
  Users, 206
  Logoff time, 202
Logon
  Users, 205
  Logon data, 149

M
MAC address, 143
Main battery, 69
  Changing, 67
  Insert, 68
  LED display, 89
Main dimensions
  Charging station, 253
  Mobile Panel 277 IWLAN, 251
  Transponder, 254
Main rechargeable battery, 199
  Charging in the charging compartment, 94
  Charging status, 131
  Temperature, 131
Maintenance, 249
Manual
  Production sequence, 248
  Scope, 3
  Transfer, 166
Mechanical ambient conditions, 41
Memory
  Technical specifications, 255
Memory card
  Inserting, 65
  Unplug, 65
Memory information
  Displaying, 139
Memory management, 133
Mobile Panel
  Applications, 13
  Front view, 14
  Interfaces, 63
  LED display,
  Main dimensions, 251
  Rear view, 15
  Side view, 15
  moisture protection, 45
Monitoring mode
  Sm@rtClient view, 217
Mounting
  Intended, 33
Mounting location
  Charging station, 49
Mounting position
  Charging station, 55
Mouse
  External, 100
  Multi-key operation, 192, 210
MultiMedia card, 64

N
Name server, 149
Network ID, 149
Network operation
  Computer name, 147
Network parameters
  Setting, 148
Network&Dial-Up Connections, 148
Notice of protected rights, 4
Number format, 136
Number of characters
  For password, 203
  For user, 203
  For user view, 203
Index

Object
Battery, 199
WLAN quality, 200
Zone name, 201
Zone quality, 201
Office location, 5
Offline
  Operating mode, 163
  Recipe tag, 233
  Testing, 169
Online
  Operating mode, 163
  Recipe tag, 233
  Testing, 170
OP properties
Battery, 131
Device, 113, 130
Firmware, 131
Memory monitoring, 133
Persistent storage, 129
Touch, 111
Transponder, 132
Operating
  Control Panel, 103
  Feedback, 193
  Handwheel, 82
  HMI device, 93
  Illuminated pushbutton, 84
  Key-operated switch, 83
  Recipe menu, 241
  Recipe screen, 234, 241
  Recipe view, 234
  Slider control, 212
  Switches, 212
  With external keyboard, 192
  With external mouse, 192
Operating mode
  Changing, 163
  Offline, 163
  Online, 163
  Transfer, 75, 163
Operating system
  Parameter assignment, 98
  Updating, 164, 175
  Updating using ProSave, 176
  Updating with WinCC flexible, 175
Operation feedback, 193
Operator control
  Recipe view, 234
  Simple recipe view, 240
  Optical feedback, 193
Option
  Installing, 164
  Installing with ProSave, 185
  Installing with WinCC flexible, 183
  Removing, 164
  Removing with ProSave, 185
  Removing with WinCC flexible, 184
Options, 107

P
Parameter assignment
  Data channel, 144
  Operating system, 98
Password, 98
  Backup, 203
  Number of characters, 203
  Removing, 115
  Restoring, 203
  Setting up, 114
Password list, 202
Password properties, 114
Password protection, 98
  Setting up, 114
Permissions in remote operation, 218
Pin assignment
  RJ45 socket, 257
  USB socket, 257
Planning
  Transponder assignment, 47
  Zone, 47
Plant
  Acceptance, 189
PLC, 189
  Acceptance, 189
  Configuration graphic, 70
  Connecting, 70
  Number, 22
  Reading recipe data record, 238, 244
  Released, 22
  Transferring recipe data record, 239, 244
PLC_User, 208, 209
POWER
  LED, 95
Power failure, 171
Power management
  Levels, 81
Power supply, 260
    Technical specifications, 256
Power supply unit
  Connecting, 74
Printer
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile Panel 277 IWLAN V2</td>
</tr>
<tr>
<td>Operating Instructions, 10/2010, A5E02480233-01</td>
</tr>
<tr>
<td>321</td>
</tr>
<tr>
<td><strong>Configuration graphic</strong>, 72</td>
</tr>
<tr>
<td><strong>Connecting</strong>, 72</td>
</tr>
<tr>
<td><strong>Operating Instructions</strong>, 10/2010, A5E02480233-01</td>
</tr>
<tr>
<td><strong>PROFINET</strong></td>
</tr>
<tr>
<td><strong>Addressing computers</strong>, 146</td>
</tr>
<tr>
<td><strong>PROFINET IO</strong></td>
</tr>
<tr>
<td><strong>Disabling direct keys</strong>, 143</td>
</tr>
<tr>
<td><strong>Enabling direct keys</strong>, 143</td>
</tr>
<tr>
<td><strong>Project</strong></td>
</tr>
<tr>
<td><strong>Adapting</strong>, 163</td>
</tr>
<tr>
<td><strong>Offline testing</strong>, 169</td>
</tr>
<tr>
<td>**Reap, 163</td>
</tr>
<tr>
<td><strong>Screen keyboard</strong>, 195</td>
</tr>
<tr>
<td><strong>Testing online</strong>, 170</td>
</tr>
<tr>
<td><strong>Transferring</strong>, 164</td>
</tr>
<tr>
<td><strong>Project file</strong></td>
</tr>
<tr>
<td><strong>Compressed</strong>, 165</td>
</tr>
<tr>
<td><strong>Protected trademark</strong>, 4</td>
</tr>
<tr>
<td><strong>Protection against ingress of solid foreign bodies</strong>, 45</td>
</tr>
<tr>
<td><strong>Protection class</strong></td>
</tr>
<tr>
<td><strong>HMI device</strong>, 45</td>
</tr>
<tr>
<td><strong>Protective foil</strong>, 16</td>
</tr>
<tr>
<td><strong>Protective measure</strong></td>
</tr>
<tr>
<td><strong>Static electricity</strong>, 272</td>
</tr>
<tr>
<td><strong>Proxy server</strong></td>
</tr>
<tr>
<td><strong>HMI device</strong>, 153</td>
</tr>
<tr>
<td><strong>Internet Explorer</strong>, 99</td>
</tr>
<tr>
<td><strong>PWR</strong></td>
</tr>
<tr>
<td><strong>LED</strong>, 79</td>
</tr>
<tr>
<td><strong>R</strong></td>
</tr>
<tr>
<td><strong>Radiation</strong></td>
</tr>
<tr>
<td><strong>High frequency</strong>, 34</td>
</tr>
<tr>
<td><strong>Radio interference</strong>, 38</td>
</tr>
<tr>
<td><strong>Emission</strong>, 40</td>
</tr>
<tr>
<td><strong>Radio network</strong>, 46</td>
</tr>
<tr>
<td><strong>Reading out</strong></td>
</tr>
<tr>
<td><strong>Recipe data record</strong>, 238, 244</td>
</tr>
<tr>
<td><strong>Recipe menu</strong></td>
</tr>
<tr>
<td><strong>Editing</strong>, 242</td>
</tr>
<tr>
<td><strong>Entering</strong>, 247</td>
</tr>
<tr>
<td><strong>Exporting</strong>, 245</td>
</tr>
<tr>
<td><strong>Importing</strong>, 246</td>
</tr>
<tr>
<td><strong>Reading from PLC</strong>, 238, 244</td>
</tr>
<tr>
<td><strong>Synchronizing with PLC</strong>, 236</td>
</tr>
<tr>
<td><strong>Transferring to PLC</strong>, 239, 244</td>
</tr>
<tr>
<td><strong>Recipe list</strong>, 230, 241</td>
</tr>
<tr>
<td><strong>Recipe menu</strong></td>
</tr>
<tr>
<td><strong>Operating</strong>, 241</td>
</tr>
<tr>
<td><strong>Recipe screen</strong>, 234, 241</td>
</tr>
<tr>
<td><strong>Recipe tag</strong></td>
</tr>
<tr>
<td><strong>Offline</strong>, 233</td>
</tr>
<tr>
<td><strong>Online</strong>, 233</td>
</tr>
<tr>
<td><strong>Synchronizing</strong>, 233, 237</td>
</tr>
<tr>
<td><strong>Recipe view</strong>, 234</td>
</tr>
<tr>
<td><strong>Editing</strong>, 240</td>
</tr>
<tr>
<td><strong>Extended</strong>, 230</td>
</tr>
<tr>
<td><strong>Menu items</strong>, 241</td>
</tr>
<tr>
<td><strong>Operating</strong>, 234</td>
</tr>
<tr>
<td><strong>Operator control</strong>, 234, 240</td>
</tr>
<tr>
<td><strong>Simple</strong>, 230</td>
</tr>
<tr>
<td><strong>Recommissioning</strong>, 164</td>
</tr>
<tr>
<td><strong>Recycling</strong>, 5</td>
</tr>
<tr>
<td><strong>Regional and language settings</strong>, 136</td>
</tr>
<tr>
<td><strong>Regional setting</strong>, 136</td>
</tr>
<tr>
<td><strong>Registered trademark</strong>, 4</td>
</tr>
<tr>
<td><strong>Registry information</strong></td>
</tr>
<tr>
<td><strong>Backup</strong>, 129</td>
</tr>
<tr>
<td><strong>Remote control</strong></td>
</tr>
<tr>
<td><strong>Closing</strong>, 219</td>
</tr>
<tr>
<td><strong>Forcing permission</strong>, 218</td>
</tr>
<tr>
<td><strong>Start</strong>, 218</td>
</tr>
<tr>
<td><strong>Removing</strong></td>
</tr>
<tr>
<td><strong>Password</strong>, 115</td>
</tr>
<tr>
<td><strong>WinCC flexible option</strong>, 164, 184, 185</td>
</tr>
<tr>
<td><strong>Replacement key set</strong>, 16</td>
</tr>
<tr>
<td><strong>Reset button</strong>, 63</td>
</tr>
<tr>
<td><strong>Resetting</strong></td>
</tr>
<tr>
<td><strong>To factory settings</strong>, 72</td>
</tr>
<tr>
<td><strong>Response time</strong></td>
</tr>
<tr>
<td><strong>Handwheel</strong>, 87</td>
</tr>
</tbody>
</table>
### Index

- **Restoring**, 203
  - From external storage device, 159
    - With ProSave, 174
    - With WinCC flexible, 173
- **Rotary coding switch**
  - Transponder, 57
- **Ruler**
  - Trend view, 213

### S

#### Safety
  - Functional scope, 25

#### Safety instruction
  - Changed tag name, 237
  - Multi-key operation, 192
  - Recipe data record in the background, 231

#### Sample cycle time, 87

#### SAR, 40

#### Scaling
  - Functional scope, 24

#### Scope
  - Manual, 3
  - Scope of delivery, 13, 55

#### Screen
  - Functional scope, 24

#### Screen keyboard
  - Adjust size, 105, 197
  - Change layout, 106, 197
  - Character repeat, 109
  - Configure, 107
  - Entering data, 197
  - For Control Panel, 104
  - For project, 195
  - Move, 105, 196
  - Representation types, 104, 195

#### Screen off, 81, 137

#### Screen saver, 138
  - Setting, 137, 138

#### SecureMode
  - Disabling, 101
  - Enabling, 101

#### Security system, 201

#### Service, 5

#### Service pack
  - HMI device, 16

#### Setting
  - Date, 127
  - Date format, 136
  - Delay time, 142
  - Double-click, 110

#### ID, 59

#### Language, 195

#### Number format, 136

#### Printer connection, 135

#### Regional data, 136

#### Screen saver, 137, 138

#### SMTP server, 151

#### Storage location, 141

#### Time, 127

#### Time format, 136

#### Setting language, 195

#### Setting up
  - Password, 114
  - Password protection, 114
  - Zone, 47

#### Side view, 15

#### SIMATIC Logon, 202

#### SIMATIC S7, 22

#### Simple alarm view, 222

#### Simple recipe view, 240

#### Menu items, 241

#### Operator control, 240

#### Simple user view, 204

#### Slider control, 211

#### Sm@rtAccess, 22

#### Sm@rtClient view, 217

#### Monitoring mode, 217

#### Usage, 217

#### Sm@rtService, 22

#### SMTP server, 150

#### Setting, 151

#### Software
  - Fail-safe operation, 22
  - Software options, 22
  - Sort order
    - Alarm view, 223

#### SSID
  - Hidden, 53

#### Standard
  - EMC testing, 36
  - TÜV, 37

#### Start
  - HMI device, 113

#### Static electricity
  - Protective measures, 272

#### Status Force, 215

#### Touch operation, 216

#### Storage location
  - Setting, 141

#### Storage medium
  - Restoring from external, 159
Index

Saving to external, 157
Subnet Mask, 149
Support
  Technical, 5
  Support Request, 5
Switch off
  HMI device, 76
Switches, 212
Switching on
  HMI device, 75
Synchronizing
  Date and time, 128
  Recipe tag, 233, 237
System alarm
  Configuring events, 273
Parameters, 273
System alarms
  Display, 273
System functions, 84
System information
  Displaying, 139, 140
System properties
  Device name, 147
  General, 139
  Memory, 140

T
Tag, 24
  Functional scope, 24
Task planner
  Functional scope, 26
TCP/IP address, 148
Technical specifications
  Display, 255
  HMI device, 255
  Input device, 255
  Interfaces, 256
  Main rechargeable battery, 259
  Memory, 255
  Power supply, 256, 260
  Weight, 260
Technical support, 5
Technical Support, 5
Temperature
  Temporary files
    Backup, 129
  Test
  Mechanical, HMI device, 43
Text list
  Functional scope, 24
Time
  Setting, 127
  Synchronizing, 128
Time format, 136
Time zone
  Setting, 127
Touch operation
  Trend view, 214
  Touch screen, 211
  Calibrating, 111
Trademark, 4
Training center, 5
Transfer
  Automatic, 167
  Cancel, 75
  Manual, 166
  Transfer settings, 144
  Directories, 141, 142
  Transfer Settings
    Channel, 144
  Transferring
    License key, 164, 187
    Project, 164
    Recipe data record, 239, 244
  Transferring back
    License key, 164, 188
  Transponder, 20
  Inserting the battery, 59
  Installation, 57
  Main dimensions, 254
  Rotary coding switch, 57
  Setting ID, 59
  Transponder assignment
    Planning, 47
  Transport damage, 55
  Trend view, 214
  Buttons, 213
  Touch operation, 214
Trends
  Functional scope, 26
  Limit violation, 213

U
UL approval, 35
Unintentional action, 192, 210
Updating
  Operating system, 175
### Index

- **With ProSave**, 176
- **With WinCC flexible**, 175
- **Updating the operating system**, 164

#### Usage
- In industry, 37
- In residential areas, 38

#### USB
- Keyboard, 100
- Mouse, 100
- Pin assignment, 257

#### USB memory stick, 17

#### USB Flashdrive, 17

#### Use
- With additional measures, 42

#### User data
- Backup, 203
- Changing, 208
- Restoring, 203

#### User group, 202

#### User name, 149

#### User view, 204
- Extended, 204
- Number of characters, 203
- Simple, 204

#### Users, 206
- Admin, 208, 209
- Creating, 206
- Delete, 209
- Logoff, 206
- Logon, 205
- Number of characters, 203
- PLC_User, 208, 209

#### V

- **Value table**, Trend view, 213

#### VBScript
- Functional scope, 26

#### Vibration alarm
- Activate, 134

#### W

- **Weight**, 260

#### WinCC flexible Internet settings
- E-mail, 150

#### WinCC flexible option, 164, 183, 185

#### License key, 186

#### Windows CE taskbar
- Password protection, 98

- **WINS**, 149
- **Server**, 146
- **Wireless approval**, 35

#### WLAN
- Assigning connection parameters, 119
- Configuring the connection, 117
- Input power, 258
- Interface, 258
- Output power, 259
- Standards, 258

- **WLAN quality**, 200

#### Z

- **ZigBee devices**, 51
- **Zone**, 201
- In the project, 47
- Planning, 47
- Quality, 48
- Setting up, 47
- Testing, 190
- Zone name, 201